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Rockwell Automation IO Device Library Reference Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

These labels may also be on or inside the equipment to provide specific precautions.

The following icon may appear in the text of this document.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which 
may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, 
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage 
may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc 
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory 
requirements for safe work practices and for Personal Protective Equipment (PPE).

Identifies information that is useful and can help to make a process easier to do or easier to understand.
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Device Object Libraries 
Overview

Our Device Object Libraries enable you to easily interface with Rockwell 
Automation intelligent devices like drives, motion, network switches, sensors, 
IO and more. The libraries contain tested, documented, and lifecycle-managed 
objects which can be used with machine builder, process, and packaged 
libraries or as standalone components. Device objects include HMI faceplates 
for FactoryTalk® View ME/SE and Studio 5000 View Designer® software and 
provide a user interface that seamlessly integrates with the products.

HMI faceplates are standard display files that provide a common user 
interface. These are HMI pop-up screens used to display detailed information 
related to a specific instruction or device. In systems that follow ISA 101.1 
design guidelines, faceplates are often referred to as Level 4 displays.

Pre-configured Device Objects include an Add-On Instruction Rung and an 
HMI Faceplate providing the following benefits:

• Collect, Process and Deliver Data between Smart Devices and 
Application Logic

• Detailed Device Data Collection and Delivery
• Enhanced Device Status and Diagnostics
• Common Control Interfaces maximizing Flexible Automation Device 

Selection & Application Code Reuse 

Device Object Use Cases:
• Basic Device Maintenance and Diagnostics
• Virtual Device Operations for Startup and Commissioning
• Operator and Program Control for Velocity Machine and Process 

Applications

Application Code Manager Studio 5000® Application Code Manager is a tool that can be used with Device 
Object Libraries to streamline project and machine development. This bulk 
coding tool allows you to easily design and standardize functionality with 
reusable application code.

Enable more efficient project development with reusable libraries of code:
• Quickly create and deploy projects through our Application Content 

Libraries
• Import Rockwell provided application content libraries to expedite 

system development
• Build your own reusable code that can be managed and deployed across 

your entire enterprise

Device Object Libraries may be downloaded from the Product Compatibility 
and Download Center. Search for “Library”.

https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111


12 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Preface          

• Easily configure objects in bulk with reusable code to increase 
application development, no additional programming is necessary

• Consolidate content for Studio 5000 Logix Designer®, FactoryTalk® 
View Studio, FactoryTalk® Alarms & Events, FactoryTalk® Historian to 
configure an object a single time and generate content for each of those 
software packages.

See the section on Using the Library with Application Code Manager for more 
details.

Other Application Code 
Libraries

This Device Object Library may be used in harmony with other Application 
Code Libraries including other Device Object Libraries (Network, IO, IO-Link, 
Safety Device Libraries) or Application Libraries (PlantPAx® Process Objects 
library, Machine Builder Libraries). All libraries are intended to follow similar 
design philosophies to provide a consistent experience for operators and 
maintenance staff.

A complete list of Application Code Libraries from Rockwell Automation® 
follows.

Libraries can be accessed from the 
Product Compatibility and Download Center.

Item Description

PlantPAx® Process Library Rockwell Automation® Library of Process Objects provides application templates, Endress + Hauser library objects, 
Application Code Manager library objects, and tools and utilities for PlantPAx® DCS applications.
Includes the following:
• Graphics for built-in instructions
• HMI images and Help files
• Logix diagnostic objects
• Process objects
• Control strategies
• Sequencer objects
• PlantPAx® Configuration Tools for Tags, Alarms and Historian
• Color Change
• Historian -- Asset Framework template and objects

Machine Builder Libraries Tested, documented and life-cycle managed library objects and faceplates for use with Studio 5000® Application Code 
Manager for use primarily with OEM and discrete machine applications.

Common Application Libraries Commonly used application library objects and faceplates for use with Studio 5000® Application Code Manager 
including basic functions like unit conversion and data collection.

Independent Cart Technology Libraries ICT Libraries for iTRAK and MagneMotion including MagneMover LITE and QuickStick for Studio 5000® Application Code 
Manager

I/O Device Library Provides objects for Rockwell Automation 1756, 1769, 1734, 1794, 1738, 1732E, 1719, 5069, 5094 I/O modules including 
pre-configured status and diagnostic faceplates 

IO-Link Device Library Provides IO-Link master and sensor objects including pre-configured status and diagnostic faceplates

Network Device Library Provides objects for Stratix® switch and Device Level Ring network objects

Power Device Library Provides objects for discrete, velocity, motion, and power monitor devices

Safety Device Library Provides safety objects to interface with safety I/O

Condition Monitoring Device Library Provides Dynamix™ -1444 module and machinery Condition Monitoring applications such as motors and pumps. This
includes FactoryTalk View® SE HMI faceplates and Studio 5000® Application Code Manager implementations.

Electrical Protection Device Library Provides a standard to represent protection devices within your electrical distribution system

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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Software and Firmware 
Upgrades

When you update software or firmware revisions, we recommend that you 
verify the impact on performance and memory utilization before 
implementing the upgrade on the production system. For FactoryTalk® View 
or ControlLogix® platforms, we recommend that you review the release notes 
and verify the impact of the upgrade on performance and memory utilization.

You can also verify the compatibility of the upgrade with the installed software 
and operating systems in use on your system. See the Product Compatibility 
and Download Center.

Rockwell Automation 
Services and Support

System Support offers technical assistance that is tailored for control systems. 
Some of the features include the following:

• Highly experienced team of engineers with training and
systems experience

• Use of online remote diagnostic tools
• Access to otherwise restricted TechConnectSM Knowledgebase content
• 24-hour, 7 days per week, 365 days per year of phone-support coverage upgrade 

option

For more information, contact your local distributor or Rockwell Automation 
representative or see http://www.rockwellautomation.com/support.

You can view or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley distributor or
Rockwell Automation sales representative.

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
http://www.rockwellautomation.com/support
http://literature.rockwellautomation.com
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Rockwell Automation® IO Device Library

The IO Device Library is a tested, documented, and life cycle managed object 
library. The Device Library provides pre-configured status and diagnostic 
faceplates sets for Rockwell Automation® I/O Modules. Additionally, the 
library includes Studio 5000® Application Code Manager module objects that 
allow users to easily add and configure I/O in their project. The IO Device 
Objects may be used with Machine Builder, Process, and Packaged Libraries or 
as standalone components. 

The IO Device Library includes HMI Faceplates for FactoryTalk® View ME, 
FactoryTalk® View SE, and Studio 5000 View Designer® compatible with Allen-
Bradley® I/O modules. This document includes the functional requirements of 
the IO device objects.

Compatibility Compatible Software
• Studio 5000 Logix Designer® V30.01.00, v31.02.00, v32.04.00, v33.01.01, 

v34.01.00 v35.01.00 for PAC Application Development
• Studio 5000® Application Code Manager v4.01 and later for bulk code 

configuration
• Studio 5000 View Designer® v5.01.00 and later for PanelView™ 5000 

Application Development
• FactoryTalk® View Studio v10.00.01 and later for PanelView™ Plus and 

FactoryTalk® View SE Application Development

Compatible Hardware
• PanelView™ 5500/5510/5310 with v5 or later firmware
• PanelView™ Plus v10 or later firmware
• ControlLogix® 5580/5570, CompactLogix® 5580/5570, GuardLogix® 

5580/5570, or Compact GuardLogix® 5580/5570 controller with v30.01 or 
later firmware. Note GuardLogix® or Compact GuardLogix® controllers 
are required for use with Safety class I/O modules.

• Allen-Bradley I/O Modules including:
- 1715 High-Availability I/O
- 1719 Ex I/O
- 1732E I/O

The IO Device Library may be downloaded from the Product Compatibility and 
Download Center. Search for IO Device Library.

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.aspx?crumb=111
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- 1734 POINT I/O
- 1738 I/O
- 1756 ControlLogix I/O
- 1756 EN4TR
- 1769 Compact I/O
- 1791ES Guard I/O
- 1794 Flex I/O
- 5015 FLEXHA 5000 I/O
- 5069 Compact 5000 I/O
- 5094 FLEX 5000 I/O

• HART Modules

Summary of Changes This publication contains the following new or updated information. This list 
includes substantive updates only and is not intended to reflect all changes.

This release consists of new module faceplate and updated ACM Library.

Footprint Each instruction requires memory footprint within the Logix controller. The 
following characteristics apply:

• Definition: Estimated memory required to store the object definition, 
including all dependents

• Instance: Estimated memory required per object instantiated.
• Execution (L85E): Estimated execution time / scan footprint evaluated 

in 1756-L85E PAC

Topic Revision Page
Updated ACM parameter for Hart modules. B Throughout
Bug fixes in 5094 ACM Library. B Throughout
Added a parameter for channel1 in 5094 and 5069 Serial modules in ACM Library. B Throughout
Added rack optimization in 1734 and1794 in ACM Library B 185
Added new Faceplates in 1756 series module B Throughout
Added new Faceplates in 1769 series module B Throughout
Added new Faceplates in 1794 series module B Throughout
Added new Faceplate in 5094 series module B Throughout
Updated Global Objects in FTView ME / SE B Throughout
Updated Faceplate and ACM revision C Throughout
Added state model details C 78
Updated importing Logic into studio 5000® projects C 91
Added Module Definition details C 97 - 111
Updated ICON for graphical button and added new button. C Throughout
Added Redundant Adapter 1756-EN4TR Chapter C 319

Device Object Footprint

Device Object Defintion (kB) Instance (kB) Execution (µs)
raC_Dvc_1756_EN4TR 36.22 4.936 95
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Library Components

IO Device Library The IO Device Library includes HMI faceplates to interface with Allen-
Bradley® I/O Modules. There are no Add-On Instructions or additional 
programming required. All HMI faceplates communicate directly with I/O 
module data structures that are pre-defined in the Logix controllers when the 
I/O module is defined in a project.

Note: 1756-ENTR includes pre-configured status and diagnostic faceplate with 
Add-on instruction.

All I/O module faceplates have similar functions. The HMI faceplate displays 
diagnostic information such as module or channel faults along with I/O 
channel status and data. HMI tags are also provided for FactoryTalk® View 
ME/SE projects to support multi-tab navigation. 

The IO Device Library also contains Studio 5000® Application Code Manager 
module objects. This allows users to add Allen-Bradley® I/O Modules, or HART 
modules to a project in Studio 5000® Application Code Manager.

This manual has grouped faceplates by module type as follows:
• Discrete Input
• Discrete Output
• Analog Input
• Analog Output
• Analog Input with HART
• Analog Output with HART
• Safety Discrete Input
• Safety Discrete Output
• Safety Analog Input
• 1715 Simplex and Duplex I/O
• 5015 Simplex and Duplex I/O
• High Speed Counter
• Sequence of Events
• Rack Optimized
• Redundant adapter

All objects in this library are considered devices:
• Device (Dvc): instruction used for devices (e.g. I/O Modules).

Library Folders and Files When you extract the library from the downloaded .zip folder, you will find the 
following folder and file structure. Note that some items are generalized with 
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TYPE (e.g. Analog, Digital, Communications), FAMILY (1756, 5094, etc), 
MODULE (e.g. OB16, IF8, etc) and SER (series e.g. A/B/C). The major and minor 
versions are represented by X and Y respectively.

Level 1 Level 2 Level 3 File Type Description
Application Example Folder Application Example Files

Project_IODevice_xxxx_Application_V5_03.xlsx XLSX Application Code Manager 
Project

IODevice_xxxx_Application_V5_03.ACD ACD Logix Designer Example project
IODeviceApplication_SE_V5_03.apa APA FTView SE Project Archive
IODeviceApplication_ME_V5_03.apa APA FTView ME Project Archive

ApplicationCodeManagerLibraries Folder Application Code Manager 
files

Attachments (.HZ1 and .txt files) Folder ACM Object Attachments
(RA-LIB)_ACM_2.00_Module_TYPE_FAMILY-MODULE_SER_(X.Y).HSL4 HSL4 ACM Module Object

HMI - FactoryTalk View ME Folder FactoryTalk® View ME files
Displays - gfx Folder FT View ME display files

(raC-X_YY-ME) raC_Dvc_FAMILY-MODULE-
faceplate.gfx GFX Object Faceplate display

Global Objects - ggfx Folder FT View ME Global Object files

(raC-X-ME) Graphic Symbols - LIBRARY.ggfx GGFX Graphic Symbol/Launch Button 
global objects

(raC-X-ME) Toolbox - LIBRARY.ggfx GGFX Toolbox global objects
HMI - FactoryTalk View SE Folder FactoryTalk® View SE Files

Displays - gfx Folder FT View SE display files
(raC-X_YY-SE) raC_Dvc_FAMILY-MODULE-
faceplate.gfx GFX Object Faceplate display

Global Objects - ggfx Folder FT View SE Global Object files

(raC-X-SE) Graphic Symbols - LIBRARY.ggfx GGFX Graphic Symbol/Launch Button 
global objects

(raC-X-SE) Toolbox - LIBRARY.ggfx GGFX Toolbox global objects
HMI - ViewDesigner - vpd Folder View Designer Files

(raC-X_YY-VD) raC_Dvc_FAMILYIO_wDesc.vpd VPD Object faceplate and graphic 
symbol/launch buttons

HMI FactoryTalk View Images - png Folder FT View ME/SE image files
images.png PNG FTView ME/SE images

Reference Manuals Folder Manuals
DEVICE-RM200x-EN-P.pdf PDF Reference manual

Studio 5000 Logix Designer Files- 
L5X Folder Studio 5000 AOI and RUNG 

Import Files
raC_Dvc_EN4TR_5.03_RUNG.L5X L5X Object Rung Import
raC_Dvc_EN4TR_5.03_AOI.L5X L5X Object AOI Import

Videos Folder How-to and Operational 
Overview Videos

How_To_Import_and_Configure_IO_Objects_in_FTViewME.mp4 MP4 How-to Video
How_To_Import_and_Configure_IO_Objects_in_FTViewSE.mp4 MP4 How-to Video
How_To_Configure_IO_Objects_in_ViewDesigner.mp4 MP4 How-to Video
Operational_Overview_of_IO_Device_Faceplate.mp4 MP4 Operational Overview video
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FTViewStudio_IOLibrary_Tags_5_00.csv CSV FTView ME/SE HMI Tags
ReadMe.txt TXT Explanation of setup.cmd

SetUp.cmd CMD Application Code Manager setup 
script to register library
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Visualization Files Each Add-On Instruction or IO-Module has associated visualization files that 
provide a common user interface. The IO Device Library supports two HMI 
options each with their own files supplied:

• FactoryTalk® View ME (Machine Edition)
• FactoryTalk® View SE (Site Edition)
• Studio 5000 View Designer®

FactoryTalk® View Visualization Files

You must import these files in the following order:
• Images (.png files)
• Global Objects(.ggfx file type)
• HMI faceplates (.gfx file type)

Global object files contain Graphic Symbols that are created once and 
referenced multiple times on multiple displays in an application. When 
changes are made to a global object, all instances in the application are 
automatically updated.

Global objects serve two purposes:
• Toolbox files contain common elements that are used to build faceplate 

displays.
• Graphic Symbols files contain device symbols or launch buttons that 

you can use to build your application displays. Select the symbol to 
open the corresponding faceplate display.

Standard display files, commonly called faceplates, provide a common user 
interface.

A complete list of includes FactoryTalk® View SE/ME HMI Faceplates is 
provided below categories by I/O family.

File Type Abbreviations FactoryTalk® View ME FactoryTalk® View SE Description

Images (.png)

All .png files in the HMI FactoryTalk® View 
Images - png folder.
IMPORTANT: FactoryTalk® View application 
renames PNG files when they are imported with a 
.bmp file extension, but the files retain a .png 
format.

All .png files in the HMI FactoryTalk® View 
Images - png folder.
IMPORTANT: FactoryTalk® View application 
renames PNG files when they are imported with a 
.bmp file extension, but the files retain a .png 
format.

Common icons that are used in the Global Objects 
and standard displays for all objects.

Global objects (.ggfx)
(raC-5-ME) Graphic Symbols - IO Device.ggfx (raC-5-SE) Graphic Symbols - IO Device.ggfx Graphic symbols or launch buttons used to open 

faceplate displays from other displays.

(raC-5-ME) Toolbox - IO Device.ggfx (raC-5-SE) Toolbox - IO Device.ggfx Common objects used across multiple device 
faceplates.

Standard displays (.gfx) (raC-5_XX-ME) precedes name of the display. (raC-5_XX-SE) precedes name of the display. e.g. (raC-5_00-SE) raC_Dvc_1756-IB16-
Faceplate.gfx
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Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1715

(raC-5_01-SE) raC_Dvc_1715_IB16D_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IB16D_Duplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_IB16D_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IB16D_Simplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_IF16_AnalogDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_AnalogDuplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_IF16_AnalogSimplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_AnalogSimplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_IF16_HARTDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_HARTDuplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_IF16_HARTSimplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_HARTSimplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate.gfx

1719

(raC-5_00-SE) raC_Dvc_1719_IBN8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IBN8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1719_IBN8B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IBN8B-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1719_IR4B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IR4B-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1719_IT4B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IT4B-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1719_OB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_OB2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1719_OB2L-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_OB2L-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1719_IF4HB-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1719_IF4HB-Faceplate.gfx

1732

(raC-5_00-SE) raC_Dvc_1732E_IB16M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IB16M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12R-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IB16M12W-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12W-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IB8M8SOER-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB8M8SOER-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IF4M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IF4M12R-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IR4IM12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IR4IM12R-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_IT4IM12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IT4IM12R-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_OB16M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB16M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_OB16M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB16M12R-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_OB8M8SR-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB8M8SR-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1732E_OF4M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OF4M12R-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB12XOB4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOB4_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB12XOB4_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOB4_SafetyTestOutput-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB12XOBV2_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOBV2_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB12XOBV2_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOBV2_SafetyTestOutput-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB16_SafetyTestOutput -Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB16_SafetyTestOutput -Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB8XOB8_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB8XOB8_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB8XOB8_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB8XOB8_SafetyTestOutput-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1732ES_IB8XOBV4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB8XOBV4_Safety-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1732ES_IB8XOBV4_SafetyTestOutput-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1732ES_IB8XOBV4_SafetyTestOutput-Faceplate.gfx



22 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Chapter 2          Library Components

1734

(raC-5_03-SE) raC_Dvc_1734_IB4D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IB4D-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1734_IB8S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IB8S_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1734_IB8S_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IB8S_SafetyTestOutput-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1734_IE4S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IE4S_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1734_OB8S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_OB8S_Safety-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IA2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IA2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IA4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IA4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IB4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IE2C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE2C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IE2V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE2V-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IE4C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE4C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IE8C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE8C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IM2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IM2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IM4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IM4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IR2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IR2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IR2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IR2E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IT2I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IT2I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IV2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IV4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_IV8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OA2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OA2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OA4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OA4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB2EP-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2EP-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB4E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB4E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OB8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB8E-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1734_OBV2S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_OBV2S_Safety-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OE2C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE2C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OE2V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE2V-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OE4C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE4C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OV2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV2E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OV4E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV4E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OV8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV8E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OW2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OW2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OW4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OW4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1734_OX2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OX2-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1734_8CFG-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734_8CFG-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1734sc_IE2CH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IE2CH-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1734sc_IE4CH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IE4CH-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1734sc_IF4U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IF4U-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1734sc_OE2CIH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_OE2CIH-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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(raC-5_01-SE) raC_Dvc_17x4_xx2-Faceplate.gfx (raC-5_01-ME) raC_Dvc_17x4_xx2-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_17x4_xx4-Faceplate.gfx (raC-5_01-ME) raC_Dvc_17x4_xx4-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_17x4_xx8-Faceplate.gfx (raC-5_01-ME) raC_Dvc_17x4_xx8-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_17x4_xx16-Faceplate.gfx (raC-5_01-ME) raC_Dvc_17x4_xx16-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_17x4_xx32-Faceplate.gfx (raC-5_01-ME) raC_Dvc_17x4_xx32-Faceplate.gfx

1738

(raC-5_00-SE) raC_Dvc_1738_IA2M12AC3-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IA2M12AC3-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IA2M12AC4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IA2M12AC4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB2M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB2M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB4M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB4M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB4M8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB8M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB8M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M23-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IB8M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IE2CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE2CM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IE2VM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE2VM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IE4CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE4CM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IR2M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IR2M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IT2IM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IT2IM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IV4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV4M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IV8M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IV8M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M23-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_IV8M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OA2M12AC3-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OA2M12AC3-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB16E19M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16E19M23-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB16E25DS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16E25DS-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB16EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16EM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB2EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB2EM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB2EPM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB2EPM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB4EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB4EM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB4EM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB4EM8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB8EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB8EM23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM23-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OB8EM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OE2CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE2CM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OE2VM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE2VM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OE4CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE4CM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OV4EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OV4EM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OW4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OW4M12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1738_OW4M12AC-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OW4M12AC-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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(raC-5_03-SE) raC_Dvc_1756_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_HSC-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IA16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA16I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IA32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA32-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_IA8D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IA8D-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB16-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_IB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16D-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IB16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB16I-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_IB16ISOE-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16ISOE-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_IB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16S_Safety-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IC16-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF16_Differential-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16_Differential-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF16_SingleEnded-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16_SingleEnded-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_IF16H-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_IF16H-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IF4FXOF2F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF4FXOF2F-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IF6CIS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF6CIS-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IF6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF6I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF8_Differential-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8_Differential-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF8_SingleEnded-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8_SingleEnded-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_IF8H-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_IF8H-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IF8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IH16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IH16I-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_IH16ISOE-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IH16ISOE-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IM16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IM16I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IN16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IN16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IR12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IR12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IR6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IR6I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IRT8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IRT8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IT16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IT16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IT6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IT6I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IV16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_IV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IV32-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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(raC-5_00-SE) raC_Dvc_1756_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OA16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA16I-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_OA8D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OA8D-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OA8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA8E-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_OB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OB16D-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB16E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB16IEF-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16IEF-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB16IEFS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16IEFS-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB8EI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8EI-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OB8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8I-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_OBV8S_SafetyBipolar-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OBV8S_SafetyBipolar-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_OBV8S_SafetySourcing-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OBV8S_SafetySourcing-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OC8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OC8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OF6xl-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF6xl-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OF6CI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF6CI-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OF6VI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF6VI-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF8-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1756_OF8H-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OF8H-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_OF8I-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_OF8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_ON8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_ON8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OV16E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OV16E-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1756_OV32E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OV32E-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IB16IF-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IB16IF-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF16IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16IH-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8IH-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_IT6I2-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IT6I2-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_OA8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OA8-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_OB16IS-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OB16IS-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_OF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OF8IH-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_OH8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OH8I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_OW16I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OW16I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756_OX8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OX8I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1756sc_IC32-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756sc_IC32-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756sc_IF8U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756sc_IF8U-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1756_EN4TR-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_EN4TR-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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1769

(raC-5_01-SE) raC_Dvc_1769_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1769_ASCII-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1769_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1769_HSC-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IA8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF16C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF16C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF16V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF16V-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF4FXOF2F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4FXOF2F-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF4XOF2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4XOF2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IM12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IQ16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IQ16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ16F-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IQ32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IQ32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ32T-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IQ6XOW4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ6XOW4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IR6-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IR6-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_IT6-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IT6-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OA8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OB16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB16P-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OB32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB32T-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF4CI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4CI-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF4VI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4VI-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF8C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF8C-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OF8V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF8V-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OV16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OV32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OV32T-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OW16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OW8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1769_OW8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW8I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1769sc_IF4IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IF4IH-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1769sc_IF8U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IF8U-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1769sc_IR6I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IR6I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1769sc_IT6I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IT6I-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1769sc_OF4IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_OF4IH-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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1791ES

(raC-5_01-SE) raC_Dvc_1791ES_IB16_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB16_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1791ES_IB16_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB16_SafetyTestOutput-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1791ES_IB8XOBV4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB8XOBV4_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1791ES_IB8XOBV4_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB8XOBV4_SafetyTestOutput-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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1794

(raC-5_01-SE) raC_Dvc_1794_IB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_IB16D-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_1794_OB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_OB16D-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1794_VHSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_VHSC-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IB10XOB6-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB10XOB6-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IB16XOB16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB16XOB16P-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IC16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IE12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IE4XOE2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE4XOE2-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IE8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IE8XOE4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE8XOE4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IF2XOF2I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IF2XOF2I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IF4I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IH16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IH16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IM16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IM16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IM8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IR8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IR8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IRT8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IRT8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IT8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IT8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IV16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_IV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IV32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA8I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OB16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB16P-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OB32P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB32P-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OB8EP-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB8EP-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OC16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OE12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OE12-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OE4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OE4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OF4I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OG16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OM16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OM16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OM8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OV16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV16P-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV32-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_1794_OW8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OW8-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1794_IB10XOB6_Rack-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB10XOB6_Rack-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1794_IB16XOB16P_Rack-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB16XOB16P_Rack-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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(raC-5_03-SE) raC_Dvc_1794_IF4ICF-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IF4ICF-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1794_IF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IF8IH-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1794_IF8IHNF-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1794_IF8IHNF-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_1794_OF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_OF8IH-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1794sc_IF8IU-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794sc_IF8IU-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1794sc_IRT8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794sc_IRT8I-Faceplate.gfx

5015
(raC-5_01-SE) raC_Dvc_5015_U8IHFTXT_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5015_U8IHFTXT_Simplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5015_U8IHFTXT_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5015_U8IHFTXT_Duplex-Faceplate.gfx

5069

(raC-5_01-SE) raC_Dvc_5069_HSC2XOB4-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_HSC2XOB4-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5069_IB8S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_IB8S_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5069_IB8S_SafetyMuting-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_IB8S_SafetyMuting-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5069_OBV8S_SafetyBipolar-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_OBV8S_SafetyBipolar-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5069_OBV8S_SafetySourcing-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_OBV8S_SafetySourcing-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBSlave-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IB16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB16F-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IB6F_3W-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB6F_3W-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IF8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_IY4-IR-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IY4-IR-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OA16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OB16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB16F-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OF4-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OF8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OW16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OW16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OW4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OW4I-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5069_OX4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OX4I-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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Studio 5000 View Designer® Visualization Files

A View Designer project file for each I/O family is supplied which contain 
faceplates and launch buttons for the IO Device Library. These files are found 
in the HMI - ViewDesigner - vpd folder. Inside of the VPD file you will find a the 
required display files inside of the User-Defined Screens folder.

A complete list of View Designer files follows:

5094

(raC-5_01-SE) raC_Dvc_5094_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_HSC-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_IB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_IB16S_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_IF8IH_HART-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_IF8IH_HART-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_IF8IH_PlantPAx-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_IF8IH_PlantPAx-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OB16S_Safety-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OF8IH_HART-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OF8IH_HART-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OF8IH_PlantPAx-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OF8IH_PlantPAx-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OW4IS_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OW4IS_Safety-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_IB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_IF8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_OB16-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_OF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_OF8-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_OW8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_OW8I-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBSlave-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_5094_IA16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IA16-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5094_IB32-Faceplate.gfx (raC-5_03-ME) raC_Dvc_5094_IB32-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5094_IM8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IM8-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_5094_IY8_IR-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IY8_IR-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_5094_IY8_IT-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IY8_IT-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_5094_OA16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OA16-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5094_OB32-Faceplate.gfx (raC-5_03-ME) raC_Dvc_5094_OB32-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5094_OB8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OB8-Faceplate.gfx

Family FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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Family View Designer File View Designer Screen

1715 raC_Dvc_1715IO_wDesc.vpd

raC_Dvc_1715-IB16D_Duplex_wDesc_FP
raC_Dvc_1715-IB16D_Simplex_wDesc_FP
raC_Dvc_1715-IF16_AnalogDuplex_wDesc_FP
raC_Dvc_1715-IF16_AnalogSimplex_wDesc_FP
raC_Dvc_1715-IF16_HARTDuplex_wDesc_FP
raC_Dvc_1715-IF16_HARTSimplex_wDesc_FP
raC_Dvc_1715-OB8DE_Duplex_wDesc_FP
raC_Dvc_1715-OB8DE_Simplex_wDesc_FP
raC_Dvc_1715-OF8I_AnalogDuplex_wDesc_FP
raC_Dvc_1715-OF8I_AnalogSimplex_wDesc_FP
raC_Dvc_1715-OF8I_HARTDuplex_wDesc_FP
raC_Dvc_1715-OF8I_HARTSimplex_wDesc_FP

1719 raC_Dvc_1719IO_wDesc.vpd

raC_Dvc_1719-IBN8_wDesc_FP
raC_Dvc_1719-IBN8B_wDesc_FP
raC_Dvc_1719-IF4HB_wDesc_FP
raC_Dvc_1719-IR4B_wDesc_FP
raC_Dvc_1719-IT4B_wDesc_FP
raC_Dvc_1719-OB2_wDesc_FP
raC_Dvc_1719-OB2L_wDesc_FP

1732 raC_Dvc_1732IO_wDesc.vpd

raC_Dvc_1732E-IB16M12_wDesc_FP
raC_Dvc_1732E-IB16M12R_wDesc_FP
raC_Dvc_1732E-IB16M12W_wDesc_FP
raC_Dvc_1732E-IB8M8SOER_wDesc_FP
raC_Dvc_1732E-IF4M12R_wDesc_FP
raC_Dvc_1732E-IR4IM12R_wDesc_FP
raC_Dvc_1732E-IT4IM12R_wDesc_FP
raC_Dvc_1732E-OB16M12_wDesc_FP
raC_Dvc_1732E-OB16M12R_wDesc_FP
raC_Dvc_1732E-OB8M8SR_wDesc_FP
raC_Dvc_1732E-OF4M12R_wDesc_FP
raC_Dvc_1732ES-IB12XOB4_Safety_wDesc_FP
raC_Dvc_1732ES-
IB12XOB4_SafetyTestOutput_wDesc_FP
raC_Dvc_1732ES-IB12XOBV2_Safety_wDesc_FP
raC_Dvc_1732ES-
IB12XOBV2_SafetyTestOutput_wDesc_FP
raC_Dvc_1732ES-IB16_SafetyTestOutput _wDesc_FP
raC_Dvc_1732ES-IB8XOB8_Safety_wDesc_FP
raC_Dvc_1732ES-IB8XOB8_SafetyTestOutput_wDesc_FP
raC_Dvc_1732ES-IB8XOBV4_Safety_wDesc_FP
raC_Dvc_1732ES-
IB8XOBV4_SafetyTestOutput_wDesc_FP
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1734 raC_Dvc_1734IO_wDesc.vpd

raC_Dvc_1734-IB4D_wDesc_FP
raC_Dvc_1734-IB8S_Safety_wDesc_FP
raC_Dvc_1734-IB8S_SafetyTestOutput_wDesc_FP
raC_Dvc_1734-IE4S_Safety_wDesc_FP
raC_Dvc_1734-OB8S_Safety_wDesc_FP
raC_Dvc_1734-IA2_wDesc_FP
raC_Dvc_1734-IA4_wDesc_FP
raC_Dvc_1734-IB2_wDesc_FP
raC_Dvc_1734-IB4_wDesc_FP
raC_Dvc_1734-IB8_wDesc_FP
raC_Dvc_1734-IE2C_wDesc_FP
raC_Dvc_1734-IE2V_wDesc_FP
raC_Dvc_1734-IE4C_wDesc_FP
raC_Dvc_1734-IE8C_wDesc_FP
raC_Dvc_1734-IM2_wDesc_FP
raC_Dvc_1734-IM4_wDesc_FP
raC_Dvc_1734-IR2_wDesc_FP
raC_Dvc_1734-IR2E_wDesc_FP
raC_Dvc_1734-IT2I_wDesc_FP
raC_Dvc_1734-IV2_wDesc_FP
raC_Dvc_1734-IV4_wDesc_FP
raC_Dvc_1734-IV8_wDesc_FP
raC_Dvc_1734-OA2_wDesc_FP
raC_Dvc_1734-OA4_wDesc_FP
raC_Dvc_1734-OB2_wDesc_FP
raC_Dvc_1734-OB2E_wDesc_FP
raC_Dvc_1734-OB2EP_wDesc_FP
raC_Dvc_1734-OB4_wDesc_FP
raC_Dvc_1734-OB4E_wDesc_FP
raC_Dvc_1734-OB8_wDesc_FP
raC_Dvc_1734-OB8E_wDesc_FP
raC_Dvc_1734-OBV2S_wDesc_FP
raC_Dvc_1734-OE2C_wDesc_FP
raC_Dvc_1734-OE2V_wDesc_FP
raC_Dvc_1734-OE4C_wDesc_FP
raC_Dvc_1734-OV2E_wDesc_FP
raC_Dvc_1734-OV4E_wDesc_FP
raC_Dvc_1734-OV8E_wDesc_FP
raC_Dvc_1734-OW2_wDesc_FP
raC_Dvc_1734-OW4_wDesc_FP
raC_Dvc_1734-OX2_wDesc_FP
raC_Dvc_1734sc_IE2CH_wDesc_FP
raC_Dvc_1734sc_IE4CH_wDesc_FP
raC_Dvc_1734sc_IF4U_wDesc_FP
raC_Dvc_1734sc_OE2CIH_wDesc_FP
raC_Dvc_1734_8CFG_wDesc_FP

Family View Designer File View Designer Screen
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1734/1794
Rack Optimized
Connections

raC_Dvc_1734IO_wDesc.vpd
or
raC_Dvc_1794IO_wDesc.vpd

raC_Dvc_17X4-xx2_wDesc_FP
raC_Dvc_17X4-xx4_wDesc_FP
raC_Dvc_17X4-xx8_wDesc_FP
raC_Dvc_17X4-xx16_wDesc_FP
raC_Dvc_17X4-xx32_wDesc_FP

1738 raC_Dvc_1738IO_wDesc.vpd

raC_Dvc_1738-IA2M12AC3_wDesc_FP
raC_Dvc_1738-IA2M12AC4_wDesc_FP
raC_Dvc_1738-IB2M12_wDesc_FP
raC_Dvc_1738-IB4M12_wDesc_FP
raC_Dvc_1738-IB4M8_wDesc_FP
raC_Dvc_1738-IB8M12_wDesc_FP
raC_Dvc_1738-IB8M23_wDesc_FP
raC_Dvc_1738-IB8M8_wDesc_FP
raC_Dvc_1738-IE2CM12_wDesc_FP
raC_Dvc_1738-IE2VM12_wDesc_FP
raC_Dvc_1738-IE4CM12_wDesc_FP
raC_Dvc_1738-IR2M12_wDesc_FP
raC_Dvc_1738-IT2IM12_wDesc_FP
raC_Dvc_1738-IV4M12_wDesc_FP
raC_Dvc_1738-IV8M12_wDesc_FP
raC_Dvc_1738-IV8M23_wDesc_FP
raC_Dvc_1738-IV8M8_wDesc_FP
raC_Dvc_1738-OA2M12AC3_wDesc_FP
raC_Dvc_1738-OB16E19M23_wDesc_FP
raC_Dvc_1738-OB16E25DS_wDesc_FP
raC_Dvc_1738-OB16EM12_wDesc_FP
raC_Dvc_1738-OB2EM12_wDesc_FP
raC_Dvc_1738-OB2EPM12_wDesc_FP
raC_Dvc_1738-OB4EM12_wDesc_FP
raC_Dvc_1738-OB4EM8_wDesc_FP
raC_Dvc_1738-OB8EM12_wDesc_FP
raC_Dvc_1738-OB8EM23_wDesc_FP
raC_Dvc_1738-OB8EM8_wDesc_FP
raC_Dvc_1738-OE2CM12_wDesc_FP
raC_Dvc_1738-OE2VM12_wDesc_FP
raC_Dvc_1738-OE4CM12_wDesc_FP
raC_Dvc_1738-OV4EM12_wDesc_FP
raC_Dvc_1738-OW4M12_wDesc_FP
raC_Dvc_1738-OW4M12AC_wDesc_FP

Family View Designer File View Designer Screen
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1756 raC_Dvc_1756IO_Input_wDesc.vpd

raC_Dvc_1756-HSC_wDesc_FP
raC_Dvc_1756-IA16_wDesc_FP
raC_Dvc_1756-IA16I_wDesc_FP
raC_Dvc_1756-IA32_wDesc_FP
raC_Dvc_1756-IA8D_wDesc_FP
raC_Dvc_1756-IB16_wDesc_FP
raC_Dvc_1756-IB16D_wDesc_FP
raC_Dvc_1756-IB16I_wDesc_FP
raC_Dvc_1756-IB16IF_wDesc_FP
raC_Dvc_1756-IB16ISOE_wDesc_FP
raC_Dvc_1756-IB16S_Safety_wDesc_FP
raC_Dvc_1756-IB32_wDesc_FP
raC_Dvc_1756-IC16_wDesc_FP
raC_Dvc_1756-IF16_wDesc_FP
raC_Dvc_1756-IF16H_wDesc_FP
raC_Dvc_1756-IF16IH_wDesc_FP
raC_Dvc_1756-IF4FXOF2F_wDesc_FP
raC_Dvc_1756-IF6CIS_wDesc_FP
raC_Dvc_1756-IF6I_wDesc_FP
raC_Dvc_1756-IF8_wDesc_FP
raC_Dvc_1756-IF8H_wDesc_FP
raC_Dvc_1756-IF8I_wDesc_FP
raC_Dvc_1756-IF8IH_wDesc_FP
raC_Dvc_1756-IG16_wDesc_FP
raC_Dvc_1756-IH16I_wDesc_FP
raC_Dvc_1756-IH16ISOE_wDesc_FP
raC_Dvc_1756-IM16I_wDesc_FP
raC_Dvc_1756-IN16_wDesc_FP
raC_Dvc_1756-IR12_wDesc_FP
raC_Dvc_1756-IR6I_wDesc_FP
raC_Dvc_1756-IRT8I_wDesc_FP
raC_Dvc_1756-IT16_wDesc_FP
raC_Dvc_1756-IT6I_wDesc_FP
raC_Dvc_1756-IT6I2_wDesc_FP
raC_Dvc_1756-IV16_wDesc_FP
raC_Dvc_1756-IV32_wDesc_FP

Family View Designer File View Designer Screen
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1756 raC_Dvc_1756IO_Output_wDesc.vpd

raC_Dvc_1756-OA16_wDesc_FP
raC_Dvc_1756-OA16I_wDesc_FP
raC_Dvc_1756-OA8D_wDesc_FP
raC_Dvc_1756-OA8E_wDesc_FP
raC_Dvc_1756-OB16D_wDesc_FP
raC_Dvc_1756-OB16E_wDesc_FP
raC_Dvc_1756-OB16I_wDesc_FP
raC_Dvc_1756-OB16IEF_wDesc_FP
raC_Dvc_1756-OB16IEFS_wDesc_FP
raC_Dvc_1756-OB32_wDesc_FP
raC_Dvc_1756-OB8_wDesc_FP
raC_Dvc_1756-OB8EI_wDesc_FP
raC_Dvc_1756-OB8I_wDesc_FP
raC_Dvc_1756-OBV8S_SafetyBipolar_wDesc_FP
raC_Dvc_1756-OBV8S_SafetySourcing_wDesc_FP
raC_Dvc_1756-OC8_wDesc_FP
raC_Dvc_1756-OF4_wDesc_FP
raC_Dvc_1756-OF6xl_wDesc_FP
raC_Dvc_1756-OF6CI_wDesc_FP
raC_Dvc_1756-OF6VI_wDesc_FP
raC_Dvc_1756-OF8_wDesc_FP
raC_Dvc_1756-OF8H_wDesc_FP
raC_Dvc_1756-OF8I_wDesc_FP
raC_Dvc_1756-OG16_wDesc_FP
raC_Dvc_1756-OH8I_wDesc_FP
raC_Dvc_1756-ON8_wDesc_FP
raC_Dvc_1756-OV16E_wDesc_FP
raC_Dvc_1756-OV32E_wDesc_FP
raC_Dvc_1756-OW16I_wDesc_FP
raC_Dvc_1756-OX8I_wDesc_FP
raC_Dvc_1756sc_IC32_wDesc_FP
raC_Dvc_1756sc_IF8U_wDesc_FP
raC_Dvc_1756_OA8_wDesc_FP
raC_Dvc_1756_OB16IS_wDesc_FP
raC_Dvc_1756-OF8IH_wDesc_FP
raC_Dvc_1756-EN4TR_FP

Family View Designer File View Designer Screen
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1769 raC_Dvc_1769IO_wDesc.vpd

raC_Dvc_1769-ASCII_wDesc_FP
raC_Dvc_1769-HSC_wDesc_FP
raC_Dvc_1769-IA16_wDesc_FP
raC_Dvc_1769-IA8I_wDesc_FP
raC_Dvc_1769-IF16C_wDesc_FP
raC_Dvc_1769-IF16V_wDesc_FP
raC_Dvc_1769-IF4_wDesc_FP
raC_Dvc_1769-IF4FXOF2F_wDesc_FP
raC_Dvc_1769-IF4I_wDesc_FP
raC_Dvc_1769-IF4XOF2_wDesc_FP
raC_Dvc_1769-IF8_wDesc_FP
raC_Dvc_1769-IG16_wDesc_FP
raC_Dvc_1769-IM12_wDesc_FP
raC_Dvc_1769-IQ16_wDesc_FP
raC_Dvc_1769-IQ16F_wDesc_FP
raC_Dvc_1769-IQ32_wDesc_FP
raC_Dvc_1769-IQ32T_wDesc_FP
raC_Dvc_1769-IQ6XOW4_wDesc_FP
raC_Dvc_1769-IR6_wDesc_FP
raC_Dvc_1769-IT6_wDesc_FP
raC_Dvc_1769-OA16_wDesc_FP
raC_Dvc_1769-OA8_wDesc_FP
raC_Dvc_1769-OB16_wDesc_FP
raC_Dvc_1769-OB16P_wDesc_FP
raC_Dvc_1769-OB32_wDesc_FP
raC_Dvc_1769-OB32T_wDesc_FP
raC_Dvc_1769-OB8_wDesc_FP
raC_Dvc_1769-OF2_wDesc_FP
raC_Dvc_1769-OF4_wDesc_FP
raC_Dvc_1769-OF4CI_wDesc_FP
raC_Dvc_1769-OF4VI_wDesc_FP
raC_Dvc_1769-OF8C_wDesc_FP
raC_Dvc_1769-OF8V_wDesc_FP
raC_Dvc_1769-OG16_wDesc_FP
raC_Dvc_1769-OV16_wDesc_FP
raC_Dvc_1769-OV32T_wDesc_FP
raC_Dvc_1769-OW16_wDesc_FP
raC_Dvc_1769-OW8_wDesc_FP
raC_Dvc_1769-OW8I_wDesc_FP
raC_Dvc_1769sc_IF4IH_wDesc_FP
raC_Dvc_1769sc_IF8U_wDesc_FP
raC_Dvc_1769sc_IR6I_wDesc_FP
raC_Dvc_1769sc_IT6I_wDesc_FP
raC_Dvc_1769sc_OF4IH_wDesc_FP

Family View Designer File View Designer Screen
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1791ES raC_Dvc_1791IEO_wDesc.vpd

raC_Dvc_1791ES-IB16_Safety_wDesc_FP
raC_Dvc_1791ES-IB16_SafetyTestOutput_wDesc_FP
raC_Dvc_1791ES-IB8XOBV4_Safety_wDesc_FP
raC_Dvc_1791ES-
IB8XOBV4_SafetyTestOutput_wDesc_FP

Family View Designer File View Designer Screen
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1794

raC_Dvc_1794IO_Input_wDesc.vpd

raC_Dvc_1794-IB16D_wDesc_FP
raC_Dvc_1794-IA16_wDesc_FP
raC_Dvc_1794-IA8_wDesc_FP
raC_Dvc_1794-IA8I_wDesc_FP
raC_Dvc_1794-IB10XOB6_wDesc_FP
raC_Dvc_1794-IB16_wDesc_FP
raC_Dvc_1794-IB16XOB16P_wDesc_FP
raC_Dvc_1794-IB32_wDesc_FP
raC_Dvc_1794-IB8_wDesc_FP
raC_Dvc_1794-IC16_wDesc_FP
raC_Dvc_1794-IE12_wDesc_FP
raC_Dvc_1794-IE4XOE2_wDesc_FP
raC_Dvc_1794-IE8_wDesc_FP
raC_Dvc_1794-IE8XOE4_wDesc_FP
raC_Dvc_1794-IF2XOF2I_wDesc_FP
raC_Dvc_1794-IF4I_wDesc_FP
raC_Dvc_1794-IG16_wDesc_FP
raC_Dvc_1794-IH16_wDesc_FP
raC_Dvc_1794-IM16_wDesc_FP
raC_Dvc_1794-IM8_wDesc_FP
raC_Dvc_1794-IR8_wDesc_FP
raC_Dvc_1794-IRT8_wDesc_FP
raC_Dvc_1794-IT8_wDesc_FP
raC_Dvc_1794-IV16_wDesc_FP
raC_Dvc_1794-IV32_wDesc_FP
raC_Dvc_1794_IF4ICF_wDesc_FP
raC_Dvc_1794_IF8IH_wDesc_FP
raC_Dvc_1794_IF8IHNF_wDesc_FP
raC_Dvc_1794sc_IF8IU_wDesc_FP
raC_Dvc_1794sc_IRT8I_wDesc_FP

raC_Dvc_1794IO_Output_wDesc.vpd

raC_Dvc_1794-OA16_wDesc_FP
raC_Dvc_1794-OA8_wDesc_FP
raC_Dvc_1794-OA8I_wDesc_FP
raC_Dvc_1794-OB16_wDesc_FP
raC_Dvc_1794-OB16P_wDesc_FP
raC_Dvc_1794-OB32P_wDesc_FP
raC_Dvc_1794-OB8_wDesc_FP
raC_Dvc_1794-OB8EP_wDesc_FP
raC_Dvc_1794-OC16_wDesc_FP
raC_Dvc_1794-OE12_wDesc_FP
raC_Dvc_1794-OE4_wDesc_FP
raC_Dvc_1794-OF4I_wDesc_FP
raC_Dvc_1794-OG16_wDesc_FP
raC_Dvc_1794-OM16_wDesc_FP
raC_Dvc_1794_VHSC_wDesc_FP
raC_Dvc_1794-OM8_wDesc_FP
raC_Dvc_1794_OB16D_wDesc_FP

Family View Designer File View Designer Screen
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raC_Dvc_1794_OV16_wDesc_FP
raC_Dvc_1794_OV16P_wDesc_FP
raC_Dvc_1794_OV32_wDesc_FP
raC_Dvc_1794_OW8_wDesc_FP
raC_Dvc_1794_OF8IH_wDesc_FP

5015 raC_Dvc_5015IO_wDesc.vpd
raC_Dvc_5015-U8IHFTXT_Simplex_wDesc_FP
raC_Dvc_5015-U8IHFTXT_Duplex_wDesc_FP

5069 raC_Dvc_5069IO_wDesc.vpd

raC_Dvc_5069-HSC2XOB4_wDesc_FP
raC_Dvc_5069-IB8S_Safety_wDesc_FP
raC_Dvc_5069-IB8S_SafetyMuting_wDesc_FP
raC_Dvc_5069-OBV8S_wDesc_FP
raC_Dvc_5069-OBV8S_wDesc_FP
raC_Dvc_5069-SERIAL_ASCII_wDesc_FP
raC_Dvc_5069-SERIAL_MBMaster_wDesc_FP
raC_Dvc_5069-SERIAL_MBSlave_wDesc_FP
raC_Dvc_5069-IA16_wDesc_FP
raC_Dvc_5069-IB16_wDesc_FP
raC_Dvc_5069-IB16F_wDesc_FP
raC_Dvc_5069-IB6F-3W_wDesc_FP
raC_Dvc_5069-IF8_wDesc_FP
raC_Dvc_5069-IY4-IR_wDesc_FP
raC_Dvc_5069-OA16_wDesc_FP
raC_Dvc_5069-OB16_wDesc_FP
raC_Dvc_5069-OB16F_wDesc_FP
raC_Dvc_5069-OB8_wDesc_FP
raC_Dvc_5069-OF4_wDesc_FP
raC_Dvc_5069-OF8_wDesc_FP
raC_Dvc_5069-OW16_wDesc_FP
raC_Dvc_5069-OW4I_wDesc_FP
raC_Dvc_5069-OX4I_wDesc_FP

Family View Designer File View Designer Screen
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Basic Faceplate Attributes Faceplates consist of tabs, and each tab consists of one or more pages. The 
Home tab is displayed when the faceplate is initially opened. The faceplate 
provides the means for operators, maintenance personnel, engineers, and 
others to interact with a device or instruction instance, which includes a view 
of its status and values. Faceplates may also manipulate an instruction through 
its commands and settings. Select the appropriate icon on the left of the 
faceplate to access a specific tab. This section provides an overview of the 
faceplate attributes that are common across the objects. More details are 
supplied in the individual section for each object.

Common Status Banner

At the top of all device object faceplates there is a common status banner which 
provides the following information:

• Ready (green LED icon)
• Not Ready Module Fault (yellow LED icon) status
• Channel Fault - Module is ready and one or more channels goes into 

fault state

5094 raC_Dvc_5094IO_wDesc.vpd

raC_Dvc_5094-HSC_wDesc_FP
raC_Dvc_5094-IB16S_Safety_wDesc_FP
raC_Dvc_5094-IF8IH_HART_wDesc_FP
raC_Dvc_5094-IF8IH_PlantPAx_wDesc_FP
raC_Dvc_5094-OB16S_Safety_wDesc_FP
raC_Dvc_5094-OF8IH_HART_wDesc_FP
raC_Dvc_5094-OF8IH_PlantPAx_wDesc_FP
raC_Dvc_5094-OW4IS_Safety_wDesc_FP
raC_Dvc_5094-IB16_wDesc_FP
raC_Dvc_5094-IF8_wDesc_FP
raC_Dvc_5094-OB16_wDesc_FP
raC_Dvc_5094-OF8_wDesc_FP
raC_Dvc_5094-OW8I_wDesc_FP
raC_Dvc_5094-SERIAL_ASCII_wDesc_FP
raC_Dvc_5094-SERIAL_MBMaster_wDesc_FP
raC_Dvc_5094-SERIAL_MBSlave_wDesc_FP
raC_Dvc_5094_IY8_IR_wDesc_FP
raC_Dvc_5094_IY8_IT_wDesc_FP
raC_Dvc_5094_IA16_wDesc_FP
raC_Dvc_5094_IB32_wDesc_FP
raC_Dvc_5094_IM8_wDesc_FP
raC_Dvc_5094_OA16_wDesc_FP
raC_Dvc_5094_OB32_wDesc_FP
raC_Dvc_5094_OB8_wDesc_FP

Family View Designer File View Designer Screen
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Faceplate Navigation

All device object faceplates have navigation tabs on the left side of the 
faceplate. Navigation tabs may vary based on device type. The active tab will 
show as a light grey, while an inactive tab will show as a dark grey.

The common tabs are shown below.

Faceplate Revision Notes By clicking on the open space near the bottom left corner of the faceplate you 
can momentarily view revision notes and details of the active faceplate. This 
may be useful in troubleshooting or when communicating with Rockwell 
Automation Tech Support.

Active Tab Inactive Tab

Home Tab

Diagnostics Tab

Item Description
1 Click near the bottom right corner to temporarily open up the revision notes dialogue
2 Revision number
3 Faceplate display name
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Launch Buttons Launch buttons are provided in Global Display (GGFX) files for FactoryTalk 
View® ME/SE as well as in Studio 5000 View Designer® projects. These are 
used to open HMI faceplate displays or pop-ups. Two types of launch buttons 
are provided:

Diagnostic Icons

Diagnostic icons may be displayed on the graphic buttons for compatible 
modules. Safety modules are designated with a small guard icon.

2

1

3

Launch Button Style Image Examples Usage

Basic Text Button Simple launch button with no diagnostic 
information.

Graphical Button
Graphic button can be used in schematic 
style displays where a system/network 
diagram is shown. When available, basic 

module diagnostics are displayed.
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Schematic Display Configuration

Additional icons are provided to represent I/O communications adapters, 
chassis, CPUs and slot fillers. Adapter icons can use Global Object Parameters 
to assign a label to the I/O rack. These icons can be used together to allow users 
to build schematic diagrams. The IO Device Library graphics can also be used 
along with similar buttons available in the Network Device Library v12.01 and 
Power Device Library v3.02. 

It is recommended set the Grid Snap ON with settings z = 4; y = 4 when using 
the graphic symbols in FactoryTalk View® ME/SE. This will make it easier to 
align modules in a chassis configuration.

A legend is provided in the FactoryTalk View® ME/SE global object displays 
(raC-5-ME) Graphic Symbols - IO Device and (raC-5-SE) Graphic Symbols - IO 
Device. 

An example of a complete system is shown below. This system includes objects 
from the IO Device Library, Network Device Library and Power Device Library.

Icon Image Visible Condition

Communications Failure Connection Faulted

Fault Any channel fault or 
Diagnostic Active

Guard Safety Class Modules
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Library Versions Each library object has a revision x.yy where: x is the Major Revision number 
and yy is the Minor Revision number. Each release of the library comes with 
release notes that describe the changes that were made since the last release. 
You can find the revision number of the object in a number of locations as 
shown below.

Application Code Manager Modules

Module type objects are provided for use with Studio 5000® Application Code 
Manager. This allows users to add I/O modules to their project in Application 
Code Manager. Modules must be added to compatible chassis or adapters.

A complete list of the included Application Code Manager module objects 
follows:

Component Example

The faceplate in FactoryTalk® View 
software has revision information visible 
when the pointer is clicked just inside the 
lower left corner of the faceplate.

The revision number is shown in the file 
names for GFX, VPD and ACM.HSL4 files

Family Application Code Manager File

1715

(RA-LIB)_ACM_2.00_Module_Digital_1715-IB16D_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1715-IF16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1715-OF8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1715-OB8DE_A_(5.3).HSL4

1719

(RA-LIB)_ACM_2.00_Module_Digital_1719-IBN8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1719-IBN8B_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1719-IR4B_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1719-IT4B_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1719-OB2_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1719-OB2L_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1719-IF4HB_A_(5.3).HSL4
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1732

(RA-LIB)_ACM_2.00_Module_Digital_1732E-IB16M12R_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732E-IB16M12W_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732E-IB8M8SOER_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1732E-IF4M12R_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1732E-IR4IM12R_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1732E-IT4IM12R_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732E-OB16M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732E-OB16M12R_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732E-OB8M8SR_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1732E-OF4M12R_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB16M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB12XOB4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB12XOBV2_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB8XOB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1732ES-IB8XOBV4_A_(5.3).HSL4

1734

(RA-LIB)_ACM_2.00_Module_Digital_1734-IB4D_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IE4S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB8S_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IE2C_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IE2V_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IE4C_(C_5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IE8C_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IM2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IM4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IR2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IR2E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-IT2I_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IV2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IV4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IV8_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OBV2S_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-OE2C_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-OE2V_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734-OE4C_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734sc-IE2CH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734sc-IE4CH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734sc-IF4U_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1734sc-OE2CIH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-8CFG_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IA2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IA4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IB2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IB4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IB4D_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IB8_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-IB8S_B_(5.3).HSL4

Family Application Code Manager File
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(RA-LIB)_ACM_2.00_Module_Digital_1734-OA2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OA4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB2E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB2EP_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB4E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB8_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OB8E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OV2E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OV4E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OV8E_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OW2_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OW4_C_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1734-OX2_C_(5.3).HSL4

Family Application Code Manager File
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1738

(RA-LIB)_ACM_2.00_Module_Digital_1738-IA2M12AC3_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IA2M12AC4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB2M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB4M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB4M8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M23_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-IE2CM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-IE2VM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-IE4CM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-IR2M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-IT2IM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IV4M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M23_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OA2M12AC3_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB16E19M23_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB16E25DS_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB16EM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB2EM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB2EPM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB4EM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB4EM8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM23_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-OE2CM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-OE2VM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1738-OE4CM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OV4EM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OW4M12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1738-OW4M12AC_A_(5.3).HSL4

Family Application Code Manager File
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1756

(RA-LIB)_ACM_2.00_Module_Speciality_1756-HSC_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IA16_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IA16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IA32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB32_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IC16_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF16_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF16H_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF4FXOF2F_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF6CIS_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF6I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF8H_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF8I_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IH16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IM16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IN16_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IR6I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IRT8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IT16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IT6I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IV16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IV32_A_(5.3).HSL4

Family Application Code Manager File
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1756

(RA-LIB)_ACM_2.00_Module_Digital_1756-OA16_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OA16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OA8E_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16E_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IEF_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IEFS_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB32_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB8_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB8EI_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB8I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OBV8S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OC8_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF4_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF6xl_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF6CI_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF6VI_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8I_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-ON8_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OV16E_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OV32E_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF16H_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF8H_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IR12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-IT6I2_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8H_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1756sc-IF8U_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IA8D_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16D_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16IF_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IB16ISOE_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-IH16ISOE_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OA8_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OA8D_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16D_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IS_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OH8I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OW16I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756-OX8I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1756sc-IC32_A_(5.3).HSL4
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1769

(RA-LIB)_ACM_2.00_Module_Speciality_1769-ASCII_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_1769-HSC_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IA8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF16C_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF16V_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF4_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF4FXOF2F_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF4I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF4XOF2_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IF8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IM12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IQ16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IQ16F_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IQ32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IQ32T_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IQ6XOW4_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IR6_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-IT6_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OA8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OB16_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OB16P_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OB32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OB32T_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF2_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4CI_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4VI_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF8C_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769-OF8V_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OV16_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OV32T_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OW16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OW8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-OW8I_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769sc-IF4IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769sc-IF8U_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769sc-IR6I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769sc-IT6I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1769sc-OF4IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1769-IA16_A_(5.3).HSL4

1791ES
(RA-LIB)_ACM_2.00_Module_Digital_1791ES-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1791ES-IB8XOBV4_A_(5.3).HSL4
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1794

(RA-LIB)_ACM_2.00_Module_Speciality_1794-VHSC_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IE12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IE4XOE2_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IE8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IE8XOE4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IF2XOF2I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IF4I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IR8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IRT8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IT8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IV32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB32P_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-OE12_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-OE4_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-OF4I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OV32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IF4ICF_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-IF8IHNF_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794-OF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794sc-IF8IU_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_1794sc-IRT8I_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IA8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IA8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB10XOB6_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB16D_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB16XOB16P_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IC16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IH16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IM16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IM8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-IV16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OA8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OA8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB16D_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB16P_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OB8EP_A_(5.3).HSL4
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1794

(RA-LIB)_ACM_2.00_Module_Digital_1794-OC16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OG16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OM16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OM8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OV16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OV16P_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_1794-OW8_A_(5.3).HSL4

5015 (RA-LIB)_ACM_2.00_Module_Universal_5015-U8IHFTXT_(5.3).HSL4

5069

(RA-LIB)_ACM_2.00_Module_Speciality_5069-HSC2XOB4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-IB8S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OBV8S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5069-SERIAL_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5069-SERIAL_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5069-SERIAL_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-IA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-IB16F_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5069-IB6F-3W_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5069-IF8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5069-IY4-IR_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OB16_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OB16F_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5069-OF4_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5069-OF8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OW16_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OW4I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5069-OX4I_A_(5.3).HSL4
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5094

(RA-LIB)_ACM_2.00_Module_Analog_5094-IF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-IF8IHXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8IH_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8IHXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OW4IS_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OW4ISXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB16XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-IF8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-IF8XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OW8I_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OW8IXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-IY8_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Analog_5094-IY8XT_B_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IA16XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB16S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB16SXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IB32XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IM8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-IM8XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OA16_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OA16XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16S_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16SXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB32_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB32XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB8_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Digital_5094-OB8XT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5094-HSC_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5094-HSCXT_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5094-SERIAL_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5094-SERIALXT_A_(5.3).HSL4
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HART Devices

A collection of HART devices is provided for use in Application Code Manager. 
This allows users to add devices to 5094 FLEX 5000 Analog HART Input/
Output modules. A complete list of files is provided below.

Communication 
Module

(RA-LIB)_ACM_2.00_Module_Communication_1734-ACNR_A_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1734-AENT_C_(5.2).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1734-AENTR_C_(5.2).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1738-ACNR_A_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1738-AENT_B_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1738-AENTR_B_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-CN2_C_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-CN2R_C_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-DNB_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-EN2T_(2.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-EN2TP_(4.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-EN2TR_(2.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-EN3TR_(2.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1756-EN4TR_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1769-AENTR_(2.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1794-ACN15_D_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1794-ACNR15_D_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1794-AENT_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1794-AENTR_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5015-AENFTXT_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5069-AEN2TR_(2.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5069-AENTR_(2.0).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AEN2SFPR_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AEN2SFPRXT_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AEN2TR_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AEN2TRXT_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AENSFPR_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AENSFPRXT_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AENTR_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_5094-AENTRXT_A_(5.1).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1715-AENTR_A_(5.2).HSL4
(RA-LIB)_ACM_2.00_Module_Communication_1719-AENTR_A_(5.1).HSL4

Family Application Code Manager File

HART Device Application Code Manager File
0304-NEWTHERMOX (RA-LIB)_ACM_2.00_Module_HART_Device_0304-NEWTHERMOX_(5.2).HSL4
0A01-TRI20 (RA-LIB)_ACM_2.00_Module_HART_Device_0A01-TRI20_(5.2).HSL4
0A02-BI_38XXVA (RA-LIB)_ACM_2.00_Module_HART_Device_0A02-BI_38XXVA_(5.2).HSL4
0A04-QUANTIM (RA-LIB)_ACM_2.00_Module_HART_Device_0A04-QUANTIM_(5.2).HSL4
0D14-Series_Gas_USM_3400 (RA-LIB)_ACM_2.00_Module_HART_Device_0D14-Series_Gas_USM_3400_(5.2).HSL4
0D15-Series_Gas_USM_3410 (RA-LIB)_ACM_2.00_Module_HART_Device_0D15-Series_Gas_USM_3410_(5.2).HSL4
0D28-Series_Liquid_USM_3800 (RA-LIB)_ACM_2.00_Module_HART_Device_0D28-Series_Liquid_USM_3800_(5.2).HSL4
0D29-Series_Liquid_USM_3810 (RA-LIB)_ACM_2.00_Module_HART_Device_0D29-Series_Liquid_USM_3810_(5.2).HSL4
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1103-FMU860 (RA-LIB)_ACM_2.00_Module_HART_Device_1103-FMU860_(5.2).HSL4
1104-FMU861 (RA-LIB)_ACM_2.00_Module_HART_Device_1104-FMU861_(5.2).HSL4
1105-FMU862 (RA-LIB)_ACM_2.00_Module_HART_Device_1105-FMU862_(5.2).HSL4
1108-FEC12 (RA-LIB)_ACM_2.00_Module_HART_Device_1108-FEC12_(5.2).HSL4
110C-FMR23x (RA-LIB)_ACM_2.00_Module_HART_Device_110C-FMR23x_(5.2).HSL4
110D-FMP200 (RA-LIB)_ACM_2.00_Module_HART_Device_110D-FMP200_(5.2).HSL4
110E-CerabarM (RA-LIB)_ACM_2.00_Module_HART_Device_110E-CerabarM_(5.2).HSL4
110F-FMR2xx (RA-LIB)_ACM_2.00_Module_HART_Device_110F-FMR2xx_(5.2).HSL4
1110-FMR53x (RA-LIB)_ACM_2.00_Module_HART_Device_1110-FMR53x_(5.2).HSL4
1111-FMU4x (RA-LIB)_ACM_2.00_Module_HART_Device_1111-FMU4x_(5.2).HSL4
1112-FMP4x (RA-LIB)_ACM_2.00_Module_HART_Device_1112-FMP4x_(5.2).HSL4
1113-FMG_60 (RA-LIB)_ACM_2.00_Module_HART_Device_1113-FMG_60_(5.2).HSL4
1117-DeltabarS (RA-LIB)_ACM_2.00_Module_HART_Device_1117-DeltabarS_(5.2).HSL4
1118-CerabarS (RA-LIB)_ACM_2.00_Module_HART_Device_1118-CerabarS_(5.2).HSL4
1119-Cerabar_M_5x (RA-LIB)_ACM_2.00_Module_HART_Device_1119-Cerabar_M_5x_(5.2).HSL4
111A-DeltapilotS (RA-LIB)_ACM_2.00_Module_HART_Device_111A-DeltapilotS_(5.2).HSL4
111B-FMU9x (RA-LIB)_ACM_2.00_Module_HART_Device_111B-FMU9x_(5.2).HSL4
111D-FMI5x (RA-LIB)_ACM_2.00_Module_HART_Device_111D-FMI5x_(5.2).HSL4
111E-FMR25x (RA-LIB)_ACM_2.00_Module_HART_Device_111E-FMR25x_(5.2).HSL4
111F_FMR54x (RA-LIB)_ACM_2.00_Module_HART_Device_111F_FMR54x_(5.2).HSL4
1120-FMP4x_I (RA-LIB)_ACM_2.00_Module_HART_Device_1120-FMP4x_I_(5.2).HSL4
1121-Deltabar_M_5x (RA-LIB)_ACM_2.00_Module_HART_Device_1121-Deltabar_M_5x_(5.2).HSL4
1122-Levelflex_FMP5x (RA-LIB)_ACM_2.00_Module_HART_Device_1122-Levelflex_FMP5x_(5.2).HSL4
1124-Waterpilot_2x (RA-LIB)_ACM_2.00_Module_HART_Device_1124-Waterpilot_2x_(5.2).HSL4
1127-Deltabar_FMD71x (RA-LIB)_ACM_2.00_Module_HART_Device_1127-Deltabar_FMD71x_(5.2).HSL4
1128-MicropilotFMR5x (RA-LIB)_ACM_2.00_Module_HART_Device_1128-MicropilotFMR5x_(5.2).HSL4
1128-Micropilot_5x (RA-LIB)_ACM_2.00_Module_HART_Device_1128-Micropilot_5x_(5.2).HSL4
112A-Cerabar_5xB_7xB (RA-LIB)_ACM_2.00_Module_HART_Device_112A-Cerabar_5xB_7xB_(5.2).HSL4
112B-MicropilotFMR6x (RA-LIB)_ACM_2.00_Module_HART_Device_112B-MicropilotFMR6x_(5.2).HSL4
112B-Micropilot_6x (RA-LIB)_ACM_2.00_Module_HART_Device_112B-Micropilot_6x_(5.2).HSL4
112D-Proservo_NMS8x (RA-LIB)_ACM_2.00_Module_HART_Device_112D-Proservo_NMS8x_(5.2).HSL4
112E-Micropilot_NMR8x (RA-LIB)_ACM_2.00_Module_HART_Device_112E-Micropilot_NMR8x_(5.2).HSL4
112F-Tank_Side_Monitor_NRF8x (RA-LIB)_ACM_2.00_Module_HART_Device_112F-Tank_Side_Monitor_NRF8x_(5.2).HSL4
1130-Gammapilot_5x (RA-LIB)_ACM_2.00_Module_HART_Device_1130-Gammapilot_5x_(5.2).HSL4
1131-Deltabar_5xB_7xB (RA-LIB)_ACM_2.00_Module_HART_Device_1131-Deltabar_5xB_7xB_(5.2).HSL4
1132-Promag_33 (RA-LIB)_ACM_2.00_Module_HART_Device_1132-Promag_33_(5.2).HSL4
1133-Prowirl70 (RA-LIB)_ACM_2.00_Module_HART_Device_1133-Prowirl70_(5.2).HSL4
1134-Promass63 (RA-LIB)_ACM_2.00_Module_HART_Device_1134-Promass63_(5.2).HSL4
1135-Promag39 (RA-LIB)_ACM_2.00_Module_HART_Device_1135-Promag39_(5.2).HSL4
1136-Promag35S (RA-LIB)_ACM_2.00_Module_HART_Device_1136-Promag35S_(5.2).HSL4
1137-Prowirl77 (RA-LIB)_ACM_2.00_Module_HART_Device_1137-Prowirl77_(5.2).HSL4
1138-Prowirl200 (RA-LIB)_ACM_2.00_Module_HART_Device_1138-Prowirl200_(5.2).HSL4
1139-Promass60 (RA-LIB)_ACM_2.00_Module_HART_Device_1139-Promass60_(5.2).HSL4
113A-Promag100 (RA-LIB)_ACM_2.00_Module_HART_Device_113A-Promag100_(5.2).HSL4
113B-Promass300_500 (RA-LIB)_ACM_2.00_Module_HART_Device_113B-Promass300_500_(5.2).HSL4
113C-Promag300_500 (RA-LIB)_ACM_2.00_Module_HART_Device_113C-Promag300_500_(5.2).HSL4
1140-Proson_F (RA-LIB)_ACM_2.00_Module_HART_Device_1140-Proson_F_(5.2).HSL4

HART Device Application Code Manager File
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1141-Promag50 (RA-LIB)_ACM_2.00_Module_HART_Device_1141-Promag50_(5.2).HSL4
1142-Promag53 (RA-LIB)_ACM_2.00_Module_HART_Device_1142-Promag53_(5.2).HSL4
1143-Promag51 (RA-LIB)_ACM_2.00_Module_HART_Device_1143-Promag51_(5.2).HSL4
1144-Promag55 (RA-LIB)_ACM_2.00_Module_HART_Device_1144-Promag55_(5.2).HSL4
1145-Promag10 (RA-LIB)_ACM_2.00_Module_HART_Device_1145-Promag10_(5.2).HSL4
1146-Promag23 (RA-LIB)_ACM_2.00_Module_HART_Device_1146-Promag23_(5.2).HSL4
1148-Promag200 (RA-LIB)_ACM_2.00_Module_HART_Device_1148-Promag200_(5.2).HSL4
1149-Cubemass_DCI (RA-LIB)_ACM_2.00_Module_HART_Device_1149-Cubemass_DCI_(5.2).HSL4
114A-Promass100 (RA-LIB)_ACM_2.00_Module_HART_Device_114A-Promass100_(5.2).HSL4
1150-Promass80 (RA-LIB)_ACM_2.00_Module_HART_Device_1150-Promass80_(5.2).HSL4
1151-Promass83 (RA-LIB)_ACM_2.00_Module_HART_Device_1151-Promass83_(5.2).HSL4
1152-Promass84 (RA-LIB)_ACM_2.00_Module_HART_Device_1152-Promass84_(5.2).HSL4
1153-Promass40 (RA-LIB)_ACM_2.00_Module_HART_Device_1153-Promass40_(5.2).HSL4
1154-Promass200 (RA-LIB)_ACM_2.00_Module_HART_Device_1154-Promass200_(5.2).HSL4
1155-CNGmass_DCI (RA-LIB)_ACM_2.00_Module_HART_Device_1155-CNGmass_DCI_(5.2).HSL4
1156-Prowirl72 (RA-LIB)_ACM_2.00_Module_HART_Device_1156-Prowirl72_(5.2).HSL4
1157-Prowirl73 (RA-LIB)_ACM_2.00_Module_HART_Device_1157-Prowirl73_(5.2).HSL4
1158-P_Flow90 (RA-LIB)_ACM_2.00_Module_HART_Device_1158-P_Flow90_(5.2).HSL4
1159-P_Flow93 (RA-LIB)_ACM_2.00_Module_HART_Device_1159-P_Flow93_(5.2).HSL4
115A-ProsonicFlow_200 (RA-LIB)_ACM_2.00_Module_HART_Device_115A-ProsonicFlow_200_(5.2).HSL4
115C-ProsonicFlow_100 (RA-LIB)_ACM_2.00_Module_HART_Device_115C-ProsonicFlow_100_(5.2).HSL4
115D-ProsonicFlow_300_500 (RA-LIB)_ACM_2.00_Module_HART_Device_115D-ProsonicFlow_300_500_(5.2).HSL4
1164-AT70 (RA-LIB)_ACM_2.00_Module_HART_Device_1164-AT70_(5.2).HSL4
1165-T_Mass65 (RA-LIB)_ACM_2.00_Module_HART_Device_1165-T_Mass65_(5.2).HSL4
1166-T_Mass_A_B_150 (RA-LIB)_ACM_2.00_Module_HART_Device_1166-T_Mass_A_B_150_(5.2).HSL4
1167-Promag400_R6 (RA-LIB)_ACM_2.00_Module_HART_Device_1167-Promag400_R6_(5.2).HSL4
1167-Promag_400 (RA-LIB)_ACM_2.00_Module_HART_Device_1167-Promag_400_(5.2).HSL4
1168-t_mass_L_T_150 (RA-LIB)_ACM_2.00_Module_HART_Device_1168-t_mass_L_T_150_(5.2).HSL4
1169-Promag400_R8 (RA-LIB)_ACM_2.00_Module_HART_Device_1169-Promag400_R8_(5.2).HSL4
1172-Promass10 (RA-LIB)_ACM_2.00_Module_HART_Device_1172-Promass10_(5.2).HSL4
1178-TMD832 (RA-LIB)_ACM_2.00_Module_HART_Device_1178-TMD832_(5.2).HSL4
1179-TMD833 (RA-LIB)_ACM_2.00_Module_HART_Device_1179-TMD833_(5.2).HSL4
117C-TMD842 (RA-LIB)_ACM_2.00_Module_HART_Device_117C-TMD842_(5.2).HSL4
118C-Mypro_pH (RA-LIB)_ACM_2.00_Module_HART_Device_118C-Mypro_pH_(5.2).HSL4
118D-Mypro_LFC (RA-LIB)_ACM_2.00_Module_HART_Device_118D-Mypro_LFC_(5.2).HSL4
118E-Mypro_LFI (RA-LIB)_ACM_2.00_Module_HART_Device_118E-Mypro_LFI_(5.2).HSL4
119C-Liquiline_CM44x (RA-LIB)_ACM_2.00_Module_HART_Device_119C-Liquiline_CM44x_(5.2).HSL4
119D-Liquistation_CSFxx (RA-LIB)_ACM_2.00_Module_HART_Device_119D-Liquistation_CSFxx_(5.2).HSL4
119F-Liquiline_CA80xx (RA-LIB)_ACM_2.00_Module_HART_Device_119F-Liquiline_CA80xx_(5.2).HSL4
11A3-LiquilineCM82 (RA-LIB)_ACM_2.00_Module_HART_Device_11A3-LiquilineCM82_(5.2).HSL4
11B5-NMT530 (RA-LIB)_ACM_2.00_Module_HART_Device_11B5-NMT530_(5.2).HSL4
11B6-NMS530 (RA-LIB)_ACM_2.00_Module_HART_Device_11B6-NMS530_(5.2).HSL4
11C8-TMT182 (RA-LIB)_ACM_2.00_Module_HART_Device_11C8-TMT182_(5.2).HSL4
11C9-TMT122 (RA-LIB)_ACM_2.00_Module_HART_Device_11C9-TMT122_(5.2).HSL4
11CA-TMT162 (RA-LIB)_ACM_2.00_Module_HART_Device_11CA-TMT162_(5.2).HSL4
11CB-TMT142 (RA-LIB)_ACM_2.00_Module_HART_Device_11CB-TMT142_(5.2).HSL4
11CC-iTEMP_TMT82 (RA-LIB)_ACM_2.00_Module_HART_Device_11CC-iTEMP_TMT82_(5.2).HSL4

HART Device Application Code Manager File
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11CE-iTEMP_TMT162 (RA-LIB)_ACM_2.00_Module_HART_Device_11CE-iTEMP_TMT162_(5.2).HSL4
11CF-TrustSensTM37x (RA-LIB)_ACM_2.00_Module_HART_Device_11CF-TrustSensTM37x_(5.2).HSL4
11D0-iTEMP_TMT72 (RA-LIB)_ACM_2.00_Module_HART_Device_11D0-iTEMP_TMT72_(5.2).HSL4
11EE-Crocus_P (RA-LIB)_ACM_2.00_Module_HART_Device_11EE-Crocus_P_(5.2).HSL4
11EF-Crocus_D (RA-LIB)_ACM_2.00_Module_HART_Device_11EF-Crocus_D_(5.2).HSL4
1207-ABB_50XM2000 (RA-LIB)_ACM_2.00_Module_HART_Device_1207-ABB_50XM2000_(5.2).HSL4
1208-ABB_50XE400 (RA-LIB)_ACM_2.00_Module_HART_Device_1208-ABB_50XE400_(5.2).HSL4
120E-ABB_50VT1000 (RA-LIB)_ACM_2.00_Module_HART_Device_120E-ABB_50VT1000_(5.2).HSL4
120F-ABB_50VM1000 (RA-LIB)_ACM_2.00_Module_HART_Device_120F-ABB_50VM1000_(5.2).HSL4
1219-ABB_50XM1000 (RA-LIB)_ACM_2.00_Module_HART_Device_1219-ABB_50XM1000_(5.2).HSL4
121A-ABB_50SM1000 (RA-LIB)_ACM_2.00_Module_HART_Device_121A-ABB_50SM1000_(5.2).HSL4
1242-PTH (RA-LIB)_ACM_2.00_Module_HART_Device_1242-PTH_(5.2).HSL4
1250-TB82PH_pH (RA-LIB)_ACM_2.00_Module_HART_Device_1250-TB82PH_pH_(5.2).HSL4
1251-TB82PH_ORP (RA-LIB)_ACM_2.00_Module_HART_Device_1251-TB82PH_ORP_(5.2).HSL4
1252-TB82PH_pION (RA-LIB)_ACM_2.00_Module_HART_Device_1252-TB82PH_pION_(5.2).HSL4
1253-TB82PH_IConc (RA-LIB)_ACM_2.00_Module_HART_Device_1253-TB82PH_IConc_(5.2).HSL4
1254-TB82EC_COND (RA-LIB)_ACM_2.00_Module_HART_Device_1254-TB82EC_COND_(5.2).HSL4
1255-TB82EC_CONC (RA-LIB)_ACM_2.00_Module_HART_Device_1255-TB82EC_CONC_(5.2).HSL4
1256-TB82TE_COND (RA-LIB)_ACM_2.00_Module_HART_Device_1256-TB82TE_COND_(5.2).HSL4
1257-TB82TE_CONC (RA-LIB)_ACM_2.00_Module_HART_Device_1257-TB82TE_CONC_(5.2).HSL4
1258-TB82TC_COND (RA-LIB)_ACM_2.00_Module_HART_Device_1258-TB82TC_COND_(5.2).HSL4
1259-TB82TC_CONC (RA-LIB)_ACM_2.00_Module_HART_Device_1259-TB82TC_CONC_(5.2).HSL4
1300-Position_Xmitter (RA-LIB)_ACM_2.00_Module_HART_Device_1300-Position_Xmitter_(5.2).HSL4
1303-DVC6000 (RA-LIB)_ACM_2.00_Module_HART_Device_1303-DVC6000_(5.2).HSL4
1304-DLC3010 (RA-LIB)_ACM_2.00_Module_HART_Device_1304-DLC3010_(5.2).HSL4
1305-DVC2000 (RA-LIB)_ACM_2.00_Module_HART_Device_1305-DVC2000_(5.2).HSL4
1309-DVC6200 (RA-LIB)_ACM_2.00_Module_HART_Device_1309-DVC6200_(5.2).HSL4
130A-DVC6200_SIS (RA-LIB)_ACM_2.00_Module_HART_Device_130A-DVC6200_SIS_(5.2).HSL4
130B-DVC6000_HW2 (RA-LIB)_ACM_2.00_Module_HART_Device_130B-DVC6000_HW2_(5.2).HSL4
130F-DLC3100 (RA-LIB)_ACM_2.00_Module_HART_Device_130F-DLC3100_(5.2).HSL4
1401-MAG2 (RA-LIB)_ACM_2.00_Module_HART_Device_1401-MAG2_(5.2).HSL4
1402-IASPT_Premium_2 (RA-LIB)_ACM_2.00_Module_HART_Device_1402-IASPT_Premium_2_(5.2).HSL4
1405-pH_876 (RA-LIB)_ACM_2.00_Module_HART_Device_1405-pH_876_(5.2).HSL4
1407-RTT30 (RA-LIB)_ACM_2.00_Module_HART_Device_1407-RTT30_(5.2).HSL4
1408-ECS_Pressure (RA-LIB)_ACM_2.00_Module_HART_Device_1408-ECS_Pressure_(5.2).HSL4
1409-CFT51 (RA-LIB)_ACM_2.00_Module_HART_Device_1409-CFT51_(5.2).HSL4
140A-RTT80 (RA-LIB)_ACM_2.00_Module_HART_Device_140A-RTT80_(5.2).HSL4
140B-pH_S876 (RA-LIB)_ACM_2.00_Module_HART_Device_140B-pH_S876_(5.2).HSL4
1419-CFT34A (RA-LIB)_ACM_2.00_Module_HART_Device_1419-CFT34A_(5.2).HSL4
141B-IMT31A (RA-LIB)_ACM_2.00_Module_HART_Device_141B-IMT31A_(5.2).HSL4
141C-IMT33A (RA-LIB)_ACM_2.00_Module_HART_Device_141C-IMT33A_(5.2).HSL4
141D-IMV31 (RA-LIB)_ACM_2.00_Module_HART_Device_141D-IMV31_(5.2).HSL4
141E-Vortex_84 (RA-LIB)_ACM_2.00_Module_HART_Device_141E-Vortex_84_(5.2).HSL4
141F-Vortex_84C (RA-LIB)_ACM_2.00_Module_HART_Device_141F-Vortex_84C_(5.2).HSL4
1428-IMT96 (RA-LIB)_ACM_2.00_Module_HART_Device_1428-IMT96_(5.2).HSL4
1429-IMT25 (RA-LIB)_ACM_2.00_Module_HART_Device_1429-IMT25_(5.2).HSL4
142E-I_A_Pressure (RA-LIB)_ACM_2.00_Module_HART_Device_142E-I_A_Pressure_(5.2).HSL4

HART Device Application Code Manager File
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142F-IMV_25_30 (RA-LIB)_ACM_2.00_Module_HART_Device_142F-IMV_25_30_(5.2).HSL4
1430-PH_875 (RA-LIB)_ACM_2.00_Module_HART_Device_1430-PH_875_(5.2).HSL4
1433-ITVORTEX (RA-LIB)_ACM_2.00_Module_HART_Device_1433-ITVORTEX_(5.2).HSL4
1434-CFT50 (RA-LIB)_ACM_2.00_Module_HART_Device_1434-CFT50_(5.2).HSL4
1435-CR_875 (RA-LIB)_ACM_2.00_Module_HART_Device_1435-CR_875_(5.2).HSL4
1436-EC_875 (RA-LIB)_ACM_2.00_Module_HART_Device_1436-EC_875_(5.2).HSL4
1438-RTT15 (RA-LIB)_ACM_2.00_Module_HART_Device_1438-RTT15_(5.2).HSL4
1440-IA_Pressure_S (RA-LIB)_ACM_2.00_Module_HART_Device_1440-IA_Pressure_S_(5.2).HSL4
1440-I_A_Pressure_S (RA-LIB)_ACM_2.00_Module_HART_Device_1440-I_A_Pressure_S_(5.2).HSL4
1441-RTT15_H (RA-LIB)_ACM_2.00_Module_HART_Device_1441-RTT15_H_(5.2).HSL4
1442-RTT15S (RA-LIB)_ACM_2.00_Module_HART_Device_1442-RTT15S_(5.2).HSL4
1444-Free_Space_Radar_LRxx (RA-LIB)_ACM_2.00_Module_HART_Device_1444-Free_Space_Radar_LRxx_(5.2).HSL4
147D-CFT_30_x (RA-LIB)_ACM_2.00_Module_HART_Device_147D-CFT_30_x_(5.2).HSL4
1501-FCX_A_C (RA-LIB)_ACM_2.00_Module_HART_Device_1501-FCX_A_C_(5.2).HSL4
1502-FCX_A2_C2 (RA-LIB)_ACM_2.00_Module_HART_Device_1502-FCX_A2_C2_(5.2).HSL4
1504-FCX_A3S (RA-LIB)_ACM_2.00_Module_HART_Device_1504-FCX_A3S_(5.2).HSL4
1505-FCX_A4 (RA-LIB)_ACM_2.00_Module_HART_Device_1505-FCX_A4_(5.2).HSL4
1540-FST (RA-LIB)_ACM_2.00_Module_HART_Device_1540-FST_(5.2).HSL4
1581-FRC (RA-LIB)_ACM_2.00_Module_HART_Device_1581-FRC_(5.2).HSL4
1605-TEU_211 (RA-LIB)_ACM_2.00_Module_HART_Device_1605-TEU_211_(5.2).HSL4
1606-TS_11 (RA-LIB)_ACM_2.00_Module_HART_Device_1606-TS_11_(5.2).HSL4
1608-TH_02 (RA-LIB)_ACM_2.00_Module_HART_Device_1608-TH_02_(5.2).HSL4
1640-TZID (RA-LIB)_ACM_2.00_Module_HART_Device_1640-TZID_(5.2).HSL4
1641-TZIDC (RA-LIB)_ACM_2.00_Module_HART_Device_1641-TZIDC_(5.2).HSL4
1685-AS800 (RA-LIB)_ACM_2.00_Module_HART_Device_1685-AS800_(5.2).HSL4
1687-Contrac (RA-LIB)_ACM_2.00_Module_HART_Device_1687-Contrac_(5.2).HSL4
1701-ST3000 (RA-LIB)_ACM_2.00_Module_HART_Device_1701-ST3000_(5.2).HSL4
1702-STT25T (RA-LIB)_ACM_2.00_Module_HART_Device_1702-STT25T_(5.2).HSL4
1703-HWFLOW_Mage_W_Plus (RA-LIB)_ACM_2.00_Module_HART_Device_1703-HWFLOW_Mage_W_Plus_(5.2).HSL4
1704-STT25H (RA-LIB)_ACM_2.00_Module_HART_Device_1704-STT25H_(5.2).HSL4
1705-HERCULINE (RA-LIB)_ACM_2.00_Module_HART_Device_1705-HERCULINE_(5.2).HSL4
1706-SmartCET (RA-LIB)_ACM_2.00_Module_HART_Device_1706-SmartCET_(5.2).HSL4
1707-STT17H (RA-LIB)_ACM_2.00_Module_HART_Device_1707-STT17H_(5.2).HSL4
1709-STT25S (RA-LIB)_ACM_2.00_Module_HART_Device_1709-STT25S_(5.2).HSL4
170B-STT25H6 (RA-LIB)_ACM_2.00_Module_HART_Device_170B-STT25H6_(5.2).HSL4
170C-STT25T6 (RA-LIB)_ACM_2.00_Module_HART_Device_170C-STT25T6_(5.2).HSL4
1720-ST_800 (RA-LIB)_ACM_2.00_Module_HART_Device_1720-ST_800_(5.2).HSL4
1721-ST_700 (RA-LIB)_ACM_2.00_Module_HART_Device_1721-ST_700_(5.2).HSL4
1722-STT850 (RA-LIB)_ACM_2.00_Module_HART_Device_1722-STT850_(5.2).HSL4
1724-SMV800 (RA-LIB)_ACM_2.00_Module_HART_Device_1724-SMV800_(5.2).HSL4
1726-SLG700 (RA-LIB)_ACM_2.00_Module_HART_Device_1726-SLG700_(5.2).HSL4
1727-SLN_700 (RA-LIB)_ACM_2.00_Module_HART_Device_1727-SLN_700_(5.2).HSL4
1729-XNX (RA-LIB)_ACM_2.00_Module_HART_Device_1729-XNX_(5.2).HSL4
172A-STT750 (RA-LIB)_ACM_2.00_Module_HART_Device_172A-STT750_(5.2).HSL4
172C-RMx40_x50 (RA-LIB)_ACM_2.00_Module_HART_Device_172C-RMx40_x50_(5.2).HSL4
1740-STT650 (RA-LIB)_ACM_2.00_Module_HART_Device_1740-STT650_(5.2).HSL4
1750-TWM9000 (RA-LIB)_ACM_2.00_Module_HART_Device_1750-TWM9000_(5.2).HSL4
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1751-TWC9000 (RA-LIB)_ACM_2.00_Module_HART_Device_1751-TWC9000_(5.2).HSL4
1754-TWV9000 (RA-LIB)_ACM_2.00_Module_HART_Device_1754-TWV9000_(5.2).HSL4
1755-TWM1000 (RA-LIB)_ACM_2.00_Module_HART_Device_1755-TWM1000_(5.2).HSL4
1756-Smartline_Radar (RA-LIB)_ACM_2.00_Module_HART_Device_1756-Smartline_Radar_(5.2).HSL4
1757-Smartline_TDR (RA-LIB)_ACM_2.00_Module_HART_Device_1757-Smartline_TDR_(5.2).HSL4
1758-Smartline_RM76 (RA-LIB)_ACM_2.00_Module_HART_Device_1758-Smartline_RM76_(5.2).HSL4
1759-Smartline_RM77 (RA-LIB)_ACM_2.00_Module_HART_Device_1759-Smartline_RM77_(5.2).HSL4
175A-RAEGuard_3 (RA-LIB)_ACM_2.00_Module_HART_Device_175A-RAEGuard_3_(5.2).HSL4
175B-VersaFlow_SONIC_1000 (RA-LIB)_ACM_2.00_Module_HART_Device_175B-VersaFlow_SONIC_1000_(5.2).HSL4
1909-Dens_3680 (RA-LIB)_ACM_2.00_Module_HART_Device_1909-Dens_3680_(5.2).HSL4
190A-TMT_4790 (RA-LIB)_ACM_2.00_Module_HART_Device_190A-TMT_4790_(5.2).HSL4
190B-Accu_Pulse_PRO (RA-LIB)_ACM_2.00_Module_HART_Device_190B-Accu_Pulse_PRO_(5.2).HSL4
1A01-KSX (RA-LIB)_ACM_2.00_Module_HART_Device_1A01-KSX_(5.2).HSL4
1A02-ABB_600T (RA-LIB)_ACM_2.00_Module_HART_Device_1A02-ABB_600T_(5.2).HSL4
1A03-ABB_2600T_268 (RA-LIB)_ACM_2.00_Module_HART_Device_1A03-ABB_2600T_268_(5.2).HSL4
1A04-ABB_2600T_262_264 (RA-LIB)_ACM_2.00_Module_HART_Device_1A04-ABB_2600T_262_264_(5.2).HSL4
1A05-ABB_2600T_364 (RA-LIB)_ACM_2.00_Module_HART_Device_1A05-ABB_2600T_364_(5.2).HSL4
1A07-ABB_2600T_266_Pressure (RA-LIB)_ACM_2.00_Module_HART_Device_1A07-ABB_2600T_266_Pressure_(5.2).HSL4
1A08-KST (RA-LIB)_ACM_2.00_Module_HART_Device_1A08-KST_(5.2).HSL4
1A0A-ABB_658T (RA-LIB)_ACM_2.00_Module_HART_Device_1A0A-ABB_658T_(5.2).HSL4
1A0B-TTX300_series (RA-LIB)_ACM_2.00_Module_HART_Device_1A0B-TTX300_series_(5.2).HSL4
1A0C-ABB_652_653S (RA-LIB)_ACM_2.00_Module_HART_Device_1A0C-ABB_652_653S_(5.2).HSL4
1A0D-TTx200_family (RA-LIB)_ACM_2.00_Module_HART_Device_1A0D-TTx200_family_(5.2).HSL4
1A1A-FVS4000 (RA-LIB)_ACM_2.00_Module_HART_Device_1A1A-FVS4000_(5.2).HSL4
1A1B-VA_Master_FAM540 (RA-LIB)_ACM_2.00_Module_HART_Device_1A1B-VA_Master_FAM540_(5.2).HSL4
1A1D-FSM4000 (RA-LIB)_ACM_2.00_Module_HART_Device_1A1D-FSM4000_(5.2).HSL4
1A1E-FEX300 (RA-LIB)_ACM_2.00_Module_HART_Device_1A1E-FEX300_(5.2).HSL4
1A1F-FEX100 (RA-LIB)_ACM_2.00_Module_HART_Device_1A1F-FEX100_(5.2).HSL4
1A22-AWT210 (RA-LIB)_ACM_2.00_Module_HART_Device_1A22-AWT210_(5.2).HSL4
1A23-TB82PH_Combined (RA-LIB)_ACM_2.00_Module_HART_Device_1A23-TB82PH_Combined_(5.2).HSL4
1A24-TB82EC_Combined (RA-LIB)_ACM_2.00_Module_HART_Device_1A24-TB82EC_Combined_(5.2).HSL4
1A25-TB82TE_Combined (RA-LIB)_ACM_2.00_Module_HART_Device_1A25-TB82TE_Combined_(5.2).HSL4
1A26-TB82TC_Combined (RA-LIB)_ACM_2.00_Module_HART_Device_1A26-TB82TC_Combined_(5.2).HSL4
1A30-APA592PH (RA-LIB)_ACM_2.00_Module_HART_Device_1A30-APA592PH_(5.2).HSL4
1A31-ACA592EC (RA-LIB)_ACM_2.00_Module_HART_Device_1A31-ACA592EC_(5.2).HSL4
1A32-ACA592TE (RA-LIB)_ACM_2.00_Module_HART_Device_1A32-ACA592TE_(5.2).HSL4
1A33-ACA592TC (RA-LIB)_ACM_2.00_Module_HART_Device_1A33-ACA592TC_(5.2).HSL4
1A35-AWT420 (RA-LIB)_ACM_2.00_Module_HART_Device_1A35-AWT420_(5.2).HSL4
1A89-ABB_263_265_2000T (RA-LIB)_ACM_2.00_Module_HART_Device_1A89-ABB_263_265_2000T_(5.2).HSL4
1A8C-ABB_261 (RA-LIB)_ACM_2.00_Module_HART_Device_1A8C-ABB_261_(5.2).HSL4
1A8D-EDP300 (RA-LIB)_ACM_2.00_Module_HART_Device_1A8D-EDP300_(5.2).HSL4
1A8E-ABB_2600T_266_MV (RA-LIB)_ACM_2.00_Module_HART_Device_1A8E-ABB_2600T_266_MV_(5.2).HSL4
1A91-Pxx100 (RA-LIB)_ACM_2.00_Module_HART_Device_1A91-Pxx100_(5.2).HSL4
1A99-Fieldkey_NHU200_WL (RA-LIB)_ACM_2.00_Module_HART_Device_1A99-Fieldkey_NHU200_WL_(5.2).HSL4
1A9C-LST_400_Ultrasonic_Level (RA-LIB)_ACM_2.00_Module_HART_Device_1A9C-LST_400_Ultrasonic_Level_(5.2).HSL4
1A9E-LWT_Guided_Wave_Radar_Level (RA-LIB)_ACM_2.00_Module_HART_Device_1A9E-LWT_Guided_Wave_Radar_Level_(5.2).HSL4
1AA0-FCXxxx (RA-LIB)_ACM_2.00_Module_HART_Device_1AA0-FCXxxx_(5.2).HSL4
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1AA3-FSV400_FSS400 (RA-LIB)_ACM_2.00_Module_HART_Device_1AA3-FSV400_FSS400_(5.2).HSL4
1AA4-FEW5xx_FEX6xx (RA-LIB)_ACM_2.00_Module_HART_Device_1AA4-FEW5xx_FEX6xx_(5.2).HSL4
1D01-B6U (RA-LIB)_ACM_2.00_Module_HART_Device_1D01-B6U_(5.2).HSL4
1D02-B3HU (RA-LIB)_ACM_2.00_Module_HART_Device_1D02-B3HU_(5.2).HSL4
1D03-HU_27 (RA-LIB)_ACM_2.00_Module_HART_Device_1D03-HU_27_(5.2).HSL4
1D04-B3HU2 (RA-LIB)_ACM_2.00_Module_HART_Device_1D04-B3HU2_(5.2).HSL4
1F07-MM_9712_Mass_flo (RA-LIB)_ACM_2.00_Module_HART_Device_1F07-MM_9712_Mass_flo_(5.2).HSL4
1F15-MM_9739_Mass_flo (RA-LIB)_ACM_2.00_Module_HART_Device_1F15-MM_9739_Mass_flo_(5.2).HSL4
1F16-MVD_Series_9739 (RA-LIB)_ACM_2.00_Module_HART_Device_1F16-MVD_Series_9739_(5.2).HSL4
1F17-K_Series (RA-LIB)_ACM_2.00_Module_HART_Device_1F17-K_Series_(5.2).HSL4
1F1E-MM_9701 (RA-LIB)_ACM_2.00_Module_HART_Device_1F1E-MM_9701_(5.2).HSL4
1F24-MVD_Series_2000_Config_I_O (RA-LIB)_ACM_2.00_Module_HART_Device_1F24-MVD_Series_2000_Config_I_O_(5.2).HSL4
1F25-MVD_Series_1000_Config_I_O (RA-LIB)_ACM_2.00_Module_HART_Device_1F25-MVD_Series_1000_Config_I_O_(5.2).HSL4
1F26-MVD_Series_2000_IS_Output (RA-LIB)_ACM_2.00_Module_HART_Device_1F26-MVD_Series_2000_IS_Output_(5.2).HSL4
1F27-MVD_Series_1000_IS_Output (RA-LIB)_ACM_2.00_Module_HART_Device_1F27-MVD_Series_1000_IS_Output_(5.2).HSL4
1F29-MVD_Series_1000_Analog_Output (RA-LIB)_ACM_2.00_Module_HART_Device_1F29-MVD_Series_1000_Analog_Output_(5.2).HSL4
1F2A-MVD_Series_2000_Analog_Output (RA-LIB)_ACM_2.00_Module_HART_Device_1F2A-MVD_Series_2000_Analog_Output_(5.2).HSL4
1F34-Mass_flo_2400S (RA-LIB)_ACM_2.00_Module_HART_Device_1F34-Mass_flo_2400S_(5.2).HSL4
1F3A-Analog_2200S (RA-LIB)_ACM_2.00_Module_HART_Device_1F3A-Analog_2200S_(5.2).HSL4
1F3D-Density_Gas_Viscosity_Meter (RA-LIB)_ACM_2.00_Module_HART_Device_1F3D-Density_Gas_Viscosity_Meter_(5.2).HSL4
1F41-MVD_Series_3000 (RA-LIB)_ACM_2.00_Module_HART_Device_1F41-MVD_Series_3000_(5.2).HSL4
1F46-Configurable_I_O_5700 (RA-LIB)_ACM_2.00_Module_HART_Device_1F46-Configurable_I_O_5700_(5.2).HSL4
1F47-MM_5700_with_Intrinsically_Safe_Outputs (RA-LIB)_ACM_2.00_Module_HART_Device_1F47-MM_5700_with_Intrinsically_Safe_Outputs_(5.2).HSL4
1F4B-MM_4200 (RA-LIB)_ACM_2.00_Module_HART_Device_1F4B-MM_4200_(5.2).HSL4
2001-TRZ (RA-LIB)_ACM_2.00_Module_HART_Device_2001-TRZ_(5.2).HSL4
2003-THZ (RA-LIB)_ACM_2.00_Module_HART_Device_2003-THZ_(5.2).HSL4
2004-THZ2 (RA-LIB)_ACM_2.00_Module_HART_Device_2004-THZ2_(5.2).HSL4
2005-HTZ (RA-LIB)_ACM_2.00_Module_HART_Device_2005-HTZ_(5.2).HSL4
2006-TCM (RA-LIB)_ACM_2.00_Module_HART_Device_2006-TCM_(5.2).HSL4
2007-MI_888 (RA-LIB)_ACM_2.00_Module_HART_Device_2007-MI_888_(5.2).HSL4
2008-THZ3_TDZ3 (RA-LIB)_ACM_2.00_Module_HART_Device_2008-THZ3_TDZ3_(5.2).HSL4
2009-STZ (RA-LIB)_ACM_2.00_Module_HART_Device_2009-STZ_(5.2).HSL4
2602-Temp_3044 (RA-LIB)_ACM_2.00_Module_HART_Device_2602-Temp_3044_(5.2).HSL4
2603-Rosemount_1151 (RA-LIB)_ACM_2.00_Module_HART_Device_2603-Rosemount_1151_(5.2).HSL4
2604-Magmeter (RA-LIB)_ACM_2.00_Module_HART_Device_2604-Magmeter_(5.2).HSL4
2606-Rosemount_3051 (RA-LIB)_ACM_2.00_Module_HART_Device_2606-Rosemount_3051_(5.2).HSL4
260C-Mag_HS (RA-LIB)_ACM_2.00_Module_HART_Device_260C-Mag_HS_(5.2).HSL4
260D-Temp_3044C (RA-LIB)_ACM_2.00_Module_HART_Device_260D-Temp_3044C_(5.2).HSL4
260E-HTG_3001C (RA-LIB)_ACM_2.00_Module_HART_Device_260E-HTG_3001C_(5.2).HSL4
260F-Rosemount_3051LP (RA-LIB)_ACM_2.00_Module_HART_Device_260F-Rosemount_3051LP_(5.2).HSL4
2610-Vortex (RA-LIB)_ACM_2.00_Module_HART_Device_2610-Vortex_(5.2).HSL4
2611-SAM_3201 (RA-LIB)_ACM_2.00_Module_HART_Device_2611-SAM_3201_(5.2).HSL4
2613-SAM_3202 (RA-LIB)_ACM_2.00_Module_HART_Device_2613-SAM_3202_(5.2).HSL4
2614-HTG_3001S (RA-LIB)_ACM_2.00_Module_HART_Device_2614-HTG_3001S_(5.2).HSL4
2616-Rosemount_3095MV (RA-LIB)_ACM_2.00_Module_HART_Device_2616-Rosemount_3095MV_(5.2).HSL4
2618-Temp_644 (RA-LIB)_ACM_2.00_Module_HART_Device_2618-Temp_644_(5.2).HSL4
261D-Tri_Loop (RA-LIB)_ACM_2.00_Module_HART_Device_261D-Tri_Loop_(5.2).HSL4
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2624-ProBar (RA-LIB)_ACM_2.00_Module_HART_Device_2624-ProBar_(5.2).HSL4
2628-ProBar_UC (RA-LIB)_ACM_2.00_Module_HART_Device_2628-ProBar_UC_(5.2).HSL4
262F-ProPlate_UC (RA-LIB)_ACM_2.00_Module_HART_Device_262F-ProPlate_UC_(5.2).HSL4
2662-Metran_150 (RA-LIB)_ACM_2.00_Module_HART_Device_2662-Metran_150_(5.2).HSL4
266D-Metran_75 (RA-LIB)_ACM_2.00_Module_HART_Device_266D-Metran_75_(5.2).HSL4
268A-Smart_Pressure_Gauge (RA-LIB)_ACM_2.00_Module_HART_Device_268A-Smart_Pressure_Gauge_(5.2).HSL4
2801-NEXGEN (RA-LIB)_ACM_2.00_Module_HART_Device_2801-NEXGEN_(5.2).HSL4
2A04-SITRANS_FUS (RA-LIB)_ACM_2.00_Module_HART_Device_2A04-SITRANS_FUS_(5.2).HSL4
2A07-SITRANS_LR (RA-LIB)_ACM_2.00_Module_HART_Device_2A07-SITRANS_LR_(5.2).HSL4
2A08-KM35 (RA-LIB)_ACM_2.00_Module_HART_Device_2A08-KM35_(5.2).HSL4
2A0A-SITRANS_P_HS (RA-LIB)_ACM_2.00_Module_HART_Device_2A0A-SITRANS_P_HS_(5.2).HSL4
2A0B-SITRANS_P_DS (RA-LIB)_ACM_2.00_Module_HART_Device_2A0B-SITRANS_P_DS_(5.2).HSL4
2A0C-SITRANS_P_ES (RA-LIB)_ACM_2.00_Module_HART_Device_2A0C-SITRANS_P_ES_(5.2).HSL4
2A0D-SITRANS_P_MS (RA-LIB)_ACM_2.00_Module_HART_Device_2A0D-SITRANS_P_MS_(5.2).HSL4
2A10-SITRANS_TW (RA-LIB)_ACM_2.00_Module_HART_Device_2A10-SITRANS_TW_(5.2).HSL4
2A12-SITRANS_TK_H (RA-LIB)_ACM_2.00_Module_HART_Device_2A12-SITRANS_TK_H_(5.2).HSL4
2A13-SITRANS_TH300 (RA-LIB)_ACM_2.00_Module_HART_Device_2A13-SITRANS_TH300_(5.2).HSL4
2A15-SIPART_PS2 (RA-LIB)_ACM_2.00_Module_HART_Device_2A15-SIPART_PS2_(5.2).HSL4
2A16-SITRANS_FM (RA-LIB)_ACM_2.00_Module_HART_Device_2A16-SITRANS_FM_(5.2).HSL4
2A18-SITRANS_FM_MAGFLO (RA-LIB)_ACM_2.00_Module_HART_Device_2A18-SITRANS_FM_MAGFLO_(5.2).HSL4
2A19-SITRANS_FC_MASSFLO (RA-LIB)_ACM_2.00_Module_HART_Device_2A19-SITRANS_FC_MASSFLO_(5.2).HSL4
2A1A-SITRANS_FM_IT2_TM2 (RA-LIB)_ACM_2.00_Module_HART_Device_2A1A-SITRANS_FM_IT2_TM2_(5.2).HSL4
2A1D-SITRANS_P300 (RA-LIB)_ACM_2.00_Module_HART_Device_2A1D-SITRANS_P300_(5.2).HSL4
2A1F-SITRANS_TR300 (RA-LIB)_ACM_2.00_Module_HART_Device_2A1F-SITRANS_TR300_(5.2).HSL4
2A20-SITRANS_VP300 (RA-LIB)_ACM_2.00_Module_HART_Device_2A20-SITRANS_VP300_(5.2).HSL4
2A22-SITRANS_FC430 (RA-LIB)_ACM_2.00_Module_HART_Device_2A22-SITRANS_FC430_(5.2).HSL4
2A23-SITRANS_P500 (RA-LIB)_ACM_2.00_Module_HART_Device_2A23-SITRANS_P500_(5.2).HSL4
2A24-SITRANS_LR560 (RA-LIB)_ACM_2.00_Module_HART_Device_2A24-SITRANS_LR560_(5.2).HSL4
2A28-SIPART_PS100 (RA-LIB)_ACM_2.00_Module_HART_Device_2A28-SIPART_PS100_(5.2).HSL4
2A2D-SITRANS_Probe_LU240 (RA-LIB)_ACM_2.00_Module_HART_Device_2A2D-SITRANS_Probe_LU240_(5.2).HSL4
2A34-SITRANS_LUT400 (RA-LIB)_ACM_2.00_Module_HART_Device_2A34-SITRANS_LUT400_(5.2).HSL4
2A3D-SITRANS_P320 (RA-LIB)_ACM_2.00_Module_HART_Device_2A3D-SITRANS_P320_(5.2).HSL4
2A3E-SITRANS_P420 (RA-LIB)_ACM_2.00_Module_HART_Device_2A3E-SITRANS_P420_(5.2).HSL4
2C02-AP3100 (RA-LIB)_ACM_2.00_Module_HART_Device_2C02-AP3100_(5.2).HSL4
2C0A-LF_Series (RA-LIB)_ACM_2.00_Module_HART_Device_2C0A-LF_Series_(5.2).HSL4
2E06-pH_2081 (RA-LIB)_ACM_2.00_Module_HART_Device_2E06-pH_2081_(5.2).HSL4
2E07-Cond_2081 (RA-LIB)_ACM_2.00_Module_HART_Device_2E07-Cond_2081_(5.2).HSL4
2E0C-Oxymitter_4000 (RA-LIB)_ACM_2.00_Module_HART_Device_2E0C-Oxymitter_4000_(5.2).HSL4
2E0D-WC_3000 (RA-LIB)_ACM_2.00_Module_HART_Device_2E0D-WC_3000_(5.2).HSL4
2E0F-OPM_2000R (RA-LIB)_ACM_2.00_Module_HART_Device_2E0F-OPM_2000R_(5.2).HSL4
2E10-OCX_4000 (RA-LIB)_ACM_2.00_Module_HART_Device_2E10-OCX_4000_(5.2).HSL4
2E1B-Xmt_A (RA-LIB)_ACM_2.00_Module_HART_Device_2E1B-Xmt_A_(5.2).HSL4
2E1C-Xmt_C_T (RA-LIB)_ACM_2.00_Module_HART_Device_2E1C-Xmt_C_T_(5.2).HSL4
2E1D-Xmt_pH (RA-LIB)_ACM_2.00_Module_HART_Device_2E1D-Xmt_pH_(5.2).HSL4
2E1E-FG_5081 (RA-LIB)_ACM_2.00_Module_HART_Device_2E1E-FG_5081_(5.2).HSL4
2E2B-XS_O2 (RA-LIB)_ACM_2.00_Module_HART_Device_2E2B-XS_O2_(5.2).HSL4
2E3A-O2_6888 (RA-LIB)_ACM_2.00_Module_HART_Device_2E3A-O2_6888_(5.2).HSL4
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2E56-Model56 (RA-LIB)_ACM_2.00_Module_HART_Device_2E56-Model56_(5.2).HSL4
2F01-PSMART (RA-LIB)_ACM_2.00_Module_HART_Device_2F01-PSMART_(5.2).HSL4
2F3C-SMARTPULP (RA-LIB)_ACM_2.00_Module_HART_Device_2F3C-SMARTPULP_(5.2).HSL4
2F3D-SMARTLX (RA-LIB)_ACM_2.00_Module_HART_Device_2F3D-SMARTLX_(5.2).HSL4
2F3E-MCAi (RA-LIB)_ACM_2.00_Module_HART_Device_2F3E-MCAi_(5.2).HSL4
2F3F-SMARTLC (RA-LIB)_ACM_2.00_Module_HART_Device_2F3F-SMARTLC_(5.2).HSL4
2F40-MCA (RA-LIB)_ACM_2.00_Module_HART_Device_2F40-MCA_(5.2).HSL4
3001-Logix_12xx (RA-LIB)_ACM_2.00_Module_HART_Device_3001-Logix_12xx_(5.2).HSL4
3003-Logix_520 (RA-LIB)_ACM_2.00_Module_HART_Device_3003-Logix_520_(5.2).HSL4
3004-Logix3200_IQ (RA-LIB)_ACM_2.00_Module_HART_Device_3004-Logix3200_IQ_(5.2).HSL4
3005-Logix3200MD (RA-LIB)_ACM_2.00_Module_HART_Device_3005-Logix3200MD_(5.2).HSL4
3006-Logix520MD (RA-LIB)_ACM_2.00_Module_HART_Device_3006-Logix520MD_(5.2).HSL4
3007-Logix_MD (RA-LIB)_ACM_2.00_Module_HART_Device_3007-Logix_MD_(5.2).HSL4
3008-Limitorque_MX_QX (RA-LIB)_ACM_2.00_Module_HART_Device_3008-Limitorque_MX_QX_(5.2).HSL4
3009-Logix_420 (RA-LIB)_ACM_2.00_Module_HART_Device_3009-Logix_420_(5.2).HSL4
300A-Logix_3820 (RA-LIB)_ACM_2.00_Module_HART_Device_300A-Logix_3820_(5.2).HSL4
300B-Logix_3820e (RA-LIB)_ACM_2.00_Module_HART_Device_300B-Logix_3820e_(5.2).HSL4
3202-Trim (RA-LIB)_ACM_2.00_Module_HART_Device_3202-Trim_(5.2).HSL4
322E-I_A_Pressure (RA-LIB)_ACM_2.00_Module_HART_Device_322E-I_A_Pressure_(5.2).HSL4
3601-MagneW (RA-LIB)_ACM_2.00_Module_HART_Device_3601-MagneW_(5.2).HSL4
3602-ST3000 (RA-LIB)_ACM_2.00_Module_HART_Device_3602-ST3000_(5.2).HSL4
3603-SVP (RA-LIB)_ACM_2.00_Module_HART_Device_3603-SVP_(5.2).HSL4
3604-ThermoPlus_ATT (RA-LIB)_ACM_2.00_Module_HART_Device_3604-ThermoPlus_ATT_(5.2).HSL4
3605-PTG (RA-LIB)_ACM_2.00_Module_HART_Device_3605-PTG_(5.2).HSL4
3608-MagneW_2W (RA-LIB)_ACM_2.00_Module_HART_Device_3608-MagneW_2W_(5.2).HSL4
360C-MAGNEW4W (RA-LIB)_ACM_2.00_Module_HART_Device_360C-MAGNEW4W_(5.2).HSL4
360D-AT9000 (RA-LIB)_ACM_2.00_Module_HART_Device_360D-AT9000_(5.2).HSL4
360E-GASCVD (RA-LIB)_ACM_2.00_Module_HART_Device_360E-GASCVD_(5.2).HSL4
360F-AVP700 (RA-LIB)_ACM_2.00_Module_HART_Device_360F-AVP700_(5.2).HSL4
3610-AVP700_SIS (RA-LIB)_ACM_2.00_Module_HART_Device_3610-AVP700_SIS_(5.2).HSL4
3611-AVP307 (RA-LIB)_ACM_2.00_Module_HART_Device_3611-AVP307_(5.2).HSL4
3614-SVP_V2 (RA-LIB)_ACM_2.00_Module_HART_Device_3614-SVP_V2_(5.2).HSL4
3615-ATT082 (RA-LIB)_ACM_2.00_Module_HART_Device_3615-ATT082_(5.2).HSL4
3616-ATT162 (RA-LIB)_ACM_2.00_Module_HART_Device_3616-ATT162_(5.2).HSL4
3701-YEWFLO (RA-LIB)_ACM_2.00_Module_HART_Device_3701-YEWFLO_(5.2).HSL4
3702-YT200 (RA-LIB)_ACM_2.00_Module_HART_Device_3702-YT200_(5.2).HSL4
3703-UNICOM (RA-LIB)_ACM_2.00_Module_HART_Device_3703-UNICOM_(5.2).HSL4
3704-EJA (RA-LIB)_ACM_2.00_Module_HART_Device_3704-EJA_(5.2).HSL4
3705-ADMAG_AE (RA-LIB)_ACM_2.00_Module_HART_Device_3705-ADMAG_AE_(5.2).HSL4
3706-AM11 (RA-LIB)_ACM_2.00_Module_HART_Device_3706-AM11_(5.2).HSL4
3708-ADMAG_SE (RA-LIB)_ACM_2.00_Module_HART_Device_3708-ADMAG_SE_(5.2).HSL4
3709-YTA (RA-LIB)_ACM_2.00_Module_HART_Device_3709-YTA_(5.2).HSL4
370A-YTA70E (RA-LIB)_ACM_2.00_Module_HART_Device_370A-YTA70E_(5.2).HSL4
370B-DYF (RA-LIB)_ACM_2.00_Module_HART_Device_370B-DYF_(5.2).HSL4
370C-ZR202 (RA-LIB)_ACM_2.00_Module_HART_Device_370C-ZR202_(5.2).HSL4
370D-ZR402 (RA-LIB)_ACM_2.00_Module_HART_Device_370D-ZR402_(5.2).HSL4
3711-YTA610 (RA-LIB)_ACM_2.00_Module_HART_Device_3711-YTA610_(5.2).HSL4
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3712-FLXA402 (RA-LIB)_ACM_2.00_Module_HART_Device_3712-FLXA402_(5.2).HSL4
3714-ISC202 (RA-LIB)_ACM_2.00_Module_HART_Device_3714-ISC202_(5.2).HSL4
3715-PH202 (RA-LIB)_ACM_2.00_Module_HART_Device_3715-PH202_(5.2).HSL4
3716-SC202 (RA-LIB)_ACM_2.00_Module_HART_Device_3716-SC202_(5.2).HSL4
3718-DO202 (RA-LIB)_ACM_2.00_Module_HART_Device_3718-DO202_(5.2).HSL4
371A-AXG4A (RA-LIB)_ACM_2.00_Module_HART_Device_371A-AXG4A_(5.2).HSL4
371B-AXW4A (RA-LIB)_ACM_2.00_Module_HART_Device_371B-AXW4A_(5.2).HSL4
371C-AXG1A (RA-LIB)_ACM_2.00_Module_HART_Device_371C-AXG1A_(5.2).HSL4
3720-SF14A (RA-LIB)_ACM_2.00_Module_HART_Device_3720-SF14A_(5.2).HSL4
3721-ZR802 (RA-LIB)_ACM_2.00_Module_HART_Device_3721-ZR802_(5.2).HSL4
3727-PH150 (RA-LIB)_ACM_2.00_Module_HART_Device_3727-PH150_(5.2).HSL4
3728-SC150 (RA-LIB)_ACM_2.00_Module_HART_Device_3728-SC150_(5.2).HSL4
372B-PH450 (RA-LIB)_ACM_2.00_Module_HART_Device_372B-PH450_(5.2).HSL4
372C-SC450 (RA-LIB)_ACM_2.00_Module_HART_Device_372C-SC450_(5.2).HSL4
372D-ISC450 (RA-LIB)_ACM_2.00_Module_HART_Device_372D-ISC450_(5.2).HSL4
373C-YTA70E_Z (RA-LIB)_ACM_2.00_Module_HART_Device_373C-YTA70E_Z_(5.2).HSL4
373D-YTA70_J (RA-LIB)_ACM_2.00_Module_HART_Device_373D-YTA70_J_(5.2).HSL4
373E-TDLS8000 (RA-LIB)_ACM_2.00_Module_HART_Device_373E-TDLS8000_(5.2).HSL4
373F-YTA70P (RA-LIB)_ACM_2.00_Module_HART_Device_373F-YTA70P_(5.2).HSL4
3740-ROTAMASS (RA-LIB)_ACM_2.00_Module_HART_Device_3740-ROTAMASS_(5.2).HSL4
3741-RAMC (RA-LIB)_ACM_2.00_Module_HART_Device_3741-RAMC_(5.2).HSL4
3742-RCCT_F3 (RA-LIB)_ACM_2.00_Module_HART_Device_3742-RCCT_F3_(5.2).HSL4
3750-AXFA11 (RA-LIB)_ACM_2.00_Module_HART_Device_3750-AXFA11_(5.2).HSL4
3751-EJX (RA-LIB)_ACM_2.00_Module_HART_Device_3751-EJX_(5.2).HSL4
3752-AXFA14 (RA-LIB)_ACM_2.00_Module_HART_Device_3752-AXFA14_(5.2).HSL4
3753-AV550G (RA-LIB)_ACM_2.00_Module_HART_Device_3753-AV550G_(5.2).HSL4
3754-EJX_MV (RA-LIB)_ACM_2.00_Module_HART_Device_3754-EJX_MV_(5.2).HSL4
3755-EJX_DRS (RA-LIB)_ACM_2.00_Module_HART_Device_3755-EJX_DRS_(5.2).HSL4
3757-AXR (RA-LIB)_ACM_2.00_Module_HART_Device_3757-AXR_(5.2).HSL4
3758-FLXA21_PH (RA-LIB)_ACM_2.00_Module_HART_Device_3758-FLXA21_PH_(5.2).HSL4
3759-FLXA21_202_SC (RA-LIB)_ACM_2.00_Module_HART_Device_3759-FLXA21_202_SC_(5.2).HSL4
375A-FLXA21_202_ISC (RA-LIB)_ACM_2.00_Module_HART_Device_375A-FLXA21_202_ISC_(5.2).HSL4
375B-FLXA21_DO (RA-LIB)_ACM_2.00_Module_HART_Device_375B-FLXA21_DO_(5.2).HSL4
375C-EJA_NEXT (RA-LIB)_ACM_2.00_Module_HART_Device_375C-EJA_NEXT_(5.2).HSL4
375D-EJA_NEXT_LP (RA-LIB)_ACM_2.00_Module_HART_Device_375D-EJA_NEXT_LP_(5.2).HSL4
375F-YTA710 (RA-LIB)_ACM_2.00_Module_HART_Device_375F-YTA710_(5.2).HSL4
3760-ROTAMASS_TI (RA-LIB)_ACM_2.00_Module_HART_Device_3760-ROTAMASS_TI_(5.2).HSL4
3B15-MSP100 (RA-LIB)_ACM_2.00_Module_HART_Device_3B15-MSP100_(5.2).HSL4
3B29-MLT100 (RA-LIB)_ACM_2.00_Module_HART_Device_3B29-MLT100_(5.2).HSL4
3B2B-MSM400 (RA-LIB)_ACM_2.00_Module_HART_Device_3B2B-MSM400_(5.2).HSL4
3B2E-MSP900_400 (RA-LIB)_ACM_2.00_Module_HART_Device_3B2E-MSP900_400_(5.2).HSL4
3B2F-MRL700 (RA-LIB)_ACM_2.00_Module_HART_Device_3B2F-MRL700_(5.2).HSL4
3E01-LD301 (RA-LIB)_ACM_2.00_Module_HART_Device_3E01-LD301_(5.2).HSL4
3E02-TT301 (RA-LIB)_ACM_2.00_Module_HART_Device_3E02-TT301_(5.2).HSL4
3E03-FY301 (RA-LIB)_ACM_2.00_Module_HART_Device_3E03-FY301_(5.2).HSL4
3E04-LD291 (RA-LIB)_ACM_2.00_Module_HART_Device_3E04-LD291_(5.2).HSL4
3E05-TP301 (RA-LIB)_ACM_2.00_Module_HART_Device_3E05-TP301_(5.2).HSL4
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3E06-DT301 (RA-LIB)_ACM_2.00_Module_HART_Device_3E06-DT301_(5.2).HSL4
3E09-TT400 (RA-LIB)_ACM_2.00_Module_HART_Device_3E09-TT400_(5.2).HSL4
3E0A-LD400 (RA-LIB)_ACM_2.00_Module_HART_Device_3E0A-LD400_(5.2).HSL4
3F01-TSV175 (RA-LIB)_ACM_2.00_Module_HART_Device_3F01-TSV175_(5.2).HSL4
3F02-DMU130 (RA-LIB)_ACM_2.00_Module_HART_Device_3F02-DMU130_(5.2).HSL4
3F03-TI_RTT20 (RA-LIB)_ACM_2.00_Module_HART_Device_3F03-TI_RTT20_(5.2).HSL4
3F04-SRD991 (RA-LIB)_ACM_2.00_Module_HART_Device_3F04-SRD991_(5.2).HSL4
3F05-DMU140 (RA-LIB)_ACM_2.00_Module_HART_Device_3F05-DMU140_(5.2).HSL4
3F06-SRD960 (RA-LIB)_ACM_2.00_Module_HART_Device_3F06-SRD960_(5.2).HSL4
3F07-LD244 (RA-LIB)_ACM_2.00_Module_HART_Device_3F07-LD244_(5.2).HSL4
3F08-SRD998 (RA-LIB)_ACM_2.00_Module_HART_Device_3F08-SRD998_(5.2).HSL4
3FD0-LR01 (RA-LIB)_ACM_2.00_Module_HART_Device_3FD0-LR01_(5.2).HSL4
3FD7-LG01 (RA-LIB)_ACM_2.00_Module_HART_Device_3FD7-LG01_(5.2).HSL4
42EB-TROVIS_3730_3 (RA-LIB)_ACM_2.00_Module_HART_Device_42EB-TROVIS_3730_3_(5.2).HSL4
42EC-TROVIS_SAFE_3793 (RA-LIB)_ACM_2.00_Module_HART_Device_42EC-TROVIS_SAFE_3793_(5.2).HSL4
42ED-TROVIS_3793 (RA-LIB)_ACM_2.00_Module_HART_Device_42ED-TROVIS_3793_(5.2).HSL4
43EE-FM6XX (RA-LIB)_ACM_2.00_Module_HART_Device_43EE-FM6XX_(5.2).HSL4
45AD-OPTISYS_IND_8100 (RA-LIB)_ACM_2.00_Module_HART_Device_45AD-OPTISYS_IND_8100_(5.2).HSL4
45AE-OPTIFLEX_3200_6200_7200_8200 (RA-LIB)_ACM_2.00_Module_HART_Device_45AE-OPTIFLEX_3200_6200_7200_8200_(5.2).HSL4
45AF-UFC300_V2 (RA-LIB)_ACM_2.00_Module_HART_Device_45AF-UFC300_V2_(5.2).HSL4
45B9-OPTIWAVE_x400_x500 (RA-LIB)_ACM_2.00_Module_HART_Device_45B9-OPTIWAVE_x400_x500_(5.2).HSL4
45BA-ESK3x (RA-LIB)_ACM_2.00_Module_HART_Device_45BA-ESK3x_(5.2).HSL4
45BB-MFC_400_S (RA-LIB)_ACM_2.00_Module_HART_Device_45BB-MFC_400_S_(5.2).HSL4
45BC-OPTIBAR_5060_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_45BC-OPTIBAR_5060_SIL_(5.2).HSL4
45BD-OPTIBAR_7060_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_45BD-OPTIBAR_7060_SIL_(5.2).HSL4
45BE-ESK4A (RA-LIB)_ACM_2.00_Module_HART_Device_45BE-ESK4A_(5.2).HSL4
45BF-OPTIWAVE_1010 (RA-LIB)_ACM_2.00_Module_HART_Device_45BF-OPTIWAVE_1010_(5.2).HSL4
45C2-SMARTPAT_COND (RA-LIB)_ACM_2.00_Module_HART_Device_45C2-SMARTPAT_COND_(5.2).HSL4
45C3-SMARTSENS_ORP (RA-LIB)_ACM_2.00_Module_HART_Device_45C3-SMARTSENS_ORP_(5.2).HSL4
45C4-OPTIBAR_5060 (RA-LIB)_ACM_2.00_Module_HART_Device_45C4-OPTIBAR_5060_(5.2).HSL4
45C5-OPTIBAR_DP_7060_C (RA-LIB)_ACM_2.00_Module_HART_Device_45C5-OPTIBAR_DP_7060_C_(5.2).HSL4
45C6-SMARTSENS_PH (RA-LIB)_ACM_2.00_Module_HART_Device_45C6-SMARTSENS_PH_(5.2).HSL4
45C7-TT53_C_R_Ex (RA-LIB)_ACM_2.00_Module_HART_Device_45C7-TT53_C_R_Ex_(5.2).HSL4
45CC-MFC400 (RA-LIB)_ACM_2.00_Module_HART_Device_45CC-MFC400_(5.2).HSL4
45CD-VFC200 (RA-LIB)_ACM_2.00_Module_HART_Device_45CD-VFC200_(5.2).HSL4
45CF-MAC100 (RA-LIB)_ACM_2.00_Module_HART_Device_45CF-MAC100_(5.2).HSL4
45D0-Optiwave_5200_C_F (RA-LIB)_ACM_2.00_Module_HART_Device_45D0-Optiwave_5200_C_F_(5.2).HSL4
45D2-UFC400 (RA-LIB)_ACM_2.00_Module_HART_Device_45D2-UFC400_(5.2).HSL4
45D3-TT51C_R (RA-LIB)_ACM_2.00_Module_HART_Device_45D3-TT51C_R_(5.2).HSL4
45D6-ESK4 (RA-LIB)_ACM_2.00_Module_HART_Device_45D6-ESK4_(5.2).HSL4
45D7-OPTIFLEX_2200 (RA-LIB)_ACM_2.00_Module_HART_Device_45D7-OPTIFLEX_2200_(5.2).HSL4
45D9-IFC_100 (RA-LIB)_ACM_2.00_Module_HART_Device_45D9-IFC_100_(5.2).HSL4
45DB-TT50C_R (RA-LIB)_ACM_2.00_Module_HART_Device_45DB-TT50C_R_(5.2).HSL4
45DD-MFC_300 (RA-LIB)_ACM_2.00_Module_HART_Device_45DD-MFC_300_(5.2).HSL4
45DE-VFC070 (RA-LIB)_ACM_2.00_Module_HART_Device_45DE-VFC070_(5.2).HSL4
45E2-ESK2A (RA-LIB)_ACM_2.00_Module_HART_Device_45E2-ESK2A_(5.2).HSL4
45E3-IFC_300 (RA-LIB)_ACM_2.00_Module_HART_Device_45E3-IFC_300_(5.2).HSL4
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45E4-Optiflex_1300C (RA-LIB)_ACM_2.00_Module_HART_Device_45E4-Optiflex_1300C_(5.2).HSL4
45E5-Optiwave_7300C (RA-LIB)_ACM_2.00_Module_HART_Device_45E5-Optiwave_7300C_(5.2).HSL4
45E6-M8E (RA-LIB)_ACM_2.00_Module_HART_Device_45E6-M8E_(5.2).HSL4
45E7-UFC030 (RA-LIB)_ACM_2.00_Module_HART_Device_45E7-UFC030_(5.2).HSL4
45E8-MFC05x (RA-LIB)_ACM_2.00_Module_HART_Device_45E8-MFC05x_(5.2).HSL4
45E9-IFC040 (RA-LIB)_ACM_2.00_Module_HART_Device_45E9-IFC040_(5.2).HSL4
45EA-M10 (RA-LIB)_ACM_2.00_Module_HART_Device_45EA-M10_(5.2).HSL4
45EC-BM102 (RA-LIB)_ACM_2.00_Module_HART_Device_45EC-BM102_(5.2).HSL4
45ED-VFM31 (RA-LIB)_ACM_2.00_Module_HART_Device_45ED-VFM31_(5.2).HSL4
45EE-BM100 (RA-LIB)_ACM_2.00_Module_HART_Device_45EE-BM100_(5.2).HSL4
45F2-ESKII (RA-LIB)_ACM_2.00_Module_HART_Device_45F2-ESKII_(5.2).HSL4
45F3-IFC110 (RA-LIB)_ACM_2.00_Module_HART_Device_45F3-IFC110_(5.2).HSL4
45F4-IFC090 (RA-LIB)_ACM_2.00_Module_HART_Device_45F4-IFC090_(5.2).HSL4
45F5-UFC500 (RA-LIB)_ACM_2.00_Module_HART_Device_45F5-UFC500_(5.2).HSL4
45F7-MFC08x (RA-LIB)_ACM_2.00_Module_HART_Device_45F7-MFC08x_(5.2).HSL4
45F8-IFC080 (RA-LIB)_ACM_2.00_Module_HART_Device_45F8-IFC080_(5.2).HSL4
45F9-BM70 (RA-LIB)_ACM_2.00_Module_HART_Device_45F9-BM70_(5.2).HSL4
47E9-RTX1000H_Gauge (RA-LIB)_ACM_2.00_Module_HART_Device_47E9-RTX1000H_Gauge_(5.2).HSL4
47EC-RTX1000H_SG (RA-LIB)_ACM_2.00_Module_HART_Device_47EC-RTX1000H_SG_(5.2).HSL4
47EF-RTX1000H_ABS (RA-LIB)_ACM_2.00_Module_HART_Device_47EF-RTX1000H_ABS_(5.2).HSL4
4800-Series_815 (RA-LIB)_ACM_2.00_Module_HART_Device_4800-Series_815_(5.2).HSL4
4D01-ICOT (RA-LIB)_ACM_2.00_Module_HART_Device_4D01-ICOT_(5.2).HSL4
4D02-SmartCal (RA-LIB)_ACM_2.00_Module_HART_Device_4D02-SmartCal_(5.2).HSL4
4D03-D_EPIC (RA-LIB)_ACM_2.00_Module_HART_Device_4D03-D_EPIC_(5.2).HSL4
4D04-D_EPIC_ESD (RA-LIB)_ACM_2.00_Module_HART_Device_4D04-D_EPIC_ESD_(5.2).HSL4
4D05-Digital_EPIC_2 (RA-LIB)_ACM_2.00_Module_HART_Device_4D05-Digital_EPIC_2_(5.2).HSL4
4D06-Digital_Epic_D200 (RA-LIB)_ACM_2.00_Module_HART_Device_4D06-Digital_Epic_D200_(5.2).HSL4
4E02-UNIVERSAL_III (RA-LIB)_ACM_2.00_Module_HART_Device_4E02-UNIVERSAL_III_(5.2).HSL4
4EEA-Radar_DRx400_DRx500 (RA-LIB)_ACM_2.00_Module_HART_Device_4EEA-Radar_DRx400_DRx500_(5.2).HSL4
4EEC-DR2000 (RA-LIB)_ACM_2.00_Module_HART_Device_4EEC-DR2000_(5.2).HSL4
4EED-DR5200 (RA-LIB)_ACM_2.00_Module_HART_Device_4EED-DR5200_(5.2).HSL4
4FEF-TankRadarPro (RA-LIB)_ACM_2.00_Module_HART_Device_4FEF-TankRadarPro_(5.2).HSL4
5072-AT100_200_Lvl_Vol_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_5072-AT100_200_Lvl_Vol_LCD_(5.2).HSL4
5073-AT100_200_2Lvl_Vol_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_5073-AT100_200_2Lvl_Vol_LCD_(5.2).HSL4
5076-AT100_200_Lvl_Temp_Vol_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_5076-AT100_200_Lvl_Temp_Vol_LCD_(5.2).HSL4
5077-AT100_200_2Lvl_Temp_Vol_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_5077-AT100_200_2Lvl_Temp_Vol_LCD_(5.2).HSL4
5078-AT100_200_Lvl (RA-LIB)_ACM_2.00_Module_HART_Device_5078-AT100_200_Lvl_(5.2).HSL4
507A-AT100_200_Lvl_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_507A-AT100_200_Lvl_LCD_(5.2).HSL4
507B-AT100_200_2Lvl_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_507B-AT100_200_2Lvl_LCD_(5.2).HSL4
507E-AT100_200_Lvl_Temp_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_507E-AT100_200_Lvl_Temp_LCD_(5.2).HSL4
507F-AT100_200_2Lvl_Temp_LCD (RA-LIB)_ACM_2.00_Module_HART_Device_507F-AT100_200_2Lvl_Temp_LCD_(5.2).HSL4
50AA-MT5000 (RA-LIB)_ACM_2.00_Module_HART_Device_50AA-MT5000_(5.2).HSL4
50AB-MT5100 (RA-LIB)_ACM_2.00_Module_HART_Device_50AB-MT5100_(5.2).HSL4
50BA-MT5200 (RA-LIB)_ACM_2.00_Module_HART_Device_50BA-MT5200_(5.2).HSL4
50C2-SS140XP (RA-LIB)_ACM_2.00_Module_HART_Device_50C2-SS140XP_(5.2).HSL4
52E8-Polytron_8000 (RA-LIB)_ACM_2.00_Module_HART_Device_52E8-Polytron_8000_(5.2).HSL4
52E9-PIR7000 (RA-LIB)_ACM_2.00_Module_HART_Device_52E9-PIR7000_(5.2).HSL4
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52EB-Polytron_7000 (RA-LIB)_ACM_2.00_Module_HART_Device_52EB-Polytron_7000_(5.2).HSL4
52ED-Polytron2_IR (RA-LIB)_ACM_2.00_Module_HART_Device_52ED-Polytron2_IR_(5.2).HSL4
52EE-PIR_7x00 (RA-LIB)_ACM_2.00_Module_HART_Device_52EE-PIR_7x00_(5.2).HSL4
52EF-Pulsar_7x00 (RA-LIB)_ACM_2.00_Module_HART_Device_52EF-Pulsar_7x00_(5.2).HSL4
52F1-Polytron_PID (RA-LIB)_ACM_2.00_Module_HART_Device_52F1-Polytron_PID_(5.2).HSL4
52F7-Polytron2 (RA-LIB)_ACM_2.00_Module_HART_Device_52F7-Polytron2_(5.2).HSL4
54F8-MSP2002 (RA-LIB)_ACM_2.00_Module_HART_Device_54F8-MSP2002_(5.2).HSL4
54F9-MST9500 (RA-LIB)_ACM_2.00_Module_HART_Device_54F9-MST9500_(5.2).HSL4
55DE-HCM_8000 (RA-LIB)_ACM_2.00_Module_HART_Device_55DE-HCM_8000_(5.2).HSL4
56DC-Eclipse_Model_700_Level_Transmitter (RA-LIB)_ACM_2.00_Module_HART_Device_56DC-Eclipse_Model_700_Level_Transmitter_(5.2).HSL4
56DF-Jupiter_Model_JM4 (RA-LIB)_ACM_2.00_Module_HART_Device_56DF-Jupiter_Model_JM4_(5.2).HSL4
56E0-Model_706 (RA-LIB)_ACM_2.00_Module_HART_Device_56E0-Model_706_(5.2).HSL4
56E2-Model_R82 (RA-LIB)_ACM_2.00_Module_HART_Device_56E2-Model_R82_(5.2).HSL4
56E3-E3_Modulevel (RA-LIB)_ACM_2.00_Module_HART_Device_56E3-E3_Modulevel_(5.2).HSL4
56E4-Model_355 (RA-LIB)_ACM_2.00_Module_HART_Device_56E4-Model_355_(5.2).HSL4
56E6-Model_RX5 (RA-LIB)_ACM_2.00_Module_HART_Device_56E6-Model_RX5_(5.2).HSL4
56E7-Model_704 (RA-LIB)_ACM_2.00_Module_HART_Device_56E7-Model_704_(5.2).HSL4
56E8-Jupiter (RA-LIB)_ACM_2.00_Module_HART_Device_56E8-Jupiter_(5.2).HSL4
56E9-Model_TA2 (RA-LIB)_ACM_2.00_Module_HART_Device_56E9-Model_TA2_(5.2).HSL4
56EA-Model_707 (RA-LIB)_ACM_2.00_Module_HART_Device_56EA-Model_707_(5.2).HSL4
56EC-Model_708 (RA-LIB)_ACM_2.00_Module_HART_Device_56EC-Model_708_(5.2).HSL4
56ED-Model_805 (RA-LIB)_ACM_2.00_Module_HART_Device_56ED-Model_805_(5.2).HSL4
56EE-Model_805 (RA-LIB)_ACM_2.00_Module_HART_Device_56EE-Model_805_(5.2).HSL4
56EF-SMARTEZ (RA-LIB)_ACM_2.00_Module_HART_Device_56EF-SMARTEZ_(5.2).HSL4
57A2-NDX_H6 (RA-LIB)_ACM_2.00_Module_HART_Device_57A2-NDX_H6_(5.2).HSL4
57A3-NDX_H7 (RA-LIB)_ACM_2.00_Module_HART_Device_57A3-NDX_H7_(5.2).HSL4
57D5-SG9000H (RA-LIB)_ACM_2.00_Module_HART_Device_57D5-SG9000H_(5.2).HSL4
57D9-VG9000H (RA-LIB)_ACM_2.00_Module_HART_Device_57D9-VG9000H_(5.2).HSL4
57DE-ND7000H (RA-LIB)_ACM_2.00_Module_HART_Device_57DE-ND7000H_(5.2).HSL4
57E4-ND9100HT (RA-LIB)_ACM_2.00_Module_HART_Device_57E4-ND9100HT_(5.2).HSL4
57E5-ND9100H (RA-LIB)_ACM_2.00_Module_HART_Device_57E5-ND9100H_(5.2).HSL4
57EB-ValvGuard (RA-LIB)_ACM_2.00_Module_HART_Device_57EB-ValvGuard_(5.2).HSL4
57EE-ND820_T (RA-LIB)_ACM_2.00_Module_HART_Device_57EE-ND820_T_(5.2).HSL4
57EF-ND820 (RA-LIB)_ACM_2.00_Module_HART_Device_57EF-ND820_(5.2).HSL4
57F1-VG9000H_H7 (RA-LIB)_ACM_2.00_Module_HART_Device_57F1-VG9000H_H7_(5.2).HSL4
58C9-SITRANS_LR300 (RA-LIB)_ACM_2.00_Module_HART_Device_58C9-SITRANS_LR300_(5.2).HSL4
58CA-LR_200 (RA-LIB)_ACM_2.00_Module_HART_Device_58CA-LR_200_(5.2).HSL4
58CC-SITRANS_LR400 (RA-LIB)_ACM_2.00_Module_HART_Device_58CC-SITRANS_LR400_(5.2).HSL4
58CD-Sitrans_Probe_LU_6m (RA-LIB)_ACM_2.00_Module_HART_Device_58CD-Sitrans_Probe_LU_6m_(5.2).HSL4
58CE-Sitrans_Probe_LU_12m (RA-LIB)_ACM_2.00_Module_HART_Device_58CE-Sitrans_Probe_LU_12m_(5.2).HSL4
58CF-Probe_LR (RA-LIB)_ACM_2.00_Module_HART_Device_58CF-Probe_LR_(5.2).HSL4
58D1-SITRANS_LR250 (RA-LIB)_ACM_2.00_Module_HART_Device_58D1-SITRANS_LR250_(5.2).HSL4
58D3-SITRANS_LR460 (RA-LIB)_ACM_2.00_Module_HART_Device_58D3-SITRANS_LR460_(5.2).HSL4
58D4-SITRANS_LR260 (RA-LIB)_ACM_2.00_Module_HART_Device_58D4-SITRANS_LR260_(5.2).HSL4
58D6-SITRANS_LR200 (RA-LIB)_ACM_2.00_Module_HART_Device_58D6-SITRANS_LR200_(5.2).HSL4
5AC8-ANDRSN1 (RA-LIB)_ACM_2.00_Module_HART_Device_5AC8-ANDRSN1_(5.2).HSL4
5ACC-L3 (RA-LIB)_ACM_2.00_Module_HART_Device_5ACC-L3_(5.2).HSL4

HART Device Application Code Manager File



68 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Chapter 2          Library Components

5BEA-IPAQ_C530_R530_X (RA-LIB)_ACM_2.00_Module_HART_Device_5BEA-IPAQ_C530_R530_X_(5.2).HSL4
5BEB-C520_R520 (RA-LIB)_ACM_2.00_Module_HART_Device_5BEB-C520_R520_(5.2).HSL4
60EC-AF14_AF15_CombiLyz (RA-LIB)_ACM_2.00_Module_HART_Device_60EC-AF14_AF15_CombiLyz_(5.2).HSL4
60ED-FLEXBAR_3501 (RA-LIB)_ACM_2.00_Module_HART_Device_60ED-FLEXBAR_3501_(5.2).HSL4
60EE-FLEXBAR_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_60EE-FLEXBAR_HRT_(5.2).HSL4
60EF-FLEXTOP_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_60EF-FLEXTOP_HRT_(5.2).HSL4
61CD-Straros_Multi_E401 (RA-LIB)_ACM_2.00_Module_HART_Device_61CD-Straros_Multi_E401_(5.2).HSL4
61CE-MemoTrans_MT201 (RA-LIB)_ACM_2.00_Module_HART_Device_61CE-MemoTrans_MT201_(5.2).HSL4
61E0-A411_CONDI (RA-LIB)_ACM_2.00_Module_HART_Device_61E0-A411_CONDI_(5.2).HSL4
61E1-A411_COND (RA-LIB)_ACM_2.00_Module_HART_Device_61E1-A411_COND_(5.2).HSL4
61E2-A411_OXY (RA-LIB)_ACM_2.00_Module_HART_Device_61E2-A411_OXY_(5.2).HSL4
61E3-A411_PH (RA-LIB)_ACM_2.00_Module_HART_Device_61E3-A411_PH_(5.2).HSL4
61E4-Stratos_Pro_CONDI (RA-LIB)_ACM_2.00_Module_HART_Device_61E4-Stratos_Pro_CONDI_(5.2).HSL4
61E5-Stratos_Pro_Cond (RA-LIB)_ACM_2.00_Module_HART_Device_61E5-Stratos_Pro_Cond_(5.2).HSL4
61E6-Stratos_Pro_OXY (RA-LIB)_ACM_2.00_Module_HART_Device_61E6-Stratos_Pro_OXY_(5.2).HSL4
61E7-Stratos_Pro_pH (RA-LIB)_ACM_2.00_Module_HART_Device_61E7-Stratos_Pro_pH_(5.2).HSL4
61E8-CondI_2211 (RA-LIB)_ACM_2.00_Module_HART_Device_61E8-CondI_2211_(5.2).HSL4
61E9-Oxy_2211 (RA-LIB)_ACM_2.00_Module_HART_Device_61E9-Oxy_2211_(5.2).HSL4
61EA-Cond_2211 (RA-LIB)_ACM_2.00_Module_HART_Device_61EA-Cond_2211_(5.2).HSL4
61EB-pH_2211 (RA-LIB)_ACM_2.00_Module_HART_Device_61EB-pH_2211_(5.2).HSL4
62BC-VEGAPULS_20_30_series (RA-LIB)_ACM_2.00_Module_HART_Device_62BC-VEGAPULS_20_30_series_(5.2).HSL4
62BD-VEGAPULS_C_20_series (RA-LIB)_ACM_2.00_Module_HART_Device_62BD-VEGAPULS_C_20_series_(5.2).HSL4
62BE-VEGAPULS_64 (RA-LIB)_ACM_2.00_Module_HART_Device_62BE-VEGAPULS_64_(5.2).HSL4
62BF-VEGADIF_80_series_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_62BF-VEGADIF_80_series_SIL_(5.2).HSL4
62C0-VEGADIF_80_series (RA-LIB)_ACM_2.00_Module_HART_Device_62C0-VEGADIF_80_series_(5.2).HSL4
62C1-VEGAPULS_69 (RA-LIB)_ACM_2.00_Module_HART_Device_62C1-VEGAPULS_69_(5.2).HSL4
62C2-VEGABAR_80_series_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_62C2-VEGABAR_80_series_SIL_(5.2).HSL4
62C3-VEGABAR_80_series (RA-LIB)_ACM_2.00_Module_HART_Device_62C3-VEGABAR_80_series_(5.2).HSL4
62C5-POINTRAC_31 (RA-LIB)_ACM_2.00_Module_HART_Device_62C5-POINTRAC_31_(5.2).HSL4
62C6-VEGAPULS_SR_68 (RA-LIB)_ACM_2.00_Module_HART_Device_62C6-VEGAPULS_SR_68_(5.2).HSL4
62C7-VEGAPULS_WL_61 (RA-LIB)_ACM_2.00_Module_HART_Device_62C7-VEGAPULS_WL_61_(5.2).HSL4
62C8-FIBERTRAC_31 (RA-LIB)_ACM_2.00_Module_HART_Device_62C8-FIBERTRAC_31_(5.2).HSL4
62C9-FIBERTRAC_32 (RA-LIB)_ACM_2.00_Module_HART_Device_62C9-FIBERTRAC_32_(5.2).HSL4
62CA-SOLITRAC_31 (RA-LIB)_ACM_2.00_Module_HART_Device_62CA-SOLITRAC_31_(5.2).HSL4
62CB-MINITRAC_31 (RA-LIB)_ACM_2.00_Module_HART_Device_62CB-MINITRAC_31_(5.2).HSL4
62CC-MINITRAC_32 (RA-LIB)_ACM_2.00_Module_HART_Device_62CC-MINITRAC_32_(5.2).HSL4
62CD-MINITRAC_33 (RA-LIB)_ACM_2.00_Module_HART_Device_62CD-MINITRAC_33_(5.2).HSL4
62D4-VEGAFLEX_80_series_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_62D4-VEGAFLEX_80_series_SIL_(5.2).HSL4
62D5-VEGAFLEX_80_series (RA-LIB)_ACM_2.00_Module_HART_Device_62D5-VEGAFLEX_80_series_(5.2).HSL4
62D6-VEGAPULS_68 (RA-LIB)_ACM_2.00_Module_HART_Device_62D6-VEGAPULS_68_(5.2).HSL4
62D7-VEGAPULS_67 (RA-LIB)_ACM_2.00_Module_HART_Device_62D7-VEGAPULS_67_(5.2).HSL4
62D8-VEGAPULS_66 (RA-LIB)_ACM_2.00_Module_HART_Device_62D8-VEGAPULS_66_(5.2).HSL4
62D9-VEGAPULS_65 (RA-LIB)_ACM_2.00_Module_HART_Device_62D9-VEGAPULS_65_(5.2).HSL4
62DA-VEGAPULS_63 (RA-LIB)_ACM_2.00_Module_HART_Device_62DA-VEGAPULS_63_(5.2).HSL4
62DB-VEGAPULS_62 (RA-LIB)_ACM_2.00_Module_HART_Device_62DB-VEGAPULS_62_(5.2).HSL4
62DC-VEGAPULS_61 (RA-LIB)_ACM_2.00_Module_HART_Device_62DC-VEGAPULS_61_(5.2).HSL4
62E1-VEGADIF_65 (RA-LIB)_ACM_2.00_Module_HART_Device_62E1-VEGADIF_65_(5.2).HSL4
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62E2-VEGABAR_5x_6x (RA-LIB)_ACM_2.00_Module_HART_Device_62E2-VEGABAR_5x_6x_(5.2).HSL4
63ED-M_Series (RA-LIB)_ACM_2.00_Module_HART_Device_63ED-M_Series_(5.2).HSL4
63EE-LIPSIL (RA-LIB)_ACM_2.00_Module_HART_Device_63EE-LIPSIL_(5.2).HSL4
63EF-LP_Series (RA-LIB)_ACM_2.00_Module_HART_Device_63EF-LP_Series_(5.2).HSL4
6464-ULTRAOVAL (RA-LIB)_ACM_2.00_Module_HART_Device_6464-ULTRAOVAL_(5.2).HSL4
6465-ExDelta (RA-LIB)_ACM_2.00_Module_HART_Device_6465-ExDelta_(5.2).HSL4
646E-Mass_flo_9401 (RA-LIB)_ACM_2.00_Module_HART_Device_646E-Mass_flo_9401_(5.2).HSL4
646F-Mass_flo_9801 (RA-LIB)_ACM_2.00_Module_HART_Device_646F-Mass_flo_9801_(5.2).HSL4
6470-Mass_flo_9201 (RA-LIB)_ACM_2.00_Module_HART_Device_6470-Mass_flo_9201_(5.2).HSL4
647B-Mass_flo_9431 (RA-LIB)_ACM_2.00_Module_HART_Device_647B-Mass_flo_9431_(5.2).HSL4
6BE4-DPT_20_SIL2 (RA-LIB)_ACM_2.00_Module_HART_Device_6BE4-DPT_20_SIL2_(5.2).HSL4
6BE5-DPT_20 (RA-LIB)_ACM_2.00_Module_HART_Device_6BE5-DPT_20_(5.2).HSL4
6BEB-DPT (RA-LIB)_ACM_2.00_Module_HART_Device_6BEB-DPT_(5.2).HSL4
6BEC-IPT (RA-LIB)_ACM_2.00_Module_HART_Device_6BEC-IPT_(5.2).HSL4
6BEE-UniTrans (RA-LIB)_ACM_2.00_Module_HART_Device_6BEE-UniTrans_(5.2).HSL4
6BEF-T32 (RA-LIB)_ACM_2.00_Module_HART_Device_6BEF-T32_(5.2).HSL4
6BF0-IPT_2x_CPT_2x (RA-LIB)_ACM_2.00_Module_HART_Device_6BF0-IPT_2x_CPT_2x_(5.2).HSL4
6BF1-IPT_2x_CPT_2x_SIL (RA-LIB)_ACM_2.00_Module_HART_Device_6BF1-IPT_2x_CPT_2x_SIL_(5.2).HSL4
6CEB-UMC2 (RA-LIB)_ACM_2.00_Module_HART_Device_6CEB-UMC2_(5.2).HSL4
6CEC-ES (RA-LIB)_ACM_2.00_Module_HART_Device_6CEC-ES_(5.2).HSL4
6CED-VTX (RA-LIB)_ACM_2.00_Module_HART_Device_6CED-VTX_(5.2).HSL4
6CEE-DIMF (RA-LIB)_ACM_2.00_Module_HART_Device_6CEE-DIMF_(5.2).HSL4
6CEF-UST_1 (RA-LIB)_ACM_2.00_Module_HART_Device_6CEF-UST_1_(5.2).HSL4
6DDF-T55 (RA-LIB)_ACM_2.00_Module_HART_Device_6DDF-T55_(5.2).HSL4
6DE6-PR5437 (RA-LIB)_ACM_2.00_Module_HART_Device_6DE6-PR5437_(5.2).HSL4
6DE7-PR_7501H7 (RA-LIB)_ACM_2.00_Module_HART_Device_6DE7-PR_7501H7_(5.2).HSL4
6DE8-PR_3113 (RA-LIB)_ACM_2.00_Module_HART_Device_6DE8-PR_3113_(5.2).HSL4
6DE9-PR_3337 (RA-LIB)_ACM_2.00_Module_HART_Device_6DE9-PR_3337_(5.2).HSL4
6DEA-PR_6337 (RA-LIB)_ACM_2.00_Module_HART_Device_6DEA-PR_6337_(5.2).HSL4
6DEB-pr_5337 (RA-LIB)_ACM_2.00_Module_HART_Device_6DEB-pr_5337_(5.2).HSL4
6DEE-PRetrans_6335 (RA-LIB)_ACM_2.00_Module_HART_Device_6DEE-PRetrans_6335_(5.2).HSL4
6DEF-PR5335_PR7501H5 (RA-LIB)_ACM_2.00_Module_HART_Device_6DEF-PR5335_PR7501H5_(5.2).HSL4
6EDD-Actuator (RA-LIB)_ACM_2.00_Module_HART_Device_6EDD-Actuator_(5.2).HSL4
71EE-MT115 (RA-LIB)_ACM_2.00_Module_HART_Device_71EE-MT115_(5.2).HSL4
72DE-SPX (RA-LIB)_ACM_2.00_Module_HART_Device_72DE-SPX_(5.2).HSL4
72DF-IPXII (RA-LIB)_ACM_2.00_Module_HART_Device_72DF-IPXII_(5.2).HSL4
72E0-IPX (RA-LIB)_ACM_2.00_Module_HART_Device_72E0-IPX_(5.2).HSL4
75EF-Klay_2000_Pressure_Level (RA-LIB)_ACM_2.00_Module_HART_Device_75EF-Klay_2000_Pressure_Level_(5.2).HSL4
76ED-VF_100 (RA-LIB)_ACM_2.00_Module_HART_Device_76ED-VF_100_(5.2).HSL4
76EE-GVF_100 (RA-LIB)_ACM_2.00_Module_HART_Device_76EE-GVF_100_(5.2).HSL4
76EF-VFGVF_100 (RA-LIB)_ACM_2.00_Module_HART_Device_76EF-VFGVF_100_(5.2).HSL4
79EF-FORCEmeter (RA-LIB)_ACM_2.00_Module_HART_Device_79EF-FORCEmeter_(5.2).HSL4
7EE0-SMT_EL (RA-LIB)_ACM_2.00_Module_HART_Device_7EE0-SMT_EL_(5.2).HSL4
7F3C-PASCAL_CI (RA-LIB)_ACM_2.00_Module_HART_Device_7F3C-PASCAL_CI_(5.2).HSL4
7FEF-Pascal_CV (RA-LIB)_ACM_2.00_Module_HART_Device_7FEF-Pascal_CV_(5.2).HSL4
817F-Intermag_Transmag (RA-LIB)_ACM_2.00_Module_HART_Device_817F-Intermag_Transmag_(5.2).HSL4
8254-TLRx400x500 (RA-LIB)_ACM_2.00_Module_HART_Device_8254-TLRx400x500_(5.2).HSL4
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8257-MMC400 (RA-LIB)_ACM_2.00_Module_HART_Device_8257-MMC400_(5.2).HSL4
8258-FGY (RA-LIB)_ACM_2.00_Module_HART_Device_8258-FGY_(5.2).HSL4
8259-AM3_H (RA-LIB)_ACM_2.00_Module_HART_Device_8259-AM3_H_(5.2).HSL4
825B-VFC200 (RA-LIB)_ACM_2.00_Module_HART_Device_825B-VFC200_(5.2).HSL4
825C-ULC_400 (RA-LIB)_ACM_2.00_Module_HART_Device_825C-ULC_400_(5.2).HSL4
8260-NLZ_H (RA-LIB)_ACM_2.00_Module_HART_Device_8260-NLZ_H_(5.2).HSL4
8261-FST4000 (RA-LIB)_ACM_2.00_Module_HART_Device_8261-FST4000_(5.2).HSL4
8263-AM_T (RA-LIB)_ACM_2.00_Module_HART_Device_8263-AM_T_(5.2).HSL4
8265-AM_H (RA-LIB)_ACM_2.00_Module_HART_Device_8265-AM_H_(5.2).HSL4
8267-VFC_070 (RA-LIB)_ACM_2.00_Module_HART_Device_8267-VFC_070_(5.2).HSL4
8269-UL6300V2 (RA-LIB)_ACM_2.00_Module_HART_Device_8269-UL6300V2_(5.2).HSL4
827B-FW_9000 (RA-LIB)_ACM_2.00_Module_HART_Device_827B-FW_9000_(5.2).HSL4
827F-FST_3000 (RA-LIB)_ACM_2.00_Module_HART_Device_827F-FST_3000_(5.2).HSL4
837D-IP8001 (RA-LIB)_ACM_2.00_Module_HART_Device_837D-IP8001_(5.2).HSL4
837E-IP8101 (RA-LIB)_ACM_2.00_Module_HART_Device_837E-IP8101_(5.2).HSL4
837F-IN_777 (RA-LIB)_ACM_2.00_Module_HART_Device_837F-IN_777_(5.2).HSL4
83EF-F793_E701 (RA-LIB)_ACM_2.00_Module_HART_Device_83EF-F793_E701_(5.2).HSL4
84EF-SEM_300 (RA-LIB)_ACM_2.00_Module_HART_Device_84EF-SEM_300_(5.2).HSL4
857F-HK_TT01 (RA-LIB)_ACM_2.00_Module_HART_Device_857F-HK_TT01_(5.2).HSL4
8661-APT3200 (RA-LIB)_ACM_2.00_Module_HART_Device_8661-APT3200_(5.2).HSL4
8667-APT3700N (RA-LIB)_ACM_2.00_Module_HART_Device_8667-APT3700N_(5.2).HSL4
866B-APT3100 (RA-LIB)_ACM_2.00_Module_HART_Device_866B-APT3100_(5.2).HSL4
866B-APT3100 (RA-LIB)_ACM_2.00_Module_HART_Device_866B-APT3100_(1.1).HSL4
8673-ATT2X00_Series (RA-LIB)_ACM_2.00_Module_HART_Device_8673-ATT2X00_Series_(5.2).HSL4
8675-ATT2100S (RA-LIB)_ACM_2.00_Module_HART_Device_8675-ATT2100S_(5.2).HSL4
8676-APT3800N (RA-LIB)_ACM_2.00_Module_HART_Device_8676-APT3800N_(5.2).HSL4
8678-APT3500W (RA-LIB)_ACM_2.00_Module_HART_Device_8678-APT3500W_(5.2).HSL4
867B-APT3500 (RA-LIB)_ACM_2.00_Module_HART_Device_867B-APT3500_(5.2).HSL4
867E-ALT6100 (RA-LIB)_ACM_2.00_Module_HART_Device_867E-ALT6100_(5.2).HSL4
8701-Pro_V (RA-LIB)_ACM_2.00_Module_HART_Device_8701-Pro_V_(5.2).HSL4
8C88-LTM_100 (RA-LIB)_ACM_2.00_Module_HART_Device_8C88-LTM_100_(5.2).HSL4
8C89-LTM_300 (RA-LIB)_ACM_2.00_Module_HART_Device_8C89-LTM_300_(5.2).HSL4
8C8A-LTM_350 (RA-LIB)_ACM_2.00_Module_HART_Device_8C8A-LTM_350_(5.2).HSL4
8E70-M400_4_wire (RA-LIB)_ACM_2.00_Module_HART_Device_8E70-M400_4_wire_(5.2).HSL4
8E74-M420_Cond_Ind (RA-LIB)_ACM_2.00_Module_HART_Device_8E74-M420_Cond_Ind_(5.2).HSL4
8E75-M420_Cond (RA-LIB)_ACM_2.00_Module_HART_Device_8E75-M420_Cond_(5.2).HSL4
8E76-M420_O2 (RA-LIB)_ACM_2.00_Module_HART_Device_8E76-M420_O2_(5.2).HSL4
8E77-M420_pH (RA-LIB)_ACM_2.00_Module_HART_Device_8E77-M420_pH_(5.2).HSL4
8E78-CondI7100 (RA-LIB)_ACM_2.00_Module_HART_Device_8E78-CondI7100_(5.2).HSL4
8E79-O2_4100e (RA-LIB)_ACM_2.00_Module_HART_Device_8E79-O2_4100e_(5.2).HSL4
8E7A-Cond7100 (RA-LIB)_ACM_2.00_Module_HART_Device_8E7A-Cond7100_(5.2).HSL4
8E7B-pH_2100 (RA-LIB)_ACM_2.00_Module_HART_Device_8E7B-pH_2100_(5.2).HSL4
8F73-LS2000 (RA-LIB)_ACM_2.00_Module_HART_Device_8F73-LS2000_(5.2).HSL4
8F74-ATX10 (RA-LIB)_ACM_2.00_Module_HART_Device_8F74-ATX10_(5.2).HSL4
8F75-Eclipse_CO2 (RA-LIB)_ACM_2.00_Module_HART_Device_8F75-Eclipse_CO2_(5.2).HSL4
8F76-X2200 (RA-LIB)_ACM_2.00_Module_HART_Device_8F76-X2200_(5.2).HSL4
8F77-X5200 (RA-LIB)_ACM_2.00_Module_HART_Device_8F77-X5200_(5.2).HSL4
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8F78-X9800 (RA-LIB)_ACM_2.00_Module_HART_Device_8F78-X9800_(5.2).HSL4
8F79-X3302 (RA-LIB)_ACM_2.00_Module_HART_Device_8F79-X3302_(5.2).HSL4
8F7A-UD10 (RA-LIB)_ACM_2.00_Module_HART_Device_8F7A-UD10_(5.2).HSL4
8F7B-GT3000 (RA-LIB)_ACM_2.00_Module_HART_Device_8F7B-GT3000_(5.2).HSL4
8F7C-X3301 (RA-LIB)_ACM_2.00_Module_HART_Device_8F7C-X3301_(5.2).HSL4
8F7E-OPECL_RX (RA-LIB)_ACM_2.00_Module_HART_Device_8F7E-OPECL_RX_(5.2).HSL4
8F7F-Eclipse (RA-LIB)_ACM_2.00_Module_HART_Device_8F7F-Eclipse_(5.2).HSL4
907B-AutoXP (RA-LIB)_ACM_2.00_Module_HART_Device_907B-AutoXP_(5.2).HSL4
907C-MS2011 (RA-LIB)_ACM_2.00_Module_HART_Device_907C-MS2011_(5.2).HSL4
907D-NDMi (RA-LIB)_ACM_2.00_Module_HART_Device_907D-NDMi_(5.2).HSL4
907E-Accu_Wave (RA-LIB)_ACM_2.00_Module_HART_Device_907E-Accu_Wave_(5.2).HSL4
907F-NCMi (RA-LIB)_ACM_2.00_Module_HART_Device_907F-NCMi_(5.2).HSL4
927F-Analyzer (RA-LIB)_ACM_2.00_Module_HART_Device_927F-Analyzer_(5.2).HSL4
9977-METRAN_303PR (RA-LIB)_ACM_2.00_Module_HART_Device_9977-METRAN_303PR_(5.2).HSL4
9979-Metran_150 (RA-LIB)_ACM_2.00_Module_HART_Device_9979-Metran_150_(5.2).HSL4
997E-METRAN_280 (RA-LIB)_ACM_2.00_Module_HART_Device_997E-METRAN_280_(5.2).HSL4
997F-METRAN_100 (RA-LIB)_ACM_2.00_Module_HART_Device_997F-METRAN_100_(5.2).HSL4
9BD3-PMV (RA-LIB)_ACM_2.00_Module_HART_Device_9BD3-PMV_(5.2).HSL4
9D70-x868 (RA-LIB)_ACM_2.00_Module_HART_Device_9D70-x868_(5.2).HSL4
9D79-XMT1000_UFM (RA-LIB)_ACM_2.00_Module_HART_Device_9D79-XMT1000_UFM_(5.2).HSL4
A002-PIR_2000 (RA-LIB)_ACM_2.00_Module_HART_Device_A002-PIR_2000_(5.2).HSL4
A0ED-OXI5000 (RA-LIB)_ACM_2.00_Module_HART_Device_A0ED-OXI5000_(5.2).HSL4
A175-LB414 (RA-LIB)_ACM_2.00_Module_HART_Device_A175-LB414_(5.2).HSL4
A179-LB480_Density (RA-LIB)_ACM_2.00_Module_HART_Device_A179-LB480_Density_(5.2).HSL4
A17A-LB480_Level (RA-LIB)_ACM_2.00_Module_HART_Device_A17A-LB480_Level_(5.2).HSL4
A17B-LB480_LevelSwitch (RA-LIB)_ACM_2.00_Module_HART_Device_A17B-LB480_LevelSwitch_(5.2).HSL4
A17D-LB491 (RA-LIB)_ACM_2.00_Module_HART_Device_A17D-LB491_(5.2).HSL4
A17F-LB490 (RA-LIB)_ACM_2.00_Module_HART_Device_A17F-LB490_(5.2).HSL4
A2EF-SMARTCET_18C (RA-LIB)_ACM_2.00_Module_HART_Device_A2EF-SMARTCET_18C_(5.2).HSL4
A57F-Sierra_i_Series (RA-LIB)_ACM_2.00_Module_HART_Device_A57F-Sierra_i_Series_(5.2).HSL4
A677-ST80_ST100A (RA-LIB)_ACM_2.00_Module_HART_Device_A677-ST80_ST100A_(5.2).HSL4
A678-ST98 (RA-LIB)_ACM_2.00_Module_HART_Device_A678-ST98_(5.2).HSL4
A679-MT100_Series (RA-LIB)_ACM_2.00_Module_HART_Device_A679-MT100_Series_(5.2).HSL4
A67E-ST50_product_family (RA-LIB)_ACM_2.00_Module_HART_Device_A67E-ST50_product_family_(5.2).HSL4
A67F-ST100_Series (RA-LIB)_ACM_2.00_Module_HART_Device_A67F-ST100_Series_(5.2).HSL4
A87F-M3500 (RA-LIB)_ACM_2.00_Module_HART_Device_A87F-M3500_(5.2).HSL4
AB01-SmartCal (RA-LIB)_ACM_2.00_Module_HART_Device_AB01-SmartCal_(5.2).HSL4
AE7F-PRI_150 (RA-LIB)_ACM_2.00_Module_HART_Device_AE7F-PRI_150_(5.2).HSL4
AEA0-T251_X_5 (RA-LIB)_ACM_2.00_Module_HART_Device_AEA0-T251_X_5_(5.2).HSL4
AF7E-ID200 (RA-LIB)_ACM_2.00_Module_HART_Device_AF7E-ID200_(5.2).HSL4
B001-MCR_TS_LP (RA-LIB)_ACM_2.00_Module_HART_Device_B001-MCR_TS_LP_(5.2).HSL4
B002-MCR_HT_TS (RA-LIB)_ACM_2.00_Module_HART_Device_B002-MCR_HT_TS_(5.2).HSL4
B005-MCR_TS_I_OLP (RA-LIB)_ACM_2.00_Module_HART_Device_B005-MCR_TS_I_OLP_(5.2).HSL4
B006-MCR_ITS_I_OLP (RA-LIB)_ACM_2.00_Module_HART_Device_B006-MCR_ITS_I_OLP_(5.2).HSL4
B012-GW_PL_ETH_BASIC_BUS (RA-LIB)_ACM_2.00_Module_HART_Device_B012-GW_PL_ETH_BASIC_BUS_(5.2).HSL4
B013-GW_PL_ETH_UNI_BUS (RA-LIB)_ACM_2.00_Module_HART_Device_B013-GW_PL_ETH_UNI_BUS_(5.2).HSL4
B301-Centurion_Guided_Radar_Device (RA-LIB)_ACM_2.00_Module_HART_Device_B301-Centurion_Guided_Radar_Device_(5.2).HSL4
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B302-Senator_24_80_Radar (RA-LIB)_ACM_2.00_Module_HART_Device_B302-Senator_24_80_Radar_(5.2).HSL4
B401-YT_2300 (RA-LIB)_ACM_2.00_Module_HART_Device_B401-YT_2300_(5.2).HSL4
B402-YT_2400 (RA-LIB)_ACM_2.00_Module_HART_Device_B402-YT_2400_(5.2).HSL4
B407-YT_3400 (RA-LIB)_ACM_2.00_Module_HART_Device_B407-YT_3400_(5.2).HSL4
B409-YT_3300 (RA-LIB)_ACM_2.00_Module_HART_Device_B409-YT_3300_(5.2).HSL4
B40A-SPTM (RA-LIB)_ACM_2.00_Module_HART_Device_B40A-SPTM_(5.2).HSL4
B40B-YT_3300_Pro (RA-LIB)_ACM_2.00_Module_HART_Device_B40B-YT_3300_Pro_(5.2).HSL4
B47F-C330 (RA-LIB)_ACM_2.00_Module_HART_Device_B47F-C330_(5.2).HSL4
B57F-Series_442 (RA-LIB)_ACM_2.00_Module_HART_Device_B57F-Series_442_(5.2).HSL4
B580-Series_642 (RA-LIB)_ACM_2.00_Module_HART_Device_B580-Series_642_(5.2).HSL4
B581-T82 (RA-LIB)_ACM_2.00_Module_HART_Device_B581-T82_(5.2).HSL4
B582-Series_662 (RA-LIB)_ACM_2.00_Module_HART_Device_B582-Series_662_(5.2).HSL4
B67F-V_series (RA-LIB)_ACM_2.00_Module_HART_Device_B67F-V_series_(5.2).HSL4
B77C-HRT_IMVS2000v2 (RA-LIB)_ACM_2.00_Module_HART_Device_B77C-HRT_IMVS2000v2_(5.2).HSL4
B77D-HRTIMVS2000 (RA-LIB)_ACM_2.00_Module_HART_Device_B77D-HRTIMVS2000_(5.2).HSL4
B77E-HRT2000v4 (RA-LIB)_ACM_2.00_Module_HART_Device_B77E-HRT2000v4_(5.2).HSL4
B97F-D331A (RA-LIB)_ACM_2.00_Module_HART_Device_B97F-D331A_(5.2).HSL4
BC7A-LI_24 (RA-LIB)_ACM_2.00_Module_HART_Device_BC7A-LI_24_(5.2).HSL4
BC7B-APC_2000ALW (RA-LIB)_ACM_2.00_Module_HART_Device_BC7B-APC_2000ALW_(5.2).HSL4
BD01-Primo_Advanced (RA-LIB)_ACM_2.00_Module_HART_Device_BD01-Primo_Advanced_(5.2).HSL4
BD02-M2000 (RA-LIB)_ACM_2.00_Module_HART_Device_BD02-M2000_(5.2).HSL4
BF7C-MDL_400 (RA-LIB)_ACM_2.00_Module_HART_Device_BF7C-MDL_400_(5.2).HSL4
C0EF-GT400 (RA-LIB)_ACM_2.00_Module_HART_Device_C0EF-GT400_(5.2).HSL4
C221-TE_52 (RA-LIB)_ACM_2.00_Module_HART_Device_C221-TE_52_(5.2).HSL4
C374-LSIII_Pressure (RA-LIB)_ACM_2.00_Module_HART_Device_C374-LSIII_Pressure_(5.2).HSL4
C580-KC_3 (RA-LIB)_ACM_2.00_Module_HART_Device_C580-KC_3_(5.2).HSL4
C581-KC_5 (RA-LIB)_ACM_2.00_Module_HART_Device_C581-KC_5_(5.2).HSL4
C780-FLOWSIC_600 (RA-LIB)_ACM_2.00_Module_HART_Device_C780-FLOWSIC_600_(5.2).HSL4
C781-FLOWSIC_100 (RA-LIB)_ACM_2.00_Module_HART_Device_C781-FLOWSIC_100_(5.2).HSL4
C782-FLOWSIC_30 (RA-LIB)_ACM_2.00_Module_HART_Device_C782-FLOWSIC_30_(5.2).HSL4
C783-FLOWSIC_IU (RA-LIB)_ACM_2.00_Module_HART_Device_C783-FLOWSIC_IU_(5.2).HSL4
C784-LFR_SicWave (RA-LIB)_ACM_2.00_Module_HART_Device_C784-LFR_SicWave_(5.2).HSL4
C785-LBR_SicWave (RA-LIB)_ACM_2.00_Module_HART_Device_C785-LBR_SicWave_(5.2).HSL4
CA80-SP301 (RA-LIB)_ACM_2.00_Module_HART_Device_CA80-SP301_(5.2).HSL4
CF80-EP1000_SPS2000 (RA-LIB)_ACM_2.00_Module_HART_Device_CF80-EP1000_SPS2000_(5.2).HSL4
CF81-EP1001 (RA-LIB)_ACM_2.00_Module_HART_Device_CF81-EP1001_(5.2).HSL4
CF83-KGP5000 (RA-LIB)_ACM_2.00_Module_HART_Device_CF83-KGP5000_(5.2).HSL4
D280-XNX (RA-LIB)_ACM_2.00_Module_HART_Device_D280-XNX_(5.2).HSL4
D281-Optima (RA-LIB)_ACM_2.00_Module_HART_Device_D281-Optima_(5.2).HSL4
D283-Searchzone_Sonk (RA-LIB)_ACM_2.00_Module_HART_Device_D283-Searchzone_Sonk_(5.2).HSL4
D380-PAD (RA-LIB)_ACM_2.00_Module_HART_Device_D380-PAD_(5.2).HSL4
D381-PAS (RA-LIB)_ACM_2.00_Module_HART_Device_D381-PAS_(5.2).HSL4
D382-PAD_F (RA-LIB)_ACM_2.00_Module_HART_Device_D382-PAD_F_(5.2).HSL4
D3EA-UMF3 (RA-LIB)_ACM_2.00_Module_HART_Device_D3EA-UMF3_(5.2).HSL4
D480-PES (RA-LIB)_ACM_2.00_Module_HART_Device_D480-PES_(5.2).HSL4
D481-PDS (RA-LIB)_ACM_2.00_Module_HART_Device_D481-PDS_(5.2).HSL4
D482-HVP (RA-LIB)_ACM_2.00_Module_HART_Device_D482-HVP_(5.2).HSL4
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D485-HVP1114 (RA-LIB)_ACM_2.00_Module_HART_Device_D485-HVP1114_(5.2).HSL4
D486-FLOW_MASTER (RA-LIB)_ACM_2.00_Module_HART_Device_D486-FLOW_MASTER_(5.2).HSL4
D487-TTS (RA-LIB)_ACM_2.00_Module_HART_Device_D487-TTS_(5.2).HSL4
D490-MPS (RA-LIB)_ACM_2.00_Module_HART_Device_D490-MPS_(5.2).HSL4
D580-SI792P (RA-LIB)_ACM_2.00_Module_HART_Device_D580-SI792P_(5.2).HSL4
D581-SI792C (RA-LIB)_ACM_2.00_Module_HART_Device_D581-SI792C_(5.2).HSL4
D582-SI792T (RA-LIB)_ACM_2.00_Module_HART_Device_D582-SI792T_(5.2).HSL4
D583-SI792E (RA-LIB)_ACM_2.00_Module_HART_Device_D583-SI792E_(5.2).HSL4
D584-SI792D (RA-LIB)_ACM_2.00_Module_HART_Device_D584-SI792D_(5.2).HSL4
D586-sc200_pH_ORP_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D586-sc200_pH_ORP_Module_(5.2).HSL4
D587-LDO (RA-LIB)_ACM_2.00_Module_HART_Device_D587-LDO_(5.2).HSL4
D588-sc200_Contacting_Conductivity_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D588-sc200_Contacting_Conductivity_Module_(5.2).HSL4
D589-sc200_Inductive_Conductivity_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D589-sc200_Inductive_Conductivity_Module_(5.2).HSL4
D58A-sc200_DO_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D58A-sc200_DO_Module_(5.2).HSL4
D58B-sc200_Ultrasonic_Flow_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D58B-sc200_Ultrasonic_Flow_Module_(5.2).HSL4
D58C-Surface_Scatter_7_Turbidimeter (RA-LIB)_ACM_2.00_Module_HART_Device_D58C-Surface_Scatter_7_Turbidimeter_(5.2).HSL4
D58D-sc200_4_20mA_Analog_Input_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D58D-sc200_4_20mA_Analog_Input_Module_(5.2).HSL4
D58E-sc_pH_ORP_Differential (RA-LIB)_ACM_2.00_Module_HART_Device_D58E-sc_pH_ORP_Differential_(5.2).HSL4
D58F-FP360sc (RA-LIB)_ACM_2.00_Module_HART_Device_D58F-FP360sc_(5.2).HSL4
D590-TSSsc (RA-LIB)_ACM_2.00_Module_HART_Device_D590-TSSsc_(5.2).HSL4
D591-Turbidimeter_1720E (RA-LIB)_ACM_2.00_Module_HART_Device_D591-Turbidimeter_1720E_(5.2).HSL4
D5AF-LDO_2 (RA-LIB)_ACM_2.00_Module_HART_Device_D5AF-LDO_2_(5.2).HSL4
D5B0-sc200_Conductivity_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D5B0-sc200_Conductivity_Module_(5.2).HSL4
D5B2-sc200_pH_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D5B2-sc200_pH_Module_(5.2).HSL4
D5B3-sc200_Amperometric_Module (RA-LIB)_ACM_2.00_Module_HART_Device_D5B3-sc200_Amperometric_Module_(5.2).HSL4
D5B5-NAx600sc_Sodium (RA-LIB)_ACM_2.00_Module_HART_Device_D5B5-NAx600sc_Sodium_(5.2).HSL4
D980-Safir (RA-LIB)_ACM_2.00_Module_HART_Device_D980-Safir_(5.2).HSL4
DB80-SharpEye (RA-LIB)_ACM_2.00_Module_HART_Device_DB80-SharpEye_(5.2).HSL4
DB81-SafEye (RA-LIB)_ACM_2.00_Module_HART_Device_DB81-SafEye_(5.2).HSL4
DB83-Spectrex_SharpEye_40_40 (RA-LIB)_ACM_2.00_Module_HART_Device_DB83-Spectrex_SharpEye_40_40_(5.2).HSL4
DE81-X3 (RA-LIB)_ACM_2.00_Module_HART_Device_DE81-X3_(5.2).HSL4
DF80-FL4000 (RA-LIB)_ACM_2.00_Module_HART_Device_DF80-FL4000_(5.2).HSL4
DF81-S4000CH (RA-LIB)_ACM_2.00_Module_HART_Device_DF81-S4000CH_(5.2).HSL4
DF82-S4000TH (RA-LIB)_ACM_2.00_Module_HART_Device_DF82-S4000TH_(5.2).HSL4
DF83-IR400 (RA-LIB)_ACM_2.00_Module_HART_Device_DF83-IR400_(5.2).HSL4
DF84-IR4000 (RA-LIB)_ACM_2.00_Module_HART_Device_DF84-IR4000_(5.2).HSL4
DF85-S4100CH (RA-LIB)_ACM_2.00_Module_HART_Device_DF85-S4100CH_(5.2).HSL4
DF87-IR5500_ULTIMA_OPIR_5 (RA-LIB)_ACM_2.00_Module_HART_Device_DF87-IR5500_ULTIMA_OPIR_5_(5.2).HSL4
DF88-IR700 (RA-LIB)_ACM_2.00_Module_HART_Device_DF88-IR700_(5.2).HSL4
DF89-TS4000H (RA-LIB)_ACM_2.00_Module_HART_Device_DF89-TS4000H_(5.2).HSL4
DF90-FL3100H_FL3101H (RA-LIB)_ACM_2.00_Module_HART_Device_DF90-FL3100H_FL3101H_(5.2).HSL4
DF93-FL500 (RA-LIB)_ACM_2.00_Module_HART_Device_DF93-FL500_(5.2).HSL4
DF95-Observer_H_Ultrasonic_EX_5 (RA-LIB)_ACM_2.00_Module_HART_Device_DF95-Observer_H_Ultrasonic_EX_5_(5.2).HSL4
DF96-Observer_i (RA-LIB)_ACM_2.00_Module_HART_Device_DF96-Observer_i_(5.2).HSL4
E082-SDT420 (RA-LIB)_ACM_2.00_Module_HART_Device_E082-SDT420_(5.2).HSL4
E088-EX200H_Positioner (RA-LIB)_ACM_2.00_Module_HART_Device_E088-EX200H_Positioner_(5.2).HSL4
E08B-Detcon_HRT_Bridge (RA-LIB)_ACM_2.00_Module_HART_Device_E08B-Detcon_HRT_Bridge_(5.2).HSL4
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E08C-UltimaXL_XT (RA-LIB)_ACM_2.00_Module_HART_Device_E08C-UltimaXL_XT_(5.2).HSL4
E093-CXT_CJT (RA-LIB)_ACM_2.00_Module_HART_Device_E093-CXT_CJT_(5.2).HSL4
E095-HBM_165_H (RA-LIB)_ACM_2.00_Module_HART_Device_E095-HBM_165_H_(5.2).HSL4
E097-WBM_165_H (RA-LIB)_ACM_2.00_Module_HART_Device_E097-WBM_165_H_(5.2).HSL4
E09E-Millenium_2_Basic (RA-LIB)_ACM_2.00_Module_HART_Device_E09E-Millenium_2_Basic_(5.2).HSL4
E09F-UltimaXEH (RA-LIB)_ACM_2.00_Module_HART_Device_E09F-UltimaXEH_(5.2).HSL4
E0A1-HRT1 (RA-LIB)_ACM_2.00_Module_HART_Device_E0A1-HRT1_(5.2).HSL4
E0AC-Wireless_Adapter (RA-LIB)_ACM_2.00_Module_HART_Device_E0AC-Wireless_Adapter_(5.2).HSL4
E0BD-FLUXUS (RA-LIB)_ACM_2.00_Module_HART_Device_E0BD-FLUXUS_(5.2).HSL4
E0C2-Axiom (RA-LIB)_ACM_2.00_Module_HART_Device_E0C2-Axiom_(5.2).HSL4
E0CB-AIR_20H (RA-LIB)_ACM_2.00_Module_HART_Device_E0CB-AIR_20H_(5.2).HSL4
E0D3-OXITEC_5000 (RA-LIB)_ACM_2.00_Module_HART_Device_E0D3-OXITEC_5000_(5.2).HSL4
E0D4-COMTEC_6000 (RA-LIB)_ACM_2.00_Module_HART_Device_E0D4-COMTEC_6000_(5.2).HSL4
E0D7-MFT_B_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E0D7-MFT_B_Series_(5.2).HSL4
E0DE-TiXo3 (RA-LIB)_ACM_2.00_Module_HART_Device_E0DE-TiXo3_(5.2).HSL4
E0DF-JB_MPHF_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E0DF-JB_MPHF_Series_(5.2).HSL4
E0E1-DLT9000 (RA-LIB)_ACM_2.00_Module_HART_Device_E0E1-DLT9000_(5.2).HSL4
E0E2-FFG_P_Level_Sensor (RA-LIB)_ACM_2.00_Module_HART_Device_E0E2-FFG_P_Level_Sensor_(5.2).HSL4
E0E3-ST5700_SteamTrap (RA-LIB)_ACM_2.00_Module_HART_Device_E0E3-ST5700_SteamTrap_(5.2).HSL4
E0E4-AD5000_Acoustic (RA-LIB)_ACM_2.00_Module_HART_Device_E0E4-AD5000_Acoustic_(5.2).HSL4
E0E6-N7 (RA-LIB)_ACM_2.00_Module_HART_Device_E0E6-N7_(5.2).HSL4
E0EA-F018p (RA-LIB)_ACM_2.00_Module_HART_Device_E0EA-F018p_(5.2).HSL4
E0F1-Freq_mA (RA-LIB)_ACM_2.00_Module_HART_Device_E0F1-Freq_mA_(5.2).HSL4
E0F3-PrimaX (RA-LIB)_ACM_2.00_Module_HART_Device_E0F3-PrimaX_(5.2).HSL4
E0F6-PrimaX_IR (RA-LIB)_ACM_2.00_Module_HART_Device_E0F6-PrimaX_IR_(5.2).HSL4
E0F7-GD10 (RA-LIB)_ACM_2.00_Module_HART_Device_E0F7-GD10_(5.2).HSL4
E0FC-XgardIQ (RA-LIB)_ACM_2.00_Module_HART_Device_E0FC-XgardIQ_(5.2).HSL4
E0FF-CALIPERAY (RA-LIB)_ACM_2.00_Module_HART_Device_E0FF-CALIPERAY_(5.2).HSL4
E184-EA10S (RA-LIB)_ACM_2.00_Module_HART_Device_E184-EA10S_(5.2).HSL4
E18D-TX200H (RA-LIB)_ACM_2.00_Module_HART_Device_E18D-TX200H_(5.2).HSL4
E190-FST_3000 (RA-LIB)_ACM_2.00_Module_HART_Device_E190-FST_3000_(5.2).HSL4
E198-OLCT_200 (RA-LIB)_ACM_2.00_Module_HART_Device_E198-OLCT_200_(5.2).HSL4
E19C-SGOES (RA-LIB)_ACM_2.00_Module_HART_Device_E19C-SGOES_(5.2).HSL4
E1AA-IT_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E1AA-IT_Series_(5.2).HSL4
E1AB-Vector_Field_Control_Unit (RA-LIB)_ACM_2.00_Module_HART_Device_E1AB-Vector_Field_Control_Unit_(5.2).HSL4
E1AD-DTU100 (RA-LIB)_ACM_2.00_Module_HART_Device_E1AD-DTU100_(5.2).HSL4
E1B5-SD_1 (RA-LIB)_ACM_2.00_Module_HART_Device_E1B5-SD_1_(5.2).HSL4
E1C1-EIM_CAM206 (RA-LIB)_ACM_2.00_Module_HART_Device_E1C1-EIM_CAM206_(5.2).HSL4
E1C3-GTD2000 (RA-LIB)_ACM_2.00_Module_HART_Device_E1C3-GTD2000_(5.2).HSL4
E1C4-VisiPro_DO (RA-LIB)_ACM_2.00_Module_HART_Device_E1C4-VisiPro_DO_(5.2).HSL4
E1C6-GIR_3000 (RA-LIB)_ACM_2.00_Module_HART_Device_E1C6-GIR_3000_(5.2).HSL4
E1D4-Meridian_Gas_Detector_Wired (RA-LIB)_ACM_2.00_Module_HART_Device_E1D4-Meridian_Gas_Detector_Wired_(5.2).HSL4
E1DC-Model2010 (RA-LIB)_ACM_2.00_Module_HART_Device_E1DC-Model2010_(5.2).HSL4
E1E1-MAT_MATD_MATS (RA-LIB)_ACM_2.00_Module_HART_Device_E1E1-MAT_MATD_MATS_(5.2).HSL4
E1E2-SAGE_PRIME_RIO (RA-LIB)_ACM_2.00_Module_HART_Device_E1E2-SAGE_PRIME_RIO_(5.2).HSL4
E1E9-KRG_10 (RA-LIB)_ACM_2.00_Module_HART_Device_E1E9-KRG_10_(5.2).HSL4
E1EA-iTrans_2 (RA-LIB)_ACM_2.00_Module_HART_Device_E1EA-iTrans_2_(5.2).HSL4

HART Device Application Code Manager File
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E1EC-ST_4312 (RA-LIB)_ACM_2.00_Module_HART_Device_E1EC-ST_4312_(5.2).HSL4
E1F1-AIR_10SH (RA-LIB)_ACM_2.00_Module_HART_Device_E1F1-AIR_10SH_(5.2).HSL4
E1FD-AUMATIC_AC_01_2_ACEx_01_2 (RA-LIB)_ACM_2.00_Module_HART_Device_E1FD-AUMATIC_AC_01_2_ACEx_01_2_(5.2).HSL4
E285-H_Pres_Transmitter (RA-LIB)_ACM_2.00_Module_HART_Device_E285-H_Pres_Transmitter_(5.2).HSL4
E286-E2T_PULSAR_4 (RA-LIB)_ACM_2.00_Module_HART_Device_E286-E2T_PULSAR_4_(5.2).HSL4
E28D-MP100 (RA-LIB)_ACM_2.00_Module_HART_Device_E28D-MP100_(5.2).HSL4
E29B-MC608 (RA-LIB)_ACM_2.00_Module_HART_Device_E29B-MC608_(5.2).HSL4
E2A1-SS235 (RA-LIB)_ACM_2.00_Module_HART_Device_E2A1-SS235_(5.2).HSL4
E2A2-EMF_1000_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E2A2-EMF_1000_Series_(5.2).HSL4
E2A3-CMF_2000_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E2A3-CMF_2000_Series_(5.2).HSL4
E2A6-L_mag (RA-LIB)_ACM_2.00_Module_HART_Device_E2A6-L_mag_(5.2).HSL4
E2AD-ML210_ME101 (RA-LIB)_ACM_2.00_Module_HART_Device_E2AD-ML210_ME101_(5.2).HSL4
E2B3-SmartPoz_8400S (RA-LIB)_ACM_2.00_Module_HART_Device_E2B3-SmartPoz_8400S_(5.2).HSL4
E2B5-DREHMO_i_matic (RA-LIB)_ACM_2.00_Module_HART_Device_E2B5-DREHMO_i_matic_(5.2).HSL4
E2B8-SNE4100B (RA-LIB)_ACM_2.00_Module_HART_Device_E2B8-SNE4100B_(5.2).HSL4
E2BA-DAT_M (RA-LIB)_ACM_2.00_Module_HART_Device_E2BA-DAT_M_(5.2).HSL4
E2BB-DAH_M (RA-LIB)_ACM_2.00_Module_HART_Device_E2BB-DAH_M_(5.2).HSL4
E2BF-GT_CT_8900 (RA-LIB)_ACM_2.00_Module_HART_Device_E2BF-GT_CT_8900_(5.2).HSL4
E2C0-GQ_CE8900 (RA-LIB)_ACM_2.00_Module_HART_Device_E2C0-GQ_CE8900_(5.2).HSL4
E2C1-ECHOPRO_LRxx (RA-LIB)_ACM_2.00_Module_HART_Device_E2C1-ECHOPRO_LRxx_(5.2).HSL4
E2C6-ACM_2_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_E2C6-ACM_2_HRT_(5.2).HSL4
E2CD-E018p (RA-LIB)_ACM_2.00_Module_HART_Device_E2CD-E018p_(5.2).HSL4
E2E7-N8 (RA-LIB)_ACM_2.00_Module_HART_Device_E2E7-N8_(5.2).HSL4
E2E8-D58_DC (RA-LIB)_ACM_2.00_Module_HART_Device_E2E8-D58_DC_(5.2).HSL4
E2E9-GD_88 (RA-LIB)_ACM_2.00_Module_HART_Device_E2E9-GD_88_(5.2).HSL4
E2ED-TxIsoRail_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_E2ED-TxIsoRail_HRT_(5.2).HSL4
E2FA-IDC24 (RA-LIB)_ACM_2.00_Module_HART_Device_E2FA-IDC24_(5.2).HSL4
E305-WD_BS_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E305-WD_BS_Series_(5.2).HSL4
E306-D58_AC (RA-LIB)_ACM_2.00_Module_HART_Device_E306-D58_AC_(5.2).HSL4
E308-TCD50 (RA-LIB)_ACM_2.00_Module_HART_Device_E308-TCD50_(5.2).HSL4
E30E-IP_0304_M1_H (RA-LIB)_ACM_2.00_Module_HART_Device_E30E-IP_0304_M1_H_(5.2).HSL4
E313-TxIsoBlock_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_E313-TxIsoBlock_HRT_(5.2).HSL4
E328-AMI_pH_Redox (RA-LIB)_ACM_2.00_Module_HART_Device_E328-AMI_pH_Redox_(5.2).HSL4
E32C-G3_LEFM (RA-LIB)_ACM_2.00_Module_HART_Device_E32C-G3_LEFM_(5.2).HSL4
E32F-KD_12 (RA-LIB)_ACM_2.00_Module_HART_Device_E32F-KD_12_(5.2).HSL4
E330-AIR_30M (RA-LIB)_ACM_2.00_Module_HART_Device_E330-AIR_30M_(5.2).HSL4
E332-BRIZ_TM_2Ex (RA-LIB)_ACM_2.00_Module_HART_Device_E332-BRIZ_TM_2Ex_(5.2).HSL4
E333-Mass_flowmeter (RA-LIB)_ACM_2.00_Module_HART_Device_E333-Mass_flowmeter_(5.2).HSL4
E334-TriVAX (RA-LIB)_ACM_2.00_Module_HART_Device_E334-TriVAX_(5.2).HSL4
E33D-CamCor (RA-LIB)_ACM_2.00_Module_HART_Device_E33D-CamCor_(5.2).HSL4
E35A-ULM (RA-LIB)_ACM_2.00_Module_HART_Device_E35A-ULM_(5.2).HSL4
E35D-series_9D_Analyzer (RA-LIB)_ACM_2.00_Module_HART_Device_E35D-series_9D_Analyzer_(5.2).HSL4
E363-APOSA (RA-LIB)_ACM_2.00_Module_HART_Device_E363-APOSA_(5.2).HSL4
E37C-OTIS_7543_6_W_HRT (RA-LIB)_ACM_2.00_Module_HART_Device_E37C-OTIS_7543_6_W_HRT_(5.2).HSL4
E389-JUMO_dTRANS_T07 (RA-LIB)_ACM_2.00_Module_HART_Device_E389-JUMO_dTRANS_T07_(5.2).HSL4
E38D-CHRONOS_IDP7600 (RA-LIB)_ACM_2.00_Module_HART_Device_E38D-CHRONOS_IDP7600_(5.2).HSL4
E38E-GT_X_1100 (RA-LIB)_ACM_2.00_Module_HART_Device_E38E-GT_X_1100_(5.2).HSL4

HART Device Application Code Manager File
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E38F-KC_200_H (RA-LIB)_ACM_2.00_Module_HART_Device_E38F-KC_200_H_(5.2).HSL4
E394-Position_Xmtr (RA-LIB)_ACM_2.00_Module_HART_Device_E394-Position_Xmtr_(5.2).HSL4
E39C-Mv110_MV210 (RA-LIB)_ACM_2.00_Module_HART_Device_E39C-Mv110_MV210_(5.2).HSL4
E3A6-BiT_Barkslade_Intelligent_Transmitter (RA-LIB)_ACM_2.00_Module_HART_Device_E3A6-BiT_Barkslade_Intelligent_Transmitter_(5.2).HSL4
E3A8-Ultra_IR800 (RA-LIB)_ACM_2.00_Module_HART_Device_E3A8-Ultra_IR800_(5.2).HSL4
E3A9-Ultra_FL800 (RA-LIB)_ACM_2.00_Module_HART_Device_E3A9-Ultra_FL800_(5.2).HSL4
E3B7-NivuFlow (RA-LIB)_ACM_2.00_Module_HART_Device_E3B7-NivuFlow_(5.2).HSL4
E3BB-XTH300i (RA-LIB)_ACM_2.00_Module_HART_Device_E3BB-XTH300i_(5.2).HSL4
E3BD-SDCU_20 (RA-LIB)_ACM_2.00_Module_HART_Device_E3BD-SDCU_20_(5.2).HSL4
E3C4-RP1000 (RA-LIB)_ACM_2.00_Module_HART_Device_E3C4-RP1000_(5.2).HSL4
E3E3-JUMO_dTRANS_T08_37 (RA-LIB)_ACM_2.00_Module_HART_Device_E3E3-JUMO_dTRANS_T08_37_(5.2).HSL4
E3E4-JUMO_dTRANS_T08_13 (RA-LIB)_ACM_2.00_Module_HART_Device_E3E4-JUMO_dTRANS_T08_13_(5.2).HSL4
E3E5-EMIS_BAR (RA-LIB)_ACM_2.00_Module_HART_Device_E3E5-EMIS_BAR_(5.2).HSL4
E405-TER (RA-LIB)_ACM_2.00_Module_HART_Device_E405-TER_(5.2).HSL4
E406-HIR (RA-LIB)_ACM_2.00_Module_HART_Device_E406-HIR_(5.2).HSL4
E408-SMT_200X (RA-LIB)_ACM_2.00_Module_HART_Device_E408-SMT_200X_(5.2).HSL4
E40A-NCS_TT106 (RA-LIB)_ACM_2.00_Module_HART_Device_E40A-NCS_TT106_(5.2).HSL4
E41A-Uniphos_501_DT (RA-LIB)_ACM_2.00_Module_HART_Device_E41A-Uniphos_501_DT_(5.2).HSL4
E41B-CURTO_CU_DQD_0235 (RA-LIB)_ACM_2.00_Module_HART_Device_E41B-CURTO_CU_DQD_0235_(5.2).HSL4
E429-EMIS_VIHR_200 (RA-LIB)_ACM_2.00_Module_HART_Device_E429-EMIS_VIHR_200_(5.2).HSL4
E42C-MR (RA-LIB)_ACM_2.00_Module_HART_Device_E42C-MR_(5.2).HSL4
E435-DX_PST_with_HRT_7 (RA-LIB)_ACM_2.00_Module_HART_Device_E435-DX_PST_with_HRT_7_(5.2).HSL4
E44D-VisiFerm_mA (RA-LIB)_ACM_2.00_Module_HART_Device_E44D-VisiFerm_mA_(5.2).HSL4
E44E-VisiTrace_mA (RA-LIB)_ACM_2.00_Module_HART_Device_E44E-VisiTrace_mA_(5.2).HSL4
E44F-iPES_IR3 (RA-LIB)_ACM_2.00_Module_HART_Device_E44F-iPES_IR3_(5.2).HSL4
E450-TGAES_RX_A (RA-LIB)_ACM_2.00_Module_HART_Device_E450-TGAES_RX_A_(5.2).HSL4
E457-Wi_Corr_Bond (RA-LIB)_ACM_2.00_Module_HART_Device_E457-Wi_Corr_Bond_(5.2).HSL4
E465-CT_PT4550 (RA-LIB)_ACM_2.00_Module_HART_Device_E465-CT_PT4550_(5.2).HSL4
E467-CT_PMS6030 (RA-LIB)_ACM_2.00_Module_HART_Device_E467-CT_PMS6030_(5.2).HSL4
E468-Leon_Meter (RA-LIB)_ACM_2.00_Module_HART_Device_E468-Leon_Meter_(5.2).HSL4
E469-SI_100 (RA-LIB)_ACM_2.00_Module_HART_Device_E469-SI_100_(5.2).HSL4
E46B-TP2000_Series (RA-LIB)_ACM_2.00_Module_HART_Device_E46B-TP2000_Series_(5.2).HSL4
E46C-DRG_M_DRS (RA-LIB)_ACM_2.00_Module_HART_Device_E46C-DRG_M_DRS_(5.2).HSL4
E47A-PT0304_VT (RA-LIB)_ACM_2.00_Module_HART_Device_E47A-PT0304_VT_(5.2).HSL4
E47B-EM_260 (RA-LIB)_ACM_2.00_Module_HART_Device_E47B-EM_260_(5.2).HSL4
E481-SD_3 (RA-LIB)_ACM_2.00_Module_HART_Device_E481-SD_3_(5.2).HSL4
E488-MC_Synergy (RA-LIB)_ACM_2.00_Module_HART_Device_E488-MC_Synergy_(5.2).HSL4
E48A-YYDG (RA-LIB)_ACM_2.00_Module_HART_Device_E48A-YYDG_(5.2).HSL4
E494-NTM8 (RA-LIB)_ACM_2.00_Module_HART_Device_E494-NTM8_(5.2).HSL4
E49F-SP4060 (RA-LIB)_ACM_2.00_Module_HART_Device_E49F-SP4060_(5.2).HSL4
E4A6-TLK_TT306H (RA-LIB)_ACM_2.00_Module_HART_Device_E4A6-TLK_TT306H_(5.2).HSL4
E4A7-TLK_TT305H (RA-LIB)_ACM_2.00_Module_HART_Device_E4A7-TLK_TT305H_(5.2).HSL4
E4A8-TLK_TT306H_R (RA-LIB)_ACM_2.00_Module_HART_Device_E4A8-TLK_TT306H_R_(5.2).HSL4
E4A9-RU (RA-LIB)_ACM_2.00_Module_HART_Device_E4A9-RU_(5.2).HSL4
E4B6-TRG80XX (RA-LIB)_ACM_2.00_Module_HART_Device_E4B6-TRG80XX_(5.2).HSL4
E4B8-REM (RA-LIB)_ACM_2.00_Module_HART_Device_E4B8-REM_(5.2).HSL4
E4BF-GDRD8X (RA-LIB)_ACM_2.00_Module_HART_Device_E4BF-GDRD8X_(5.2).HSL4

HART Device Application Code Manager File
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HMI Tags The IODevice Library contains "FTViewStudio_IOLibrary_Tags_5_00.CSV", 
which is used by FactoryTalk® View Site Edition and FactoryTalk® View 
Machine Edition applications to operate the page navigation and revision 
screens. The CSV import file includes the following tags:

E4C2-RV (RA-LIB)_ACM_2.00_Module_HART_Device_E4C2-RV_(5.2).HSL4
E4D5-IP_0304_M3_H (RA-LIB)_ACM_2.00_Module_HART_Device_E4D5-IP_0304_M3_H_(5.2).HSL4
E4D8-DA_500 (RA-LIB)_ACM_2.00_Module_HART_Device_E4D8-DA_500_(5.2).HSL4
E4DE-PID901 (RA-LIB)_ACM_2.00_Module_HART_Device_E4DE-PID901_(5.2).HSL4
E537-ACTUATOR (RA-LIB)_ACM_2.00_Module_HART_Device_E537-ACTUATOR_(5.2).HSL4
Generic (RA-LIB)_ACM_2.00_Module_HART_Device_Generic_(5.2).HSL4

HART Device Application Code Manager File

Member Description Data Type

IOLibNavTag Page navigation tag INT

IOLibRevTag 99 = Revision screen is active on the device. INT
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State Model The following section will discuss the state model for Device Object. The figure 
below shows the core logic states.

By default, each state is active for a minimum of 256us to allow for evaluation 
of state outside of the ADO   instance in the user program

Interfaces Device object interfaces are intended to provide the application programmer a 
class based harmonized interface for interacting with the device object from 
user code. Standard control interfaces are used for passing device inputs (Inp), 
device configuration (Cfg), Settings (Set), Commands (Cmd) and Status (Sts). 

The following IO-Device Common Control Interface tags are the primary 
device program tags to read and write to when interfacing to IO-Devices. The 
value of using these tags in your specific application code is that you may use a 
number of different IO-Devices such as 1756-EN4TR without having to update 
your application device interface tags. 

For detailed information on specific interfaces, please refer to the appropriate 
section in this manual. A list of interface UDTs used in this library follows. 
Note that OBJECT used in the Inp interfaces is replaced with the specific IO-
Device object (e.g. 1756-EN4TR).
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Data Types The following IO-Device Common Control Interface tags are the primary 
device program tags to read to when interfacing to IO-Devices. The value of 
using these tags in your specific application code is that you may use a number 
of different IO-Devices such as 1756-EN4TR without having to update your 
application device interface tags. 

raC_UDT_ItfAD_IODevice_Cmd

This is the IO-Device Common Control Interface User-Defined Data Type for 
device commands. Its members provide application program access to 
common device commands.

The table below shows member names, descriptions, and tag data types. Note: 
Physical & Virtual members are not currently used in the Add-On Instruction 
and are reserved for future use.

raC_UDT_ItfAD_IODevice_Inf

This is the IO-Device interfacing data which provide the device type 
information to the IO-Device. 

The below table shows detailed information of members used in this UDT tag.

Interface Class Object Class Object Sub-Class Interface Type Interface Name (UDT)

Control IO-Device IO-Devices 

Setting raC_UDT_ItfAD_IODevice_CtrlSet
Command raC_UDT_ItfAD_IODevice_CtrlCmd
Status raC_UDT_ItfAD_IODevice_CtrlSts
Information raC_UDT_ItfAD_IODevice_Inf
Interfacing raC_UDT_ItfAD_IODevices

  Member Description   DataType

bCmd Bit Overlay (Visible) covering all subsequent boolean members. DINT

Physical 1 = Operate as Physical Device. BOOL

Virtual 1 = Operate as Virtual Device. BOOL

ResetWarn 1 = Reset device warning. BOOL

ResetFault 1 = Reset device trip or fault. BOOL
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raC_UDT_ItfAD_IODevice_Set

This is the IO-Device Common Control Interface User-Defined Data Type for 
device settings. Its members provide application program access to allow or 
inhibit commands and settings from the device faceplate or other external 
sources. The table below shows member names, descriptions, and tag data 
types.

For example, to inhibit write commands from the device faceplate or other 
external sources write a 1 to the _InstanceName_CtlrSet.InhibitCmd program 
tag from your application program. This would prevent a Locate, Reset count, 
Reset Duration commands from the device faceplate.

raC_UDT_ItfAD_IODevice_Sts

This is the IO-Device Common Control interfacing Status tag. By configuring 
these tags, we can read various status from the device like Ready, Connected, 
and Available etc. The below table shows detailed information of members 
used in this UDT tags. Note: Physical & Virtual members are not currently used 
in the Add-On Instruction and are reserved for future use.

Member Description Data Type

ModulePath Module CIP path. STR0032

bExtensionEnabled Object extension is present in the controller, represented bitwise: 0 
= False, 1 = True. DINT

Member Description Data Type

bInhibit Inhibits (Bit Overlay). DINT

InhibitCmd 1 = Inhibit user Commands from external sources, 0 = Allow. BOOL

InhibitSet 1 = Inhibit user Settings from external sources, 0 = Allow. BOOL

InhibitCfg 1 = Inhibit user Configuration from external sources, 0 = Allow. BOOL

Input Description Data Type

eState

Enumerated state value:
0 = Unused
1 = Initializing
2 = Disconnected
3 = Disconnecting
4 = Connecting
5 = Idle
6 = Configuring
7 = Available

DINT

FirstWarning First Warning Event Data raC_UDT_Event

FirstFault First Fault Event Data raC_UDT_Event

eCmdFail Enumerated command failure code. DINT

bSts Bit overlay (Visible) covering all subsequent boolean members. DINT

Physical 1 = Controlling physical device. BOOL
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raC_UDT_Event

raC_UDT_1756_EN4TR_MsgData

This is the IO-Device Message data which provide the command and status 
related information to the EN4TR. 

The below table shows detailed information of members used in this UDT tag.

Virtual 1 = Controlling virtual device. BOOL

Connected 1 = PAC to device connection has been established. BOOL

Ready 1 = Device is ready to ... BOOL

Warning 1 = A warning is active on the device. BOOL

Faulted 1 = A fault is active on the device. BOOL

Member Description Data Type

Type

Event type:
1 = Status
2 = Warning
3 = Fault
4...n = User

DINT

ID User definable event ID. DINT

Category User definable category (Electrical,Mechanical,Materials,Utility,etc.). DINT

Action User definable event action code. DINT

Value User definable event value or fault code. DINT

Message Event message text. STRING

EventTime_L Timestamp (Date/Time format). LINT

EventTime_D Timestamp (Y,M,D,h,m,s,us). DINT[7]

Member Description Data Type

AutoQualOption Auto-qualification configuration 
option INT

AutoQualState Present state of auto-qualification 
enabling INT

ProgCommands
Controls whether or not user 
programs can initiate redundancy 
commands

INT

PasswordScope
Controls whether or not 
redundancy configuration changes 
and/or user-initiated commands 
are password protected

INT

ModuleRedundancyStat
e

Indicates the module redundancy 
state of this module INT

ChassisRedundancySta
te

Indicates the chassis redundancy 
state of this chassis INT

PartnerRedundancySta
te

Indicates the module redundancy 
state of the partner module, if one 
exists

INT

Input Description Data Type
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raC_UDT_LookupMember_STR0082

Application Code Manager Architectural Overview

Device libraries, as with most Application Code Libraries are divided into 2 
logical groups: either Asset-Control Object or Device Implement Object.

Asset-Control Objects contain the asset definition of an object and any 
associated content which belongs to the asset. This includes controller tags, 
add-on instructions, data types, and attachments such as HMI content and 
documentation. These are found under the (RA-LIB) Device > Asset-Control 
folder and have names like raC_Dvc_xxxx where xxxx is the device name.

Device Implement Objects contain an instance of an asset-control object and 
provide all related configuration of the asset. The Device implement type is the 
application code (e.g. programming rung). This includes the required 
controller tags, programs, modules, and FactoryTalk View ME/SE symbols. 
These are found under the (RA-LIB) Device > Device folder and have names like 
raC_LD_Dvc_xxxx where xxxx is the device name. LD stands for ladder logic.

PartnerChassisState
Indicates the chassis redundancy 
state of the partner chassis, if one 
exists

INT

QualificationInProgress
Indicates whether the chassis is 
currently in the qualification 
process

INT

NotApplied NA INT[12]

Member Description Data Type

Code Stores the value of device fault code DINT

Desc Stores the Messages related to fault code STRING

Member Description Data Type
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Using the Library

Install the Library Download the Library

For the latest compatible software information and to download the Rockwell 
Automation Library, see the Product Compatibility and Download Center.

Search “Device Library” or filter on Application Content to quickly find the 
library.

Download & Install Studio 5000® Application Code Manager

Studio 5000® Application Code Manager is free to install from Rockwell 
Automation’s Product Compatibility and Download Center.

Search “Application Code Manager” and select the item to download. 

https://compatibility.rockwellautomation.com/Pages/home.aspx#/scenarios
https://compatibility.rockwellautomation.com/Pages/home.aspx#/scenarios
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Extract the downloaded .zip file by running the 4.xx.00-Studio5000_ACM-
DVD.exe executable file. This will extract a new folder containing a Setup.exe file 
which can be run to begin product installation.

Follow the prompts from the splash screen until installation is complete. Note 
that a SQL server is required for Application Code Manager. SQL Server 
Express is offered for free and is included in the Application Code Manager 
installer.

Register Libraries in Studio 5000 Application Code Manager

It is recommended that you use Studio 5000® Application Code Manager to 
add I/O modules to a project and pre-configure FactoryTalk® View ME/SE 
faceplate HMI objects. To use the library in Application Code Manager you 
must first register the libraries.

Register Complete Library Automatically

To automatically register the entire library, find and run the setup.cmd file in 
the root folder of the library files. You will see a windows console appear as the 

The Lite version of Studio 5000® Application Code Manager is free of charge and can 
be downloaded from the Product Compatibility and Download Centre. None of the 
features included in the Standard (paid) version are required to use Device Object 
Libraries.
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script runs. When it is complete it will display “Deployment Complete”. Enter 
“Y” to exist the console.

Register Individual Library Objects Manually

As an alternative to registering the entire library using the setup.cmd script, 
you can manually register one or multiple library objects in Studio 5000® 
Application Code Manager. Open up Application Code Manager and view the 
Registered Libraries panel on the right. Right-click on Registered Libraries and 
select Register. Browse to the ApplicationCodeManagerLibraries folder within the 
library files and select any HSL4 files that you would like to register. Note you 
may select more than one at a time. Once you complete registering the desired 
objects they will be shown under the (RA-LIB) Device solution folder.
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Using Studio 5000 View 
Designer

Using View Designer Project Files

Studio 5000 View Designer® may be used for HMI development for 
PanelView™ 5000 applications. Open up your Studio 5000 View Designer® 
project alongside a second application instance running the required VSD file 
in the library folder HMI - ViewDesigner - vpd.

You will notice there are multiple screens available under the User-Defined 
Screens folder:

• raC_Dvc_XXXX_Type: This has the graphic symbol launch buttons for 
the faceplate where XXXX is the I/O family and Type is the module type 
(e.g. AC_Input).

• raC_Dvc_XXXX_wDesc_FP: This is a faceplate pop-up screen.

To include these files in your project, perform the following steps:
• Copy the entire faceplate _wDesc_FP screen from the supplied VSD 

project to your project application.
• Open the graphic symbols screen and copy the desired graphic symbol 

and paste it into a screen in your project application.

In the Library there is a folder named Videos which contains many How-To Import Videos which walk step-by-step through each 
process. You can refer to the following videos for this section: “How_To_Import_and_Configure_IO_Objects_into_View_Designer”
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Configuring View Designer Objects

To link the launch button to the faceplate, highlight the button and view the 
Events tab of within the Properties pane. Set an Event to Open popup on release 
with the following settings:

• Key: Touch Only
• Popup: Select desired faceplate screen
• Module_InputTag: Browse to Input (:I) tag of the I/O module in your 

controller file. This is required for all module types.
• Module_OutputTag: Browse to Output (:O) tag of the I/O module in 

your controller file. This is only defined and required for Output 
modules and some specialty modules.

Using FactoryTalk® View 
Studio

Import HMI Tags

An HMI Tag file FTViewStudio_IOLibrary_Tags_5_00.CSV is provided in the root 
of the library folder for use with FactoryTalk® View ME and SE. This is 
required to support faceplate navigation between tabs and pages where 
application.
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To import the tag file, in FactoryTalk® View Studio go to Tools > Tag Import and 
Export Wizard...

Set the Operation to Import FactoryTalk® View tag CSV files.

Choose the appropriate Project Type (Machine Edition or Site Edition). Browse 
for the desired project .MED file.

Browse for the .CSV file in the root of the IODeviceLibrary_v5.xx library folder.

In the Library there is a folder named Videos which contains many How-To Import Videos which walk step-by-step through each 
process. You can refer to the following videos for this section: 
“How_To_Import_and_Configure_IO_Objects_in_FTViewME”
“How_To_Import_and_Configure_IO_Objects_in_FTViewSE”
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You may choose to Skip existing or Update existing tags. If this has not been 
done previously the choice should not make a difference.

The following tags are now imported:

Import FactoryTalk® View Visualization Files 

There are several components to import for the visualization files. You import 
files from the downloaded Rockwell Automation library files via FactoryTalk® 
View ME or FactoryTalk® View SE. The workflow is the same for both 
FactoryTalk® View ME and SE. All image and display items can be imported 
either by right-clicking in FactoryTalk® View on the Graphic sub-folder (e.g. 
Displays, Global Objects, Images) or simply dragging and dropping the files 
into the application.

Import files in this order:
1. Import HMI Images files.

Tag Name Type Description
IOLibNavTag Analog Navigation tag for IO Module Facepaltes
IOLibRevTag Analog Revision tag for IO Module Faceplates
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Select all the images in the \HMI FactoryTalk® View Images - png folder 
and Open.

2. Import Global Object files

Select the global object (.ggfx) files from the \HMI - FactoryTalk® View 
ME\Global Objects - ggfx or \HMI - FactoryTalk® View SE\Global Objects - 
ggfx folder

3. Import HMI Faceplates

Select the faceplate (.gfx) files from the \HMI - FactoryTalk® View ME\Displays - 
gfx or \HMI - FactoryTalk® View SE\Displays - gfx folder

Configuring FactoryTalk® View Objects

Once the files have been imported into the FactoryTalk® View Studio project, 
you can begin using them in your application. Open the Global Display (raC-5-
ME) Graphic Symbols - IO Device. Copy the desired launch button style and paste 
it into a display in your application where you would like to open the faceplate. 
For more information on graphic symbols, refer to the Graphic Symbols 
section of the specific device type chapter in this manual.

To configure the graphic symbol launch button, right-click and select Global 
Object Parameter Values. You can browse for the tag in your controller project by 
clicking ‘...’ or manually type them in. These parameters may vary depending 
on the graphic symbol used, please refer to the Graphic Symbols section of the 
device type for detailed information. Generally Global Object Parameters for 
the IO Device Library are defined as follows:

Name/# Description Mandatory
#102 Faceplate Display Name e.g. (raC-5_00-ME) raC_Dvc_XXXX_XXXX-Faceplate Yes
#103 IO Module Input Tag .e.g. {::[Topic Name]Local:1:I} Yes
#104 IO Module Output Tag .e.g. {::[Topic Name]Local:1:O} Output Modules Only
#106 Custom Button Label. Leave blank to use InputTag.@Description No
#111 IO Class: Blank=Standard; 1=Safety No
#120 Display’s left position (e.g. 100) No
#121 Display’s top position (e.g. 100) No
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Importing Logic into Studio 
5000® Projects

There are multiple methods to using the logic in a Studio 5000 application. For 
projects that are being developed from scratch using Application Code 
Manager along with other Application Code Libraries such as the PlantPAx 
Process Objects Library or the Machine Builder Library, you can continue to 
use the Device Object Libraries in Application Code Manager. For existing 
applications where devices are being added, it is recommended to use the 
Studio 5000 Plug-In “Import Library Objects” Wizard. Alternatively you can 
import the RUNG.L5X files into your program and configure them manually.

Below is a table to capture recommendations on when to use which tool or 
workflow when importing and configuring device objects.

These Global Object Parameter Values are automatically configured when you use 
Studio 5000® Application Code Manager to design and configure your project. Refer 
to Using Studio 5000® Application Code Manager for more information.

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section: 
“How_To_Import_and_Configure_IO_Device_Objects_in_LogixDesigner.mp4” 

It is not recommended to simply import the AOI.L5X files and attempt to build your 
own logic rung. Doing so will increase the likelihood of configuration errors and likely 
miss logic that is required outside of the Add-On Instruction.
AOI files should only be imported when updating an existing application from a 
previous version of a Device Object Library to a newer one.

Tool/Workflow Description of when to use Software Requirements

Application Code Manager
(full application)

Project is developed from scratch using 
Application Code Manager along with 
PlantPAx or Machine Builder libraries.

Studio 5000 Logix Designer®
Studio 5000® Application Code Manager 
(Lite)
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Import Library Objects Wizard

The most simple way to import a Device Object into an existing application is 
to use the Studio 5000 Plug-In “Import Library Objects” wizard. This plug-in 
requires Application Code Manager to be installed but does not require it to be 
open or have a project created.

Right click on an item (e.g. Controller, Task, Program, etc) in the Controller 
Organizer and select Plug-Ins > Import Library Objects...

This will launch a small wizard version of Application Code Manager inside of 
your Studio 5000 Logix Designer® Project. In the Registered Libraries panel on 
the left, find your desired object under Registered Libraries > (RA-LIB) Device > 
Device and drag it into the Library Object(s) list in the Object Configuration 
Tab.

Studio 5000 Plug-In “Import 
Library Objects” Wizard

Application Code Manager is installed but 
not required for the entire project. 
Application has already been developed 
but some Device Objects need to be 
added.

Studio 5000 Logix Designer®
Studio 5000® Application Code Manager 
(Lite)

Import RUNG.L5X File

Application Code Manager is not installed. 
Application has already been developed 
but some Device Objects need to be 
added.
Familiar with rung import workflow.

Studio 5000 Logix Designer®

Import AOI.L5X File
Updating existing application that 
contains an older version of a Device 
Object AOI.

Studio 5000 Logix Designer®

Tool/Workflow Description of when to use Software Requirements
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Perform the following configuration:
• Enter a name and description. Maximum name length can be 22 

characters. Note that other parameters such as the RoutineName, 
TagName, etc will auto-complete based on these fields.

• Assign the Task and Program.
• The ModuleReference represents the IO-Device Module to which the 

IO-device is connected.
• Assign the ModuleName by typing or browsing to the instance of the 

IO-Device Module in the controller project (e.g. 1756-EN4TR)
• The HMI Configuration options are not used in the Plug-In Wizard and 

can be ignored.
• Click next or click on the Linked Libraries tab. Click the Auto Create 

button to automatically create all of the required linked libraries.

• On the following screen you can select the desired Merge Actions. 
Generally these can be left with the default actions.
• Add: used when AOIs don’t previously exist in application
• Overwrite: usually preferred. Used when AOIs previously exist but 

may or may not be the same revision.
• Use Existing: used when AOIs previously exist in the application and 

you do not wish to overwrite the existing items.
• Click next and you can now see any new logic and modules that will be 

created.
• Click Finish to complete the import.

You can manually create new linked libraries or point to existing linked libraries if 
necessary. You may need to do this if you would like to use an older version of library 
objects when multiple versions are installed in Application Code Manager.
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Import Rung Logic

An Add-On Instruction is defined once in each controller project, and can be 
instantiated multiple times in your application code. To use pre-engineered 
logic, import each desired RUNG.L5X file into a controller project.

1. In the Studio 5000 Logix Designer® application, open a new or
existing project.

2. Choose or create a new ladder routine to open. Right-click in the 
routine ladder and choose Import Rungs... 

3. Select the desired RUNG and Select Import. The file will have a name 
like raC_Dvc_1756_EN4TR_RUNG.L5X. 

.

IMPORTANT Add-On Instruction definitions can be imported, but not updated, online.

Both “RUNG” and “AOI” .L5X files are provided. Import the RUNG 
file to get all required additional tags, data types, and message 
configurations.
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4. An Import Configuration dialogue window will open and display generic 
Import names which include “_InstanceName”. Click the Find/Replace... 
button and replace all instances of “_InstanceName” with your desired 
device name (e.g. “EN4TR”).

5. Click the Find/Replace... button and replace of “Intsnce_Description” 
with your desired description e.g. “EN4TR Module”). 
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6. Click the Other Componets... and select of “_ModuleName” with your 
desired Module Name e.g. “EN4TR_Adapter”).
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7. Click “OK” on the “Import Configuration dialog box”. The rung will now 
be imported into your ladder routine.

Module Definition Module Configuration

The specified Configuration is necessary when user manually creating Studio 
5000 Project. However if Application Code Manager is used for Project 
construction, these configurations are automatically managed. According to 
the faceplate user are required to adjust module settings. Refer to the table 
below for necessary configurations across all series.

1715 High- Availability I/O Configuration

FactoryTalk View xx Faceplate Connection Input / Output 
Data Data Format Redundant SIL2 safety HART Enabled

(raC-5_xx-xx) raC_Dvc_1715_IF16_AnalogDuplex-Faceplate.gfx

Data

Analog only Float

Yes

No

No
(raC-5_xx-xx) raC_Dvc_1715_IF16_AnalogSimplex-Faceplate.gfx No
(raC-5_xx-xx) raC_Dvc_1715_IF16_HARTDuplex-Faceplate.gfx Yes

Yes
(raC-5_xx-xx) raC_Dvc_1715_IF16_HARTSimplex-Faceplate.gfx No
(raC-5_xx-xx) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx Yes

No
(raC-5_xx-xx) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate.gfx No
(raC-5_xx-xx) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx Yes

Yes
(raC-5_xx-xx) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate.gfx No
(raC-5_xx-xx) raC_Dvc_1715_IB16D_Duplex-Faceplate.gfx

N/A N/A

Yes

N/A
(raC-5_xx-xx) raC_Dvc_1715_IB16D_Simplex-Faceplate.gfx No
(raC-5_xx-xx) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx Yes
(raC-5_xx-xx) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx No
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1719 Ex I/O Configuration

1732E Armor Block Configuration

1732E Armor Block Safety Configuration

FactoryTalk View xx Faceplate Input / Output 
Data Output Data

(raC-5_xx-xx) raC_Dvc_1719_IF4HB-Faceplate.gfx

Data

Analog Data + 
HART

(raC-5_xx-xx) raC_Dvc_1719_IR4B-Faceplate.gfx
Analog Data

(raC-5_xx-xx) raC_Dvc_1719_IT4B-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1719_IBN8-Faceplate.gfx

N/A
(raC-5_xx-xx) raC_Dvc_1719_IBN8B-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1719_OB2-Faceplate.gfx Low Current 

,two points(raC-5_xx-xx) raC_Dvc_1719_OB2L-Faceplate.gfx

FactoryTalk View xx Faceplate Connection Data Format Time Stamp Enable MAOC 
Support

(raC-5_xx-xx) raC_Dvc_1732E_IF4M12R-Faceplate.gfx

Data

N/A

N/A

N/A

(raC-5_xx-xx) raC_Dvc_1732E_IR4IM12R-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_IT4IM12R-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_OF4M12R-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_IB16M12-Faceplate.gfx

Integer(raC-5_xx-xx) raC_Dvc_1732E_IB16M12R-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_IB16M12W-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_IB8M8SOER-Faceplate.gfx N/A Per Point
(raC-5_xx-xx) raC_Dvc_1732E_OB16M12-Faceplate.gfx

Integer N/A
(raC-5_xx-xx) raC_Dvc_1732E_OB16M12R-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1732E_OB8M8SR-Faceplate.gfx N/A Per Point Yes 

FactoryTalk View xx Faceplate Input Data Input Status Output Data Data Format

(raC-5_xx-xx) raC_Dvc_1732ES_IB12XOB4_Safety-Faceplate.gfx Safety Pt.Status-
Muting Safety

Integer

(raC-5_xx-xx) raC_Dvc_1732ES_IB12XOB4_SafetyTestOutput-
Faceplate.gfx

Safety - 
Readback

Pt. Status - 
Muting - Test 
Output

Combined

(raC-5_xx-xx) raC_Dvc_1732ES_IB12XOBV2_Safety-Faceplate.gfx Safety Pt.Status-
Muting Safety

(raC-5_xx-xx) raC_Dvc_1732ES_IB12XOBV2_SafetyTestOutput-
Faceplate.gfx

Safety - 
Readback

Pt. Status - 
Muting - Test 
Output

Combined
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(raC-5_xx-xx) raC_Dvc_1732ES_IB16_SafetyTestOutput -
Faceplate.gfx safety

Pt. Status - 
Muting - Test 
Output Test

N/A

(raC-5_xx-xx) raC_Dvc_1732ES_IB8XOB8_Safety-Faceplate.gfx Safety Pt.Status-
Muting Safety

(raC-5_xx-xx) raC_Dvc_1732ES_IB8XOB8_SafetyTestOutput-
Faceplate.gfx

Safety - 
Readback

Pt. Status - 
Muting - Test 
Output

Combined

(raC-5_xx-xx) raC_Dvc_1732ES_IB8XOBV4_Safety-Faceplate.gfx Safety Pt.Status-
Muting Safety

(raC-5_xx-xx) raC_Dvc_1732ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

Safety - 
Readback

Pt. Status - 
Muting - Test 
Output

Combined

FactoryTalk View xx Faceplate Input Data Input Status Output Data Data Format
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1734 POINT IO Configuration

FactoryTalk View xx Faceplate Connection Data Format
(raC-5_xx-xx) raC_Dvc_1734_IE2C-Faceplate.gfx

Data

Integer

(raC-5_xx-xx) raC_Dvc_1734_IE2V-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IE4C-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IE8C-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IR2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IR2E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IT2I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734sc_IE2CH-Faceplate.gfx Analog with 

Hart(raC-5_xx-xx) raC_Dvc_1734sc_IE4CH-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734sc_IF4U-Faceplate.gfx N/A
(raC-5_xx-xx) raC_Dvc_1734_OE2C-Faceplate.gfx

Integer(raC-5_xx-xx) raC_Dvc_1734_OE2V-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OE4C-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1734sc_OE2CIH-Faceplate.gfx Analog with 
Hart

(raC-5_xx-xx) raC_Dvc_1734_8CFG-Faceplate.gfx

Integer

(raC-5_xx-xx) raC_Dvc_1734_IA2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IA4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IB2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IB4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IB8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IM2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IM4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IV2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IV4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_IV8-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1734_IB4D-Faceplate.gfx Diagnostics 
Data
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1734 POINT IO Safety Configuration

(raC-5_xx-xx) raC_Dvc_1734_OA2-Faceplate.gfx

Data

Integer

(raC-5_xx-xx) raC_Dvc_1734_OA4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB2E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB2EP-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB4E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OB8E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OV2E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OV4E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OV8E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OW2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OW4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1734_OX2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_17x4_xx2-Faceplate.gfx

Data
Rack 
Optimization

(raC-5_xx-xx) raC_Dvc_17x4_xx4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_17x4_xx8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_17x4_xx16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_17x4_xx32-Faceplate.gfx

FactoryTalk View xx Faceplate Connection Data Format

FactoryTalk View xx Faceplate Input Data Output Data Process Data Input Status

(raC-5_xx-xx) raC_Dvc_1734_IE4S_Safety-Faceplate.gfx Safety
None

Status Alarm 
Faults N/A

(raC-5_xx-xx) raC_Dvc_1734_IB8S_Safety-Faceplate.gfx

N/A N/A

Pt- Status

(raC-5_xx-xx) raC_Dvc_1734_IB8S_SafetyTestOutput-
Faceplate.gfx Test

Pt-Staus-
Power-Muting 
-Test output 

(raC-5_xx-xx) raC_Dvc_1734_OB8S_Safety-Faceplate.gfx
Safety Pt- Status - 

Readback(raC-5_xx-xx) raC_Dvc_1734_OBV2S_Safety-Faceplate.gfx
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FactoryTalk View xx Faceplate Connection Data Format
(raC-5_xx-xx) raC_Dvc_1738_IE2CM12-Faceplate.gfx

Data Integer

(raC-5_xx-xx) raC_Dvc_1738_IE2VM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IE4CM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IR2M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IT2IM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OE2CM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OE2VM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OE4CM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IA2M12AC3-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IA2M12AC4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB2M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB4M8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB4M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB8M8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB8M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IB8M23-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IV4M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IV8M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_IV8M23-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OA2M12AC3-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB2EM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB2EPM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB4EM8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB4EM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB8EM8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB8EM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB8EM23-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB16E19M23-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB16E25DS-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OB16EM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OV4EM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OW4M12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1738_OW4M12AC-Faceplate.gfx
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FactoryTalk View xx Faceplate Connection Input / Output 
Data Data Format Coordinated 

System time Comm Format
Configure 
HART 
Device(s)

(raC-5_xx-xx) raC_Dvc_1756_IF16_SingleEnded-Faceplate.gfx

Data

Single-Ended 
Data Integer

N/A

N/A

N/A

(raC-5_xx-xx) raC_Dvc_1756_IF16_Differential-Faceplate.gfx Differential 
Data

Float(raC-5_xx-xx) raC_Dvc_1756_IF16H-Faceplate.gfx
Analog and 
HART by 
Channel

Timestamped

(raC-5_xx-xx) raC_Dvc_1756_IF16IH-Faceplate.gfx
Analog and 
HART by 
Channel

(raC-5_xx-xx) raC_Dvc_1756_IF4FXOF2F-Faceplate.gfx
N/A N/A N/A(raC-5_xx-xx) raC_Dvc_1756_IF6CIS-Faceplate.gfx

N/A Float Data
(raC-5_xx-xx) raC_Dvc_1756_IF6I-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_IF8_SingleEnded-Faceplate.gfx

Data

Single-Ended 
Data

Float

N/A

N/A

(raC-5_xx-xx) raC_Dvc_1756_IF8_Differential-Faceplate.gfx Differential 
Data

(raC-5_xx-xx) raC_Dvc_1756_IF8H-Faceplate.gfx
Analog and 
HART by 
Channel

N/A

(raC-5_xx-xx) raC_Dvc_1756_IF8I-Faceplate.gfx Input Data N/A

(raC-5_xx-xx) raC_Dvc_1756_IF8IH-Faceplate.gfx Data
Analog and 
HART by 
Channel

(raC-5_xx-xx) raC_Dvc_1756_IR12-Faceplate.gfx Input Data

N/A

(raC-5_xx-xx) raC_Dvc_1756_IR6I-Faceplate.gfx N/A Float Data
(raC-5_xx-xx) raC_Dvc_1756_IRT8I-Faceplate.gfx

Input Data N/A
(raC-5_xx-xx) raC_Dvc_1756_IT16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IT6I-Faceplate.gfx

N/A Float Data
(raC-5_xx-xx) raC_Dvc_1756_IT6I2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_OF4-Faceplate.gfx Data Data Float N/A
(raC-5_xx-xx) raC_Dvc_1756_OF6CI-Faceplate.gfx

N/A N/A N/A Float Data
(raC-5_xx-xx) raC_Dvc_1756_OF6VI-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_OF8-Faceplate.gfx

Data

Data

Float

N/A

(raC-5_xx-xx) raC_Dvc_1756_OF8H-Faceplate.gfx
Analog and 
HART by 
Channel

Timestamped

(raC-5_xx-xx) raC_Dvc_1756_OF8I-Faceplate.gfx Output Data N/A N/A N/A

(raC-5_xx-xx) raC_Dvc_1756_OF8IH-Faceplate.gfx
Data

Analog and 
HART by 
Channel Float Timestamped

No

(raC-5_xx-xx) raC_Dvc_1756sc_IF8U-Faceplate.gfx N/A N/A
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(raC-5_xx-xx) raC_Dvc_1756_IA16-Faceplate.gfx

Data

Data

N/A N/A

N/A

N/A

(raC-5_xx-xx) raC_Dvc_1756_IA16I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IA32-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IA8D-Faceplate.gfx N/A
(raC-5_xx-xx) raC_Dvc_1756_IB16-Faceplate.gfx Data
(raC-5_xx-xx) raC_Dvc_1756_IB16D-Faceplate.gfx N/A
(raC-5_xx-xx) raC_Dvc_1756_IB16I-Faceplate.gfx Data

(raC-5_xx-xx) raC_Dvc_1756_IB16IF-Faceplate.gfx TimeStamp 
Data

(raC-5_xx-xx) raC_Dvc_1756_IB16ISOE-Faceplate.gfx CIP  sync Per 
point N/A

(raC-5_xx-xx) raC_Dvc_1756_IB32-Faceplate.gfx

Data Data
(raC-5_xx-xx) raC_Dvc_1756_IC16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IG16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IH16I-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_IH16ISOE-Faceplate.gfx CIP  sync Per 
point N/A

(raC-5_xx-xx) raC_Dvc_1756_IM16I-Faceplate.gfx

Data

Data
(raC-5_xx-xx) raC_Dvc_1756_IN16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IV16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_IV32-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OA16-Faceplate.gfx Timestamp 
Data

(raC-5_xx-xx) raC_Dvc_1756_OA16I-Faceplate.gfx
Data(raC-5_xx-xx) raC_Dvc_1756_OA8-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OA8D-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OA8E-Faceplate.gfx Timestamp 
Data

(raC-5_xx-xx) raC_Dvc_1756_OB16D-Faceplate.gfx Data

(raC-5_xx-xx) raC_Dvc_1756_OB16E-Faceplate.gfx Timestamp 
Data

(raC-5_xx-xx) raC_Dvc_1756_OB16I-Faceplate.gfx
Data

(raC-5_xx-xx) raC_Dvc_1756_OB16IEF-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OB16IEFS-Faceplate.gfx Schedule Per 
Point

(raC-5_xx-xx) raC_Dvc_1756_OB16IS-Faceplate.gfx
Data(raC-5_xx-xx) raC_Dvc_1756_OB32-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OB8-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1756_OB8EI-Faceplate.gfx Timestamp 
Data

(raC-5_xx-xx) raC_Dvc_1756_OB8I-Faceplate.gfx N/A Output Data
(raC-5_xx-xx) raC_Dvc_1756_OC8-Faceplate.gfx

Data

N/A

(raC-5_xx-xx) raC_Dvc_1756_OG16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_OH8I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_ON8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_OV16E-Faceplate.gfx Timestamp 

Data(raC-5_xx-xx) raC_Dvc_1756_OV32E-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1756_OW16I-Faceplate.gfx Data

FactoryTalk View xx Faceplate Connection Input / Output 
Data Data Format Coordinated 

System time Comm Format
Configure 
HART 
Device(s)
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(raC-5_xx-xx) raC_Dvc_1756_OX8I-Faceplate.gfx Data Data

N/A N/A
N/A

N/A(raC-5_xx-xx) raC_Dvc_1756sc_IC32-Faceplate.gfx
CST 
Timestamped 
Input N/A

(raC-5_xx-xx) raC_Dvc_1756_HSC-Faceplate.gfx N/A HSC data

FactoryTalk View xx Faceplate Connection Input / Output 
Data Data Format Coordinated 

System time Comm Format
Configure 
HART 
Device(s)

FactoryTalk View xx Faceplate Input / Output 
Data Output Mode

(raC-5_xx-xx) raC_Dvc_1756_IB16S_Safety-Faceplate.gfx

Safety Data

N/A
(raC-5_xx-xx) raC_Dvc_1756_OBV8S_SafetyBipolar-Faceplate.gfx Bipolar
(raC-5_xx-xx) raC_Dvc_1756_OBV8S_SafetySourcing-
Faceplate.gfx Sourcing
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1769 Compact IO Configuration

FactoryTalk View xx Faceplate Connection Data Format Mode
(raC-5_xx-xx) raC_Dvc_1769_IF16C-Faceplate.gfx

Data

Integer
N/A

(raC-5_xx-xx) raC_Dvc_1769_IF16V-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IF4-Faceplate.gfx Input
(raC-5_xx-xx) raC_Dvc_1769_IF4FXOF2F-Faceplate.gfx

Output
(raC-5_xx-xx) raC_Dvc_1769_IF4I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IF4XOF2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IF8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IR6-Faceplate.gfx

Input
(raC-5_xx-xx) raC_Dvc_1769_IT6-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OF2-Faceplate.gfx Output
(raC-5_xx-xx) raC_Dvc_1769_OF4-Faceplate.gfx Data
(raC-5_xx-xx) raC_Dvc_1769_OF4CI-Faceplate.gfx

Output
(raC-5_xx-xx) raC_Dvc_1769_OF4VI-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OF8C-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OF8V-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769sc_IF4IH-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769sc_IF8U-Faceplate.gfx

Input(raC-5_xx-xx) raC_Dvc_1769sc_IR6I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769sc_IT6I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769sc_OF4IH-Faceplate.gfx Output
(raC-5_xx-xx) raC_Dvc_1769_IG16-Faceplate.gfx

Input

(raC-5_xx-xx) raC_Dvc_1769_IM12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IQ16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IQ16F-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IQ32-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IQ32T-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_IQ6XOW4-Faceplate.gfx

Output

(raC-5_xx-xx) raC_Dvc_1769_OA16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OA8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OB16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OB16P-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OB32-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OB32T-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OB8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OG16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OV16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OV32T-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OW16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OW8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_OW8I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1769_ASCII-Faceplate.gfx Alternate
(raC-5_xx-xx) raC_Dvc_1769_HSC-Faceplate.gfx N/A
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1791ES Guard IO Safety Configuration

FactoryTalk View xx Faceplate Input Data Input Status Output Data Data Format
(raC-5_xx-xx) raC_Dvc_1791ES_IB16_Safety-Faceplate.gfx

Safety

Pt- Status None

Integer

(raC-5_xx-xx) raC_Dvc_1791ES_IB16_SafetyTestOutput-
Faceplate.gfx

Pt-Staus-
Muting -Test 
output

Test

(raC-5_xx-xx) raC_Dvc_1791ES_IB8XOBV4_Safety-Faceplate.gfx Pt-Staus-
Muting Safety

(raC-5_xx-xx) raC_Dvc_1791ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

Safety 
Readback

Pt-Staus-
Muting -Test 
output

Combined
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1794 Flex IO Configuration

FactoryTalk View xx Faceplate Connection Data Format Mode
(raC-5_xx-xx) raC_Dvc_1794_IE12-Faceplate.gfx

Data

Analog Data
N/A

(raC-5_xx-xx) raC_Dvc_1794_IE4XOE2-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IE8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IE8XOE4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IF2XOF2I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IF4I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IF4ICF-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1794_IF8IH-Faceplate.gfx Analog Data 
and Hart PV

(raC-5_xx-xx) raC_Dvc_1794_IF8IHNF-Faceplate.gfx N/A Input Data and 
HART PV

(raC-5_xx-xx) raC_Dvc_1794_IR8-Faceplate.gfx

Analog Data N/A

(raC-5_xx-xx) raC_Dvc_1794_IRT8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IT8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OE12-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OE4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OF4I-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_1794_OF8IH-Faceplate.gfx

N/A

Input Data and 
HART PV

(raC-5_xx-xx) raC_Dvc_1794sc_IF8IU-Faceplate.gfx

Data
Rack 
Optimization

Data-INT
(raC-5_xx-xx) raC_Dvc_1794sc_IRT8I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IA16-Faceplate.gfx

N/A

(raC-5_xx-xx) raC_Dvc_1794_IA8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IA8I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB10XOB6-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB16D-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB16XOB16P-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB32-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IB8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IC16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IG16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IH16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IM16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IM8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IV16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_IV32-Faceplate.gfx Data
(raC-5_xx-xx) raC_Dvc_1794_OA16-Faceplate.gfx

Output Data
Rack 
Optimization

(raC-5_xx-xx) raC_Dvc_1794_OA8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OA8I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OB16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OB16D-Faceplate.gfx Output Data

(raC-5_xx-xx) raC_Dvc_1794_OB16P-Faceplate.gfx
Output Data
Rack 
Optimization

(raC-5_xx-xx) raC_Dvc_1794_OB32P-Faceplate.gfx Output Data
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(raC-5_xx-xx) raC_Dvc_1794_OB8-Faceplate.gfx

Output Data
Rack 
Optimization N/A N/A

(raC-5_xx-xx) raC_Dvc_1794_OB8EP-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OC16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OG16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OM16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OM8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OV16-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OV16P-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OV32-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_1794_OW8-Faceplate.gfx Output Data
(raC-5_xx-xx) raC_Dvc_1794_VHSC-Faceplate.gfx Data

FactoryTalk View xx Faceplate Input / Output 
Data Output Data

(raC-5_xx-xx) raC_Dvc_5015_U8IHFTXT_Simplex-Faceplate.gfx Simplex
Analog Input (Required when 
connecting HART device as 
input)

(raC-5_xx-xx) raC_Dvc_5015_U8IHFTXT_Duplex-Faceplate.gfx Duplex
2. Analog Output (Required 
when connecting HART 
device as output)

FactoryTalk View xx Faceplate Connection Data Format Mode
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5069 Compact 5000 IO Configuration

5069 Compact 5000 IO Safety Configuration

FactoryTalk View xx Faceplate Conenction Input data/ 
Output Data Counters Channel 0 Channel 1

(raC-5_xx-xx) raC_Dvc_5069_IF8-Faceplate.gfx

Data

Analog Data
N/A

N/A N/A

(raC-5_xx-xx) raC_Dvc_5069_IY4-IR-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_OF4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_OF8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_IA16-Faceplate.gfx N/A
(raC-5_xx-xx) raC_Dvc_5069_IB16-Faceplate.gfx

Data None(raC-5_xx-xx) raC_Dvc_5069_IB16F-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_IB6F_3W-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_OA16-Faceplate.gfx N/A

N/A

(raC-5_xx-xx) raC_Dvc_5069_OB16-Faceplate.gfx
Data(raC-5_xx-xx) raC_Dvc_5069_OB16F-Faceplate.gfx

(raC-5_xx-xx) raC_Dvc_5069_OB8-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_OW16-Faceplate.gfx

N/A

(raC-5_xx-xx) raC_Dvc_5069_OW4I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_OX4I-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_5069_HSC2XOB4-Faceplate.gfx
(raC-5_xx-xx) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx Generic ASCII Generic ASCII
(raC-5_xx-xx) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx Modbus Master Modbus Master
(raC-5_xx-xx) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx Modbus Slave Modbus Slave

FactoryTalk View xx Faceplate Input / Output 
Data

Muting Lamp 
Points Output Mode

(raC-5_xx-xx) raC_Dvc_5069_IB8S_Safety-Faceplate.gfx

Safety Data

None
N/A

(raC-5_xx-xx) raC_Dvc_5069_IB8S_SafetyMuting-Faceplate.gfx Point 02 and 
03

(raC-5_xx-xx) raC_Dvc_5069_OBV8S_SafetyBipolar-Faceplate.gfx
N/A

Bipolar
(raC-5_xx-xx) raC_Dvc_5069_OBV8S_SafetySourcing-
Faceplate.gfx Sourcing
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5094 Flex 5000 IO Configuration

5094 Flex 5000 IO Safety Configuration

Library Upgrades Add-On Instruction Upgrades

There are two methods to upgrading existing device object add-on 
instructions in a project. You can do this either by using the Studio 5000 Plug-
In Import Library Objects Wizard or by importing individual add-on instruction 
AOI.L5X files. Both methods are described in the following sections.

Note that all updates to Add-On Instructions must be done with Studio 5000 
Logix Designer in OFFLINE mode and a download to the controller is required.

FactoryTalk View xx Faceplate Connection Input / Output 
Data Counters 

(raC-5_00-SE) raC_Dvc_5094_IF8-Faceplate.gfx

Data

Analog Data

N/A

(raC-5_01-SE) raC_Dvc_5094_IF8IH_HART-Faceplate.gfx Analog
(raC-5_01-SE) raC_Dvc_5094_IF8IH_PlantPAx-Faceplate.gfx Analog
(raC-5_02-SE) raC_Dvc_5094_IY8_IR-Faceplate.gfx

Analog Data
(raC-5_02-SE) raC_Dvc_5094_IY8_IT-Faceplate.gfx
(raC-5_00-SE) raC_Dvc_5094_OF8-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OF8IH_HART-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_OF8IH_PlantPAx-Faceplate.gfx
(raC-5_02-SE) raC_Dvc_5094_IA16-Faceplate.gfx N/A
(raC-5_00-SE) raC_Dvc_5094_IB16-Faceplate.gfx

Data None
(raC-5_03-SE) raC_Dvc_5094_IB32-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_5094_IM8-Faceplate.gfx N/A

N/A

(raC-5_02-SE) raC_Dvc_5094_OA16-Faceplate.gfx
Data(raC-5_03-SE) raC_Dvc_5094_OB32-Faceplate.gfx

(raC-5_03-SE) raC_Dvc_5094_OB8-Faceplate.gfx
(raC-5_01-SE) raC_Dvc_5094_HSC-Faceplate.gfx

N/A
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx

FactoryTalk View xx Faceplate Input / Output 
Data  Controlled by

(raC-5_01-SE) raC_Dvc_5094_IB16S_Safety-Faceplate.gfx
Safety Data This Controller(raC-5_01-SE) raC_Dvc_5094_OB16S_Safety-Faceplate.gfx

(raC-5_01-SE) raC_Dvc_5094_OW4IS_Safety-Faceplate.gfx
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Upgrades Using Studio 5000 Plug-In to Import Library Objects

If Studio 5000 Application Code Manager is installed, you can use the Studio 
5000 Plug-In Import Library Objects Wizard to update existing Add-On 
Instructions. For complete information on Studio 5000 Application Code 
Manager, refer to the section Using Application Code Manager.

Right-click in your controller organizer or within a routine to access Plug-Ins > 
Import Library Objects...

The Library Object Import Wizard dialogue window will open. Under Registered 
Libraries expend (RA-LIB) Device > Asset-Control and find the desired object and 
version. Drag the object into the Object Configuration window on the right.
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In the Merge Actions window, select the Action for the AddOnIntructionDefinition 
to Overwrite. This will update any existing instance of the object to the newer 
version. You may also choose to overwrite any other Data Types or Tags. 
Review the release notes of the latest library release to understand what may be 
impacted. Click next and finish to complete the process.
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• After Importing the AOI. Make sure the controller is error-free and 

download it to the controller.

Upgrades by Importing AOI.L5X Files

To upgrade or migrate a project that uses a previous library version to a newer 
one, the add-on instruction L5X files are supplied. To perform an upgrade to 
an object perform the following steps:

• Open the controller file. Note changes must be done offline.
• In the Controller Organizer pane right-click on Assets > Add-On Instructions 

and select Import Add-On Instruction. Navigate to the AOI.L5X file in the 
Studio 5000 Logix Designer Files - L5X and Open.

• You will be prompted that there is an existing version of the instruction 
that is different. Choose Overwrite as the operation and select OK once 
you have read and understood the warnings. Your existing logic will be 
updated with the new add-on instruction. Verify that your code 
compiles and test adequately.
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After Importing the AOI. The AOI references in the routine are affected and 
need to reconfigure it. 

FactoryTalk® View Upgrades

To upgrade a device object in a FactoryTalk® View ME/SE application, simply 
import the new faceplate .gfx display file into the application. If any global 
objects or images have been added or modified, you may need to import these 
as well. Any unused displays from previous versions may be removed or 
deleted from the application.

Studio 5000 View Designer® Upgrades

To upgrade a device object in a Studio 5000 View Designer® application, 
simply import the open the new View Designer .vpd file and copy the 
raC_Dvc_xxxxx_wDesc_FP pop-up screen into the existing application. Find 
any graphic symbol launch buttons in the application that open the faceplate, 
and update the Action to open the new pop-up screen. Any unused pop-up 
screens from previous versions may be removed or deleted from the 
application.
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Chapter 4

Using Application Code Manager

Overview of Application 
Code Manager

Studio 5000® Application Code Manager is a tool that enables more efficient 
project development with libraries of reusable code. Application Code 
Manager creates modular objects with customizable configuration parameters 
using the reusable content. Application Code Manager can also create the 
associated visualization, historical and alarming elements for a project.

Studio 5000® Application Code Manager can be easily used along with 
Rockwell Automation® application code libraries such as the PlantPAx® 
Process Objects Library, Machine Builder Library, and Device Object Libraries. 
For more information on Studio 5000® Application Code Manager, refer to the 
Application Code Manager User Manual.

Creating a New Project Begin by opening Application Code Manager.

Note: the last project (if any) is opened by default; otherwise a blank screen is 
displayed.

Create a New Project or open an existing project. Navigate to File > New > 
Project.

 

 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um003_-en-p.pdf
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Select the desired project type (e.g. (RA-LIB) ACM 2.00 Project - Basic_Project) 
and fill in the Name and Description.

To add a new controller to a project, in the Controller Preview window, right-
click on Controllers and select Add New...

Select the desired controller type (e.g. ControlLogix_Controller, 
GuardLogix_Controller, CompactLogix_Controller, etc). Enter a Name and 
Description for the controller. Select the appropriate Chassis and Processor 
configurations.

You can also configure the HMI AreaPath and.or AreaPathME parameters which 
will be referenced if you use Application Code Manager to generate 
FactoryTalk® View ME/SE displays with graphic symbol launch buttons.
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You can now add in any desired tasks and programs to your controller. Right-
Click on the Tasks folder underneath your controller in the Controller Preview 
and Add New Task. Similarly, right-click on any Task and select Add New 
Program. Complete the desired parameters for Tasks and Programs such as 
name, type, period, etc.
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Adding & Configuring Device 
Objects

Prior to adding in any Device Objects, ensure you have registered the library in 
Application Code Manager. Refer to Registering Libraries in Studio 5000® 
Application Code Manager for details.

Adding Communication Modules

If not already done you may need to add Communication modules to your 
Controller I/O Configuration. This will allow you add additional I/O systems 
and modules.

In the Controller Preview pane you find the I/O Configuration folder underneath 
your controller. Right-click the desired location such as the backplane or an 
existing Ethernet network and select Add New.

You may choose to click on the Category filter to easily sort and find 
Communication modules. Selected the desired Communication module and 
click Next.



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 121

          Using Application Code Manager

For new I/O chassis assign a unique ChassisName. You can also assign a unique 
IP Address and other parameters like Size, RPI, Unnicast and EnableTimeSync. 
Click Finish to complete.
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Adding I/O Modules

If an I/O chassis exists in a project then you can add I/O modules to that 
chassis. To add a new I/O module right-click on a chassis’ communications 
adapter module and Add New...

You may choose to click on the Category filter to easily sort and find Analog or 
Digital modules. Selected the desired I/O module and click Next
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Configuration parameters may very slightly depending on the I/O module. 
Perform the following configuration:

• Assign Channel Descriptions to all channels. This will be entered in the 
I/O module tag’s .@Description fields of the primary channel data tags. 
If using the HMI faceplates, it is recommended not to leave any 
descriptions blank since this will result in diagnostic events in 
FactoryTalk View.

• Assign the FPLaunch_Button_Label which set’s the I/O module tag’s 
.@Description extended tag property. This will be shown on the launch 
button if using the basic text launch buttons in FactoryTalk® View ME/
SE.

• If using FactoryTalk® View ME/SE you may assign the SEAssocDisplay 
and/or MEAssocDisplay to create a launch button with pre-defined 
Global Object Parameters. For more information onHMI Configuration 
refer to Configuring Displays. 

• Assign the desired module Slot and RPI.

• Note that there is nothing to complete on the DI/DO/AI/AO tab.
• Click Finish to complete the object configuration.

For specific devices details, refer to the appropriate chapter in this manual.
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Adding HART Devices to 50xx HART Analog Module Channels

You can optionally add HART devices to compatible HART Analog I/O 
modules. At this time, compatible I/O modules include:

• 5094-IF8IH/XT
• 5094-OF8IH/XT
• 5015-U8IHFTXT

HART devices must be added to the communications adapter module in 
Application Code Manager. Right-click on the adapter and select Add New...

You may choose to click on the Category filter to easily sort and find HART 
Device modules. Selected the desired HART Device and click Next
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In the Object Configuration Wizard of the HART Device you can assign the 
ParentModule to the Analog HART I/O module. Click ‘...’ to Select a Reference 
from the project.

Complete the device configuration by assigning the I/O Channel and adjust the 
RPI as needed.

Using HART Devices with PlantPAx PAI Instruction

To use Analog HART Modules and HART Devices in PlantPAx DCS 
Applications you must configure the PAI instruction a specific way in 
Application Code Manager. There are two ways to use the PAI instruction with 
HART Devices:

1. Analog HART Module with PV only from HART Device
2. Analog HART Module with PV/SV/TV/QV from HART Device

The two methods are as defined as follows.

1. Analog HART Module with PV only from HART Device

The PAI parameters are used as follows:
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This generates the following Studio 5000 Logix Designer® code for a 
PlantPAx® project:

ACM Parameter Usage
Inp_PV Connect to the channel of the IO module that the instrument is connected to.
Cfg_HasHART Set to True
Cfg_UseHARTScaling Set to True if you want to connect the scaling parameters from the PAH module
Cfg_ UseHARTDigitalData Not applicable, leave at default value
Hart_Type Select the HART protocol revision (Generic, Hart, Hart5, Hart6 orHart7)
Hart7_DiagTable_Selection Select the relevant Diag Table value for the instrument.
Ref_HartDevice Connect to the instrument object in ACM

 

 



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 127

          Using Application Code Manager

2. Analog HART Module with PV/SV/TV/FV from HART Device

The PAI parameters are used as follows:

In this example the SV of the HART device is mapped:

To do so, you can browse to select a reference from the device as shown below:

This generates the following Studio 5000 Logix Designer® code for a 
PlantPAx® project:

ACM Parameter Usage

Inp_PV Set this reference to the PV,SV, TV or QV of the 5094_HART_MapIO object that was 
created from the HART Device

Cfg_HasHART Set to True
Cfg_UseHARTScaling Not applicable, leave at default value
Cfg_ UseHARTDigitalData Set to True
Hart_Type Not applicable, leave at default value
Hart7_DiagTable_Selection Not applicable, leave at default value
Ref_HartDevice Not applicable, leave blank
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Configuring Displays Application Code Manager can be used to automatically configure graphic 
symbol launch buttons for device objects In FactoryTalk® View ME or SE. Note 
that Application Code Manager is not compatible with Studio 5000 View 
Designer® applications. 

First you must add Displays to your project. Under the System View panel 
expand HMI and right-click on Displays to select Add. Choose the type of 
display (e.g. FTViewME or FTViewSE depending on your project requirements.

In the display object parameter configuration, you must select the 
DisplayTemplate type to match the version of FactoryTalk® View application 
that you are using.
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Navigate to the Displays tab where you can right-click and Add New display.

Set the desired name and display parameters. Generally all display parameters 
aside from Name can be left as default since this will often be used as a 
temporary display where object launch buttons are copied from.

Return to your device object configuration and view the HMI Configuration 
section of the parameters. You can browse or type in the 
HMI_Server_Name.HMI_Display_Name.
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If you browse for the display, select the desired display server in the left panel, 
then click on the Display tab in the right panel and select the specific display. 
Click finish.

This workflow can be followed for either FactoryTalk® View ME or SE 
depending on the project requirements.

Generating Displays Once you have assigned displays to all of the device objects, you can generate 
the displays. In the System View highlight the desired display server under HMI 
> Display and right-click to select Generate Displays > All Displays or select 
individual displays. Choose a place to save the generated files and take note of 
it.

Importing Displays into 
FactoryTalk® View Studio

To import the configured displays, open your FactoryTalk® View ME/SE 
project in FactoryTalk® View Studio. Right-click on Graphic > Displays and 
select Import and Export...

Follow the required prompts:
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• Import graphic information into displays
• Choose whether or not to backup displays
• Choose either a Single display import file (must have an existing or blank 

display to import into) or Multiple displays batch import file if All Displays 
was used to Generate Displays.

• If this is the first time it is recommended to import Multiple displays 
batch import file and then Create new objects on the display.

• If you have done this before and are updating the imported display 
after modifying your Application Code Manager project, you can 
choose Update existing objects on the display. 

• Browse for the BatchImport.xml file or individual display.xml file.

Open up the newly imported display. Notice that there are graphic symbol 
launch buttons labeled and configured for each item that was configured in 
Application Code Manager.

Right-click on the object and select Global Object Parameters to view that all of 
the parameters have been pre-configured for you.

You may not copy and paste this graphic symbol onto any other display in your 
application.

Generating Controller Files Once you have completed configuring your project in Studio 5000® 
Application Code Manager, you can generate the controller file for use in 
Studio 5000 Logix Designer®.

In the Controller Preview pane right-click on the controller name within the 
Controllers folder and select Generate Controller.

In the Logix Code Generation dialogue window you will need to check Create 
ACD. You ma also need to check Overwrite Existing if this is not the first time 
generating the controller code.
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Once the controller file is generated, you can navigate to the location set in 
Save Path and open your file. Note that all of the configuration that was done in 
Application Code Manager is now shown in your Logix Designer ACD file.

Exporting Attachments Application Code Libraries not only contain Logix code, but also contain 
Visualization collateral and associated documentation. Every Asset library 
contains at least a reference manual (RM). Those libraries which have 
associated Visualization content also have all required global objects (GO), 
images, static displays and View Designer applications added as attachments. 
In this manner the user can generate only the necessary visualization and 
documentation for the objects included in the project.

To access the attached files, right click on the Controller in Class View and 
select Extract Attached Files.
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Select the destination folder on your computer, and select OK. An Extract 
Attachments dialog will show the extraction status.

The extracted folder will contain the following:
• Reference Manual
• Required Images
• View Designer Faceplate Files
• FactoryTalk® View Machine Edition Displays
• FactoryTalk® View Machine Edition Global Objects
• FactoryTalk® View Site Edition Displays
• FactoryTalk® View Site Edition Global Objects
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Chapter 5

Using the IO Device Library with Other Application 
Code Libraries

Application Code Libraries The IO Device Library is can be used alongside other Application Code 
Libraries. 

The Machine Builder Library and PlantPAx® Process Object Library 
application-level library objects may be used in the same applications with the 
module objects in the IO Device Library. This allows you to map application 
instruction I/O tags to I/O module channels in your project.

The IO Device Library is also used with the Safety Device Library for safety 
applications to allow mapping safety instructions to I/O module channel tags.
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Chapter 6

Digital Input Modules

Overview Digital input module objects include Studio 5000® Application Code Manager 
modules and HMI faceplates for FactoryTalk® View ME/SE and Studio 5000 
View Designer®. HMI faceplates provide the following information:

• Module description, status, and faults
• Channel description, status and faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module FactoryTalk® View SE Faceplate FactoryTalk® View ME Faceplate

1719
1719-IBN8 (raC-5_00-SE) raC_Dvc_1719_IBN8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IBN8-Faceplate.gfx

1719-IBN8B (raC-5_00-SE) raC_Dvc_1719_IBN8B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IBN8B-Faceplate.gfx
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1732E

1732E-IB16M12 (raC-5_00-SE) raC_Dvc_1732E_IB16M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12-Faceplate.gfx

1732E-IB16M12R (raC-5_00-SE) raC_Dvc_1732E_IB16M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12R-Faceplate.gfx

1732E-IB16M12W (raC-5_00-SE) raC_Dvc_1732E_IB16M12W-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB16M12W-Faceplate.gfx

1732E-IB8M8SOER (raC-5_00-SE) raC_Dvc_1732E_IB8M8SOER-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IB8M8SOER-Faceplate.gfx

1734

1734-IA2 (raC-5_00-SE) raC_Dvc_1734_IA2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IA2-Faceplate.gfx

1734-IA4 (raC-5_00-SE) raC_Dvc_1734_IA4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IA4-Faceplate.gfx

1734-IB2 (raC-5_00-SE) raC_Dvc_1734_IB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB2-Faceplate.gfx

1734-IB4 (raC-5_00-SE) raC_Dvc_1734_IB4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB4-Faceplate.gfx

1734-IB8 (raC-5_00-SE) raC_Dvc_1734_IB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IB8-Faceplate.gfx

1734-IM2 (raC-5_00-SE) raC_Dvc_1734_IM2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IM2-Faceplate.gfx

1734-IM4 (raC-5_00-SE) raC_Dvc_1734_IM4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IM4-Faceplate.gfx

1734-IV2 (raC-5_00-SE) raC_Dvc_1734_IV2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV2-Faceplate.gfx

1734-IV4 (raC-5_00-SE) raC_Dvc_1734_IV4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV4-Faceplate.gfx

1734-8CFG (raC-5_03-SE) raC_Dvc_1734_8CFG-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734_8CFG-Faceplate.gfx

1734-IV8 (raC-5_00-SE) raC_Dvc_1734_IV8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IV8-Faceplate.gfx

1738

1738-IA2M12AC3 (raC-5_00-SE) raC_Dvc_1738_IA2M12AC3-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IA2M12AC3-Faceplate.gfx

1738-IA2M12AC4 (raC-5_00-SE) raC_Dvc_1738_IA2M12AC4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IA2M12AC4-Faceplate.gfx

1738-IB2M12 (raC-5_00-SE) raC_Dvc_1738_IB2M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB2M12-Faceplate.gfx

1738-IB4M12 (raC-5_00-SE) raC_Dvc_1738_IB4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB4M12-Faceplate.gfx

1738-IB4M8 (raC-5_00-SE) raC_Dvc_1738_IB4M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB4M8-Faceplate.gfx

1738-IB8M12 (raC-5_00-SE) raC_Dvc_1738_IB8M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M12-Faceplate.gfx

1738-IB8M23 (raC-5_00-ME) raC_Dvc_1738_IB8M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M23-Faceplate.gfx

1738-IB8M8 (raC-5_00-SE) raC_Dvc_1738_IB8M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IB8M8-Faceplate.gfx

1738-IV4M12 (raC-5_00-SE) raC_Dvc_1738_IV4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV4M12-Faceplate.gfx

1738-IV8M12 (raC-5_00-SE) raC_Dvc_1738_IV8M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M12-Faceplate.gfx

1738-IV8M23 (raC-5_00-SE) raC_Dvc_1738_IV8M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M23-Faceplate.gfx

1738-IV8M8 (raC-5_00-SE) raC_Dvc_1738_IV8M8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IV8M8-Faceplate.gfx

1756

1756-IA16 (raC-5_00-SE) raC_Dvc_1756_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA16-Faceplate.gfx

1756-IA16I (raC-5_00-SE) raC_Dvc_1756_IA16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA16I-Faceplate.gfx

1756-IA32 (raC-5_00-SE) raC_Dvc_1756_IA32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IA32-Faceplate.gfx

1756-IB16 (raC-5_00-SE) raC_Dvc_1756_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB16-Faceplate.gfx

1756-IB16I (raC-5_00-SE) raC_Dvc_1756_IB16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB16I-Faceplate.gfx

1756-IB32 (raC-5_00-SE) raC_Dvc_1756_IB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IB32-Faceplate.gfx

1756-IC16 (raC-5_00-SE) raC_Dvc_1756_IC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IC16-Faceplate.gfx

1756-IG16 (raC-5_00-SE) raC_Dvc_1756_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IG16-Faceplate.gfx

1756-IH16I (raC-5_00-SE) raC_Dvc_1756_IH16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IH16I-Faceplate.gfx

1756-IM16I (raC-5_00-SE) raC_Dvc_1756_IM16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IM16I-Faceplate.gfx

1756-IN16 (raC-5_00-SE) raC_Dvc_1756_IN16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IN16-Faceplate.gfx

1756-IV16 (raC-5_00-SE) raC_Dvc_1756_IV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IV16-Faceplate.gfx

1756-IV32 (raC-5_00-SE) raC_Dvc_1756_IV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IV32-Faceplate.gfx

1756-IB16IF (raC-5_02-SE) raC_Dvc_1756_IB16IF-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IB16IF-Faceplate.gfx

1756-IB16ISOE (raC-5_01-SE) raC_Dvc_1756_IB16ISOE-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16ISOE-Faceplate.gfx

1756sc-IC32 (raC-5_02-SE) raC_Dvc_1756sc_IC32-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756sc_IC32-Faceplate.gfx

Family Module FactoryTalk® View SE Faceplate FactoryTalk® View ME Faceplate
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

1769

1769-IA16 (raC-5_02-SE) raC_Dvc_1769_IA16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769_IA16-Faceplate.gfx

1769-IA8I (raC-5_00-SE) raC_Dvc_1769_IA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IA8I-Faceplate.gfx

1769-IG16 (raC-5_00-SE) raC_Dvc_1769_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IG16-Faceplate.gfx

1769-IM12 (raC-5_00-SE) raC_Dvc_1769_IM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IM12-Faceplate.gfx

1769-IQ16 (raC-5_00-SE) raC_Dvc_1769_IQ16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ16-Faceplate.gfx

1769-IQ16F (raC-5_00-SE) raC_Dvc_1769_IQ16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ16F-Faceplate.gfx

1769-IQ32 (raC-5_00-SE) raC_Dvc_1769_IQ32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ32-Faceplate.gfx

1769-IQ32T (raC-5_00-SE) raC_Dvc_1769_IQ32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ32T-Faceplate.gfx

1769-IQ6XOW4 (raC-5_00-SE) raC_Dvc_1769_IQ6XOW4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IQ6XOW4-Faceplate.gfx

1794

1794-IA16 (raC-5_00-SE) raC_Dvc_1794_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA16-Faceplate.gfx

1794-IA8 (raC-5_00-SE) raC_Dvc_1794_IA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA8-Faceplate.gfx

1794-IA8I (raC-5_00-SE) raC_Dvc_1794_IA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IA8I-Faceplate.gfx

1794-IB10XOB6 (raC-5_02-SE) raC_Dvc_1794_IB10XOB6-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB10XOB6-Faceplate.gfx

1794-IB16 (raC-5_00-SE) raC_Dvc_1794_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB16-Faceplate.gfx

1794-IB16XOB16P (raC-5_02-SE) raC_Dvc_1794_IB16XOB16P-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB16XOB16P-Faceplate.gfx

1794-IB32 (raC-5_00-SE) raC_Dvc_1794_IB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB32-Faceplate.gfx

1794-IB8 (raC-5_00-SE) raC_Dvc_1794_IB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IB8-Faceplate.gfx

1794-IC16 (raC-5_00-SE) raC_Dvc_1794_IC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IC16-Faceplate.gfx

1794-IG16 (raC-5_00-SE) raC_Dvc_1794_IG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IG16-Faceplate.gfx

1794-IH16 (raC-5_00-SE) raC_Dvc_1794_IH16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IH16-Faceplate.gfx

1794-IM16 (raC-5_00-SE) raC_Dvc_1794_IM16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IM16-Faceplate.gfx

1794-IM8 (raC-5_00-SE) raC_Dvc_1794_IM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IM8-Faceplate.gfx

1794-IV16 (raC-5_00-SE) raC_Dvc_1794_IV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IV16-Faceplate.gfx

1794-IV32 (raC-5_00-SE) raC_Dvc_1794_IV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IV32-Faceplate.gfx

5069

5069-IA16 (raC-5_00-SE) raC_Dvc_5069_IA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IA16-Faceplate.gfx

5069-IB6F-3W (raC-5_00-ME) raC_Dvc_5069_IB6F_3W-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB6F_3W-Faceplate.gfx

5069-IB16 (raC-5_00-SE) raC_Dvc_5069_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB16-Faceplate.gfx

5069-IB16F (raC-5_00-SE) raC_Dvc_5069_IB16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IB16F-Faceplate.gfx

5094

5094-IB16 (raC-5_00-SE) raC_Dvc_5094_IB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_IB16-Faceplate.gfx

5094-IA16 (raC-5_02-SE) raC_Dvc_5094_IA16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IA16-Faceplate.gfx

5094-IB32 (raC-5_03-SE) raC_Dvc_5094_IB32-Faceplate.gfx (raC-5_03-ME) raC_Dvc_5094_IB32-Faceplate.gfx

5094-IM8 (raC-5_03-SE) raC_Dvc_5094_IM8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IM8-Faceplate.gfx

Family Module FactoryTalk® View SE Faceplate FactoryTalk® View ME Faceplate

Family View Designer File Module View Designer Screen

1719 raC_Dvc_1719IO_wDesc.v
pd

1719-IBN8 raC_Dvc_1719-IBN8_wDesc_FP

1719-IBN8B raC_Dvc_1719-IBN8B_wDesc_FP
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1732E raC_Dvc_1732IO_wDesc.v
pd

1732E-IB16M12 raC_Dvc_1732E-IB16M12_wDesc_FP

1732E-IB16M12R raC_Dvc_1732E-IB16M12R_wDesc_FP

1732E-IB16M12W raC_Dvc_1732E-IB16M12W_wDesc_FP

1732E-IB8M8SOER raC_Dvc_1732E-IB8M8SOER_wDesc_FP

1734 raC_Dvc_1734IO_wDesc.v
pd

1734-IA2 raC_Dvc_1734-IA2_wDesc_FP

1734-IA4 raC_Dvc_1734-IA4_wDesc_FP

1734-IB2 raC_Dvc_1734-IB2_wDesc_FP

1734-IB4 raC_Dvc_1734-IB4_wDesc_FP

1734-IB8 raC_Dvc_1734-IB8_wDesc_FP

1734-IM2 raC_Dvc_1734-IM2_wDesc_FP

1734-IM4 raC_Dvc_1734-IM4_wDesc_FP

1734-IV2 raC_Dvc_1734-IV5_wDesc_FP

1734-IV4 raC_Dvc_1734-IV4_wDesc_FP

1734-IV8 raC_Dvc_1734-IV8_wDesc_FP

1738 raC_Dvc_1738IO_wDesc.v
pd

1738-IA2M12AC3 raC_Dvc_1738-IA2M12AC3_wDesc_FP

1738-IA2M12AC4 raC_Dvc_1738-IA2M12AC4_wDesc_FP

1738-IB2M12 raC_Dvc_1738-IB2M12_wDesc_FP

1738-IB4M12 raC_Dvc_1738-IB4M12_wDesc_FP

1738-IB4M8 raC_Dvc_1738-IB4M8_wDesc_FP

1738-IB8M12 raC_Dvc_1738-IB8M12_wDesc_FP

1738-IB8M23 raC_Dvc_1738-IB8M23_wDesc_FP

1738-IB8M8 raC_Dvc_1738-IB8M8_wDesc_FP

1738-IV4M12 raC_Dvc_1738-IV4M12_wDesc_FP

1738-IV8M12 raC_Dvc_1738-IV8M12_wDesc_FP

1738-IV8M23 raC_Dvc_1738-IV8M23_wDesc_FP

1738-IV8M8 raC_Dvc_1738-IV8M8_wDesc_FP

1756 raC_Dvc_1756IO_wDesc.v
pd

1756-IA16 raC_Dvc_1756-IA16_wDesc_FP

1756-IA16I raC_Dvc_1756-IA16I_wDesc_FP

1756-IA32 raC_Dvc_1756-IA32_wDesc_FP

1756-IB16 raC_Dvc_1756-IB16_wDesc_FP

1756-IB16I raC_Dvc_1756-IB16I_wDesc_FP

1756-IB16ISOE raC_Dvc_1756-IB16ISOE_wDesc_FP

1756-IB16IF raC_Dvc_1756-IB16IF_wDesc_FP

1756-IB32 raC_Dvc_1756-IB32_wDesc_FP

1756-IC16 raC_Dvc_1756-IC16_wDesc_FP

1756-IG16 raC_Dvc_1756-IG16_wDesc_FP

1756-IH16I raC_Dvc_1756-IH16I_wDesc_FP

1756-IB16ISOE raC_Dvc_1756-IB16ISOE_wDesc_FP

1756-IM16I raC_Dvc_1756-IM16I_wDesc_FP

1756-IN16 raC_Dvc_1756-IN16_wDesc_FP

1756-IV16 raC_Dvc_1756-IV16_wDesc_FP

1756-IV32 raC_Dvc_1756-IV32_wDesc_FP

Family View Designer File Module View Designer Screen
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

1769 raC_Dvc_1769IO_wDesc.v
pd

1769-IA16 raC_Dvc_1769-IA16_wDesc_FP

1769-IA8I raC_Dvc_1769-IA8I_wDesc_FP

1769-IG16 raC_Dvc_1769-IG16_wDesc_FP

1769-IM12 raC_Dvc_1769-IM12_wDesc_FP

1769-IQ16 raC_Dvc_1769-IQ16_wDesc_FP

1769-IQ16F raC_Dvc_1769-IQ16F_wDesc_FP

1769-IQ32 raC_Dvc_1769-IQ32_wDesc_FP

1769-IQ32T raC_Dvc_1769-IQ32T_wDesc_FP

1769-IQ6XOW4 raC_Dvc_1769-IQ6XOW4_wDesc_FP

1794 raC_Dvc_1794IO_wDesc.v
pd

1794-IA16 raC_Dvc_1794-IA16_wDesc_FP

1794-IA8 raC_Dvc_1794-IA8_wDesc_FP

1794-IA8I raC_Dvc_1794-IA8I_wDesc_FP

1794-IB10XOB6 raC_Dvc_1794-IB10XOB6_wDesc_FP

1794-IB16 raC_Dvc_1794-IB16_wDesc_FP

1794-IB16XOB16P raC_Dvc_1794-IB16XOB16P_wDesc_FP

1794-IB32 raC_Dvc_1794-IB32_wDesc_FP

1794-IB8 raC_Dvc_1794-IB8_wDesc_FP

1794-IC16 raC_Dvc_1794-IC16_wDesc_FP

1794-IG16 raC_Dvc_1794-IG16_wDesc_FP

1794-IH16 raC_Dvc_1794-IH16_wDesc_FP

1794-IM16 raC_Dvc_1794-IM16_wDesc_FP

1794-IM8 raC_Dvc_1794-IM8_wDesc_FP

1794-IV16 raC_Dvc_1794-IV16_wDesc_FP

1794-IV32 raC_Dvc_1794-IV32_wDesc_FP

5069 raC_Dvc_5069IO_wDesc.
vpd

5069-IA16 raC_Dvc_5069-IA16_wDesc_FP

5069-IB6F-3W raC_Dvc_5069-IB6F-3W_wDesc_FP

5069-IB16 raC_Dvc_5069-IB16_wDesc_FP

5069-IB16F raC_Dvc_5069-IB16F_wDesc_FP

5094 raC_Dvc_5094IO_wDesc.
vpd

5094-IB16 raC_Dvc_5094-IB16_wDesc_FP

5094-IM8 raC_Dvc_5094_IM8_wDesc_FP

5094-IB32 raC_Dvc_5094_IB32_wDesc_FP

5094-IA16 raC_Dvc_5094_IA16_wDesc_FP

Family View Designer File Module View Designer Screen
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Family Module Application Code Manager File

1719
1719-IBN8 (RA-LIB)_ACM_2.00_Module_Digital_1719-IBN8_(5.3).HSL4

1719-IBN8B (RA-LIB)_ACM_2.00_Module_Digital_1719-IBN8B_(5.3).HSL4

1732E

1732E-IB16M12 (RA-LIB)_ACM_2.00_Module_Digital_1732E-IB16M12_A_(5.3).HSL4

1732E-IB16M12W (RA-LIB)_ACM_2.00_Module_Digital_1732E-IB16M12W_A_(5.3).HSL4

1732E-IB16M12R (RA-LIB)_ACM_2.00_Module_Digital_1732E-IB16M12R_B_(5.3).HSL4

1732E-IB8M8SOER (RA-LIB)_ACM_2.00_Module_Digital_1732E-IB8M8SOER_A_(5.3).HSL4

1734

1734-IA2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IA2_C_(5.3).HSL4

1734-IA4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IA4_C_(5.3).HSL4

1734-IB2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB2_C_(5.3).HSL4

1734-IB4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB4_C_(5.3).HSL4

1734-IB8 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB8_C_(5.3).HSL4

1734-IM2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IM2_C_(5.3).HSL4

1734-IM4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IM4_C_(5.3).HSL4

1734-IV2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV2_C_(5.3).HSL4

1734-IV4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV4_C_(5.3).HSL4

1734-IV8 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV8_C_(5.3).HSL4

1734-8CFG (RA-LIB)_ACM_2.00_Module_Digital_1734-8CFG_C_(5.3).HSL4

1738

1738-IA2M12AC3 (RA-LIB)_ACM_2.00_Module_Digital_1738-IA2M12AC3_A_(5.3).HSL4

1738-IA2M12AC4 (RA-LIB)_ACM_2.00_Module_Digital_1738-IA2M12AC4_A_(5.3).HSL4

1738-IB2M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB2M12_A_(5.3).HSL4

1738-IB4M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB4M12_A_(5.3).HSL4

1738-IB4M8 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB4M8_A_(5.3).HSL4

1738-IB8M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M12_A_(5.3).HSL4

1738-IB8M23 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M23_A_(5.3).HSL4

1738-IB8M8 (RA-LIB)_ACM_2.00_Module_Digital_1738-IB8M8_A_(5.3).HSL4

1738-IV4M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-IV4M12_A_(5.3).HSL4

1738-IV8M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M12_A_(5.3).HSL4

1738-IV8M23 (RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M23_A_(5.3).HSL4

1738-IV8M8 (RA-LIB)_ACM_2.00_Module_Digital_1738-IV8M8_A_(5.3).HSL4

1756

1756-IA16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IA16_(5.3).HSL4

1756-IA16I (RA-LIB)_ACM_2.00_Module_Digital_1756-IA16I_(5.3).HSL4

1756-IA32 (RA-LIB)_ACM_2.00_Module_Digital_1756-IA32_A_(5.3).HSL4

1756-IB16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16_(5.3).HSL4

1756-IB16I (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16I_(5.3).HSL4

1756-IB32 (RA-LIB)_ACM_2.00_Module_Digital_1756-IA32_A_(5.3).HSL4

1756-IC16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IC16_(5.3).HSL4

1756-IG16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IG16_A_(5.3).HSL4

1756-IH16I (RA-LIB)_ACM_2.00_Module_Digital_1756-IH16I_(5.3).HSL4

1756-IM16I (RA-LIB)_ACM_2.00_Module_Digital_1756-IM16I_(5.3).HSL4

1756-IN16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IN16_(5.3).HSL4

1756-IV16 (RA-LIB)_ACM_2.00_Module_Digital_1756-IV16_A_(5.3).HSL4

1756sc-IC32 (RA-LIB)_ACM_2.00_Module_Digital_1756sc-IC32_A_(5.3).HSL4

1756-IB16IF (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16IF_A_(5.3).HSL4

1756-IB16ISOE (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16ISOE_A_(5.3).HSL4

1756-IH16ISOE (RA-LIB)_ACM_2.00_Module_Digital_1756-IH16ISOE_A_(5.3).HSL4

1756-IV32 (RA-LIB)_ACM_2.00_Module_Digital_1756-IV32_A_(5.3).HSL4
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

1769

1769-IA16 (RA-LIB)_ACM_2.00_Module_Digital_1769-IA16_A_(5.3).HSL4

1769-IA8I (RA-LIB)_ACM_2.00_Module_Digital_1769-IA8I_(5.3).HSL4

1769-IG16 (RA-LIB)_ACM_2.00_Module_Digital_1769-IG16_A_(5.3).HSL4

1769-IM12 (RA-LIB)_ACM_2.00_Module_Digital_1769-IM12_A_(5.3).HSL4

1769-IQ16 (RA-LIB)_ACM_2.00_Module_Digital_1769-IQ16_A_(5.3).HSL4

1769-IQ16F (RA-LIB)_ACM_2.00_Module_Digital_1769-IQ16F_A_(5.3).HSL4

1769-IQ32 (RA-LIB)_ACM_2.00_Module_Digital_1769-IQ32_A_(5.3).HSL4

1769-IQ32T (RA-LIB)_ACM_2.00_Module_Digital_1769-IQ32T_A_(5.3).HSL4

1769-IQ6XOW4 (RA-LIB)_ACM_2.00_Module_Digital_1769-IQ6XOW4_B_(5.3).HSL4

1794

1794-IA16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IA16_A_(5.3).HSL4

1794-IA8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IA8_A_(5.3).HSL4

1794-IA8I (RA-LIB)_ACM_2.00_Module_Digital_1794-IA8I_A_(5.3).HSL4

1794-IB10XOB6 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB10XOB6_A_(5.3).HSL4

1794-IB16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB16_A_(5.3).HSL4

1794-IB16XOB16P (RA-LIB)_ACM_2.00_Module_Digital_1794-IB16XOB16P_A_(5.3).HSL4

1794-IB32 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB32_A_(5.3).HSL4

1794-IB8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB8_A_(5.3).HSL4

1794-IC16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IC16_A_(5.3).HSL4

1794-IG16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IG16_A_(5.3).HSL4

1794-IH16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IH16_A_(5.3).HSL4

1794-IM16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IM16_A_(5.3).HSL4

1794-IM8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IM8_A_(5.3).HSL4

1794-IV16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IV16_A_(5.3).HSL4

1794-IV32 (RA-LIB)_ACM_2.00_Module_Digital_1794-IV32_A_(5.3).HSL4

5069

5069-IA16 (RA-LIB)_ACM_2.00_Module_Digital_5069-IA16_A_(5.3).HSL4

5069-IB6F-3W (RA-LIB)_ACM_2.00_Module_Digital_5069-IB6F-3W_A_(5.3).HSL4

5069-IB16 (RA-LIB)_ACM_2.00_Module_Digital_5069-IB16_A_(5.3).HSL4

5069-IB16F (RA-LIB)_ACM_2.00_Module_Digital_5069-IB16F_A_(5.3).HSL4

5094

5094-IB16 (RA-LIB)_ACM_2.00_Module_Digital_5094-IB16_A_(5.3).HSL4

5094-IB16XT (RA-LIB)_ACM_2.00_Module_Digital_5094-IB16XT_A_(5.3).HSL4

5094-IA16 (RA-LIB)_ACM_2.00_Module_Digital_5094-IA16_A_(5.3).HSL4

5094-IA16XT (RA-LIB)_ACM_2.00_Module_Digital_5094-IA16XT_A_(5.3).HSL4

5094-IB32 (RA-LIB)_ACM_2.00_Module_Digital_5094-IB32_A_(5.3).HSL4

5094-IB32XT (RA-LIB)_ACM_2.00_Module_Digital_5094-IB32XT_A_(5.3).HSL4

5094-IM8 (RA-LIB)_ACM_2.00_Module_Digital_5094-IM8_A_(5.3).HSL4

5094-IM8XT (RA-LIB)_ACM_2.00_Module_Digital_5094-IM8XT_A_(5.3).HSL4

Family Module Application Code Manager File
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_1794 Use with 1794 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_5094 Use with 5094 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchIn_Armor Use with 1732E/1738 Digital Input Only Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position
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Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_1794 Use with 1794 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_5094 Use with 5094 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchIn_Armor Use with 1732E/1738 Digital Input Only Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes for more information.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual I.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The main tab of the faceplate is the Home tab, which displays information 
regarding the I/O channels and faults. The banner at the top of the faceplate 
displays module status and fault information.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

1

2

7

6

3

4

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Data.x.@Description
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Module Object Parameters

Each module object (e.g. 1756-IB16F) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button Type

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules

Launch Button GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

Launch Button GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules

Launch Button GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules

Launch Button GO_Launch_DCIn_1794 Use with 1794 DC Input Modules

Launch Button GO_Launch_DCIn_5094 Use with 5094 DC Input Modules

Launch Button GO_LaunchACIn_1794 Use with 1794 AC Input Modules

Launch Button GO_LaunchACIn_5094 Use with 5094 AC Input Modules

Launch Button GO_LaunchIn_Armor Use with 1732E/1738 Digital Input Only Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 
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V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\

 Name Description File Name Extraction Path
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Digital Input Diagnostic Modules

Overview Digital input diagnostic module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, status and detailed faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1756
1756-IA8D (raC-5_03-SE) raC_Dvc_1756_IA8D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IA8D-Faceplate.gfx

1756-IB16D (raC-5_01-SE) raC_Dvc_1756_IB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16D-Faceplate.gfx
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

1734 1734-IB4D (raC-5_03-SE) raC_Dvc_1734_IB4D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IB4D-Faceplate.gfx

1794 1794-IB16D (raC-5_01-SE) raC_Dvc_1794_IB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_IB16D-Faceplate.gfx

1715 1715-IB16D (raC-5_01-SE) raC_Dvc_1715_IB16D_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IB16D_Simplex-Faceplate.gfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

Family View Designer File Module View Designer Screen

1756 raC_Dvc_1756IO_wDesc.vpd
1756-IA8D raC_Dvc_1756-IA8D_wDesc_FP

1756-IB16D raC_Dvc_1756-IB16D_wDesc_FP

1734 raC_Dvc_1734IO_wDesc.vpd 1734-IB4D raC_Dvc_1734-IB4D_wDesc_FP

1794 raC_Dvc_1794IO_wDesc.vpd 1794-IB16D raC_Dvc_1794-IB16D_wDesc_FP

1715 raC_Dvc_1715IO_wDesc.vpd 1715-IB16D raC_Dvc_1715-IB16D_Simplex_wDesc_FP

Family Module Application Code Manager File

1756
1756-IA8D (RA-LIB)_ACM_2.00_Module_Digital_1756-IA8D_(5.3).HSL4

1756-IB16D (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16D_(5.3).HSL4

1734 1734-IB4D (RA-LIB)_ACM_2.00_Module_Digital_1734-IB4D_C_(5.3).HSL4

1794 1794-IB16D (RA-LIB)_ACM_2.00_Module_Digital_1794-IB16D_A_(5.3).HSL4

1715 1715-IB16D (RA-LIB)_ACM_2.00_Module_Digital_1715-IB16D_A_(5.3).HSL4
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_1794 Use with 1794 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_5094 Use with 5094 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes for more information.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_1794 Use with 1794 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_5094 Use with 5094 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual I.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

1

2

7

6

3

4

5

8

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Data.x.@Description

8

Channel Fault Description:
-Open Wire
- Fault
- Short Circuit (1715 only)
- Indeterminate (1715 Only)
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Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-IB16D) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button Type

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules

Launch Button GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

Launch Button GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules

Launch Button GO_LaunchACIn_50xx Use with 1719/5069/5015 AC Input Modules

Launch Button GO_Launch_DCIn_1794 Use with 1794 DC Input Modules

Launch Button GO_Launch_DCIn_5094 Use with 5094 DC Input Modules
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Attachments

Launch Button GO_LaunchACIn_1794 Use with 1794 AC Input Modules

Launch Button GO_LaunchACIn_5094 Use with 5094 AC Input Modules

Launch Button GO_LaunchIn_Armor Use with 1732E/1738 Digital Input Only Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Overview Digital Output module objects include Studio 5000® Application Code 
Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, status and faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1719
1719-OB2 (raC-5_00-SE) raC_Dvc_1719_OB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_OB2-Faceplate.gfx
1719-OB2L (raC-5_00-SE) raC_Dvc_1719_OB2L-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_OB2L-Faceplate.gfx

1732E
1732E-OB16M12 (raC-5_00-SE) raC_Dvc_1732E_OB16M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB16M12-Faceplate.gfx
1732E-OB16M12R (raC-5_00-SE) raC_Dvc_1732E_OB16M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB16M12R-Faceplate.gfx
1732E-OB8M8SR (raC-5_00-SE) raC_Dvc_1732E_OB8M8SR-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OB8M8SR-Faceplate.gfx

1734

1734-OA2 (raC-5_00-SE) raC_Dvc_1734_OA2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OA2-Faceplate.gfx
1734-OA4 (raC-5_00-SE) raC_Dvc_1734_OA4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OA4-Faceplate.gfx
1734-OB2 (raC-5_00-SE) raC_Dvc_1734_OB2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2-Faceplate.gfx
1734-OB2E (raC-5_00-SE) raC_Dvc_1734_OB2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2E-Faceplate.gfx
1734-OB2EP (raC-5_00-SE) raC_Dvc_1734_OB2EP-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB2EP-Faceplate.gfx
1734-OB4 (raC-5_00-SE) raC_Dvc_1734_OB4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB4-Faceplate.gfx
1734-OB4E (raC-5_00-SE) raC_Dvc_1734_OB4E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB4E-Faceplate.gfx
1734-OB8 (raC-5_00-SE) raC_Dvc_1734_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB8-Faceplate.gfx
1734-OB8E (raC-5_00-SE) raC_Dvc_1734_OB8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OB8E-Faceplate.gfx
1734-OV2E (raC-5_00-SE) raC_Dvc_1734_OV2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV2E-Faceplate.gfx
1734-OV4E (raC-5_00-SE) raC_Dvc_1734_OV4E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV4E-Faceplate.gfx
1734-OV8E (raC-5_00-SE) raC_Dvc_1734_OV8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OV8E-Faceplate.gfx
1734-OW2 (raC-5_00-SE) raC_Dvc_1734_OW2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OW2-Faceplate.gfx
1734-OW4 (raC-5_00-SE) raC_Dvc_1734_OW4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OW4-Faceplate.gfx
1734-OX2 (raC-5_00-SE) raC_Dvc_1734_OX2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OX2-Faceplate.gfx

1738

1738-OA2M12AC3 (raC-5_00-SE) raC_Dvc_1738_OA2M12AC3-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OA2M12AC3-Faceplate.gfx
1738-OB16E19M23 (raC-5_00-SE) raC_Dvc_1738_OB16E19M23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16E19M23-Faceplate.gfx
1738-OB16E25DS (raC-5_00-SE) raC_Dvc_1738_OB16E25DS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16E25DS-Faceplate.gfx
1738-OB16EM12 (raC-5_00-SE) raC_Dvc_1738_OB16EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB16EM12-Faceplate.gfx
1738-OB2EM12 (raC-5_00-SE) raC_Dvc_1738_OB2EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB2EM12-Faceplate.gfx
1738-OB2EPM12 (raC-5_00-SE) raC_Dvc_1738_OB2EPM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB2EPM12-Faceplate.gfx
1738-OB4EM12 (raC-5_00-SE) raC_Dvc_1738_OB4EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB4EM12-Faceplate.gfx
1738-OB4EM8 (raC-5_00-SE) raC_Dvc_1738_OB4EM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB4EM8-Faceplate.gfx
1738-OB8EM12 (raC-5_00-SE) raC_Dvc_1738_OB8EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM12-Faceplate.gfx
1738-OB8EM23 (raC-5_00-SE) raC_Dvc_1738_OB8EM23-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM23-Faceplate.gfx
1738-OB8EM8 (raC-5_00-SE) raC_Dvc_1738_OB8EM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OB8EM8-Faceplate.gfx
1738-OV4EM12 (raC-5_00-SE) raC_Dvc_1738_OV4EM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OV4EM12-Faceplate.gfx
1738-OW4M12 (raC-5_00-SE) raC_Dvc_1738_OW4M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OW4M12-Faceplate.gfx
1738-OW4M12AC4 (raC-5_00-SE) raC_Dvc_1738_OW4M12AC4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OW4M12AC4-Faceplate.gfx
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1756

1756-OA16 (raC-5_00-SE) raC_Dvc_1756_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA16-Faceplate.gfx
1756-OA16I (raC-5_00-SE) raC_Dvc_1756_OA16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA16I-Faceplate.gfx
1756-OA8E (raC-5_00-SE) raC_Dvc_1756_OA8E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OA8E-Faceplate.gfx
1756-OB16E (raC-5_00-SE) raC_Dvc_1756_OB16E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16E-Faceplate.gfx
1756-OB16I (raC-5_00-SE) raC_Dvc_1756_OB16I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16I-Faceplate.gfx
1756-OB16IEF (raC-5_00-SE) raC_Dvc_1756_OB16IEF-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16IEF-Faceplate.gfx
1756-OB16IEFS (raC-5_00-SE) raC_Dvc_1756_OB16IEFS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB16IEFS-Faceplate.gfx
1756-OB32 (raC-5_00-SE) raC_Dvc_1756_OB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB32-Faceplate.gfx
1756-OB8 (raC-5_00-SE) raC_Dvc_1756_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8-Faceplate.gfx
1756-OB8EI (raC-5_00-SE) raC_Dvc_1756_OB8EI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8EI-Faceplate.gfx
1756-OB8I (raC-5_00-SE) raC_Dvc_1756_OB8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OB8I-Faceplate.gfx
1756-OC8 (raC-5_00-SE) raC_Dvc_1756_OC8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OC8-Faceplate.gfx
1756-OG16 (raC-5_00-SE) raC_Dvc_1756_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OG16-Faceplate.gfx
1756-ON8 (raC-5_00-SE) raC_Dvc_1756_ON8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_ON8-Faceplate.gfx
1756-OV16E (raC-5_00-SE) raC_Dvc_1756_OV16E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OV16E-Faceplate.gfx
1756-OV32E (raC-5_00-SE) raC_Dvc_1756_OV32E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OV32E-Faceplate.gfx
1756-OA8 (raC-5_03-SE) raC_Dvc_1756_OA8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OA8-Faceplate.gfx
1756-OB16IS (raC-5_02-SE) raC_Dvc_1756_OB16IS-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OB16IS-Faceplate.gfx
1756-OH8I (raC-5_02-SE) raC_Dvc_1756_OH8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OH8I-Faceplate.gfx
1756-OW16I (raC-5_02-SE) raC_Dvc_1756_OW16I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OW16I-Faceplate.gfx
1756-OX8I (raC-5_02-SE) raC_Dvc_1756_OX8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OX8I-Faceplate.gfx

1769

1769-OA16 (raC-5_00-SE) raC_Dvc_1769_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OA16-Faceplate.gfx
1769-OA8 (raC-5_03-SE) raC_Dvc_1769_OA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OA8-Faceplate.gfx
1769-OB16 (raC-5_00-SE) raC_Dvc_1769_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB16-Faceplate.gfx
1769-OB16P (raC-5_00-SE) raC_Dvc_1769_OB16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB16P-Faceplate.gfx
1769-OB32 (raC-5_00-SE) raC_Dvc_1769_OB32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB32-Faceplate.gfx
1769-OB32T (raC-5_00-SE) raC_Dvc_1769_OB32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB32T-Faceplate.gfx
1769-OB8 (raC-5_00-SE) raC_Dvc_1769_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OB8-Faceplate.gfx
1769-OG16 (raC-5_00-SE) raC_Dvc_1769_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OG16-Faceplate.gfx
1769-OV16 (raC-5_00-SE) raC_Dvc_1769_OV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OV16-Faceplate.gfx
1769-OV32T (raC-5_00-SE) raC_Dvc_1769_OV32T-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OV32T-Faceplate.gfx
1769-OW16 (raC-5_00-SE) raC_Dvc_1769_OW16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW16-Faceplate.gfx
1769-OW8 (raC-5_00-SE) raC_Dvc_1769_OW8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW8-Faceplate.gfx
1769-OW8I (raC-5_00-SE) raC_Dvc_1769_OW8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OW8I-Faceplate.gfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

1794

1794-OA16 (raC-5_00-SE) raC_Dvc_1794_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA16-Faceplate.gfx
1794-OA8 (raC-5_00-SE) raC_Dvc_1794_OA8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA8-Faceplate.gfx
1794-OA8I (raC-5_00-SE) raC_Dvc_1794_OA8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OA8I-Faceplate.gfx
1794-OB16 (raC-5_00-SE) raC_Dvc_1794_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB16-Faceplate.gfx
1794-OB16P (raC-5_00-SE) raC_Dvc_1794_OB16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB16P-Faceplate.gfx
1794-OB32P (raC-5_00-SE) raC_Dvc_1794_OB32P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB32P-Faceplate.gfx
1794-OB8 (raC-5_00-SE) raC_Dvc_1794_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB8-Faceplate.gfx
1794-OB8EP (raC-5_00-SE) raC_Dvc_1794_OB8EP-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OB8EP-Faceplate.gfx
1794-OC16 (raC-5_00-SE) raC_Dvc_1794_OC16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OC16-Faceplate.gfx
1794-OG16 (raC-5_00-SE) raC_Dvc_1794_OG16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OG16-Faceplate.gfx
1794-OM16 (raC-5_00-SE) raC_Dvc_1794_OM16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OM16-Faceplate.gfx
1794-OM8 (raC-5_00-SE) raC_Dvc_1794_OM8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OM8-Faceplate.gfx
1794-OV16 (raC-5_00-SE) raC_Dvc_1794_OV16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV16-Faceplate.gfx
1794-OV16P (raC-5_00-SE) raC_Dvc_1794_OV16P-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV16P-Faceplate.gfx
1794-OV32 (raC-5_00-SE) raC_Dvc_1794_OV32-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OV32-Faceplate.gfx
1794-OW8 (raC-5_00-SE) raC_Dvc_1794_OW8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OW8-Faceplate.gfx

5069

5069-OA16 (raC-5_00-ME) raC_Dvc_5069_OA16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OA16-Faceplate.gfx
5069-OB16 (raC-5_00-ME) raC_Dvc_5069_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB16-Faceplate.gfx
5069-OB16F (raC-5_00-ME) raC_Dvc_5069_OB16F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB16F-Faceplate.gfx
5069-OB8 (raC-5_00-ME) raC_Dvc_5069_OB8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OB8-Faceplate.gfx
5069-OW16 (raC-5_00-ME) raC_Dvc_5069_OW16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OW16-Faceplate.gfx
5069-OW4I (raC-5_00-ME) raC_Dvc_5069_OW4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OW4I-Faceplate.gfx
5069-OX4I (raC-5_00-ME) raC_Dvc_5069_OX4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OX4I-Faceplate.gfx

5094

5094-OB16 (raC-5_00-SE) raC_Dvc_5094_OB16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_OB16-Faceplate.gfx
5094-OA16 (raC-5_02-SE) raC_Dvc_5094_OA16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OA16-Faceplate.gfx
5094-OB32 (raC-5_02-SE) raC_Dvc_5094_OB32-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OB32-Faceplate.gfx
5094-OB8 (raC-5_03-SE) raC_Dvc_5094_OB8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OB8-Faceplate.gfx
5094-OW8I (raC-5_00-SE) raC_Dvc_5094_OW8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_OW8I-Faceplate.gfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

Family View Designer File Module View Designer Screen

1719
raC_Dvc_1719IO_wDesc
.vpd
raC_Dvc_1719IO_wDesc
.vpd

1719-OB2 raC_Dvc_1719-OB2_wDesc_FP

1719-OB2L raC_Dvc_1719-OB2L_wDesc_FP

1732E raC_Dvc_1732IO_wDesc
.vpd

1732E-OB16M12 raC_Dvc_1732E-OB16M12_wDesc_FP
1732E-OB16M12R raC_Dvc_1732E-OB16M12R_wDesc_FP
1732E-OB8M8SR raC_Dvc_1732E-OB8M8SR_wDesc_FP
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1734 raC_Dvc_1734IO_wDes
c.vpd

1734-OA2 raC_Dvc_1734-OA2_wDesc_FP
1734-OA4 raC_Dvc_1734-OA4_wDesc_FP
1734-OB2 raC_Dvc_1734-OB2_wDesc_FP
1734-OB2E raC_Dvc_1734-OB2E_wDesc_FP
1734-OB2EP raC_Dvc_1734-OB2EP_wDesc_FP
1734-OB4 raC_Dvc_1734-OB4_wDesc_FP
1734-OB4E raC_Dvc_1734-OB4E_wDesc_FP
1734-OB8 raC_Dvc_1734-OB8_wDesc_FP
1734-OB8E raC_Dvc_1734-OB8E_wDesc_FP
1734-OV2E raC_Dvc_1734-OV2E_wDesc_FP
1734-OV4E raC_Dvc_1734-OV4E_wDesc_FP
1734-OV8E raC_Dvc_1734-OV8E_wDesc_FP
1734-OW2 raC_Dvc_1734-OW2_wDesc_FP
1734-OW4 raC_Dvc_1734-OW4_wDesc_FP
1734-OX2 raC_Dvc_1734-OX2_wDesc_FP

1738 raC_Dvc_1738IO_wDesc
.vpd

1738-OA2M12AC3 raC_Dvc_1738-OA2M12AC3_wDesc_FP
1738-OB16E19M23 raC_Dvc_1738-OB16E19M23_wDesc_FP
1738-OB16E25DS raC_Dvc_1738-OB16E25DS_wDesc_FP
1738-OB16EM12 raC_Dvc_1738-OB16EM12_wDesc_FP
1738-OB2EM12 raC_Dvc_1738-OB2EM12_wDesc_FP
1738-OB2EPM12 raC_Dvc_1738-OB2EPM12_wDesc_FP
1738-OB4EM12 raC_Dvc_1738-OB4EM12_wDesc_FP
1738-OB4EM8 raC_Dvc_1738-OB4EM8_wDesc_FP
1738-OB8EM12 raC_Dvc_1738-OB8EM12_wDesc_FP
1738-OB8EM23 raC_Dvc_1738-OB8EM23_wDesc_FP
1738-OB8EM8 raC_Dvc_1738-OB8EM8_wDesc_FP
1738-OV4EM12 raC_Dvc_1738-OV4EM12_wDesc_FP
1738-OW4M12 raC_Dvc_1738-OW4M12_wDesc_FP
1738-OW4M12AC4 raC_Dvc_1738-OW4M12AC4_wDesc_FP

1756 raC_Dvc_1756IO_wDesc
.vpd

1756-OA16 raC_Dvc_1756-OA16_wDesc_FP
1756-OA16I raC_Dvc_1756-OA16I_wDesc_FP
1756-OA8E raC_Dvc_1756-OA8E_wDesc_FP
1756-OB16E raC_Dvc_1756-OB16E_wDesc_FP
1756-OB16I raC_Dvc_1756-OB16I_wDesc_FP
1756-OB16IEF raC_Dvc_1756-OB16IEF_wDesc_FP
1756-OB16IEFS raC_Dvc_1756-OB16IEFS_wDesc_FP
1756-OB32 raC_Dvc_1756-OB32_wDesc_FP
1756-OB8 raC_Dvc_1756-OB8_wDesc_FP
1756-OB8EI raC_Dvc_1756-OB8EI_wDesc_FP
1756-OB8I raC_Dvc_1756-OB8I_wDesc_FP
1756-OC8 raC_Dvc_1756-OC8_wDesc_FP
1756-OG16 raC_Dvc_1756-OG16_wDesc_FP
1756-OH8I raC_Dvc_1756-OH8I_wDesc_FP
1756-ON8 raC_Dvc_1756-ON8_wDesc_FP
1756-OV16E raC_Dvc_1756-OV16E_wDesc_FP
1756-OV32E raC_Dvc_1756-OV32E_wDesc_FP
1756-OW16I raC_Dvc_1756-OW16I_wDesc_FP

Family View Designer File Module View Designer Screen
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1756 raC_Dvc_1756IO_wDes
c.vpd 1756-OX8I raC_Dvc_1756-OX8I_wDesc_FP

1769 raC_Dvc_1769IO_wDesc
.vpd

1769-OA16 raC_Dvc_1769-OA16_wDesc_FP
1769-OA8 raC_Dvc_1769-OA8_wDesc_FP
1769-OB16 raC_Dvc_1769-OB16_wDesc_FP
1769-OB16P raC_Dvc_1769-OB16P_wDesc_FP
1769-OB32 raC_Dvc_1769-OB32_wDesc_FP
1769-OB32T raC_Dvc_1769-OB32T_wDesc_FP
1769-OB8 raC_Dvc_1769-OB8_wDesc_FP
1769-OG16 raC_Dvc_1769-OG16_wDesc_FP
1769-OV16 raC_Dvc_1769-OV16_wDesc_FP
1769-OV32T raC_Dvc_1769-OV32T_wDesc_FP
1769-OW16 raC_Dvc_1769-OW16_wDesc_FP
1769-OW8 raC_Dvc_1769-OW8_wDesc_FP
1769-OW8I raC_Dvc_1769-OW8I_wDesc_FP

1794 raC_Dvc_1794IO_wDesc
.vpd

1794-OA16 raC_Dvc_1794-OA16_wDesc_FP
1794-OA8 raC_Dvc_1794-OA8_wDesc_FP
1794-OA8I raC_Dvc_1794-OA8I_wDesc_FP
1794-OB16 raC_Dvc_1794-OB16_wDesc_FP
1794-OB16P raC_Dvc_1794-OB16P_wDesc_FP
1794-OB32P raC_Dvc_1794-OB32P_wDesc_FP
1794-OB8 raC_Dvc_1794-OB8_wDesc_FP
1794-OB8EP raC_Dvc_1794-OB8EP_wDesc_FP
1794-OC16 raC_Dvc_1794-OC16_wDesc_FP
1794-OG16 raC_Dvc_1794-OG16_wDesc_FP
1794-OM16 raC_Dvc_1794-OM16_wDesc_FP
1794-OM8 raC_Dvc_1794-OM8_wDesc_FP
1794-OV16 raC_Dvc_1794-OV16_wDesc_FP
1794-OV16P raC_Dvc_1794-OV16P_wDesc_FP
1794-OV32 raC_Dvc_1794-OV32_wDesc_FP
1794-OW8 raC_Dvc_1794-OW8_wDesc_FP

5069 raC_Dvc_5069IO_wDes
c.vpd

5069-OA16 raC_Dvc_5069-OA16_wDesc_FP
5069-OB16 raC_Dvc_5069-OB16_wDesc_FP
5069-OB16F raC_Dvc_5069-OB16F_wDesc_FP
5069-OB8 raC_Dvc_5069-OB8_wDesc_FP
5069-OW16 raC_Dvc_5069-OW16_wDesc_FP
5069-OW4I raC_Dvc_5069-OW4I_wDesc_FP
5069-OX4I raC_Dvc_5069-OX4I_wDesc_FP

5094 raC_Dvc_5094IO_wDes
c.vpd

5094-OB16 raC_Dvc_5094-OB16_wDesc_FP
5094-OA16 raC_Dvc_5094_OA16_wDesc_FP
5094-OB32 raC_Dvc_5094_OB32_wDesc_FP
5094-OB8 raC_Dvc_5094_OB8_wDesc_FP
5094-OW8I raC_Dvc_5094-OW8I_wDesc_FP

Family View Designer File Module View Designer Screen
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Family Module Application Code Manager File

1719
1719-OB2 (RA-LIB)_ACM_2.00_Module_Digital_1719-OB2_A_(5.3).HSL4
1719-OB2L (RA-LIB)_ACM_2.00_Module_Digital_1719-OB2L_A_(5.3).HSL4

1732E
1732E-OB16M12 (RA-LIB)_ACM_2.00_Module_Digital_1732E-OB16M12_A_(5.3).HSL4
1732E-OB16M12R (RA-LIB)_ACM_2.00_Module_Digital_1732E-OB16M12R_B_(5.3).HSL4
1732E-OB8M8SR (RA-LIB)_ACM_2.00_Module_Digital_1732E-OB8M8SR_A_(5.3).HSL4

1734

1734-OA2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OA2_C_(5.3).HSL4
1734-OA4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OA4_C_(5.3).HSL4
1734-OB2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB2_C_(5.3).HSL4
1734-OB2E (RA-LIB)_ACM_2.00_Module_Digital_1734-OB2E_C_(5.3).HSL4
1734-OB2EP (RA-LIB)_ACM_2.00_Module_Digital_1734-OB2EP_C_(5.3).HSL4
1734-OB4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB4_C_(5.3).HSL4
1734-OB4E (RA-LIB)_ACM_2.00_Module_Digital_1734-OB4E_C_(5.3).HSL4
1734-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB8_C_(5.2).HSL4
1734-OB8E (RA-LIB)_ACM_2.00_Module_Digital_1734-OB8E_C_(5.3).HSL4
1734-OV2E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV2E_C_(5.3).HSL4
1734-OV4E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV4E_C_(5.3).HSL4
1734-OV8E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV8E_C_(5.3).HSL4
1734-OW2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OW2_C_(5.3).HSL4
1734-OW4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OW4_C_(5.3).HSL4
1734-OX2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OX2_C_(5.3).HSL4
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1738

1738-OA2M12AC3 (RA-LIB)_ACM_2.00_Module_Digital_1738-OA2M12AC3_A_(5.3).HSL4
1738-OB16E19M23 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB16E19M23_A_(5.3).HSL4
1738-OB16E25DS (RA-LIB)_ACM_2.00_Module_Digital_1738-OB16E25DS_A_(5.3).HSL4
1738-OB16EM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB16EM12_A_(5.3).HSL4
1738-OB2EM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB2EM12_A_(5.3).HSL4
1738-OB2EPM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB2EPM12_A_(5.3).HSL4
1738-OB4EM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB4EM12_A_(5.3).HSL4
1738-OB4EM8 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB4EM8_A_(5.3).HSL4
1738-OB8EM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM12_A_(5.3).HSL4
1738-OB8EM23 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM23_A_(5.3).HSL4
1738-OB8EM8 (RA-LIB)_ACM_2.00_Module_Digital_1738-OB8EM8_A_(5.3).HSL4
1738-OV4EM12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OV4EM12_A_(5.3).HSL4
1738-OW4M12 (RA-LIB)_ACM_2.00_Module_Digital_1738-OW4M12_A_(5.3).HSL4
1738-OW4M12AC (RA-LIB)_ACM_2.00_Module_Digital_1738-OW4M12AC_A_(5.3).HSL4

1756

1756-OA16 (RA-LIB)_ACM_2.00_Module_Digital_1756-OA16_(5.3).HSL4
1756-OA16I (RA-LIB)_ACM_2.00_Module_Digital_1756-OA16I_(5.3).HSL4
1756-OA8E (RA-LIB)_ACM_2.00_Module_Digital_1756-OA8E_(5.3).HSL4
1756-OB16E (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16E_(5.3).HSL4
1756-OB16I (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16I_(5.3).HSL4
1756-OB16IEF (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IEF_A_(5.3).HSL4
1756-OB16IEFS (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IEFS_A_(5.3).HSL4
1756-OB32 (RA-LIB)_ACM_2.00_Module_Digital_1756-OB32_(5.3).HSL4
1756-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1756-OB8_(5.3).HSL4
1756-OB8EI (RA-LIB)_ACM_2.00_Module_Digital_1756-OB8EI_(5.3).HSL4
1756-OB8I (RA-LIB)_ACM_2.00_Module_Digital_1756-OB8I_(5.3).HSL4
1756-OC8 (RA-LIB)_ACM_2.00_Module_Digital_1756-OC8_(5.3).HSL4
1756-OG16 (RA-LIB)_ACM_2.00_Module_Digital_1756-OG16_(5.3).HSL4
1756-ON8 (RA-LIB)_ACM_2.00_Module_Digital_1756-ON8_(5.3).HSL4
1756-OV16E (RA-LIB)_ACM_2.00_Module_Digital_1756-OV16E_A_(5.3).HSL4
1756-OV32E (RA-LIB)_ACM_2.00_Module_Digital_1756-OV32E_A_(5.3).HSL4
1756-OA8 (RA-LIB)_ACM_2.00_Module_Digital_1756-OA8_(5.3).HSL4
1756-OH8I (RA-LIB)_ACM_2.00_Module_Digital_1756-OH8I_(5.3).HSL4
1756-OW16I (RA-LIB)_ACM_2.00_Module_Digital_1756-OW16I_(5.3).HSL4
1756-OX8I (RA-LIB)_ACM_2.00_Module_Digital_1756-OX8I_(5.3).HSL4

1769

1769-OA16 (RA-LIB)_ACM_2.00_Module_Digital_1769-OA16_A_(5.3).HSL4
1769-OA8 (RA-LIB)_ACM_2.00_Module_Digital_1769-OA8_B_(5.3).HSL4
1769-OB16 (RA-LIB)_ACM_2.00_Module_Digital_1769-OB16_B_(5.3).HSL4
1769-OB16P (RA-LIB)_ACM_2.00_Module_Digital_1769-OB16P_B_(5.3).HSL4
1769-OB32 (RA-LIB)_ACM_2.00_Module_Digital_1769-OB32_A_(5.3).HSL4
1769-OB32T (RA-LIB)_ACM_2.00_Module_Digital_1769-OB32T_A_(5.3).HSL4
1769-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1769-OB8_A_(5.3).HSL4
1769-OG16 (RA-LIB)_ACM_2.00_Module_Digital_1769-OG16_A_(5.3).HSL4
1769-OV16 (RA-LIB)_ACM_2.00_Module_Digital_1769-OV16_B_(5.3).HSL4
1769-OV32T (RA-LIB)_ACM_2.00_Module_Digital_1769-OV32T_A_(5.3).HSL4
1769-OW16 (RA-LIB)_ACM_2.00_Module_Digital_1769-OW16_A_(5.3).HSL4
1769-OW8 (RA-LIB)_ACM_2.00_Module_Digital_1769-OW8_B_(5.3).HSL4
1769-OW8I (RA-LIB)_ACM_2.00_Module_Digital_1769-OW8I_B_(5.3).HSL4

Family Module Application Code Manager File
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

1794

1794-OA16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OA16_A_(5.3).HSL4
1794-OA8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OA8_A_(5.3).HSL4
1794-OA8I (RA-LIB)_ACM_2.00_Module_Digital_1794-OA8I_A_(5.3).HSL4
1794-OB16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OB16_A_(5.3).HSL4
1794-OB16P (RA-LIB)_ACM_2.00_Module_Digital_1794-OB16P_A_(5.3).HSL4
1794-OB32P (RA-LIB)_ACM_2.00_Module_Digital_1794-OB32P_A_(5.3).HSL4
1794-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OB8_A_(5.3).HSL4
1794-OB8EP (RA-LIB)_ACM_2.00_Module_Digital_1794-OB8EP_A_(5.3).HSL4
1794-OC16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OC16_A_(5.3).HSL4
1794-OG16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OG16_A_(5.3).HSL4
1794-OM16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OM16_A_(5.3).HSL4
1794-OM8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OM8_A_(5.3).HSL4
1794-OV16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OV16_A_(5.3).HSL4
1794-OV16P (RA-LIB)_ACM_2.00_Module_Digital_1794-OV16P_A_(5.3).HSL4
1794-OV32 (RA-LIB)_ACM_2.00_Module_Digital_1794-OV32_A_(5.3).HSL4
1794-OW8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OW8_A_(5.3).HSL4

5069

5069-OA16 (RA-LIB)_ACM_2.00_Module_Digital_5069-OA16_A_(5.3).HSL4
5069-OB16 (RA-LIB)_ACM_2.00_Module_Digital_5069-OB16_B_(5.3).HSL4
5069-OB16F (RA-LIB)_ACM_2.00_Module_Digital_5069-OB16F_B_(5.3).HSL4
5069-OB8 (RA-LIB)_ACM_2.00_Module_Digital_5069-OB8_A_(5.3).HSL4
5069-OW16 (RA-LIB)_ACM_2.00_Module_Digital_5069-OW16_B_(5.3).HSL4
5069-OW4I (RA-LIB)_ACM_2.00_Module_Digital_5069-OW4I_A_(5.3).HSL4
5069-OX4I (RA-LIB)_ACM_2.00_Module_Digital_5069-OX4I_A_(5.3).HSL4

5094

5094-OB16 (RA-LIB)_ACM_2.00_Module_Digital_5094-OB16_A_(5.3).HSL4
5094-OB16XT (RA-LIB)_ACM_2.00_Module_Digital_5094-OB16XT_A_(5.3).HSL4
5094-OA16 (RA-LIB)_ACM_2.00_Module_Digital_5094-OA16_A_(5.3).HSL4
5094-OA16XT (RA-LIB)_ACM_2.00_Module_Digital_5094-OA16XT_A_(5.3).HSL4
5094-OB32 (RA-LIB)_ACM_2.00_Module_Digital_5094-OB32_A_(5.3).HSL4
5094-OB32XT (RA-LIB)_ACM_2.00_Module_Digital_5094-OB32XT_A_(5.3).HSL4
5094-OB8 (RA-LIB)_ACM_2.00_Module_Digital_5094-OB8_A_(5.3).HSL4
5094-OB8XT (RA-LIB)_ACM_2.00_Module_Digital_5094-OB8XT_A_(5.3).HSL4
5094-OW8I (RA-LIB)_ACM_2.00_Module_Digital_5094-OW8I_A_(5.3).HSL4
5094-OW8IXT (RA-LIB)_ACM_2.00_Module_Digital_5094-OW8IXT_A_(5.3).HSL4

Family Module Application Code Manager File
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCOut_1794 Use with 1794 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCOut_509
4 Use with 5094 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_1794 Use with 1794 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_5094 Use with 5094 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchInOut_Armor Use with 1732E/1738 Digital Input/Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position
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event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_DCOut_1794 Use with 1794 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_DCOut_509
4 Use with 5094 DC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes for more information.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Output modules this is the individual O.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

GO_LaunchACOut_1794 Use with 1794 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_5094 Use with 5094 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchInOut_Armor Use with 1732E/1738 Digital Input/Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol
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Home

The main tab of the faceplate is the Home tab, which displays information 
regarding the I/O channels and faults. The banner at the top of the faceplate 
displays module status and fault information.

1

2

7

6

3

4

5
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-OH8I) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:O.Data.x.@Description

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:O.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
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Configured HMI Content

Attachments

RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button Type

Parameter Name Default Value Description

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

Launch Button GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules

Launch Button GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

Launch Button GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules

Launch Button GO_Launch_DCOut_1794 Use with 1794 DC Output Modules

Launch Button GO_Launch_DCOut_5094 Use with 5094 DC Output Modules

Launch Button GO_LaunchACOut_1794 Use with 1794 AC Output Modules

Launch Button GO_LaunchACOut_5094 Use with 5094 AC Output Modules

Launch Button GO_LaunchIn_Armor Use with 1732E/1738 Digital Input/Output Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Chapter 9

Digital Output Diagnostics Modules

Overview Digital Output diagnostic module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, status and detailed faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1756
1756-OA8D (raC-5_03-SE) raC_Dvc_1756_OA8D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OA8D-Faceplate.gfx

1756-OB16D (raC-5_01-SE) raC_Dvc_1756_OB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OB16D-Faceplate.gfx
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

1794 1794-OB16D (raC-5_01-SE) raC_Dvc_1794_OB16D-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_OB16D-Faceplate.gfx

1715 1715-OB8DE
(raC-5_03-SE) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx

(raC-5_03-SE) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

Family View Designer File Module View Designer Screen

1756 raC_Dvc_1756IO_wDesc.v
pd

1756-OA8D raC_Dvc_1756-OA8D_wDesc_FP

1756-OB16D raC_Dvc_1756-OB16D_wDesc_FP

1794 raC_Dvc_1794IO_wDesc.vp
d 1794-OB16D raC_Dvc_1794-OB16D_wDesc_FP

1715 raC_Dvc_1715IO_wDesc.vp
d 1715-OB8DE

raC_Dvc_1715-OB8DE_Simplex_wDesc_FP

raC_Dvc_1715-OB8DE_Duplex_wDesc_FP

Family Module Application Code Manager File

1756
1756-OA8D (RA-LIB)_ACM_2.00_Module_Digital_1756-OA8D_(5.3).HSL4

1756-OB16D (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16D_(5.3).HSL4

1794 1794-OB16D (RA-LIB)_ACM_2.00_Module_Digital_1794-OB16D_A_(5.3).HSL4

1715 1715-OB8DE (RA-LIB)_ACM_2.00_Module_Digital_1715-OB8DE_A_(5.3).HSL4
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCOut_1794 Use with 1794 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCOut_509
4 Use with 5094 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_1794 Use with 1794 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_5094 Use with 5094 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position
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Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_DCOut_1794 Use with 1794 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_DCOut_509
4 Use with 5094 DC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_1794 Use with 1794 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_5094 Use with 5094 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes for more information.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Output modules this is the individual O.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Diagnostic Tab

The Diagnostic tab is available only for 1715-OB8DE diagnostic modules. This 
tab displays current and voltage data for each point and the field power 
sources.

1

2

7

6

3

4

5

8

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:O.Data.x.@Description

8

Channel fault description
- Output Verify Fault (1756/1794 only)
- Field Power Loss (1756/1794 only)
- Fuse Blown (1756/1794 only)
- No Load
- Channel Fault
- Short Circuit (1715 only)
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-OB16D) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

1

2

Item Description
1 Diagnostic tab navigation button
2 Current (mA) and Voltage (mV) data.

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:O.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
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Configured HMI Content

Attachments

MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button Type

Parameter Name Default Value Description

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

Launch Button GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules

Launch Button GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

Launch Button GO_LaunchACOut_50xx Use with 1719/5069/5015 AC Output Modules

Launch Button GO_Launch_DCOut_1794 Use with 1794 DC Output Modules

Launch Button GO_Launch_DCOut_5094 Use with 5094 DC Output Modules

Launch Button GO_LaunchACOut_1794 Use with 1794 AC Output Modules

Launch Button GO_LaunchACOut_5094 Use with 5094 AC Output Modules

Launch Button GO_LaunchIn_Armor Use with 1732E/1738 Digital Input/Output Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Chapter 10

Digital Input/Output 17x4 Rack Optimized Modules

Overview Digital Input/Output 1734/1794 Rack Optimized module objects include Studio 
5000® Application Code Manager modules and HMI faceplates for 
FactoryTalk® View ME/SE and Studio 5000 View Designer®. 

These faceplates apply to 1734 POINT I/O and 1794 FLEX I/O modules 
configured as Rack Optimized connection mode. This simplifies the tag’s data 
structure and does not include any diagnostic information. For modules 
configured as data connection mode, see the other sections that cover Digital 
Input Modules or Digital Output Modules.

HMI faceplates provide the following information:
• Module description
• Channel status and description

Faceplates for rack optimized digital input/output modules are provided based 
on I/O density (2/4/8/16/32 channel). The faceplates can be used with either 
1734 or 1794 modules and either input or output modules as long as the channel 
density is correct.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.



186 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Chapter 10          Digital Input/Output 17x4 Rack Optimized Modules

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Family Module FactoryTalk® View SE Faceplate FactoryTalk® View ME Faceplate

1734
/1794

1734-IA2

(raC-5_03-SE) raC_Dvc_17x4_xx2-Faceplate.gfx (raC-5_02-ME) raC_Dvc_17x4_xx2-Faceplate.gfx

1734-IB2

1734-IE2C

1734-IE2V

1734-IM2

1734-IV2
1734-OA2
1734-OB2
1734-OB2E
1734-OB2EP
1734-OE2C
1734-OE2V
1734-OV2E
1734-OW2
1734-OX2
1734-IV4

(raC-5_03-SE) raC_Dvc_17x4_xx4-Faceplate.gfx (raC-5_02-ME) raC_Dvc_17x4_xx4-Faceplate.gfx

1734-IB4D

1734-IA4

1734-IB4

1734-IM4

1734-IE4C
1734-OA4
1734-OB4
1734-OB4E
1734-OE4C
1734-OV4E
1794-OE4
1734-OW4
1734-IB8

(raC-5_03-SE) raC_Dvc_17x4_xx8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_17x4_xx8-Faceplate.gfx

1734-IE8C

1734-IV8
1734-OB8
1734-OB8E
1734-OV8E
1794-IA8

1794-IA8I

1794-IE8

1794-IM8
1794-OA8
1794-OA8I
1794-OB8
1794-OB8EP
1794-OM8
1794-OW8
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

1794

1794-IA16

(raC-5_03-SE) raC_Dvc_17x4_xx16-Faceplate.gfx (raC-5_02-ME) raC_Dvc_17x4_xx16-Faceplate.gfx

1794-IB16

1794-IC16

1794-IG16

1794-IH16

1794-IM16

1794-IV16
1794-OA16
1794-OB16
1794-OB16P
1794-OC16
1794-OG16
1794-OM16
1794-OV16
1794-OV16P
1794-IB10XOB6 (raC-5_02-SE) raC_Dvc_1794_IB10XOB6_Rack-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB10XOB6_Rack-Faceplate.gfx
1794-IB16XOB16P (raC-5_02-SE) raC_Dvc_1794_IB16XOB16P_Rack-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IB16XOB16P_Rack-Faceplate.gfx

Family Module FactoryTalk® View SE Faceplate FactoryTalk® View ME Faceplate
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Family View Designer File Module View Designer Screen

1734 raC_Dvc_1734IO_wDesc.vpd

1734-IA2

raC_Dvc_17x4_xx2_wDesc_FP

1734-IB2

1734-IE2C

1734-IE2V

1734-IM2

1734-IV2

1734-OA2

1734-OB2

1734-OB2E

1734-OB2EP

1734-OE2C

1734-OE2V

1734-OV2E

1734-OW2

1734-OX2

1734-IV4

raC_Dvc_17x4_xx4_wDesc_FP

1734-IB4D

1734-IA4

1734-IB4

1734-IM4

1734-IE4C

1734-OA4

1734-OB4

1734-OB4E

1734-OE4C

1734-OV4E

1794-OE4

1734-OW4

1734-IB8

raC_Dvc_17x4_xx8_wDesc_FP

1734-IE8C

1734-IV8

1734-OB8

1734-OB8E

1734-OV8E
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

1794 raC_Dvc_1794IO_wDesc.vpd

1794-IA8

raC_Dvc_17x4_xx8_wDesc_FP

1794-IA8I

1794-IB8

1794-IM8

1794-OA8

1794-OA8I

1794-OB8

1794-OB8EP

1794-OM8

1794-OW8

1794-IA16

raC_Dvc_17x4_xx16_wDesc_FP

1794-IB16

1794-IC16

1794-IG16

1794-IH16

1794-IM16

1794-IV16

1794-OA16

1794-OB16

1794-OB16P

1794-OC16

1794-OG16

1794-OM16

1794-OV16

1794-OV16P

Family View Designer File Module View Designer Screen
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Family Module Application Code Manager File

1734

1734-IB4D (RA-LIB)_ACM_2.00_Module_Digital_1734-IB4D_C_(5.3).HSL4

1734-IA2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IA2_C_(5.3).HSL4

1734-IA4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IA4_C_(5.3).HSL4

1734-IB2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB2_C_(5.3).HSL4

1734-IB4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB4_C_(5.3).HSL4

1734-IB8 (RA-LIB)_ACM_2.00_Module_Digital_1734-IB8_C_(5.3).HSL4

1734-IE2C (RA-LIB)_ACM_2.00_Module_Digital_1734-IE2C_C_(5.3).HSL4

1734-IE2V (RA-LIB)_ACM_2.00_Module_Digital_1734-IE2V_C_(5.3).HSL4

1734-IE4C (RA-LIB)_ACM_2.00_Module_Digital_1734-IE4C_C_(5.3).HSL4

1734-IE8C (RA-LIB)_ACM_2.00_Module_Digital_1734-IE8C_C_(5.3).HSL4

1734-IM2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IM2_C_(5.3).HSL4

1734-IM4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IM4_C_(5.3).HSL4

1734-IV2 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV2_C_(5.3).HSL4

1734-IV4 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV4_C_(5.3).HSL4

1734-IV8 (RA-LIB)_ACM_2.00_Module_Digital_1734-IV8_C_(5.3).HSL4
1734-OA2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OA2_C_(5.3).HSL4
1734-OA4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OA4_C_(5.3).HSL4
1734-OB2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB2_C_(5.3).HSL4
1734-OB2E ((RA-LIB)_ACM_2.00_Module_Digital_1734-OB2E_C_(5.3).HSL4
1734-OB2EP (RA-LIB)_ACM_2.00_Module_Digital_1734-OB2EP_C_(5.3).HSL4
1734-OB4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB4_C_(5.3).HSL4
1734-OB4E (RA-LIB)_ACM_2.00_Module_Digital_1734-OB4E_C_(5.3).HSL4
1734-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1734-OB8_C_(5.3).HSL4
1734-OB8E (RA-LIB)_ACM_2.00_Module_Digital_1734-OB8E_C_(5.3).HSL4
1734-OE2C (RA-LIB)_ACM_2.00_Module_Digital_1734-OE2C_C_(5.3).HSL4
1734-OE2V (RA-LIB)_ACM_2.00_Module_Digital_1734-OE2V_C_(5.3).HSL4
1734-OE4C (RA-LIB)_ACM_2.00_Module_Digital_1734-OE4C_C_(5.3).HSL4
1734-OV2E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV2E_C_(5.3).HSL4
1734-OV4E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV4E_C_(5.3).HSL4
1734-OV8E (RA-LIB)_ACM_2.00_Module_Digital_1734-OV8E_C_(5.3).HSL4
1734-OW2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OW2_C_(5.3).HSL4
1734-OW4 (RA-LIB)_ACM_2.00_Module_Digital_1734-OW4_C_(5.3).HSL4
1734-OX2 (RA-LIB)_ACM_2.00_Module_Digital_1734-OX2_C_(5.3).HSL4
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

1794

1794-IA16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IA16_A_(5.3).HSL4

1794-IA8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IA8_A_(5.3).HSL4

1794-IA8I (RA-LIB)_ACM_2.00_Module_Digital_1794-IA8I_A_(5.3).HSL4

1794-IB16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB16_A_(5.3).HSL4

1794-IB32 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB32_A_(5.3).HSL4

1794-IB8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IB8_A_(5.3).HSL4

1794-IC16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IC16_A_(5.3).HSL4

1794-IG16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IG16_A_(5.3).HSL4

1794-IH16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IH16_A_(5.3).HSL4

1794-IM16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IM16_A_(5.3).HSL4

1794-IM8 (RA-LIB)_ACM_2.00_Module_Digital_1794-IM8_A_(5.3).HSL4

1794-IV16 (RA-LIB)_ACM_2.00_Module_Digital_1794-IV16_A_(5.3).HSL4

1794-IV32 (RA-LIB)_ACM_2.00_Module_Digital_1794-IV32_A_(5.3).HSL4
1794-OA16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OA16_A_(5.3).HSL4
1794-OA8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OA8_A_(5.3).HSL4
1794-OA8I (RA-LIB)_ACM_2.00_Module_Digital_1794-OA8I_A_(5.3).HSL4
1794-OB16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OB16_A_(5.3).HSL4
1794-OB16P (RA-LIB)_ACM_2.00_Module_Digital_1794-OB16P_A_(5.3).HSL4
1794-OB32P (RA-LIB)_ACM_2.00_Module_Digital_1794-OB32P_A_(5.3).HSL4
1794-OB8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OB8_A_(5.3).HSL4
1794-OB8EP (RA-LIB)_ACM_2.00_Module_Digital_1794-OB8EP_A_(5.3).HSL4
1794-OC16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OC16_A_(5.3).HSL4

1794-OG16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OG16_A_(5.3).HSL4
1794-OM16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OM16_A_(5.3).HSL4
1794-OM8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OM8_A_(5.3).HSL4
1794-OV16 (RA-LIB)_ACM_2.00_Module_Digital_1794-OV16_A_(5.3).HSL4
1794-OV16P (RA-LIB)_ACM_2.00_Module_Digital_1794-OV16P_A_(5.3).HSL4
1794-OV32 (RA-LIB)_ACM_2.00_Module_Digital_1794-OV32_A_(5.3).HSL4
1794-OW8 (RA-LIB)_ACM_2.00_Module_Digital_1794-OW8_A_(5.3).HSL4

Family Module Application Code Manager File
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FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Use with 1734/1794 Rack Optimized.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_1794 Use with 1794 AC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCOut_1794

Use with 1794 DC Input/ Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

Use with 1794 DC Output Modules 

#102: Faceplate Display Name
#103: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_1794 Use with 1794 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position
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GO_LaunchACIn_1734_R
ack Use with 1734 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_1734_R
ack Use with 1734 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_1734_
Rack Use with 1734 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_1734_
Rack Use with 1734 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACIn_1794_R
ack Use with 1794 AC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_1794_R
ack Use with 1794 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchACOut_1794_
Rack Use with 1794 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_1794_
Rack Use with 1794 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

GO_Launch_DCIn_1794 Use with 1794 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchACIn_1794 Use with 1794 AC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_DCOut_1794 Use with 1794 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchACOut_1794 Use with 1794 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol
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The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual I.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1734-OB8) has parameters which can be configured in 
Studio 5000® Application Code Manager prior to Controller code generation.

1

42

3

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Channel Status

BLUE = Active/High

GREY = Inactive/Low

3 Page navigation; used for modules with more than 16 channels.
4 Channel description. Module:I.Data.x.@Description
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Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

Connection Data
Connection type:
- Data
- RackOptimized

NavigationButton GraphicalButton Select Navigation Button Type

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules

Launch Button GO_LaunchACIn_17xx Use with 1715/1734/1756/1769 AC Input Modules

Launch Button GO_Launch_DCIn_1794 Use with 1794 DC Input Modules

Launch Button GO_LaunchACIn_1794 Use with 1794 AC Input Modules

Launch Button GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

Launch Button GO_LaunchACOut_17xx Use with 1715/1734/1756/1769 AC Output Modules

Launch Button GO_Launch_DCOut_1794 Use with 1794 DC Output Modules

Launch Button GO_LaunchACOut_1794 Use with 1794 AC Output Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 
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V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\

 Name Description File Name Extraction Path
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Analog Input Modules

Overview Analog input module objects include Studio 5000® Application Code Manager 
modules and HMI faceplates for FactoryTalk® View ME/SE and Studio 5000 
View Designer®. HMI faceplates provide the following information:

• Module description, status, and faults
• Channel description, data and faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1715 1715-IF16 (raC-5_02-SE) raC_Dvc_1715_IF16_Simplex-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1715_IF16_Simplex-Faceplate.gfx

1719

1719-IR4B (raC-5_00-SE) raC_Dvc_1719_IR4B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IR4B-Faceplate.gfx

1719-IF4HB (raC-5_02-SE) raC_Dvc_1719_IF4HB-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1719_IF4HB-Faceplate.gfx

1719-IT4B (raC-5_00-SE) raC_Dvc_1719_IT4B-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1719_IT4B-Faceplate.gfx

1732E

1732E-IF4M12R (raC-5_00-SE) raC_Dvc_1732E_IF4M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IF4M12R-Faceplate.gfx

1732E-IR4IM12R (raC-5_00-SE) raC_Dvc_1732E_IR4IM12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IR4IM12R-Faceplate.gfx

1732E-IT4IM12R (raC-5_00-SE) raC_Dvc_1732E_IT4IM12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_IT4IM12R-Faceplate.gfx

1734

1734-IR2 (raC-5_00-SE) raC_Dvc_1734_IR2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IR2-Faceplate.gfx

1734-IE2C (raC-5_00-SE) raC_Dvc_1734_IE2C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE2C-Faceplate.gfx

1734-IE2V (raC-5_00-SE) raC_Dvc_1734_IE2V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE2V-Faceplate.gfx

1734-IE4C (raC-5_00-SE) raC_Dvc_1734_IE4C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE4C-Faceplate.gfx

1734_IE4S (raC-5_01-SE) raC_Dvc_1734_IE4S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IE4S_Safety-Faceplate.gfx

1734-IE8C (raC-5_00-SE) raC_Dvc_1734_IE8C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IE8C-Faceplate.gfx

1734-IR2E (raC-5_00-SE) raC_Dvc_1734_IR2E-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IR2E-Faceplate.gfx

1734-IT2I (raC-5_00-SE) raC_Dvc_1734_IT2I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_IT2I-Faceplate.gfx

1734sc-IE2CH (raC-5_02-SE) raC_Dvc_1734sc_IE2CH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IE2CH-Faceplate.gfx

1734sc-IE4CH (raC-5_02-SE) raC_Dvc_1734sc_IE4CH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IE4CH-Faceplate.gfx

1734sc-IF4U (raC-5_03-SE) raC_Dvc_1734sc_IF4U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_IF4U-Faceplate.gfx

1738

1738-IE2CM12 (raC-5_00-SE) raC_Dvc_1738_IE2CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE2CM12-Faceplate.gfx

1738-IE2VM12 (raC-5_00-SE) raC_Dvc_1738_IE2VM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE2VM12-Faceplate.gfx

1738-IE4CM12 (raC-5_00-SE) raC_Dvc_1738_IE4CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IE4CM12-Faceplate.gfx

1738-IR2M12 (raC-5_00-SE) raC_Dvc_1738_IR2M12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IR2M12-Faceplate.gfx

1738-IT2IM12 (raC-5_00-SE) raC_Dvc_1738_IT2IM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_IT2IM12-Faceplate.gfx

1756

1756-IF16
(raC-5_02-SE) raC_Dvc_1756_IF16_Differential-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16_Differential-Faceplate.gfx
(raC-5_02-SE)raC_Dvc_1756_IF16_SingleEnded-
Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16_SingleEnded-Faceplate.gfx

1756-IF4FXOF2F (raC-5_00-SE) raC_Dvc_1756_IF4FXOF2F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF4FXOF2F-Faceplate.gfx

1756-IF6CIS (raC-5_00-SE) raC_Dvc_1756_IF6CIS-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF6CIS-Faceplate.gfx

1756-IF6I (raC-5_00-SE) raC_Dvc_1756_IF6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF6I-Faceplate.gfx

1756-IF8
(raC-5_02-SE) raC_Dvc_1756_IF8_Differential-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8_Differential-Faceplate.gfx

(raC-5_02-SE) raC_Dvc_1756_IF8_SingleEnded-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8_SingleEnded-Faceplate.gfx

1756-IF8I (raC-5_00-SE) raC_Dvc_1756_IF8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IF8I-Faceplate.gfx

1756-IR12 (raC-5_00-SE) raC_Dvc_1756_IR12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IR12-Faceplate.gfx

1756-IR6I (raC-5_00-SE) raC_Dvc_1756_IR6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IR6I-Faceplate.gfx

1756-IRT8I (raC-5_00-SE) raC_Dvc_1756_IRT8I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IRT8I-Faceplate.gfx

1756-IT16 (raC-5_00-SE) raC_Dvc_1756_IT16-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IT16-Faceplate.gfx

1756-IT6I (raC-5_00-SE) raC_Dvc_1756_IT6I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_IT6I-Faceplate.gfx

1756-IT6I2 (raC-5_02-SE) raC_Dvc_1756_IT6I2-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IT6I2-Faceplate.gfx

1756sc-IF8U (raC-5_03-SE) raC_Dvc_1756sc_IF8U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756sc_IF8U-Faceplate.gfx
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

1769

1769-IF16C (raC-5_00-SE) raC_Dvc_1769_IF16C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF16C-Faceplate.gfx

1769-IF16V (raC-5_00-SE) raC_Dvc_1769_IF16V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF16V-Faceplate.gfx

1769-IF4 (raC-5_00-SE) raC_Dvc_1769_IF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4-Faceplate.gfx

1769-IF4FXOF2F (raC-5_00-SE) raC_Dvc_1769_IF4FXOF2F-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4FXOF2F-Faceplate.gfx

1769-IF4I (raC-5_00-SE) raC_Dvc_1769_IF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4I-Faceplate.gfx

1769-IF4XOF2 (raC-5_00-SE) raC_Dvc_1769_IF4XOF2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF4XOF2-Faceplate.gfx

1769-IF8 (raC-5_00-SE) raC_Dvc_1769_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IF8-Faceplate.gfx

1769sc-IF8U (raC-5_02-SE) raC_Dvc_1769sc_IF8U-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IF8U-Faceplate.gfx

1769-IT6 (raC-5_00-SE) raC_Dvc_1769_IT6-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IT6-Faceplate.gfx

1769sc-IT6I (raC-5_02-SE) raC_Dvc_1769sc_IT6I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IT6I-Faceplate.gfx

1769-IR6 (raC-5_00-SE) raC_Dvc_1769_IR6-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_IR6-Faceplate.gfx

1769sc-IR6I (raC-5_02-SE) raC_Dvc_1769sc_IR6I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IR6I-Faceplate.gfx

1794

1794-IE12 (raC-5_00-SE) raC_Dvc_1794_IE12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE12-Faceplate.gfx

1794-IE4XOE2 (raC-5_00-SE) raC_Dvc_1794_IE4XOE2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE4XOE2-Faceplate.gfx

1794-IE8 (raC-5_00-SE) raC_Dvc_1794_IE8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE8-Faceplate.gfx

1794-IE8XOE4 (raC-5_00-SE) raC_Dvc_1794_IE8XOE4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IE8XOE4-Faceplate.gfx

1794-IF2XOF2I (raC-5_00-SE) raC_Dvc_1794_IF2XOF2I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IF2XOF2I-Faceplate.gfx

1794-IF4I (raC-5_00-SE) raC_Dvc_1794_IF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IF4I-Faceplate.gfx

1794-IR8 (raC-5_00-SE) raC_Dvc_1794_IR8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IR8-Faceplate.gfx

1794-IRT8 (raC-5_00-SE) raC_Dvc_1794_IRT8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IRT8-Faceplate.gfx

1794-IF4ICF (raC-5_03-SE) raC_Dvc_1794_IF4ICF-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IF4ICF-Faceplate.gfx

1794sc-IF8IU (raC-5_03-SE) raC_Dvc_1794sc_IF8IU-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794sc_IF8IU-Faceplate.gfx

1794sc-IRT8I (raC-5_03-SE) raC_Dvc_1794sc_IRT8I-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794sc_IRT8I-Faceplate.gfx

1794-IT8 (raC-5_00-SE) raC_Dvc_1794_IT8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_IT8-Faceplate.gfx

5069
5069-IF8 (raC-5_00-ME) raC_Dvc_5069_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IF8-Faceplate.gfx

5069-IY4-IR (raC-5_00-ME) raC_Dvc_5069_IY4-IR-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_IY4-IR-Faceplate.gfx

5094

5094-IF8 (raC-5_00-SE) raC_Dvc_5094_IF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5094_IF8-Faceplate.gfx

5094-IY8_IR (raC-5_02-SE) raC_Dvc_5094_IY8_IR-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IY8_IR-Faceplate.gfx

5094-IY8_IT (raC-5_02-SE) raC_Dvc_5094_IY8_IT-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IY8_IT-Faceplate.gfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
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Family View Designer File Module View Designer Screen

1715 raC_Dvc_1715IO_wDesc
.vpd 1715-IF16 raC_Dvc_1715-IF16_Simplex_wDesc_FP

1719 raC_Dvc_1719IO_wDesc
.vpd

1719-IR4B raC_Dvc_1719-IR4B_wDesc_FP

1719-IT4B raC_Dvc_1719-IT4B_wDesc_FP

1719-IR4HB raC_Dvc_1719-IR4HB_wDesc_FP

1732E raC_Dvc_1732IO_wDesc
.vpd

1732E-IF4M12R raC_Dvc_1732E-IF4M12R_wDesc_FP

1732E-IR4IM12R raC_Dvc_1732E-IR4IM12R_wDesc_FP

1732E-IT4IM12R raC_Dvc_1732E-IT4IM12R_wDesc_FP

1734 raC_Dvc_1734IO_wDes
c.vpd

1734-IE2C raC_Dvc_1734-IE2C_wDesc_FP

1734-IE2V raC_Dvc_1734-IE2V_wDesc_FP

1734-IE4C raC_Dvc_1734-IE4C_wDesc_FP

1734-IE8C raC_Dvc_1734-IE8C_wDesc_FP

1734-IR2 raC_Dvc_1734-IR2_wDesc_FP

1734-IR2E raC_Dvc_1734-IR2E_wDesc_FP

1734-IE4S raC_Dvc_1734-IE4S_Safety_wDesc_FP

1734-IT2I raC_Dvc_1734-IT2I_wDesc_FP

1738 raC_Dvc_1738IO_wDesc
.vpd

1738-IR2M12 raC_Dvc_1738-IR2M12_wDesc_FP

1738-IE2CM12 raC_Dvc_1738-IE2CM12_wDesc_FP

1738-IE2VM12 raC_Dvc_1738-IE2VM12_wDesc_FP

1738-IE4CM12 raC_Dvc_1738-IE4CM12_wDesc_FP

1738-IT2IM12 raC_Dvc_1738-IT2IM12_wDesc_FP

1756 raC_Dvc_1756IO_wDesc
.vpd

1756-IF16 raC_Dvc_1756-IF16_wDesc_FP

1756-IF4FXOF2F raC_Dvc_1756-IF4FXOF2F_wDesc_FP

1756-IF6CIS raC_Dvc_1756-IF6CIS_wDesc_FP

1756-IF6I raC_Dvc_1756-IF6I_wDesc_FP

1756-IF8 raC_Dvc_1756-IF8_wDesc_FP

1756-IF8I raC_Dvc_1756-IF8I_wDesc_FP

1756-IR12 raC_Dvc_1756-IR12_wDesc_FP

1756-IR6I raC_Dvc_1756-IR6I_wDesc_FP

1756-IRT8I raC_Dvc_1756-IRT8I_wDesc_FP

1756sc-IF8U raC_Dvc_1756sc-IF8U_wDesc_FP

1756-IT16 raC_Dvc_1756-IT16_wDesc_FP

1756-IT6I raC_Dvc_1756-IT6I_wDesc_FP

1769 raC_Dvc_1769IO_wDesc
.vpd

1769-IF16C raC_Dvc_1769-IF16C_wDesc_FP

1769-IF16V raC_Dvc_1769-IF16V_wDesc_FP

1769-IF4 raC_Dvc_1769-IF4_wDesc_FP

1769-IF4FXOF2F raC_Dvc_1769-IF4FXOF2F_wDesc_FP

1769-IF4I raC_Dvc_1769-IF4I_wDesc_FP

1769-IF4XOF2 raC_Dvc_1769-IF4XOF2_wDesc_FP

1769-IR6 raC_Dvc_1769-IR6_wDesc_FP

1769-IR6I raC_Dvc_1769sc_IR6I_wDesc_FP

1769-IT6 raC_Dvc_1769-IT6_wDesc_FP

1769-IT6I raC_Dvc_1769sc_IT6I_wDesc_FP

1769-IF8U raC_Dvc_1769sc_IF8U_wDesc_FP

1769-IF8 raC_Dvc_1769-IF8_wDesc_FP
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

1794 raC_Dvc_1794IO_wDesc
.vpd

1794-IE12 raC_Dvc_1794-IE12_wDesc_FP

1794-IE4XOE2 raC_Dvc_1794-IE4XOE2_wDesc_FP

1794-IE8 raC_Dvc_1794-IE8_wDesc_FP

1794-IE8XOE4 raC_Dvc_1794-IE8XOE4_wDesc_FP

1794-IF2XOF2I raC_Dvc_1794-IF2XOF2I_wDesc_FP

1794-IF4I raC_Dvc_1794-IF4I_wDesc_FP

1794-IF4ICF raC_Dvc_1794_IF4ICF_wDesc_FP

1794sc-IF8IU raC_Dvc_1794sc_IF8IU_wDesc_FP

1794sc-IRT8I raC_Dvc_1794sc_IRT8I_wDesc_FP

1794-IR8 raC_Dvc_1794-IR8_wDesc_FP

1794-IRT8 raC_Dvc_1794-IRT8_wDesc_FP

1794-IT8 raC_Dvc_1794-IT8_wDesc_FP

5069 raC_Dvc_5069IO_wDes
c.vpd

5069-IF8 raC_Dvc_5069-IF8_wDesc_FP

5069-IY4-IR raC_Dvc_5069-IY4-IR_wDesc_FP

5094 raC_Dvc_5094IO_wDes
c.vpd

5094-IF8 raC_Dvc_5094-IF8_wDesc_FP

5094_IY8
raC_Dvc_5094_IY8_IR_wDesc_FP

raC_Dvc_5094_IY8_IT_wDesc_FP

Family Module Application Code Manager File
1715 1715-IF16 (RA-LIB)_ACM_2.00_Module_Analog_1715-IF16_A_(5.3).HSL4

1719

1719-IR4B (RA-LIB)_ACM_2.00_Module_Analog_1719-IR4B_A_(5.3).HSL4

1719-IF4HB (RA-LIB)_ACM_2.00_Module_Analog_1719-IF4HB_A_(5.3).HSL4

1719-IT4B (RA-LIB)_ACM_2.00_Module_Analog_1719-IT4B_A_(5.3).HSL4

1732E

1732E-IF4M12R (RA-LIB)_ACM_2.00_Module_Analog_1732E-IF4M12R_A_(5.3).HSL4

1732E-IR4IM12R (RA-LIB)_ACM_2.00_Module_Analog_1732E-IR4IM12R_A_(5.3).HSL4

1732E-IT4IM12R (RA-LIB)_ACM_2.00_Module_Analog_1732E-IT4IM12R_A_(5.3).HSL4

Family View Designer File Module View Designer Screen
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1734

1734-IR2 (RA-LIB)_ACM_2.00_Module_Analog_1734-IR2_C_(5.3).HSL4

1734-IE2C (RA-LIB)_ACM_2.00_Module_Analog_1734-IE2C_C_(5.3).HSL4

1734-IE2V (RA-LIB)_ACM_2.00_Module_Analog_1734-IE2V_C_(5.3).HSL4

1734-IE4C (RA-LIB)_ACM_2.00_Module_Analog_1734-IE4C_C_(5.3).HSL4

1734-IE8C (RA-LIB)_ACM_2.00_Module_Analog_1734-IE8C_C_(5.3).HSL4

1734-IR2E (RA-LIB)_ACM_2.00_Module_Analog_1734-IR2E_C_(5.3).HSL4

1734-IT2I (RA-LIB)_ACM_2.00_Module_Analog_1734-IT2I_C_(5.3).HSL4

1734sc-IE4CH (RA-LIB)_ACM_2.00_Module_Analog_1734sc-IE4CH_A_(5.3).HSL4

1734sc-IF4U (RA-LIB)_ACM_2.00_Module_Analog_1734sc-IF4U_A_(5.3).HSL4

1734-IE4S (RA-LIB)_ACM_2.00_Module_Digital_1734-IE4S_A_(5.3).HSL4

1734sc-IE2CH (RA-LIB)_ACM_2.00_Module_Analog_1734sc-IE2CH_A_(5.3).HSL4

1738

1738-IR2M12 (RA-LIB)_ACM_2.00_Module_Analog_1738-IR2M12_A_(5.3).HSL4

1738-IE2CM12 (RA-LIB)_ACM_2.00_Module_Analog_1738-IE2CM12_A_(5.3).HSL4

1738-IE2VM12 (RA-LIB)_ACM_2.00_Module_Analog_1738-IE2VM12_A_(5.3).HSL4

1738-IE4CM12 (RA-LIB)_ACM_2.00_Module_Analog_1738-IE4CM12_A_(5.3).HSL4

1738-IT2IM12 (RA-LIB)_ACM_2.00_Module_Analog_1738-IT2IM12_A_(5.3).HSL4

1756

1756-IF16 (RA-LIB)_ACM_2.00_Module_Analog_1756-IF16_B_(5.3).HSL4

1756-IF4FXOF2F (RA-LIB)_ACM_2.00_Module_Analog_1756-IF4FXOF2F_(5.3).HSL4

1756-IF6CIS (RA-LIB)_ACM_2.00_Module_Analog_1756-IF6CIS_A_(5.3).HSL4

1756-IF6I (RA-LIB)_ACM_2.00_Module_Analog_1756-IF6I_(5.3).HSL4

1756-IF8 (RA-LIB)_ACM_2.00_Module_Analog_1756-IF8_B_(5.3).HSL4

1756-IF8I (RA-LIB)_ACM_2.00_Module_Analog_1756-IF8I_B_(5.3).HSL4

1756-IR12 (RA-LIB)_ACM_2.00_Module_Analog_1756-IR12_A_(5.3).HSL4

1756-IR6I (RA-LIB)_ACM_2.00_Module_Analog_1756-IR6I_(5.3).HSL4

1756-IRT8I (RA-LIB)_ACM_2.00_Module_Analog_1756-IRT8I_A_(5.3).HSL4

1756-IT16 (RA-LIB)_ACM_2.00_Module_Analog_1756-IT16_A_(5.3).HSL4

1756-IT6I2 (RA-LIB)_ACM_2.00_Module_Analog_1756-IT6I2_(5.3).HSL4

1756sc-IF8U (RA-LIB)_ACM_2.00_Module_Analog_1756sc-IF8U_A_(5.3).HSL4

1756-IT6I (RA-LIB)_ACM_2.00_Module_Analog_1756-IT6I_(5.3).HSL4

1769

1769-IF16C (RA-LIB)_ACM_2.00_Module_Analog_1769-IF16C_A_(5.3).HSL4

1769-IF16V (RA-LIB)_ACM_2.00_Module_Analog_1769-IF16V_A_(5.3).HSL4

1769-IF4 (RA-LIB)_ACM_2.00_Module_Analog_1769-IF4_B_(5.3).HSL4

1769-IF4FXOF2F (RA-LIB)_ACM_2.00_Module_Analog_1769-IF4FXOF2F_A_(5.3).HSL4

1769-IF4I (RA-LIB)_ACM_2.00_Module_Analog_1769-IF4I_A_(5.3).HSL4

1769-IF4XOF2 (RA-LIB)_ACM_2.00_Module_Analog_1769-IF4XOF2_A_(5.3).HSL4

1769-IF8 (RA-LIB)_ACM_2.00_Module_Analog_1769-IF8_A_(5.3).HSL4

1769sc-IF8U (RA-LIB)_ACM_2.00_Module_Analog_1769sc-IF8U_A_(5.3).HSL4

1769sc-IR6I (RA-LIB)_ACM_2.00_Module_Analog_1769sc-IR6I_A_(5.3).HSL4

1769-IR6 (RA-LIB)_ACM_2.00_Module_Analog_1769-IR6_A_(5.3).HSL4

1769-IT6 (RA-LIB)_ACM_2.00_Module_Analog_1769-IT6_A_(5.3).HSL4

1769sc-IT6I (RA-LIB)_ACM_2.00_Module_Analog_1769sc-IT6I_A_(5.3).HSL4

Family Module Application Code Manager File
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols

1794

1794-IE12 (RA-LIB)_ACM_2.00_Module_Analog_1794-IE12_A_(5.3).HSL4

1794-IE4XOE2 (RA-LIB)_ACM_2.00_Module_Analog_1794-IE4XOE2_B_(5.3).HSL4

1794-IE8 (RA-LIB)_ACM_2.00_Module_Analog_1794-IE8_B_(5.3).HSL4

1794-IE8XOE4 (RA-LIB)_ACM_2.00_Module_Analog_1794-IE8XOE4_A_(5.3).HSL4

1794-IF2XOF2I (RA-LIB)_ACM_2.00_Module_Analog_1794-IF2XOF2I_A_(5.3).HSL4

1794-IF4I (RA-LIB)_ACM_2.00_Module_Analog_1794-IF4I_A_(5.3).HSL4

1794-IR8 (RA-LIB)_ACM_2.00_Module_Analog_1794-IR8_B_(5.3).HSL4

1794-IRT8 (RA-LIB)_ACM_2.00_Module_Analog_1794-IRT8_A_(5.3).HSL4

1794-IF4ICF (RA-LIB)_ACM_2.00_Module_Analog_1794-IF4ICF_A_(5.3).HSL4

1794-IF8IHNF (RA-LIB)_ACM_2.00_Module_Analog_1794-IF8IHNF_A_(5.3).HSL4

1794sc-IF8IU (RA-LIB)_ACM_2.00_Module_Analog_1794sc-IF8IU_(5.3).HSL4

1794sc-IRT8I (RA-LIB)_ACM_2.00_Module_Analog_1794sc-IRT8I_(5.3).HSL4

1794-IT8 (RA-LIB)_ACM_2.00_Module_Analog_1794-IT8_B_(5.3).HSL4

5069
5069-IF8 (RA-LIB)_ACM_2.00_Module_Analog_5069-IF8_A_(5.3).HSL4

5069-IY4-IR (RA-LIB)_ACM_2.00_Module_Analog_5069-IY4-IR_A_(5.3).HSL4

5094

5094-IF8 (RA-LIB)_ACM_2.00_Module_Analog_5094-IF8_A_(5.3).HSL4

5094-IF8XT (RA-LIB)_ACM_2.00_Module_Analog_5094-IF8XT_A_(5.3).HSL4

5094-IY8 (RA-LIB)_ACM_2.00_Module_Analog_5094-IY8_B_(5.3).HSL4

5094-IY8XT (RA-LIB)_ACM_2.00_Module_Analog_5094-IY8XT_B_(5.3).HSL4

Family Module Application Code Manager File

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input 
Modules (-IF8I, -IRT8I, -IR12, -IT16)

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

GO_Launch_AI_1794 Use with 1794 Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AI_5094 Use with 5094 Analog Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchIn_Armor Use with 1732E/1738 Analog Input Only Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Analog Input modules this is the individual I.ChxData 

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input 
Modules (-IF8I, -IRT8I, -IR12, -IT16)

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_1794 Use with 1794 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_5094 Use with 5094 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchIn_Armor Use with 1732E/1738 Analog Input Only Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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REAL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.

1

2

7

6

3

4

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Data
4 Channel Fault Indication. “!” icon and yellow border.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-IF8I) has parameters which can be configured in 
Studio 5000® Application Code Manager prior to Controller code generation.

5

Channel Fault Type:
- Rate Alarm
- Overrange Alarm
- Underrange Alarm
- Calibration Fault
- High High Alarm
- High Alarm
- Low Alarm
- Low Low Alarm

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Data.x.@Description

Item Description

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
InputRange Sets the input Range type of the channels. 0=-10 to 10V, 1= 0 to 5 V, 2= 0 to 10V , 3= 0 to 20ma
OverrideDefaults False User can modify the H\L Signal and H\L Engineering values for the channels
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Configured HMI Content

Attachments

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules

Launch Button GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules

Launch Button GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules

Launch Button GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input Modules (-
IF8I, -IRT8I, -IR12, -IT16)

Launch Button GO_Launch_AI_1794 Use with 1794 Analog Input Modules

Launch Button GO_Launch_AI_5094 Use with 5094 Analog Input Modules

Launch Button GO_LaunchIn_Armor Use with 1732E/1738 Analog Input Only Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 213

Chapter 12

Analog Input with HART Modules

Overview Analog input with HART module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, data and faults
• HART multi-variable data and diagnostics

Note that 5094 HART modules have two modes:
• HART
• PlantPAx HART

Use the PlantPAx® faceplate and Application Code Manager configuration in 
PlantPAx® applications for use with the PlantPAx® Process Object Library.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1715 1715-IF16 (raC-5_01-SE) raC_Dvc_1715_IF16_HARTSimplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_HARTSimplex-Faceplate.gfx

1756

1756-IF16H (raC-5_03-SE) raC_Dvc_1756_IF16H-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_IF16H-Faceplate.gfx

1756-IF16IH (raC-5_02-SE) raC_Dvc_1756_IF16IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF16IH-Faceplate.gfx

1756-IF8IH (raC-5_02-SE) raC_Dvc_1756_IF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_IF8IH-Faceplate.gfx

1756-IF8H (raC-5_03-SE) raC_Dvc_1756_IF8H-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_IF8H-Faceplate.gfx

1769 1769sc-IF4IH (raC-5_02-SE) raC_Dvc_1769sc_IF4IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_IF4IH-Faceplate.gfx

1794
1794-IF8IH (raC-5_02-SE) raC_Dvc_1794_IF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_IF8IH-Faceplate.gfx

1794-IF8IHNF (raC-5_03-SE) raC_Dvc_1794_IF8IHNF-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1794_IF8IHNF-Faceplate.gfx

5094 5094-IF8IH
(raC-5_02-SE) raC_Dvc_5094_IF8IH_HART-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IF8IH_HART-Faceplate.gfx

(raC-5_02-SE) raC_Dvc_5094_IF8IH_PlantPAx-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_IF8IH_PlantPAx-Faceplate.gfx

Family Module View Designer File View Designer Screen
1715 1715-IF16 raC_Dvc_1715IO_wDesc.vpd raC_Dvc_1715-IF16_HARTSimplex_wDesc_FP

1756

1756-IF16H

raC_Dvc_1756IO_wDesc.vpd

raC_Dvc_1756-IF16H_wDesc_FP

1756-IF16IH raC_Dvc_1756_IF16IH_wDesc_FP

1756-IF8IH raC_Dvc_1756_IF8IH_wDesc_FP

1756-IF8H raC_Dvc_1756-IF8H_wDesc_FP

1769 1769sc-IF4IH raC_Dvc_1769IO_wDesc.vpd raC_Dvc_1769sc_IF4IH_wDesc_FP

1794 1794-IF8IH raC_Dvc_1794IO_Input_wDes
c.vpd

raC_Dvc_1794_IF8IH_wDesc_FP

raC_Dvc_1794_IF8IHNF_wDesc_FP

5094 5094-IF8IH raC_Dvc_5094IO_wDesc.vpd
raC_Dvc_5094-IF8IH_HART_wDesc_FP

raC_Dvc_5094-IF8IH_PlantPAx_wDesc_FP
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All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

Note:- If you are not utilizing all the channels of 5094-IF8IH, you should follow 
the steps below for the unused channels.

Step:-1

The Dummy_HART tag should be created in the controller scope and the data 
type should be the same as the Hart module.

Step :-2

Whenever a channel is used for a Hart module, it must have a tag description. 
If the Hart module is not present on any one of the channel, you need to specify 
“Unused” in the channel description.e.g. If HART module is not used on 
channel no. 02 then add AENTR_5094:1:I.Ch02.Data.@Description = Unused

Family Module Application Code Manager File
1715 1715-IF16 (RA-LIB)_ACM_2.00_Module_Analog_1715-IF16_B_(5.3).HSL4

1756

1756-IF16H (RA-LIB)_ACM_2.00_Module_Analog_1756-IF16H_A_(5.3).HSL4

1756-IF16IH (RA-LIB)_ACM_2.00_Module_Analog_1756-IF16IH_A_(5.3).HSL4

1756-IF8IH (RA-LIB)_ACM_2.00_Module_Analog_1756-IF8IH_A_(5.3).HSL4

1756-IF8H (RA-LIB)_ACM_2.00_Module_Analog_1756-IF8H_A_(5.3).HSL4

1769 1769sc-IF4IH (RA-LIB)_ACM_2.00_Module_Analog_1769sc-IF4IH_A_(5.3).HSL4

1794
1794-IF8IH (RA-LIB)_ACM_2.00_Module_Analog_1794-IF8IH_A_(5.3).HSL4

1794-IF8IHNF (RA-LIB)_ACM_2.00_Module_Analog_1794-IF8IHNF_A_(5.3).HSL4

5094
5094-IF8IH (RA-LIB)_ACM_2.00_Module_Analog_5094-IF8IH_A_(5.3).HSL4

5094-IF8IHXT (RA-LIB)_ACM_2.00_Module_Analog_5094-IF8IHXT_A_(5.3).HSL4
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Step:-3

You should put a dummy tag if you are not using channels
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FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_GotoDisplay2 Use with 5094-IF8IH & 5094-IF8IHXT Analog Input 
Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Channel 0 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#106: Channel 1 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#107: Channel 2 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#108: Channel 3 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#109: Channel 4 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#110: Channel 5 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#111: Channel 6 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#112: Channel 7 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#155: Custom button Label. Leave blank to use tag.@description
#120: Display's left position (e.g. 100)
#121: Display's top position (e.g. 100)

GO_GotoDisplay6 Use with 1794-IF8IH & 1794-IF8IHNF Analog Input 
Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input 
Modules (-IF8I, -IRT8I, -IR12, -IT16)

#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

GO_LaunchAI_17xx1 Use with 1738 Hart Analog Input
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AI_1794 Use with 1794 Analog Input Modules

#102: Faceplate Display Name
#103: IO Module Input1 Tag
#105: IO Module Input2 Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AI_5094 Use with 5094 Analog Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Channel 0 HART/PlantPAx Input Tag
#106: Channel 1 HART/PlantPAx Input Tag
#107: Channel 2 HART/PlantPAx Input Tag
#108: Channel 3 HART/PlantPAx Input Tag
#109: Channel 4 HART/PlantPAx Input Tag
#110: Channel 5 HART/PlantPAx Input Tag
#111: Channel 6 HART/PlantPAx Input Tag
#112: Channel 7 HART/PlantPAx Input Tag
#120: Display’s left position
#121: Display’s top position

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Analog Input modules this is the individual I.ChxData 
REAL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input 
Modules (-IF8I, -IRT8I, -IR12, -IT16)

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_1794 Use with 1794 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_AI_5094 Use with 5094 Analog Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.

1

2

7

6

3

4

8

5

10

9

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Data
4 Channel Fault Indication. “!” icon and yellow border.
5 Page Navigation. 2 channels shown per page.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Data.x.@Description

8

HART Data:
PV: Primary Value
SV: Secondary Value
TV: Third/Tertiary Value
FV: Fourth Value

9

HART Diagnostics (1715 modules only)
Command Status:
- Success
- Busy
- Command Not Implemented
- Buffer Overflow
- Reserved, Set to 0
- Longitudinal Parity Error
- Framing Error
- Overrun Error
- Vertical Parity Error
Field Status:
- Primary Variable Out of Limits
- Non-Prim Var. Out of Limits
- Analog Output Saturated
- Analog Output Current Fixed
- More Status Available
- Cold Start
- Configuration Changed
- Field Device Malfunction
External Device Status:
- Maintenance Required
- Device Variable Alert
- Critical Power Failure
- Undefined

10

Channel Fault Type:
- Maintenance Required
- Configuration Changed
- Device Variable Alert
- Current Fault
- HART Comm Fail
- Broken Wire
- HART Fault
- Calibration Fault
- Overrange
- Underrange

Item Description
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Module Object Parameters

Each module object (e.g. 5094-IF8IH) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription
Whenever a channel is used for a Hart module, it must have a tag description. If the Hart module is not 
present, you need to specify “Unused” in the channel description. Channel tag description is used in 
Studio 5000 and HMI faceplate.:I.Data.x.@Description tag and shown on HMI faceplates.

FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
FaceplateType PlantPAxData Selected Faceplate Type PlantPAxData or Data
ChXReference Select the channel tag referance

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules

Launch Button GO_LaunchAI_50xx Use with 1719/5069/5015 Analog Input Modules

Launch Button GO_Launch_AI_1756 Use with 1756 Standard Analog Input Modules

Launch Button GO_Launch_AIHR_1756 Use with 1756 High-Resolution Analog Input Modules (-
IF8I, -IRT8I, -IR12, -IT16)

Launch Button GO_Launch_AI_5069 Use with 5069 Analog Input Modules

Launch Button GO_Launch_AI_5094 Use with 5094 Analog Input Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 
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V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\

 Name Description File Name Extraction Path
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Chapter 13

Analog Output Modules

Overview Analog Output module objects include Studio 5000® Application Code 
Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, data and faults

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1715 1715-OF8I
(raC-5_03-SE) raC_Dvc_1715_OF8I_Simplex-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate.gfx

(raC-5_03-SE) raC_Dvc_1715_OF8I_Duplex-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx

1732E 1732E-OF4M12R (raC-5_00-SE) raC_Dvc_1732E_OF4M12R-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1732E_OF4M12R-Faceplate.gfx

1734

1734sc-OE2CIH (raC-5_02-SE) raC_Dvc_1734sc_OE2CIH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1734sc_OE2CIH-Faceplate.gfx

1734-OE2C (raC-5_00-SE) raC_Dvc_1734_OE2C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE2C-Faceplate.gfx

1734-OE2V (raC-5_00-SE) raC_Dvc_1734_OE2V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE2V-Faceplate.gfx

1734-OE4C (raC-5_00-SE) raC_Dvc_1734_OE4C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1734_OE4C-Faceplate.gfx

1738

1738-OE2CM12 (raC-5_00-SE) raC_Dvc_1738_OE2CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE2CM12-Faceplate.gfx

1738-OE2VM12 (raC-5_00-SE) raC_Dvc_1738_OE2VM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE2VM12-Faceplate.gfx

1738-OE4CM12 (raC-5_00-SE) raC_Dvc_1738_OE4CM12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1738_OE4CM12-Faceplate.gfx

1756

1756-OF4 (raC-5_00-SE) raC_Dvc_1756_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF4-Faceplate.gfx

1756-OF8 (raC-5_00-SE) raC_Dvc_1756_OF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF8-Faceplate.gfx

1756-OF6CI (raC-5_00-SE) raC_Dvc_1756_OF6CI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF6CI-Faceplate.gfx

1756-OF6VI (raC-5_00-SE) raC_Dvc_1756_OF6VI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1756_OF6VI-Faceplate.gfx

1756-OF8H (raC-5_01-SE) raC_Dvc_1756_OF8H-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OF8H-Faceplate.gfx

1756-OF8IH (raC-5_02-SE) raC_Dvc_1756_OF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OF8IH-Faceplate.gfx

1756-OF8I (raC-5_03-SE) raC_Dvc_1756_OF8I-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_OF8I-Faceplate.gfx

1769

1769-OF2 (raC-5_00-SE) raC_Dvc_1769_OF2-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF2-Faceplate.gfx

1769-OF4 (raC-5_00-SE) raC_Dvc_1769_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4-Faceplate.gfx

1769-OF4CI (raC-5_00-SE) raC_Dvc_1769_OF4CI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4CI-Faceplate.gfx

1769-OF4VI (raC-5_00-SE) raC_Dvc_1769_OF4VI-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF4VI-Faceplate.gfx

1769-OF8C (raC-5_00-SE) raC_Dvc_1769_OF8C-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF8C-Faceplate.gfx

1769-OF8V (raC-5_00-SE) raC_Dvc_1769_OF8V-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1769_OF8V-Faceplate.gfx

1794

1794-OE12 (raC-5_00-SE) raC_Dvc_1794_OE12-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OE12-Faceplate.gfx

1794-OE4 (raC-5_00-SE) raC_Dvc_1794_OE4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OE4-Faceplate.gfx

1794-OF4I (raC-5_00-SE) raC_Dvc_1794_OF4I-Faceplate.gfx (raC-5_00-ME) raC_Dvc_1794_OF4I-Faceplate.gfx

5069
5069-OF4 (raC-5_00-SE) raC_Dvc_5069_OF4-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OF4-Faceplate.gfx

5069-OF8 (raC-5_00-SE) raC_Dvc_5069_OF8-Faceplate.gfx (raC-5_00-ME) raC_Dvc_5069_OF8-Faceplate.gfx

5094 5094-OB8 (raC-5_03-SE) raC_Dvc_5094_OB8-Faceplate.gfx (raC-5_02-ME) raC_Dvc_5094_OB8-Faceplate.gfx

Family View Designer File Module View Designer Screen

1715 raC_Dvc_1715IO_wDesc
.vpd 1715-OF8I

raC_Dvc_1715-OF8I_AnalogSimplex_wDesc_FP

raC_Dvc_1715-OF8I_AnalogDuplex_wDesc_FP

1732E raC_Dvc_1732IO_wDesc
.vpd 1732E-OF4M12R raC_Dvc_1732E-OF4M12R_wDesc_FP
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

1734 raC_Dvc_1734IO_wDes
c.vpd

1734-OE2C raC_Dvc_1734-OE2C_wDesc_FP

1734-OE2V raC_Dvc_1734-OE2V_wDesc_FP

1734-OE4C raC_Dvc_1734-OE4C_wDesc_FP

1738 raC_Dvc_1738IO_wDes
c.vpd

1738-OE2CM12 raC_Dvc_1738-OE2CM12_wDesc_FP

1738-OE2VM12 raC_Dvc_1738-OE2VM12_wDesc_FP

1738-OE4CM12 raC_Dvc_1738-OE4CM12_wDesc_FP

1756 raC_Dvc_1756IO_wDesc
.vpd

1756-OF4 raC_Dvc_1756-OF4_wDesc_FP

1756-OF8 raC_Dvc_1756-OF8_wDesc_FP

1756-OF8I raC_Dvc_1756-OF8I_wDesc_FP

1756-OF8H raC_Dvc_1756-OF8H_wDesc_FP

1756_OF8IH raC_Dvc_1756_OF8IH_wDesc_FP

1756-OF6CI raC_Dvc_1756-OF6CI_wDesc_FP

1756-OF6VI raC_Dvc_1756-OF6VI_wDesc_FP

1769 raC_Dvc_1769IO_wDesc
.vpd

1769-OF2 raC_Dvc_1769-OF2_wDesc_FP

1769-OF4 raC_Dvc_1769-OF4_wDesc_FP

1769-OF4CI raC_Dvc_1769-OF4CI_wDesc_FP

1769-OF4VI raC_Dvc_1769-OF4VI_wDesc_FP

1769-OF8C raC_Dvc_1769-OF8C_wDesc_FP

1769-OF8V raC_Dvc_1769-OF8V_wDesc_FP

1794 raC_Dvc_1794IO_wDesc
.vpd

1794-OF4I raC_Dvc_1794-OF4I_wDesc_FP

1794-OE12 raC_Dvc_1794-OE12_wDesc_FP

1794-OE4 raC_Dvc_1794-OE4_wDesc_FP

5069 raC_Dvc_5069IO_wDes
c.vpd

5069-OF4 raC_Dvc_5069-OF4_wDesc_FP

5069-OF8 raC_Dvc_5069-OF8_wDesc_FP

5094 raC_Dvc_5094IO_wDe
sc.vpd 5094-OF8 raC_Dvc_5094-OF8_wDesc_FP

Family View Designer File Module View Designer Screen
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

Family Application Code Manager File
1715 (RA-LIB)_ACM_2.00_Module_Analog_1715-OF8I_A_(5.3).HSL4

1732E (RA-LIB)_ACM_2.00_Module_Analog_1732E-OF4M12R_A_(5.3).HSL4

1734

(RA-LIB)_ACM_2.00_Module_Analog_1734sc-OE2CIH_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1734-OE2C_C_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1734-OE2V_C_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1734-OE4C_C_(5.3).HSL4

1738

(RA-LIB)_ACM_2.00_Module_Analog_1738-OE2CM12_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1738-OE2VM12_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1738-OE4CM12_A_(5.3).HSL4

1756

(RA-LIB)_ACM_2.00_Module_Analog_1756-OF4_B_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8_B_(5.3)HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1756-OF6CI_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1756-OF6VI_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1756-OF8I_B_(5.3).HSL4

1769

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF2_B_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4CI_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF4VI_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF8C_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1769-OF8V_A_(5.3).HSL4

1794

(RA-LIB)_ACM_2.00_Module_Analog_1794-OF4I_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1794-OE12_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_1794-OE4_B_(5.3).HSL4

5069
(RA-LIB)_ACM_2.00_Module_Analog_5069-OF4_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_5069-OF8_A_(5.3).HSL4

5094
(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8_A_(5.3).HSL4

(RA-LIB)_ACM_2.00_Module_Analog_5094-OF8XT_A_(5.3).HSL4
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_OutputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output 
Modules (-OF8I)

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_1794 Use with 1794 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_5094 Use with 5094 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchIn_Armor Use with 1732E/1738 Analog Input/Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position
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Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output 
Modules (-OF8I)

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_1794 Use with 1794 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_5094 Use with 5094 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchIn_Armor Use with 1732E/1738 Analog Input/Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s Output tag instance. This is user-configurable 
from controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Analog Output modules this is the individual 
O.ChxData REAL tags. Failure to fill in these tags will result in HMI diagnostic 
errors. These tags can be filled out using Studio 5000 Application Code 
Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

1

2

7

6

3

4

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Data
4 Channel Fault Indication. “!” icon and yellow border.

5

Channel Fault Type:
- Ramp Alarm
- Not A Number
- Wire Off
- Calibration Fault
- In Hold
- High Limit Alarm
- Low Limit Alarm

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:O.Data.x.@Description
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Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-OF8) has parameters which can be configured in 
Studio 5000® Application Code Manager prior to Controller code generation.

Configured HMI Content

Parameter Name Default Value Description

OverrideDefaults True User can modify the H\L Engineering value for the channels
LowSignal 0 Low signal input to module
HighSignal 20 High signal input to module
LowEngineering 0 Low scaled signal output from module
HighEngineering 20 High scaled signal output from module
ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
CommFormat Float Data Select the communications format to be used
OutputRange 0 Sets the input Range type of the channels 0=-10V to 10V, 1=0 ma to 20ma

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

Launch Button GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules

Launch Button GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules

Launch Button GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output Modules (-
OF8I)

Launch Button GO_Launch_AO_1794 Use with 1794 Analog Output Modules

Launch Button GO_Launch_AO_5094 Use with 5094 Analog Output Modules

Launch Button GO_LaunchInOut_Armor Use with 1732E/1738 Analog Input/Output Modules
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Attachments

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Analog Output with HART Modules

Overview Analog Output with HART module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, data and faults
• HART multi-variable data and diagnostics

Note that 5094 HART modules have two modes:
• HART
• PlantPAx HART
• Use the PlantPAx® faceplate and Application Code Manager 

configuration in PlantPAx® applications for use with the PlantPAx® 
Process Object Library.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1715 1715-OF8I
(raC-5_03-SE) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate.gfx

(raC-5_03-SE) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx

1756
1756-OF8H (raC-5_01-SE) raC_Dvc_1756_OF8H-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OF8H-Faceplate.gfx

1756-OF8IH (raC-5_02-SE) raC_Dvc_1756_OF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1756_OF8IH-Faceplate.gfx

1769 1769sc-OF4IH (raC-5_02-SE) raC_Dvc_1769sc_OF4IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1769sc_OF4IH-Faceplate.gfx

1794 1794-OF8IH (raC-5_02-SE) raC_Dvc_1794_OF8IH-Faceplate.gfx (raC-5_02-ME) raC_Dvc_1794_OF8IH-Faceplate.gfx

5094 5094-OF8IH
(raC-5_01-SE) raC_Dvc_5094_OF8IH_HART-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OF8IH_HART-Faceplate.gfx

(raC-5_01-SE) raC_Dvc_5094_OF8IH_PlantPAx-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OF8IH_PlantPAx-Faceplate.gfx

Family View Designer File Module View Designer Screen

1715 raC_Dvc_1715IO_wDesc
.vpd 1715-OF8I

raC_Dvc_1715-OF8I_HARTSimplex_wDesc_FP

raC_Dvc_1715-OF8I_HARTDuplex_wDesc_FP

1756 raC_Dvc_1756IO_wDes
c.vpd

1756-OF8H raC_Dvc_1756-OF8H_wDesc_FP

1756-OF8IH raC_Dvc_1756-OF8IH_wDesc_FP

1769 raC_Dvc_1769IO_wDes
c.vpd 1769sc-OF4IH raC_Dvc_1769sc_OF4IH_wDesc_FP

1794 raC_Dvc_1794IO_Outp
ut_wDesc.vpd 1794-OF8IH raC_Dvc_1794_OF8IH_wDesc_FP

5094 raC_Dvc_5094IO_wDes
c.vpd 5094-OF8IH

raC_Dvc_5094-OF8IH_HART_wDesc_FP

raC_Dvc_5094-OF8IH_PlantPAx_wDesc_FP
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

Note:- If you are not utilizing all the channels of 5094-OF8IH, you should 
follow the steps below for the unused channels.

Step:-1

The Dummy_HART tag should be created in the controller scope and the data 
type should be the same as the Hart module.

Step :-2

Whenever a channel is used for a Hart module, it must have a tag description. 
If the Hart module is not present on any one of the channel, you need to specify 
“Unused” in the channel description.e.g. If HART module is not used on 
channel no. 02 then add AENTR_5094:1:I.Ch02.Data.@Description = Unused

Family Module Application Code Manager File
1715 1715-OF8I (RA-LIB)_ACM_2.00_Module_Analog_1715-OF8I_A_(5.3).HSL4

1756 1756-OF8H (RA-LIB)_ACM_2.00_Module_Analog_1756-OF8H_B_(5.3).HSL4

1769 1769sc-OF4IH (RA-LIB)_ACM_2.00_Module_Analog_1769sc-OF4IH_A_(5.3).HSL4

1794 1794-OF8IH (RA-LIB)_ACM_2.00_Module_Analog_1794-OF8IH_A_(5.3).HSL4

5094
5094-OF8IH (RA-LIB)_ACM_2.00_Module_Analog_5094-OF8IH_A_(5.3).HSL4

5094-OF8IHXT (RA-LIB)_ACM_2.00_Module_Analog_5094-OF8IHXT_A_(5.3).HSL4
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Step:-3

You should put a dummy tag if you are not using channels
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FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_GotoDisplay3 Use with 5094-OF8IH & 5094-OF8IHXT Analog 
Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Channel 0 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#106: Channel 1 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#107: Channel 2 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#108: Channel 3 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#109: Channel 4 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#110: Channel 5 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#111: Channel 6 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#112: Channel 7 HART/PlantPAx Input Tag, If channel is unused, 
add {::[Topic Name]Dummy_Hart} tag}
#155: Custom button Label. Leave blank to use tag.@description
#120: Display's left position (e.g. 100)
#121: Display's top position (e.g. 100)

GO_GotoDisplay7 Use with 1794-OF8IH Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: IO Module Input Tag
#106: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output 
Modules (-OF8I)

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_OutputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

GO_LaunchAO_17xx1 Use with 1734 Hart Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_1794 Use with 1794 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_Launch_AO_5094 Use with 5094 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s Output tag instance. This is user-configurable 
from controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Analog Output modules this is the individual 
O.ChxData REAL tags. Failure to fill in these tags will result in HMI diagnostic 

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output 
Modules (-OF8I)

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_1794 Use with 1794 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_AO_5094 Use with 5094 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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errors. These tags can be filled out using Studio 5000 Application Code 
Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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1

2

7

6

3

4

8

5

9

10

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Data
4 Channel Fault Indication. “!” icon and yellow border.
5 Page Navigation. 2 channels shown per page.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

7 Channel description. Module:O.Data.x.@Description

8

HART Data:
PV: Primary Value
SV: Secondary Value
TV: Third/Tertiary Value
FV: Fourth Value

9

Channel Fault Type:
- Variable Out of Limits
- Maintenance Required
- Configuration Changed
- Device Variable Alert
- Current Saturated
- HART Comm Failt
- PV Out of Limits
- Not a Number
- Broken Wire
- Current Fixed
- Power Low
- Fault Low Low
- HART Fault
- Ramp Alarm
- Cold Start
- Changed
- Calibration Fault
- Fault High High
- Open Wire
- In Hold

10

HART Diagnostics (1715 modules only)
Command Status:
- Success
- Busy
- Command Not Implemented
- Buffer Overflow
- Reserved, Set to 0
- Longitudinal Parity Error
- Framing Error
- Overrun Error
- Vertical Parity Error
Field Status:
- Primary Variable Out of Limits
- Non-Prim Var. Out of Limits
- Analog Output Saturated
- Analog Output Current Fixed
- More Status Available
- Cold Start
- Configuration Changed
- Field Device Malfunction
External Device Status:
- Maintenance Required
- Device Variable Alert
- Critical Power Failure
- Undefined

Item Description
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Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 5094-IF8IH) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Parameter Name Default Value Description

ChxDescription
Whenever a channel is used for a Hart module, it must have a tag description. If the Hart module is not 
present, you need to specify “Unused” in the channel description. Channel tag description is used in 
Studio 5000 and HMI faceplate.:I.Data.x.@Description tag and shown on HMI faceplates.

FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
FaceplateType PlantPAxData Selected Faceplate Type PlantPAxData or Data
ChXReference The tag reference for the channel should be selected 

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

Launch Button GO_LaunchAO_50xx Use with 1719/5069/5015 Analog Output Modules

Launch Button GO_Launch_AO_1756 Use with 1756 Standard Analog Output Modules

Launch Button GO_Launch_AOHR_1756 Use with 1756 High-Resolution Analog Output Modules (-
OF8I)

Launch Button GO_Launch_AO_1794 Use with 1794 Analog Output Modules

Launch Button GO_Launch_AO_5094 Use with 5094 Analog Output Modules



246 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Chapter 14          Analog Output with HART Modules

Attachments

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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1715 Duplex Modules

Overview 1715 Duplex I/O module objects include Studio 5000® Application Code 
Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. 

The 1715 I/O family offers the ability to run each module as simplex or duplex 
(redundant) mode. Analog modules can also be configured as standard analog 
or as analog HART. For simplex mode, see the other sections in this manual 
for:

• Digital Input Diagnostic Modules
• Digital Output Diagnostic Modules
• Analog Input Modules
• Analog Input with HART Modules
• Analog Output Modules
• Analog Output with HART Modules

This section covers unique attributes of using the duplex faceplates along with 
duplex configured 1715 I/O modules. There are 6duplex faceplates for the 
following configurations:

• Duplex Digital Input Diagnostic Modules
• Duplex Digital Output Diagnostic Modules
• Duplex Analog Input Modules
• Duplex Analog Input with HART Modules
• Duplex Analog Output Modules
• Duplex Analog Output with HART Modules

In addition to the simplex version of these modules, these duplex faceplates 
offer the following information:

• Module A/B status and fault information
• Channel Module A/B fault information

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.
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FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1715

1715-IB16D (raC-5_01-SE) raC_Dvc_1715_IB16D_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IB16D_Duplex-Faceplate.gfx
1715-IF16 (raC-5_01-SE) raC_Dvc_1715_IF16_AnalogDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_AnalogDuplex-Faceplate.gfx
1715-IF16 (raC-5_01-SE) raC_Dvc_1715_IF16_HARTDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_IF16_HARTDuplex-Faceplate.gfx

1715-OB8DE
(raC-5_03-SE) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Duplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OB8DE_Simplex-Faceplate.gfx

1715-OF8I

(raC-5_03-SE) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1715_OF8I_AnalogDuplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate (raC-5_01-ME) raC_Dvc_1715_OF8I_AnalogSimplex-Faceplate
(raC-5_03-SE) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1715_OF8I_HARTDuplex-Faceplate.gfx
(raC-5_03-SE) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate (raC-5_03-ME) raC_Dvc_1715_OF8I_HARTSimplex-Faceplate



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 249

Chapter 15          1715 Duplex Modules

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

Family
View 
Designer 
File

Module View Designer Screen

1715
raC_Dvc_171
5IO_wDesc.v
pd

1715-IB16D raC_Dvc_1715-IB16D_Duplex_wDesc_FP
1715-IF16 raC_Dvc_1715-IF16_AnalogDuplex_wDesc_FP
1715-IF16 raC_Dvc_1715-IF16_HARTDuplex_wDesc_FP

1715-OB8DE
raC_Dvc_1715-OB8DE_Duplex_wDesc_FP
raC_Dvc_1715-OB8DE_Simplex_wDesc_FP

1715-OF8I

raC_Dvc_1715-OF8I_AnalogDuplex_wDesc_FP
raC_Dvc_1715-OF8I_AnalogSimplex_wDesc_FP
raC_Dvc_1715-OF8I_HARTDuplex_wDesc_FP
raC_Dvc_1715-OF8I_HARTSimplex_wDesc_FP

Family Module Application Code Manager File

1715

1715-IF16 (RA-LIB)_ACM_2.00_Module_Analog_1715-IF16_A_(5.3).HSL4
1715-OB8DE (RA-LIB)_ACM_2.00_Module_Digital_1715-OB8DE_A_(5.3).HSL4
1715-OF8I (RA-LIB)_ACM_2.00_Module_Analog_1715-OF8I_A_(5.3).HSL4
1715-IB16D (RA-LIB)_ACM_2.00_Module_Digital_1715-IB16D_A_(5.3).HSL4
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag label. 
Use with input modules.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_GotoDisplay1 Faceplate navigation button with string tag label. 
Use with output modules.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.
Use with input modules.

InitialTab: 11
Module_InputTag: IO Module Input Tag

Button_002
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.
Use with output modules.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. This is the channel’s individual I or O tags such as I.Data.x 
BOOL tags for Digital Inputs. Failure to fill in these tags will result in HMI 
diagnostic errors. These tags can be filled out using Studio 5000 Application 
Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.

The faceplates for 1715 Duplex I/O modules are the same as other platform’s I/
O modules with the addition of duplex fault information. This section explains 
only the differences that are unique to duplex modules.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

1

2 3

4

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

4

Module/Channel Fault status text. May display the following:
- Module A - Fault or module not present
- Module B - Fault or module not present
- Module A Channel Fault Exists - Module B Data Shown
- Module B Channel Fault Exists - Module A Data Shown

5
Channel Fault Description (in addition to standard faults)
- Module A Fault
- Module B Fault
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Module Object Parameters

Each module object (e.g. 1715-IF16) has parameters which can be configured in 
Studio 5000® Application Code Manager prior to Controller code generation.

Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

Redundancy Yes
Module redundancy
- Yes
- No
This parameter is used to set the redundant property of the module.

CommFormat Analog Only This is used to Enable Hart parameters.

HMI Content Instance Name  Description

Launch Button GO_GotoDisplay Faceplate navigation button with string tag label. Use 
with input modules.

Launch Button GO_GotoDisplay1 Faceplate navigation button with string tag label. Use 
with output modules.

Launch Button GO_LaunchDCIn_17xx Use with 1715/1734/1756/1769 DC Input Modules

Launch Button GO_LaunchDCOut_17xx Use with 1715/1734/1756/1769 DC Output Modules

Launch Button GO_LaunchAI_17xx Use with 1715/1734/1769 Analog Input Modules

Launch Button GO_LaunchAO_17xx Use with 1715/1734/1769 Analog Output Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 
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V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\

 Name Description File Name Extraction Path
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5015 FLEXHA 5000 Universal I/O Modules

Overview 5015 FLEXHA 5000 Universal I/O (5015-U8IHFTXT) module objects include 
Studio 5000® Application Code Manager modules and HMI faceplates for 
FactoryTalk® View ME/SE and Studio 5000 View Designer®. 

5015-U8IHFTXT modules can be run in simplex or duplex mode. A different 
faceplate is provided for simplex mode and duplex. Each channel of the 
universal I/O module can be configured for an I/O type (digital input/digital 
output/analog input/analog output). At this time the HMI faceplates provided 
do not display channel specific information.

HMI faceplates provide the following information:
• Module description, status, and faults.
• Duplex modules provide channel diagnostic status.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

5015 5015-U8IHFTXT
Simplex (raC-5_01-SE) raC_Dvc_5015_U8IHFTXT_Simplex-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5015_U8IHFTXT_Simplex-Faceplate.gfx

Duplex (raC-5_03-SE) raC_Dvc_5015_U8IHFTXT_Duplex-
Faceplate.gfx (raC-5_01-ME) raC_Dvc_5015_U8IHFTXT_Duplex-Faceplate.gfx

Family
View 
Designer 
File

Module Variation View Designer Screen

5015
raC_Dvc_501
5IO_wDesc.v
pd

5015-U8IHFTXT
Simplex raC_Dvc_5015-U8IHFTXT_Simplex_wDesc_FP

Duplex raC_Dvc_5015-U8IHFTXT_Duplex_wDesc_FP

Family Module Application Code Manager File
5015 5015-U8IHFTXT (RA-LIB)_ACM_2.00_Module_Universal_5015-U8IHFTXT_(5.3).HSL4
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FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag 
label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchSpeciality_50xx Use with50xx Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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5015 Universal I/O Simplex Mode

1

2

5

4

3

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Module Fault Indication. “!” icon and yellow border.

4 Module/Channel Fault status text. May display the following:
- Connection faulted

5

Module Fault Description:
- Internal Fault
- Critical Temperature
- Over Temperature
- RTB Fault
- System Power A Fault
- System Power B Fault
- Backplane A Fault
- Backplane B Fault
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5015 Universal I/O Duplex Mode

1

2

6

5

3

4

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Module Fault Indication. “!” icon and yellow border.

4
Channel Diagnostic Status:
- Ready
- Diagnostic Active

5

Module/Channel Fault status text. May display the following:
- Connection faulted
- Module A - Fault or module not present
- Module B - Fault or module not present
- Module A Channel Fault Exists - Module B Data Shown
- Module B Channel Fault Exists - Module A Data Shown

6

Module Ready/Fault Description:
- Ready
- Internal Fault
- Critical Temperature
- Over Temperature
- RTB Fault
- System Power A Fault
- System Power B Fault
- Backplane A Fault
- Backplane B Fault
- Flash Update Fault
- Missing Fault
- Product Type Fault
- Revision Fault
- Ownership Fault
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 5015-U8IHFTXT) has parameters which can be 
configured in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Parameter Name Default Value Description

FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
SlotDuplex 0 This is the slot that this module is located in.Note that duplex module consume 2 slots.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

ChxAssignment Undefined

Channel Type
- Undefined
- Digital - Input
- Digital - Output
- Analog - Input
- Analog - Output

Redundancy Simplex Simplex (single module) or Duplex (dual module)
Symbolstyle GraphicalButton FTView HMI launch button symbol style.

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchSpeciality_50xx Use with50xx Specialty Modules
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Attachments

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Digital Input Safety Modules

Overview Digital input safety module objects include Studio 5000® Application Code 
Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, status and detailed faults
• Module diagnostic status and count (1756/5069/5094)

Some Safety I/O modules are provided with multiple configuration options. 
The most popular variations are available in this library. These can be 
configured using Application Code Manager. Unique faceplates for each 
variation are provided. These may include:

• Safety
• Safety Test Output
• Safety Muting

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1732ES 1732ES-IB16 SafetyTestOutput (raC-5_01-SE) raC_Dvc_1732ES_IB16_SafetyTestOutput -Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB16_SafetyTestOutput -Faceplate.gfx

1734 1734-IB8S SafetyTestOutput (raC-5_01-SE) raC_Dvc_1734_IB8S_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_IB8S_SafetyTestOutput-Faceplate.gfx

1756 1756-IB16S Safety (raC-5_01-SE) raC_Dvc_1756_IB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_IB16S_Safety-Faceplate.gfx

1791ES 1791ES-IB16
Safety (raC-5_01-SE) raC_Dvc_1791ES_IB16_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB16_Safety-Faceplate.gfx

SafetyTestOutput (raC-5_01-SE) raC_Dvc_1791ES_IB16_SafetyTestOutput-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB16_SafetyTestOutput-Faceplate.gfx

5069 5069-IB8S
Safety (raC-5_01-SE) raC_Dvc_5069_IB8S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_IB8S_Safety-Faceplate.gfx

SafetyMuting (raC-5_01-SE) raC_Dvc_5069_IB8S_SafetyMuting-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_IB8S_SafetyMuting-Faceplate.gfx

5094 5094-IB16S Safety (raC-5_01-SE) raC_Dvc_5094_IB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_IB16S_Safety-Faceplate.gfx

Family Module View Designer File Variation View Designer Screen
1732ES 1732ES-IB16 raC_Dvc_1732IO_wDesc.vpd SafetyTestOutput raC_Dvc_1732ES-IB16_SafetyTestOutput _wDesc_FP

1734 1734-IB8S raC_Dvc_1734IO_wDesc.vpd SafetyTestOutput raC_Dvc_1734-IB8S_SafetyTestOutput_wDesc_FP

1756 1756-IB16S raC_Dvc_1756IO_wDesc.vpd Safety raC_Dvc_1756-IB16S_Safety_wDesc_FP

1791ES 1791ES-IB16 raC_Dvc_1791IO_wDesc.vpd
Safety raC_Dvc_1791ES-IB16_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1791ES-IB16_SafetyTestOutput_wDesc_FP

5069 5069-IB8S
raC_Dvc_5069IO_wDesc.vpd Safety raC_Dvc_5069-IB8S_Safety_wDesc_FP

raC_Dvc_5069IO_wDesc.vpd SafetyMuting raC_Dvc_5069-IB8S_SafetyMuting_wDesc_FP

5094 5094-IB16S raC_Dvc_5094IO_wDesc.vpd Safety raC_Dvc_5094-IB16S_Safety_wDesc_FP
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols

Family Module Variation Application Code Manager File

1732ES 1732ES-IB16 SafetyTestOutput (RA-LIB)_ACM_2.00_Module_Digital_1732ES-
IB16_(5.3).HSL4

1734 1734-IB8S SafetyTestOutput (RA-LIB)_ACM_2.00_Module_Digital_1734-
IB8S_A_(5.3).HSL4

1756 1756-IB16S Safety (RA-LIB)_ACM_2.00_Module_Digital_1756-IB16S_(5.3).HSL4

1791ES 1791ES-IB16
Safety (RA-LIB)_ACM_2.00_Module_Digital_1791ES-

IB16_(5.3).HSL4SafetyTestOutput

5069 5069-IB8S
Safety

(RA-LIB)_ACM_2.00_Module_Digital_5069-IB8S_(5.3).HSL4
SafetyMuting

5094
5094-IB16S

Safety

(RA-LIB)_ACM_2.00_Module_Digital_5094-
IB16S_A_(5.3).HSL4

5094-IB16SXT (RA-LIB)_ACM_2.00_Module_Digital_5094-
IB16SXT_A_(5.3).HSL4

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay Faceplate navigation button with string tag 
label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyIn_1756 Use with 1756 Safety DC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyDI_1734 Use with 1734 SafetyDC Input Modules
#102: Faceplate Display Name
#103: IO Module Input Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_InSafety_Armor Use with 1732ES Safety Input Only Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I).

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchSafetyIn_1756 Use with 1756 Safety DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchSafetyDI_1745 Use with 1734 SafetyDC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_DCIn_5094 Use with 5094 DC Input Modules InitialTab: 11
Module_InputTag: IO Module Input Tag

GO_Launch_InSafety_Armor Use with 1732ES Safety Input Only Modules InitialTab: 11
Module_InputTag: IO Module Input Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual I.Ptxx.Data 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Diagnostic Tab

The Diagnostic tab is available only for 1756, 5094 and 5069 Safety I/O modules. 
This tab displays the Diagnostic Active status and the Diagnostic Count.

1

2

7

6

3

4

5

8

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Ptxx.Data.@Description

8
Channel Fault Description:
- Fault
- Short Circuit (1756/5094/5069 only)
- Uncertain (1756/5094/5069 only)
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-IB16S) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

1

2

3

Item Description
1 Diagnostic tab navigation button

2

Diagnostic Active Status

BLUE = Active/High

GREY = Inactive/Low

3 Diagnostic Count
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Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

PointMode Safety

Select the operation mode of the Points. Selections may vary depending on specific module. Options may 
include:
- Safety
- SafetyPulseTest
- SafetyMuting
- SafetyTestOutput

NavigationButton GraphicalButton Select Navigation Button Type

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchSafetyIn_1756 Use with 1756 Safety DC Input Modules

Launch Button GO_LaunchSafetyDI_1745 Use with 1734 SafetyDC Input Modules

Launch Button GO_LaunchDCIn_50xx Use with 1719/5069/5015 DC Input Modules

Launch Button GO_Launch_DCIn_5094 Use with 5094 DC Input Modules

Launch Button GO_Launch_InSafety_Armor Use with 1732ES Safety Input Only Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Digital Output Safety Modules

Overview Digital Output and combination Digital Input/Output safety module objects 
include Studio 5000® Application Code Manager modules and HMI faceplates 
for FactoryTalk® View ME/SE and Studio 5000 View Designer®. HMI 
faceplates provide the following information:

• Module description, status, and faults
• Channel description, status and detailed faults
• Module diagnostic status and count (1756/5069/5094)

Some Safety I/O modules are provided with multiple configuration options. 
The most popular variations are available in this library. These can be 
configured using Application Code Manager. Unique faceplates for each 
variation are provided. These may include:

• Safety
• Safety Bipolar
• Safety Sourcing

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx
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GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1734
1734-OB8S Safety (raC-5_01-SE) raC_Dvc_1734_OB8S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_OB8S_Safety-Faceplate.gfx

1734-OBV2S Safety (raC-5_01-SE) raC_Dvc_1734_OBV2S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1734_OBV2S_Safety-Faceplate.gfx

1732ES

1732ES-
IB12XOB4

Safety (raC-5_01-SE) raC_Dvc_1732ES_IB12XOB4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOB4_Safety-Faceplate.gfx
SafetyTestOutp
ut

(raC-5_01-SE) raC_Dvc_1732ES_IB12XOB4_SafetyTestOutput-
Faceplate.gfx

(raC-5_01-ME) raC_Dvc_1732ES_IB12XOB4_SafetyTestOutput-
Faceplate.gfx

1732ES-
IB12XOBV2

Safety (raC-5_01-SE) raC_Dvc_1732ES_IB12XOBV2_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB12XOBV2_Safety-Faceplate.gfx
SafetyTestOutp
ut

(raC-5_01-SE) raC_Dvc_1732ES_IB12XOBV2_SafetyTestOutput-
Faceplate.gfx

(raC-5_01-ME) raC_Dvc_1732ES_IB12XOBV2_SafetyTestOutput-
Faceplate.gfx

1732ES-
IB8XOB8

Safety (raC-5_01-SE) raC_Dvc_1732ES_IB8XOB8_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB8XOB8_Safety-Faceplate.gfx
SafetyTestOutp
ut

(raC-5_01-SE) raC_Dvc_1732ES_IB8XOB8_SafetyTestOutput-
Faceplate.gfx

(raC-5_01-ME) raC_Dvc_1732ES_IB8XOB8_SafetyTestOutput-
Faceplate.gfx

1732ES-
IB8XOBV4

Safety (raC-5_01-SE) raC_Dvc_1732ES_IB8XOBV4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1732ES_IB8XOBV4_Safety-Faceplate.gfx
SafetyTestOutp
ut

(raC-5_03-SE) raC_Dvc_1732ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

(raC-5_03-ME) raC_Dvc_1732ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

1756 1756-OBV8S
SafetyBipolar (raC-5_01-SE) raC_Dvc_1756_OBV8S_SafetyBipolar-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OBV8S_SafetyBipolar-Faceplate.gfx

SafetySourcing (raC-5_01-SE) raC_Dvc_1756_OBV8S_SafetySourcing-
Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_OBV8S_SafetySourcing-Faceplate.gfx

1791ES 1791ES-
IB8XOBV4

Safety (raC-5_01-SE) raC_Dvc_1791ES_IB8XOBV4_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1791ES_IB8XOBV4_Safety-Faceplate.gfx
SafetyTestOut
put

(raC-5_01-SE) raC_Dvc_1791ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

(raC-5_01-ME) raC_Dvc_1791ES_IB8XOBV4_SafetyTestOutput-
Faceplate.gfx

5069 5069-
OBV8S

SafetyBipolar (raC-5_01-SE) raC_Dvc_5069_OBV8S_SafetyBipolar-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_OBV8S_SafetyBipolar-Faceplate.gfx

SafetySourcing (raC-5_01-SE) raC_Dvc_5069_OBV8S_SafetySourcing-
Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_OBV8S_SafetySourcing-Faceplate.gfx

5094
5094-OB16S

Safety
(raC-5_01-SE) raC_Dvc_5094_OB16S_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OB16S_Safety-Faceplate.gfx

5094-OW4IS (raC-5_01-SE) raC_Dvc_5094_OW4IS_Safety-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_OW4IS_Safety-Faceplate.gfx

Family View Designer File Module Variation View Designer Screen

1734 raC_Dvc_1734IO_wDesc.vpd
1734-OB8S Safety raC_Dvc_1734-OB8S_Safety_wDesc_FP

1734-OBV2S Safety raC_Dvc_1734-OBV2S_wDesc_FP

1732ES raC_Dvc_1732IO_wDesc.vpd

1732ES-IB12XOB4
Safety raC_Dvc_1732ES-IB12XOB4_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1732ES-IB12XOB4_SafetyTestOutput_wDesc_FP

1732ES-IB12XOBV2
Safety raC_Dvc_1732ES-IB12XOBV2_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1732ES-IB12XOBV2_SafetyTestOutput_wDesc_FP

1732ES-IB8XOB8
Safety raC_Dvc_1732ES-IB8XOB8_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1732ES-IB8XOB8_SafetyTestOutput_wDesc_FP

1732ES-IB8XOBV4
Safety raC_Dvc_1732ES-IB8XOBV4_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1732ES-IB8XOBV4_SafetyTestOutput_wDesc_FP

1756 raC_Dvc_1756IO_wDesc.vpd 1756-OBV8S
SafetyBipolar raC_Dvc_1756-OBV8S_SafetyBipolar_wDesc_FP

SafetySourcing raC_Dvc_1756-OBV8S_SafetySourcing_wDesc_FP

1791ES raC_Dvc_1791IO_wDesc.vpd 1791ES-IB8XOBV4
Safety raC_Dvc_1791ES-IB8XOBV4_Safety_wDesc_FP

SafetyTestOutput raC_Dvc_1791ES-IB8XOBV4_SafetyTestOutput_wDesc_FP
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

5069 raC_Dvc_5069IO_wDesc.vpd 5069-OBV8S
SafetyBipolar raC_Dvc_5069-OBV8S_wDesc_FP

SafetySourcing raC_Dvc_5069-OBV8S_wDesc_FP

5094 raC_Dvc_5094IO_wDesc.vpd
5094-OB16S

Safety
raC_Dvc_5094-OB16S_Safety_wDesc_FP

5094-OW4IS raC_Dvc_5094-OW4IS_Safety_wDesc_FP

Family View Designer File Module Variation View Designer Screen

Family Module Variation Application Code Manager File

1734
1734-OB8S Safety (RA-LIB)_ACM_2.00_Module_Digital_1734-OB8S_(5.3).HSL4

1734-OBV2S Safety (RA-LIB)_ACM_2.00_Module_Digital_1734-OBV2S_(5.3).HSL4

1732ES

1732ES-IB12XOB4
Safety (RA-LIB)_ACM_2.00_Module_Digital_1732ES-

IB12XOB4_(5.3).HSL4SafetyTestOutput

1732ES-
IB12XOBV2

Safety (RA-LIB)_ACM_2.00_Module_Digital_1732ES-
IB12XOBV2_(5.3).HSL4SafetyTestOutput

1732ES-IB8XOB8
Safety (RA-LIB)_ACM_2.00_Module_Digital_1732ES-

IB8XOB8_(5.3).HSL4SafetyTestOutput

1732ES-
IB8XOBV4

Safety (RA-LIB)_ACM_2.00_Module_Digital_1732ES-
IB8XOBV4_(5.3).HSL4SafetyTestOutput

1756 1756-OBV8S

SafetyBipolar (RA-LIB)_ACM_2.00_Module_Digital_1756-OBV8S_(5.3).HSL4

1756-OB16IS (RA-LIB)_ACM_2.00_Module_Digital_1756-OB16IS_(5.3).HSL4

SafetySourcing (RA-LIB)_ACM_2.00_Module_Digital_1756-OBV8S_(5.3).HSL4

1791ES 1791ES-IB8XOBV4 Safety
(RA-LIB)_ACM_2.00_Module_Digital_1791ES-
IB8XOBV4_(5.3).HSL4SafetyTestOutput

5069 5069-OBV8S
SafetyBipolar (RA-LIB)_ACM_2.00_Module_Digital_5069-OBV8S_(5.3).HSL4

SafetySourcing (RA-LIB)_ACM_2.00_Module_Digital_5069-OBV8S_(5.3).HSL4

5094

5094-OB16S

Safety

(RA-LIB)_ACM_2.00_Module_Digital_5094-OB16S_A_(5.3).HSL4

5094-OW4IS (RA-LIB)_ACM_2.00_Module_Digital_5094-OW4IS_(5.3).HSL4

5094-OW4ISXT (RA-LIB)_ACM_2.00_Module_Digital_5094-
OW4ISXT_(5.3).HSL4

5094-OB16SXT (RA-LIB)_ACM_2.00_Module_Digital_5094-
OB16SXT_A_(5.3).HSL4
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string 
tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyIn_1756 Use with 1756 Safety DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyDI_1734 Use with 1734 SafetyDC Output Modules & 
with TestOutput Module Configuration

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output 
Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyOut_1756 Use with 1756 Safety AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSafetyDO_1734 Use with 1734 Safety AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchDCOut_50xx Use with 1719/5069/5015 AC Output 
Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_LaunchInOutSafety_Armor1 Use with 1791ES Safety Compact Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: Custom button label.
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

GO_Launch_DCOut_5094 Use with 5094 DC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_ACOut_5094 Use with 5094 AC Output Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#111: IO Class: Blank = Standard; 1= Safety
#120: Display’s left position
#121: Display’s top position

GO_Launch_InOutSafety_Armor
Use with 1732ES Safety Input/Output 
Modules & with TestOutput Module 
Configuration

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSafetyIn_175
6 Use with 1756 Safety DC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSafetyDI_173
4 Use with 1734 SafetyDC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSafetyOut_17
56 Use with 1756 Safety AC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSafetyDO_17
34 Use with 1734 Safety AC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchDCOut_50xx Use with 1719/5069/5015 AC Output Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual O.Ptxx.Data 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

GO_Launch_DCOut_509
4 Use with 5094 DC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_ACOut_509
4 Use with 5094 AC Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_Launch_InOutSafety
_Armor Use with 1732ES Safety Input/Output Modules

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol
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Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.

Home Page - Outputs

The first page(s) of the home tab displays Output channels. 8 channels will be 
shown per page; depending on the exact model this data may be shown on 
page 1 or page 1 and page 2.

1

2

7

6

3

4

5

8

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready
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Home Page - Readback

The next page of the home tab displays readback channels. 8 channels will be 
shown per page; depending on the exact model this data may be shown on 
page 2or page 3and page 4.

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border. This is correlated to the 
Module:O.Ptxx.Status tag where 0 = fault.

5 Page navigation; used for modules with more than 16 channels.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:O.Ptxx.Data.@Description

8

Channel fault description
- Field Power Off (1756/5069/5094 only)
- Channel Fault
- Short Circuit (1756/5069/5094 only)
- Uncertain (1756/5069/5094 only)

Item Description

1

2

5

3

4

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready
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Diagnostic Tab

The Diagnostic tab is available only for 1756, 5094 and 5069 Safety I/O modules. 
This tab displays the Diagnostic Active status and the Diagnostic Count.

Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Page navigation; used for modules with more than 16 channels.
5 Channel description. Module:I.Ptxx.Readback.@Description

Item Description

1

2

3

Item Description
1 Diagnostic tab navigation button

2

Diagnostic Active Status

BLUE = Active/High

GREY = Inactive/Low

3 Diagnostic Count
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Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-OBV8S) has parameters which can be configured 
in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Parameter Name Default Value Description

OUTChxDescription Channel tag description used in Module:O.Data.x.@Description tag and shown on HMI faceplates.
READBACKChXDescription Channel tag description used in studio 5000 and HMI faceplate.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

PointMode Safety

Select the operation mode of the Points. Selections may vary depending on specific module. Options may 
include:
- Safety
- SafetyPulseTest

NavigationButton GraphicalButton Select navigation button type

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchSafetyIn_1756 Use with 1756 Safety DC Output Modules

Launch Button GO_LaunchSafetyDI_1734 Use with 1734 SafetyDC Output Modules

Launch Button GO_LaunchDCOut_50xx Use with 1719/5069/5015 DC Output Modules

Launch Button GO_LaunchSafetyOut_1756 Use with 1756 Safety AC Output Modules

Launch Button GO_LaunchSafetyDO_1734 Use with 1734 Safety AC Output Modules

Launch Button GO_LaunchDCOut_50xx Use with 1719/5069/5015 AC Output Modules
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Attachments

Launch Button GO_Launch_DCOut_5094 Use with 5094 DC Output Modules

Launch Button GO_Launch_ACOut_5094 Use with 5094 AC Output Modules

Launch Button GO_Launch_InOutSafety_Ar
mor Use with 1732ES Safety Input/Output Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Sequence of Event (SOE) Modules

Overview Sequence of event (SOE) module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. HMI faceplates provide the following 
information:

• Module description, status, and faults
• Channel description, status and faults
• Event on/off timestamps and new data indications

The 1756-IB16ISOE and 1756-IH16SOE modules have multiple module 
configuration options. A single HMI faceplate is provided for both modules 
supporting two configurations. Using Application Code Manager you can 
select the desired configuration from the following options:

• CIP Sync Per Point
• CST Per Point

FIFO configurations are not supported with Application Code Manager or 
HMI faceplates at this time.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.
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GGFX Global Object Files

GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate

1756

1756-IB16ISOE
CIP Sync Per Point

(raC-5_01-SE) raC_Dvc_1756_Ix16ISOE-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_Ix16ISOE-Faceplate.gfx
CST Per Point

1756-IH16ISOE
CIP Sync Per Point

CST Per Point

Family View Designer File Module Variation View Designer Screen

1756 raC_Dvc_1756IO_wDesc
.vpd

1756-IB16ISOE
CIP Sync Per Point

raC_Dvc_1756-
Ix16ISOE_wDesc_FP

CST Per Point

1756-IH16ISOE
CIP Sync Per Point

CST Per Point
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756_Ix16ISOE-FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Family Module Variation Application Code Manager File

1756

1756-IB16ISOE
CIP Sync Per Point (RA-LIB)_ACM_2.00_Module_Digital_1756-

IB16ISOE_A_(5.2).HSL4CST Per Point

1756-IH16ISOE
CIP Sync Per Point (RA-LIB)_ACM_2.00_Module_Digital_1756-

IH16ISOE_A_(5.2).HSL4CST Per Point

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSOESerial_17xx Use with 17xx SOE and SERIAL Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSOESerial_17xx Use with 17xx SOE and SERIAL Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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The I/O channel descriptions are linked to the channel’s primary data tag 
.@Description field. For Digital Input modules this is the individual I.Data.x 
BOOL tags. Failure to fill in these tags will result in HMI diagnostic errors. 
These tags can be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

1

2

8

7

3

4

6

9

10

115

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel Status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Total number of events
6 Page navigation; used for modules with more than 8 channels.

7
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

8 Channel description. Module:I.Data.x.@Description
9 Timestamp On & Timestamp Off

10 Channels with new data shown highlighted with (i) 
icon.

11
Time Mode:
- CST
- UTC



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 293

Chapter 19          Sequence of Event (SOE) Modules

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-IBISOE) has parameters which can be 
configured in Studio 5000® Application Code Manager prior to Controller code 
generation.

Configured HMI Content

Attachments

Parameter Name Default Value Description

ChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button type.

HMI Content Instance Name  Description

Launch Button GO_GotoDisplay1 Faceplate navigation button with string tag label.

Launch Button GO_LaunchSOESerial_17xx Use with 17xx SOE and SERIAL Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 
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V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\

 Name Description File Name Extraction Path
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High Speed Counter (HSC) Modules

Overview High Speed Counter (HSC) module objects include Studio 5000® Application 
Code Manager modules and HMI faceplates for FactoryTalk® View ME/SE and 
Studio 5000 View Designer®. Functionality varies slightly depending on the I/
O family (1756/1769/1794/5069/5094). HMI faceplates provide the following 
information:

• All Modules (1756/1769/1794/5069/5094):
- Module description, status, and faults
- HSC channel description, data, count and faults

• 1769/5069/5094 modules additionally provide:
- channel A/B/Z status
- pulse width/interval
- Current rate/acceleration

• 5069 and 5094 modules additionally provide:
- detailed channel faults
- Output channel status, description and detailed faults
- In window status and window detailed faults

I/O modules may be configured with either Data or Data with Events; however, 
Event data is not displayed on any faceplates at this time.

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.
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GGFX Global Object Files

GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1756 1756-HSC (raC-5_03-SE) raC_Dvc_1756_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1756_HSC-Faceplate.gfx

1769 1769-HSC (raC-5_03-SE) raC_Dvc_1769_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1769_HSC-Faceplate.gfx

1794 1794-VHSC (raC-5_03-SE) raC_Dvc_1794_VHSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1794_VHSC-Faceplate.gfx

5069 5069-HSC2XOB4 (raC-5_01-SE) raC_Dvc_5069_HSC2XOB4-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5069_HSC2XOB4-Faceplate.gfx

5094 5094-HSC (raC-5_01-SE) raC_Dvc_5094_HSC-Faceplate.gfx (raC-5_01-ME) raC_Dvc_5094_HSC-Faceplate.gfx

Family View Designer File Module View Designer Screen

1756 raC_Dvc_1756IO_wDesc.
vpd 1756-HSC raC_Dvc_1756-HSC_wDesc_FP

1769 raC_Dvc_1769IO_wDesc.
vpd 1769-HSC raC_Dvc_1769-HSC_wDesc_FP

1794 raC_Dvc_1794IO_wDesc.
vpd 1794-VHSC raC_Dvc_1794-VHSC_wDesc_FP

5069 raC_Dvc_5069IO_wDesc
.vpd 5069-HSC2XOB4 raC_Dvc_5069-HSC2XOB4_wDesc_FP

5094 raC_Dvc_5094IO_wDesc
.vpd 5094-HSC raC_Dvc_5094-HSC_wDesc_FP
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Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 

Family Module Application Code Manager File
1756 1756-HSC (RA-LIB)_ACM_2.00_Module_Speciality_1756-HSC_B_(5.3).HSL4

1769 1769-HSC (RA-LIB)_ACM_2.00_Module_Speciality_1769-HSC_A_(5.3).HSL4

1794 1794-VHSC (RA-LIB)_ACM_2.00_Module_Speciality_1794-
VHSC_A_(5.3).HSL4

5069 5069-HSC2XOB4 (RA-LIB)_ACM_2.00_Module_Speciality_5069-
HSC2XOB4_A_(5.3).HSL4

5094
5094-HSC (RA-LIB)_ACM_2.00_Module_Speciality_5094-

HSC_A_(5.3).HSL4

5094-HSCXT (RA-LIB)_ACM_2.00_Module_Speciality_5094-
HSCXT_A_(5.3).HSL4

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpecialty_1794 Use with 1794 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position



298 Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023

Chapter 20          High Speed Counter (HSC) Modules

InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSpecialty_1794 Use with 1794 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The channel descriptions are linked to the channel’s primary data tag 
.@Description field. 

For 50xx Modules:
• Counter channel description is linked to the module’s I.Counterxx tags. 
• Output channel description fields are linked to the 

I.Outputxx.@Description fields.

For 1756 Modules:
• Counter channel description is linked to the module’s I.PresentValue[x] 

tags. 

For 1794 Modules:
• Counter channel description is linked to the module’s 

I.ChxCurrentCount tags.

Failure to fill in these tags will result in HMI diagnostic errors. These tags can 
be filled out using Studio 5000 Application Code Manager.
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Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information.

5069 and 5094 have 3 pages within the home tab. They display the following 
data:

• Page 1: Counter channel data
• Page 2: Output channel data
• Page 3: Window data
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1756/1794 Home Tab - Counters

1

2

7

6

3

4

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel current count
4 Channel Fault Indication. “!” icon and yellow border.

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.PresentValue[x]@Description (1756) or 
Module:I.ChxCurrentCount.@Description (1794)
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1769/5069/5094 Home Tab - Counters

1

2

7

6

3

4 9

8

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3

Channel A/B/Z status indicator.

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state
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5069/5094 Home Tab - Outputs

7 Channel description. Module:I.Counterxx.@Description

8

Detailed counter channel data
- Count
- Frequency
- Pulse Width
- Acceleration

9

Detailed fault data:
- Zero Frequency Alarm
- Missing Pulse Alarm
- Partial Average Frequency
- Partial Average Pulse Width
- HSC Uncertain
- Acceleration Average Alarm
- Deceleration Average Alarm
- Not a Number
- Zero Frequency Alarm
- Frequency Average Alarm
- Pulse Width Average Alarm
- Deceleration Alarm
- Acceleration Alarm
- Rollover
- Frequency Overrange
- Pulse Width Alarm
- Frequency Alarm

Item Description

1

2

7

6

3

4

8

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready
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5069/5094 Home Tab - Windows

3

Output channel status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Module:I.Outputxx.@Description

8

Detailed fault data:
- Short Circuit
- Uncertain
- No Load
- Channel Fault

Item Description

1

2 6

3

4 7

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 1756-HSC) has parameters which can be configured in 
Studio 5000® Application Code Manager prior to Controller code generation.

3

In window status

BLUE = Active/High

GREY = Inactive/Low

4 Channel Fault Indication. “!” icon and yellow border.
5 Page navigation

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

8 Detailed fault data:
- Not a Number

Item Description

Parameter Name Default Value Description

CounterChxDescription Channel tag description used in Module:I.Data.x.@Description tag and shown on HMI faceplates.
FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.
NavigationButton GraphicalButton Select Navigation Button type.
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Configured HMI Content

Attachments

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules

Launch Button GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules

Launch Button GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules

Launch Button GO_LaunchSpecialty_1794 Use with 1794 Specialty Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Overview Serial module objects include Studio 5000® Application Code Manager 
modules and HMI faceplates for FactoryTalk® View ME/SE and Studio 5000 
View Designer®. Functionality varies slightly depending on the I/O family 
(1769/5069/5094). HMI faceplates provide the following information:

• All serial modules:
- Module description, status, and faults
- Serial channel description and detailed fault status

• 1769-ASCII
- New data and Tx Data Sent status
- Tx Ack count
- Rx ID and Rx Data Length

• 5069/5094-SERIAL - ASCII Channel
- Diagnostic status and count
- New data status
- CTS/RTS/DSR/DCD/DTR/XOFF Status
- Tx Data sent status, Tx Ack count, Tx ID and Tx Data length
- Rx ID and Rx Data Length

• 5069/5094-SERIAL - Modbus Master/Slave Channel
- Diagnostic status and count

5069/5094 SERIAL modules can use the same HMI faceplates. One faceplate is 
assigned per serial channel and is dependent on one of the three serial types 
used:

• ASCII
• Modbus Master
• Modbus Slave

Required Files IO Device Objects include HMI faceplates. There is no controller programming 
required other than the creation of the I/O module in the project. If using 
FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages.

Note that the revision numbers (e.g. 5.01) used in filenames below can change 
as new revisions are created.
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FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1769 1769-ASCII N/A (raC-5_01-SE) raC_Dvc_1769_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_1769_ASCII-Faceplate.gfx

5069 5069-SERIAL
ASCII (raC-5_03-SE) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx
MBMaster (raC-5_03-SE) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx
MBSlave (raC-5_03-SE) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBSlave-Faceplate.gfx

5094 5094-SERIAL
ASCII (raC-5_03-SE) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_ASCII-Faceplate.gfx
MBMaster (raC-5_03-SE) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBMaster-Faceplate.gfx
MBSlave (raC-5_03-SE) raC_Dvc_50x_SERIAL_MBSlave-Faceplate.gfx (raC-5_01-ME) raC_Dvc_50xx_SERIAL_MBSlave-Faceplate.gfx

Family View Designer File Module Variation View Designer Screen

1769 raC_Dvc_1769IO_wDe
sc.vpd 1769-ASCII N/A raC_Dvc_1769-ASCII_wDesc_FP

5069 raC_Dvc_5069IO_wDe
sc.vpd 5069-SERIAL

ASCII raC_Dvc_5069-SERIAL_ASCII_wDesc_FP

MBMaster raC_Dvc_5069-
SERIAL_MBMaster_wDesc_FP

MBSlave raC_Dvc_5069-
SERIAL_MBSlave_wDesc_FP

5094 raC_Dvc_5094IO_wDe
sc.vpd 5094-SERIAL

ASCII raC_Dvc_5094-SERIAL_ASCII_wDesc_FP

MBMaster raC_Dvc_5094-
SERIAL_MBMaster_wDesc_FP

MBSlave raC_Dvc_5094-
SERIAL_MBSlave_wDesc_FP
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols

Family Module Application Code Manager File
1769 1769-ASCII (RA-LIB)_ACM_2.00_Module_Speciality_1769-ASCII_(5.3).HSL4
5069 5069-SERIAL (RA-LIB)_ACM_2.00_Module_Speciality_5069-SERIAL_(5.3).HSL4

5094 5094-SERIAL
(RA-LIB)_ACM_2.00_Module_Speciality_5094-SERIAL_A_(5.3).HSL4
(RA-LIB)_ACM_2.00_Module_Speciality_5094-SERIALXT_A_(5.3).HSL4

Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay1 Faceplate navigation button with string tag label.

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#105: Custom button label. Leave blank to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position

GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules

#102: Faceplate Display Name
#103: IO Module Input Tag
#104: IO Module Output Tag
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_5_02_Dvc_1756OB16D_wDesc_FP). The required Property 
Configurations are found in the following table where you may assign an 
InitialTab to 11 to ensure the pop-up opens on the Home Tab, and assign the 
Module_InputTag to the module’s :I controller tag (e.g. ::PAC.Local:3:I) and 
Module_OutputTag to the module’s :O controller tag (e.g. ::PAC.Local:3:O).

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
Faceplate navigation button with string tag label. 
Use Properties > General > Text to modify the 
button label text.

InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag

GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules
InitialTab: 11
Module_InputTag: IO Module Input Tag
Module_OutputTag: IO Module Output Tag
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

In this document, the faceplate pictures (or snapshots) are shown in 
FactoryTalk® View ME. Faceplates will look similar in FactoryTalk® View SE or 
Studio 5000 View Designer®. Number of I/O channels and minor details may 
vary depending on the exact I/O module.

The faceplate title is linked to Module:I.@description, the .@description extended 
tag property of the module’s input tag instance. This is user-configurable from 
controller/program tags in Studio 5000 Logix Designer.

The channel descriptions are linked to the channel tag’s .@Description field. 

Failure to fill in these tags will result in HMI diagnostic errors. These tags can 
be filled out using Studio 5000 Application Code Manager.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information. Home tabs vary based on the type of module and serial 
channel type.
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50xx ASCII Channel

1

2

8

6

3

4
9

7

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Fault Indication. “!” icon and yellow border.

4

Channel Status:
- Diagnostic Active
- New Data
- Tx Data Sent
- CTS
- RTS
- DSR
- CDC
- DTR
- XOFF

BLUE = Active/High

GREY = Inactive/Low

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 313

Chapter 21          Serial Modules

50xx Modbus Master Channel

7 Channel description. Channel:I.@Description 

8

Channel Fault Details:
- Non Delimited Record
- Rx Data Length Invalid
- Tx Data Length Invalid
- Handshake Error
- Break Interrupt
- Buffer Overrun
- Rx FIFO Empty
- Tx FIFO Empty
- Framing Error
- Tx Data Lost
- Rx Data Lost
- Uncertain
- Parity Error

9

Channel Data:
- Diagnostic Count
- Tx Ack Count
- Tx ID
- Tx Data Length
- Rx ID
- Rx Data Length

Item Description

1

2

8

6

3

4 9

7

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Fault Indication. “!” icon and yellow border.
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50xx Modbus SlaveChannel

4

Channel Status:
- Diagnostic Active

BLUE = Active/High

GREY = Inactive/Low

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Channel:I.@Description

8 Channel Fault Details:
- Uncertain

9 Channel Data:
- Diagnostic Count

Item Description

1

2

8

6

3

4 9

7

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Fault Indication. “!” icon and yellow border.
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1769-ASCII Channel

4

Channel Status:
- Diagnostic Active

BLUE = Active/High

GREY = Inactive/Low

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Channel:I.@Description

8

Channel Fault Details:
- Uncertain
- Illegal Data Address
- CRC LRC Error
- Buffer Overrun
- Framing Error
- Parity Error

9 Channel Data:
- Diagnostic Count

Item Description

1

2

8

6

3

4 9

7

10

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready

3 Channel Fault Indication. “!” icon and yellow border.
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Application Code Manager The IO Device Library can be used with Studio 5000® Application Code 
Manager to configure all required I/O for a project. All I/O modules can be 
found in the (RA-LIB) ACM 2.00 Library within the Module folder.

Refer to the section Using Application Code Manager for complete details.

Module Object Parameters

Each module object (e.g. 5094-SERIAL) has parameters which can be 
configured in Studio 5000® Application Code Manager prior to Controller code 
generation.

4

Channel Status:
- New Data
- Tx Data Sent

BLUE = Active/High

GREY = Inactive/Low

6
Module/Channel Fault status text. May display the following:
- Module Fault - All Channel Data remains at last pre-fault state
- Channel Fault Exists - Data remains at last pre-fault state

7 Channel description. Channel:I.@Description

8

Channel Fault Details:
- Non Delimited Record
- Tx Data Overflow
- Handshake Error
- Tx FIFO Empty
- Rx FIFO Empty
- Rx Data Lots
- Tx Data Lost
- Parity Error

9
Channel Data:
- TX Ack
- RX ID
- Rx Data Length

10 Page navigation. One page per ASCII channel.

Item Description

Parameter Name Default Value Description

FPLaunch_Button_Label [ModuleName] Module:I.@Descroption tag and shown on basic text launch buttons.
SEAssocDisplay Associated HMI SE Display
MEAssocDisplay Associated HMI ME Display
Slot Next Available This is the slot that this module is located in.
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Configured HMI Content

Attachments

RPI 20 This is the RPI of the module (ms).
ChassisName [ChassisName] This is the Chassis that this module is located in.

Channel0 Disabled

Serial channel type (5069/5094 only)
- Disabled
- Generic ASCII
- Modbus Master
- Modbus Slave

Channel1 Disabled

Serial channel type (5069/5094 only)
- Disabled
- Generic ASCII
- Modbus Master
- Modbus Slave

NavigationButton GraphicalButton Select navigation button type.

Parameter Name Default Value Description

HMI Content Instance Name  Description

Launch Button GO_LaunchFP Global Object generic rectangular text launch button

Launch Button GO_LaunchSpeciality_50xx Use with 5069 Specialty Modules

Launch Button GO_LaunchHSC_17xx Use with 1734/1756/1769 Specialty Modules

Launch Button GO_LaunchSpecialty_5094 Use with 5094 Specialty Modules

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200A-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 

V5_IO_Device_HMI_Tag HMI Tag FTViewStudio_IOLibrary_Tags_5_00.CSV {ProjectName}\Visualization\
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Redundant Adapter 1756-EN4TR

Overview 1756-EN4TR redundant adapter module objects include Studio 5000® 
Application Code Manager modules, HMI faceplates for FactoryTalk® View 
ME/SE and Studio 5000 View Designer®, and an Add-On Instruction (AOI).

The redundant adapter feature is available for 1756-EN4TR modules when used 
as remote adapters and the modules must be installed in slots 0 and 1 of the 
remote chassis. The benefit of this feature is increased reliability of the 
remotely located ControlLogix I/O modules. For more information on 
redundant adapters, refer to the ControlLogix EtherNet/IP Network Devices User 
Manual.

• HMI faceplates provide the following information:
- Status of redundant adapter pair
- Primary module IP address
- Primary module slot number
- Primary module status
- Partner module status
- Information on when a qualification of the partner module is 

occurring
- Port status indicator for each Ethernet port within the redundant 

adapter pair

Required Files IO Device Objects include HMI faceplates. For the 1756-EN4TR redundant 
adapter, controller programming includes the creation of the I/O modules in 
the project and use of an AOI to manage the redundant adapter information. If 
using FactoryTalk® View ME/SE you must also import the tag import file 
FTViewStudio_IOLibrary_Tags_5_00.CSV to support navigation on faceplates 
with multiple tabs or pages

Note that the revision numbers (e.g. 5.03) used in filenames below can change 
as new revisions are created.

Controller Files

Add-On Instructions are reusable code objects that contain encapsulated logic 
that can streamline implementing your system. This lets you create your own 
instruction set for programming logic as a supplement to the instruction set 
provided natively in the ControlLogix® firmware. An Add-On Instruction is 
defined once in each controller project, and can be instantiated multiple times

in your application code as needed.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um004_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um004_-en-p.pdf
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The Add-On Instruction must be imported into the controller project to be 
used in the controller configuration. These can be imported as Add-On 
Instruction files, or as part of the Rung Import or Import Library Objects 
wizard.

All Add-On Instruction and Rung Import files can be found in the /Studio 5000 
Logix Designer Files - L5X/ folder in the library. 

FactoryTalk® View HMI Files

FactoryTalk® View ME/SE applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk View ME/ library folder and 
FactoryTalk® View SE files are stored in the /HMI - FactoryTalk View SE/ library 
folder.

GGFX Global Object Files

GFX Display Files

Studio 5000 View Designer HMI Files

All Studio 5000 View Designer Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library. Each I/O family (e.g. 1756) has a single .VPD file which 
contains faceplate screens for all I/O modules in that family.

Device/Item Compatible Modules Add-On Instruction Rung Import
EN4TR 1756-EN4TR raC_Dvc_1756_EN4TR_5.03_AOI.L5X raC_Dvc_1756_EN4TR_5.03_Rung.L5X

Device/Item Compatible Modules FactoryTalk® View SE
Faceplate

FactoryTalk® View ME
Faceplate

Graphic Symbols All IO Modules (raC-5-SE) Graphic Symbols - IO Device (raC-5-ME) Graphic Symbols - IO Device
Toolbox All IO Modules (raC-5-SE) Toolbox -IO Device.ggfx (raC-5-ME) Toolbox -IO Device.ggfx

Family Module Variation FactoryTalk View SE Faceplate FactoryTalk View ME Faceplate
1756 1756-EN4TR N/A (raC-5_03-SE) raC_Dvc_1756_EN4TR-Faceplate.gfx (raC-5_03-ME) raC_Dvc_1756_EN4TR-Faceplate.gfx

Family View Designer File Module Variation View Designer Screen

1756 raC_Dvc_1756_EN4TR
.vpd 1756-EN4TR N/A raC_Dvc_1756_EN4TR_FP
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Module files 
include attachments of all required files for that object. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Device Definition The 1756-EN4TR must be configured with the correct device definition. Proper 
module configuration is required to use the redundant adapter feature and 
leverage the associated Add-On instruction and faceplate.

To verify the device definition:

Find the device in the Controller Organizer pane in Studio 5000 Logix 
Designer® and open the Module Properties by double-clicking or right-click 
and select Properties. 

On the Overview tab click on the Device Definition button.

Implementation 
Object

Compatible 
Modules Asset Control File (.HSL4) Device File (.HSL4)

1756-EN4TR 1756-EN4TR (RA-LIB)_Device_Asset-Control_IO-
Device_raC_Dvc_1756_EN4TR_(5.3).HSL4

(RA-LIB)_Device_Device_IO-
Device_raC_LD_Dvc_1756_EN4TR_(5.3).HSL4
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Ensure Redundant field is set to Adapter Pair.



Rockwell Automation Publication DEVICE-RM200C-EN-P - October 2023 323

Chapter 22          Redundant Adapter 1756-EN4TR

Library Versions Each library object has a revision x.yy where: x is the Major Revision number 
and yy is the Minor Revision number. Each release of the library comes with 
release notes that describe the changes that were made since the last release. 
You can find the revision number of the object in a number of locations as 
shown below.

Component Example

The Add-On Instruction in Logix Designer 
application has revision information visible 
when the instruction is selected in the 
Controller Organizer.

The Add-On Instruction Definition General 
tab shows the revision number along with 
basic revision notes. Refer to the release 
notes for complete revision notes.

The faceplate in FactoryTalk View 
software has revision information visible 
when the pointer is clicked just inside the 
lower left corner of the faceplate.

The revision number is shown in the file 
names for GFX, VPD, ACM.HSL4, AOI.L5X, 
and RUNG.L5X files.
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Add-On Instruction I/O Data InOut Data

Note that the 1756_EN4TR_RedAdapter device object has several InOut 
Parameters for MSG instructions which are required to communicate with the 
redundant adapter pair. These controller scoped tags are automatically 
imported when using Application Code Manager or importing the RUNG.L5X 
file. Ensure the Destination Elements for each MSG are set to unique tags 
when using multiple instances of the object.

InOut Function / Description  DataType

Inf_Lookup Code / Description List Entry raC_UDT_LookupMember_STR0082[2]

Ref_Ctrl_Cmd Automation Device Command Interface - 
IODevice

raC_UDT_ItfAD_IODevice_Cmd

Ref_Ctrl_Inf Automation Device Information Interface - 
IODevice

raC_UDT_ItfAD_IODevice_Inf

Ref_Ctrl_Set Automation Device Setting Interface - 
IODevice

raC_UDT_ItfAD_IODevice_Set

Ref_Ctrl_Sts Automation Device Status Interface - 
IODevice

raC_UDT_ItfAD_IODevice_Sts

Ref_Module Address in I/O tree of redundant adapter 
pair

Module

Ref_MsgData General messaging data SINT[100]

Ref_MsgCustGetAll General messaging data MESSAGE

Ref_MsgGetAttrSgl General messaging data MESSAGE
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Input Data

Output Data

Input Function / Description  DataType

Inp_Enable Trigger for AOI BOOL

EnableIn Enable Input - System Defined Parameter BOOL

Output Function / Description  DataType

Val_LinkStsWordPrim1 Status of port 1 on the primary adapter 
module

DINT

Val_LinkStsWordPrim2 Status of port 2 on the primary adapter 
module

DINT

Val_LinkStsWordSec1 Status of port 1 on the secondary adapter 
module

DINT

Val_LinkStsWordSec2 Status of port 2 on the secondary adapter 
module

DINT

Val_ModuleStatus Module status DINT

raC_Dvc_1756_EN4TR_Red
Adapter

Unique Parameter Name for auto - 
discovery

BOOL

Sts_Available Device is available for interaction with 
user code

BOOL

Sts_bNotReady Bitwise device 'not ready' reason DINT

Sts_Connected Device is connected to the Programmable 
Automation Controller

BOOL

Sts_DSwP Disqualified secondary with primary BOOL

Sts_Faulted Device faulted status: 1 = an active fault 
exists

BOOL

Sts_InProgress Qualification attempt in progress BOOL

Sts_InhibitCmd Disable Command inputs from external 
sources

BOOL

Sts_InhibitSet Disable Setting inputs from external 
sources

BOOL

Sts_PartnerState State of partner module in redundant 
adapter pair

INT

Sts_PrimarySlot Current primary slot of redundant adapter 
(0 or 1)

DINT

Sts_PrimState State of primary module in redundant 
adapter pair

INT

Sts_PwDS Primary with disqualified secondary BOOL

Sts_PwNS Primary with no secondary BOOL

Sts_PwQS Primary with qualified secondary BOOL

Sts_QS Qualified secondary BOOL

Sts_Ready Device is ready to perform primary 
function

BOOL

Sts_Running At least one remote adapter of the 
redundant pair is running

BOOL

Sts_Virtual Virtual device status: 1 = Device is 
operating as a 'virtual' device

BOOL

Sts_Warning Device warning status: 1 = an active alarm 
or warning exists

BOOL

Sts_InvalidPath It shows an invalidpath error when 
entering the long path

BOOL

EnableOut Enable Output - System Defined 
Parameter

BOOL
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Programming Example Fully configured device on a rung is provided below for reference. Note that 
this programming example is the same code that is imported when either 
importing the supplied RUNG.L5X files or when using Application Code 
Manager or the Studio 5000® Import Library Objects wizard plug-in. 

The device (1756-EN4TR redundant adapter pair) must also be configured with 
the correct device definition. Note that this configuration is completed 
automatically when using Application Code Manager or the Studio 5000® 
Import Library Objects wizard plug-in. For details on setting up the device, 
refer to the Device Definition section.

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. A generic rectangular pushbutton with a text label can be 
used, or a graphical style button with abnormal indicator icons can be used. 
See Basic Launch Button Attributes section for details on configuration and 
indicators.

FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Description Global Object Parameter Values Graphic Symbol

GO_GotoDisplay4 Faceplate navigation button with string tag label.

#102: Add-On Instruction Backing Tag e.g. ({::[Topic 
Name]Redundant_Adapter_AOI_Example})
#105: Custom button label. Leave blank 
to use Tag.@Description
#120: Display’s left position
#121: Display’s top position

GO_LaunchEN4TR_Redunda
ntAdapter_1756 Use with 1756-EN4TR Modules

#102: Add-On Instruction Backing Tag e.g. ({::[Topic 
Name]Redundant_Adapter_AOI_Example})
#120: Display’s left position
#121: Display’s top position
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Studio 5000 View Designer® Graphic Symbols

All Studio 5000 View Designer® graphic symbols must be configured with an 
Event to open up the appropriate Popup screen. Select the graphic symbol and 
in the Properties window navigate to the Events tab. Assign a Button Behavior 
event to Open popup on release. Assign the required Popup screen (e.g. User-
Defined Screens\raC_Dvc_1756_EN4TR_FP). 

Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 40.

Graphic Symbol Name Description Properties - Events Configuration Graphic Symbol

Button_001
The supplied launch button in View
Designer is used to navigate to the
faceplate in a user application.

AOI_Tag: Object’s Add-On Instruction Tag

GO_LaunchComm_1756_EN4T
R Use with 1756-EN4TR Modules AOI_Tag: Object’s Add-On Instruction Tag
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The faceplate title is linked to _InstanceName.@description, the .@description 
extended tag property of the Add-On Instruction instance. This is user-
configurable from controller/program tags in Studio 5000 Logix Designer.

Home

The Home tab is the main tab of the faceplate. I/O channel data and fault 
information. The banner at the top of the faceplate displays module status and 
fault information. Home tabs vary based on the type of module and serial 
channel type.

1

2 7

3

4 6

5

Item Description
1 Faceplate title bar. Display’s Module:I.@Description

2

Module ready status.

GREEN = Ready

YELLOW = Module Fault/Not Ready
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Application Code Manager IO-Link Device Library objects can be set-up and configured using Studio 5000 
Application Code Manager.

Refer to the section Using Application Code Manager for complete details.

Definition Objects: raC_Dvc_1756_EN4TR

This Asset-Control object contains the Add-On Instruction definition and 
required data types. It is used as a linked library to the device implement 
object. This gives users the flexibility to choose to instantiate only definition 
and create custom implement code. A user may also create their own 
implement library and link with this definition library object.

Implementation Objects: raC_LD_Dvc_1756_EN4TR

The Device Implementation Object is the rung that is instantiated when 
generating controller code using Application Code Manager. This 
implementation object includes a reference to the Asset-Control Add-On 
Instruction definition, along with any required controller tags, programs, 
modules, and HMI objects.

3 Redundant adapter pair status information overview 

4

Slot 0 Port status

Green = Active

Gray = Inactive

5 Current location of Primary and Secondary slots
6 Slot 1 Port status

7 Green = Active

8 Gray = Inactive

9
Module/Channel Fault status text. May display the following:
- Module Fault – Neither Adapter is Running
- AOI Not Enabled – All Data remains at last enabled state

Item Description
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Configured HMI Content

Attachments

Parameter Name Default Value Instance Name Definition Description

RoutineName {ObjectName} {RoutineName} Routine

Enter Routine name.  Routine will be created and Object implement 
rung(s) inserted.  
A JSR will be inserted in MainRoutine.  
If routine name already exists, then object will be inserted into 
existing routine.  
By default, parameter is set to Object Name.

TagName {ObjectName} {TagName} Backing Tag
Enter the backing tag of the main AOI.
This will serve as the base tag name for other tags in this object that 
are derived from the base.

TagDescription {ObjectDescription} {TagDescription} Tag Description of the main AOI backing tag

ModuleReference ModuleReference Select the EN4TR module.

NavigationButton GraphicalButton Select Navigation Button type.

HMI Content Instance Name  Description

Launch Button {ObjectName}_GO_LaunchF
P Global Object configured callout  instance

 Name Description File Name Extraction Path

V5_raC_Dvc_Globall Graphic Symbols ME (raC-5-ME) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewME\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate ME (raC-5_xx-ME) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays 

V5_raC_Dvc_Globall Graphic Symbols SE (raC-5-SE) Graphic Symbols - IO Device.ggfx {ProjectName}\Visualization\FTViewSE\Global Object 

V5_raC_Dvc_FAMILY_MODULE Faceplate SE (raC-5_xx-SE) raC_Dvc_FAMILY_MODULE-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays 

V5_raC_Dvc_FAMILY View Designer (raC-5_xx-VD) raC_Dvc_FAMILYIO_wDesc.vpd {ProjectName}\Visualization\ViewDesigner\Displays 

V5_RM_raC_Dvc_IO Reference Manual DEVICE-RM200C-EN-P.pdf {ProjectName}\Documentation

V5_IO_Device_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images 
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